
University of South Florida University of South Florida 

Digital Commons @ University of Digital Commons @ University of 

South Florida South Florida 

FUNDAMENTALS OF INFORMATION 
TECHNOLOGY: Textbook – English 

The Modernization of Digital Information 
Technology 

2023 

Fundamentals of Information Technology Fundamentals of Information Technology 

Shambhavi Roy 

Clinton Daniel 
University of South Florida, cedanie2@usf.edu 

Manish Agrawal 
University of South Florida, magrawal@usf.edu 

Follow this and additional works at: https://digitalcommons.usf.edu/dit_tb_eng 

Scholar Commons Citation Scholar Commons Citation 
Roy, Shambhavi; Daniel, Clinton; and Agrawal, Manish, "Fundamentals of Information Technology" (2023). 
FUNDAMENTALS OF INFORMATION TECHNOLOGY: Textbook – English. 19. 
https://digitalcommons.usf.edu/dit_tb_eng/19 

This Book is brought to you for free and open access by the The Modernization of Digital Information Technology 
at Digital Commons @ University of South Florida. It has been accepted for inclusion in FUNDAMENTALS OF 
INFORMATION TECHNOLOGY: Textbook – English by an authorized administrator of Digital Commons @ University 
of South Florida. For more information, please contact digitalcommons@usf.edu. 

https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/dit_tb_eng
https://digitalcommons.usf.edu/dit_tb_eng
https://digitalcommons.usf.edu/dit
https://digitalcommons.usf.edu/dit
https://digitalcommons.usf.edu/dit_tb_eng?utm_source=digitalcommons.usf.edu%2Fdit_tb_eng%2F19&utm_medium=PDF&utm_campaign=PDFCoverPages
https://digitalcommons.usf.edu/dit_tb_eng/19?utm_source=digitalcommons.usf.edu%2Fdit_tb_eng%2F19&utm_medium=PDF&utm_campaign=PDFCoverPages
mailto:digitalcommons@usf.edu


INFORMATION
TECHNOLOGY

FUNDAMENTALS OF

SHAMBHAVI ROY
CLINTON DANIEL

MANISH AGRAWAL



Copyright 2023

This project was supported by the Cybersecurity and IT Pathways grant 
from the Florida Department of Education through Cyber Florida, 

project number 291-1231C-2C001, funding authority 84.425C-D CRRSA 
ACT ESSER II 84.425D & GEER II 84.425C, FAIN#: S425C210052. More 

information at cyberflorida.org/pathways/.

Print textbook ISBN:  978-0-9776744-5-9

Digital textbook ISBN:  978-0-9776744-6-6



Table of Contents i

Table of Contents

Chapter 1: Digital Information Technology Course 
Introduction (Preface)	 1

Overview	 2
Key Features and Outline	 2
Digital Information Technology Standards	 3
Acknowledgments	 3

Section 1 
Fundamentals

Chapter 2: History of Information Technology	 7
Overview	 8
How Information Technology Began	 11

The Era of Personal Computers	 14
The Era of Networked Computers and the Internet	 15
The Internet and the World Wide Web	 16
The Mobile Revolution	 17
Women in Technology	 18

Chapter Terms and Definitions	 20
Chapter Case: Anthony’s Learners Permit	 22

Chapter 3: Careers in Information Technology	 23
Overview	 24

Software Development	 25
IT Infrastructure	 26
IT Support	 26
Data Management	 26
Cybersecurity	 26
Computer Forensics	 27



ii Table of Contents

Internet Infrastructure	 27
Research and Development	 28
Careers Supporting IT	 28

Skills Needed to Succeed in IT	 28
Soft Skills	 29
Organizational and Project Management Skills	 29
Basic Computer Skills	 29
Familiarity with Office Tools	 30
Web Skills	 30
Wi-Fi Access	 31
Collaboration Skills	 31

Chapter Terms and Definitions	 34
Chapter Case: Anthony’s Learners Permit	 36

Chapter 4: Researching and Using the Web	 37
Overview	 38
Information Sources	 38

Search Engines	 38
Specialized Review Platforms	 41
Public Wikis/Encyclopedias	 42

Online Training	 43
Informal Training Sites	 44
Massive Open Online Courses (MOOCs)	 44
Training by Industry-Specific Organizations	 45

Using the Web: Risks, Pitfalls, and Strategies 	 45
Is the Source Reputable?	 46
Check the URL	 46
Look at Multiple Sources	 46
What’s Beyond the Headline? 	 47
Is the Author an Expert in the Field?	 47
Check Your Biases 	 47
Bounce Your Ideas With Others	 48
What Motivates the Source? 	 48
Search Tracking	 48

Chapter Terms and Definitions	 49
Chapter Case: Christopher’s Google Search	 50



Table of Contents iii

Chapter 5: Microcomputers	 51
Overview	 52
Microcomputers	 52

Desktop Computer 	 52
Laptop	 53
Tablet	 54
Smartphone	 55
Smartwatch	 56

Architecture of a Microcomputer	 57
Motherboard	 57
CPU	 58
RAM	 60
Storage	 64

HDD vs SSD vs Portable Flash Drives	 65
Bus	 66
GPU	 67

GPUs for Video Content Creation	 68
GPUs for ML and Crypto Mining	 68

Input Devices	 69
Keyboard	 69
Mouse and Trackpad	 70
Camera and Microphone	 71

Output Devices	 71
Speakers	 72

Conclusion	 72
Chapter Terms and Definitions	 74
Chapter Case: Gaming Consoles Yesterday, Today, and 

Tomorrow	 76

Chapter 6: File Management	 77
Overview	 78
Why Manage Files?	 79
Using File Managing Utilities	 81
Opening the File Managers	 81

File Manager Components	 82

File and Folder Properties	 84
Names	 84

Parts of File Names	 85



iv Table of Contents

Locating Files	 87
Navigation	 88

File Paths	 88
Search	 89

System Generated Folders	 92
File Operations	 94

Renaming Files and Folders	 94
Copying Files	 95
Moving Files	 97
Deleting Files	 99
Restoring Files	 99

File Compression and Decompression	 101
File Backup	 102
Cloud-Based File Management	 103
Task or Activity Manager	 105
Chapter Terms and Definitions	 108
Chapter Case: Ian’s Research Paper File	 110

Section 2 
Personal Productivity Applications

Chapter 7: Productivity Applications	 113
Overview	 114
What Are Productivity Applications?	 114
Documents	 115

Portable Document Format (PDF)	 116

Spreadsheets	 117
Presentations	 120
Email		  121
Calendar		 122
Web Conferencing	 123
Chat		  125
Office 365 and Google Suite	 126

Bundling	 126

Chapter Terms and Definitions	 128



Table of Contents v

Chapter Case: A Teacher’s Work is Never Done	 129

Chapter 8: Word Processors	 131
Overview	 133
Getting Started	 134
Essential File Operations	 135

Save	 135
Print	 136
Export	 136

Creating Content	 137
Fonts	 137

Serif Fonts	 138
Sans-Serif Fonts	 138
Script Fonts	 139

Spacing	 140
Indentation and Alignment	 142
Lists	 143
Styles	 144
Tables	 145

Captions	 146
References	 147
Insert Menu	 148
Keyboard Shortcuts	 148

Page Layout	 149
Orientation	 149
Other Page Layout Properties	 149

Headers and Footers	 150
Image Editing	 150
Shapes	 151

Revision and Proofreading	 152
Track Changes	 152
Comments	 153
Find and Replace	 154
Spelling and Grammar	 156
Thesaurus	 157

References	 157
Citations and Bibliography	 157
Hyperlinks	 158
Bookmarks	 160
Footnotes	 161



vi Table of Contents

Table of Contents	 161

Mail Merge	 163
Chapter Terms and Definitions	 166
Chapter Case: My First Resume	 167

Chapter 9: Introduction to Spreadsheets	 169
Overview	 170
What is a Spreadsheet?	 171

Managing Spreadsheets	 173
Menu Options	 174
Entering Cell Data	 175
Row and Column Titles	 177
Formatting Cells and Worksheets	 177
Styles	 179
Themes	 179
Merging and Splitting Cells	 180
Hide and Unhide Columns and Rows	 181
Page Layout Options	 182
Formulas and Functions	 183
Charts and Images	 184
Benefits of Charts	 185
Images	 186
Share and Collaborate	 186

Analyzing and Organizing Data	 187
Filters	 187

Sorting 	 188
Conditional Formatting	 189
Pivot Tables	 190

Additional Resources	 190

Chapter Terms and Definitions	 191
Chapter Case: Sports Tracking Spreadsheet	 192

Chapter 10: Introduction to Presentation 
Applications	 193

Overview	 194
What is a Presentation Application?	 194

Slides	 195
Adding, Deleting, and Reordering Slides	 195



Table of Contents vii

Formatting Slides	 197
Adding Content	 200
Business Elements: Charts, Graphs, Tables, and 

Spreadsheets	 203
Sharing, and Printing Slides	 207

Delivering the Presentation	 209
Learning to Deliver Great Presentations	 211

Chapter Terms and Definitions	 213
Chapter Case: Amber’s Business Presentation	 214

Chapter 11: Email	 215
Overview	 216
Email Origins	 216
The Impact of Email	 217
Email Technologies	 217

Mail Clients	 218
Desktop Mail Clients	 219
Mobile Mail Clients	 219
Receiving, Creating, and Forwarding Mails	 220
Organizing Email into Folders	 225
Mail Labels	 225
Mailing Lists	 226
Mail Filters and Rules	 226
Managing Signatures	 228
Email Sensitivity, Security, and Delivery Options	 230
Email Contacts	 232
Automated Messages	 232
Using Calendars to Schedule Meetings and Tasks	 234

Email Security	 238
Phishing Attacks	 239
Spear Phishing	 239
Emails Don’t Go Away	 240

Chapter Terms and Definitions	 241
Chapter Case: I’m Admitted to USF!	 243



viii Table of Contents

Section 3 
Enterprise Productivity Applications

Chapter 12: Introduction to HTML  
and Website Development	 247

Overview	 248
What is HTML?	 249

Structure of an HTML Page	 251
Elements in HTML	 252

Adding Links	 253
Adding Images	 254
Creating Lists	 255
Creating Tables	 255
Creating Forms	 256

Cascading Style Sheets (CSS)	 260
Website Design and Storyboarding	 261
Structure of a Website	 263

Hosting a Website	 265
Website Editors	 266

HTML Extensions	 268
Dynamic HTML (DHTML)	 268
Extensible Markup Language (XML)	 269

XML and JSON	 272

Chapter Terms and Definitions	 274
Chapter Case: Wrenley Saves the Pets!	 276

Chapter 13: Computer Languages, Applications, 
and Emerging Technologies	 277

Overview	 278
Types of Computer Languages	 278

Binary Code	 279

Computer Programming	 279
Block Based Coding	 280

Programming Basics	 281
Variables	 281
Functions/Methods	 282
Algorithm	 284



Table of Contents ix

Object Oriented Programming	 285
Objects	 286
Popular OOP Languages	 286

Applications	 287
Desktop Applications	 288
Web Applications	 288
Mobile Applications	 289
The Interplay Between Desktop, Web, and Mobile	 289
Computer Program Design	 289

Emerging Technologies	 290
Artificial Intelligence (AI) and Machine Learning (ML)	 290
Blockchain and Cryptocurrencies	 292
Augmented Reality and Virtual Reality	 292

Internet of Things	 293
Autonomous Vehicles (Self-Driving Cars, EVTOL, Drone 

Delivery)	 293
Advanced Robotics	 294
Biotechnology	 294

Learning to Program: Getting Started	 295
Chapter Terms and Definitions	 298
Chapter Case: Vivian’s Raspberry Pi	 299

Chapter 14: Database Applications	 301
Overview	 302

Evolution of Database Technologies	 302
Why Study Databases	 304

Relational Databases	 305
Introduction to SQL	 306
SQL Commands Types	 307
Querying a Database Using DML Commands	 307

Querying from Multiple Tables	 308
Updating Data 	 309
Deleting Data	 310
Advanced Querying Options	 311

Sorting	 311
Grouping	 312
Calculated Fields	 313

Creating and Managing Tables Using DDL Commands	 314
Inserting Data	 315



x Table of Contents

Importing Data	 316

Transactions Using TCL Commands	 317
Controlling Database Privileges Using DCL Commands	 319
Conclusion	 319
Chapter Terms and Definitions	 320
Chapter Case: Dionne’s Grade Tracking Database	 321

Chapter 15: Computer Networks	 323
Overview	 324

The Internet	 325

TCP/IP Stack	 326
Physical Layer	 327
Data Link Layer	 329
Network Layer	 331
Transport Layer	 332
Application Layer	 332

Networking Support Services 	 333
Computer Network Security	 335
Chapter Terms and Definitions	 337
Chapter Case: WHOIS Arianna’s Domain	 338

Chapter 16: Cybersecurity	 339
Overview—What is Cybersecurity?	 340

Confidentiality	 340
Integrity	 341
Availability	 341

Brief History of Cybersecurity Events	 343
The Basic Information Security Model	 349

Assets	 350
Threats	 351
Vulnerabilities	 353
Controls	 354

Cyber Hygiene	 355
Teams in Cybersecurity	 356
Chapter Terms and Definitions	 358
Chapter Case: The Red Team Operators	 359



Table of Contents xi

Section 4 
Issues of Personal and Social Concern

Chapter 17: Ethical Issues in Information 
Technology	 365

Overview	 366
Ownership Rules	 367

Copyright 	 367
Public Domain	 369
Fair Use	 369
Plagiarism	 370
Piracy	 371

Ethics and Online Content	 371
Online Privacy	 371
Social Media Addiction	 372
Online Tracking	 372
Political Impacts	 373
Biases in Artificial Intelligence (AI) Models	 374

Chapter Terms and Definitions	 376
Chapter Case: Allison’s Report—To Plagiarize or Not To 

Plagiarize	 377

Chapter 18: Social Media	 379
Overview	 380
Benefits of Social Media	 381

Professional Benefits	 381
Personal Benefits	 382

Risks of Social Media	 382
Professional Risks	 382
Personal Risks	 383

Tracking	 383
Addiction	 384
Cyberbullying	 385
Online Predators	 386
Online Scammers	 387
Echo Chambers or Confirming Your Biases	 388
Mental Health	 388

Conclusion	 389



xii Table of Contents

Chapter Terms and Definitions	 390
Chapter Case: Ken’s Social Media Safety Research	 391

Index		  393



Chapter 1—Digital Information Technology Course Introduction (Preface) 1

Digital Information Technology Course 
Introduction (Preface)

Overview	 2
Key Features and Outline	 2
Digital Information Technology Standards	 3
Acknowledgments	 3



2 Chapter 1—Digital Information Technology Course Introduction (Preface)

Where is the “any” key?

—Homer Simpson, in response to the message, “Press any key.”

Overview
In today’s digital age, technology permeates every aspect of our lives. Understanding the fundamentals 
of information technology is increasingly critical for personal satisfaction and professional success. 
Whether you are a curious novice or an aspiring technology professional, this book is your gateway 
to unlocking the mysteries and endless possibilities of the world of computing.

This book aims to give someone with no background in information technology the essential working 
knowledge of computers while also offering a sweeping view of the more complex topics. Whether 
you aspire to build cutting-edge applications, do groundbreaking research, or simply want to gain a 
deeper understanding of technology to be proficient at your job, this book will equip you with the 
essential knowledge and tools to thrive.

By the end of this book, you will know the history of computers; be comfortable using the common 
productivity tools to write a document, create a spreadsheet, make a presentation, send an email; 
organize your files; use the web for research; understand the ethical issues associated with information 
technology; and know the pitfalls of social media. This will help you participate in intelligent 
conversations about current and upcoming technologies with professionals in the field.

Through clear explanations, practical examples, and hands-on exercises, we aim to demystify complex 
concepts like cybersecurity and computer networks, empower you to think critically, and encourage 
you to embrace a creative and problem-solving mindset that lies at the heart of information 
technology. We also hope that this information will encourage you to consider college and career 
options in the dynamic world of digital information technologies.

Are you ready to embark on this adventure? Let’s dive into the captivating realm of digital information 
technologies and unlock the boundless opportunities therein.

Key Features and Outline
This book is divided into a few sections. The first section covers the fundamentals and provides an 
overview of the components of digital information technologies. Chapter 2 covers the history of 
information technology, from the time women served as “computers” to today’s mobile revolution. 
In Chapter 3, you will learn about all the possible career options and the skills necessary to be a 
proficient worker in the digital age. Chapter 4 will equip you with skills to navigate the web, find online 
training, and make you aware of the risks associated with online information. Chapter 5 is all about 
the architecture of microcomputers, including tablets, smartphones, and smartwatches. Chapter 
6 will give you the basics of file and folder management, including compression, decompression, 
and backup. The next section focuses on personal productivity applications. Chapter 7 provides an 
overview of production by apps. Chapters 8, 9, 10, and 11 delve into the intricacies of word processing, 
spreadsheets, presentation applications, and emails. After productivity applications, we introduce 
enterprise technologies, the core technologies used by large companies to manage their operations. 
You will spend a lot of time using these technologies if you choose information technologies as 
your career. Chapter 12 teaches basic HTML and website development skills. Chapters 13 and 14 
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introduce computer languages and databases to give you a taste of what it might be like to work as 
a programmer. Chapters 15 and 16 offer the basics of computer networks and cybersecurity. The last 
section focuses on issues of personal and social concern. Chapter 17 talks about ethical issues and 
Chapter 18 discusses social media. 

Digital Information Technology Standards
This book supports a course titled Digital Information Technology (DIT) (8207310) used within the 
Florida Department of Education (FDOE) public school system. The content included in this book 
aligns with the FDOE Student Performance Standards for DIT. The FDOE describes the DIT course as: 

This core course is designed to provide a basic overview of current business and information 
systems and trends, and to introduce students to fundamental skills required for today’s business 
and academic environments. Emphasis is placed on developing fundamental computer skills. The 
intention of this course is to prepare students to be successful both personally and professionally 
in an information-based society. Digital Information Technology includes the exploration and use 
of: databases, the internet, social media, spreadsheets, presentation applications, management of 
personal information and email, word processing and document manipulation, HTML, web page 
design, and the integration of these programs using software that meets industry standards. 

This definition is taken from the DIT website, Business Management & Administration, Digital 
Information Technology (8207310), 2023-24 CTE Curriculum Frameworks, https://www.fldoe.
org/academics/career-adult-edu/career-tech-edu/curriculum-frameworks/2023-24-frameworks/
business-management-administration.stml. This link is current as of June 2023.

Beyond this textbook, there are additional resources that can be used to supplement the DIT 
course. These resources can be downloaded from here: https://digitalcommons.usf.edu/dit/. These 
supplemental course resources include a comic book and a learning management system course 
designed using Canvas. The comic book serves as an alternative medium to learning topics covered 
in DIT. The Canvas course includes resources that can help students learn and instructors teach DIT 
according to the FDOE standards. 

Acknowledgments
In addition to the support funded by the Cybersecurity and IT Pathways grant from the FDOE through 
Cyber Florida, the authors of this book would like to acknowledge the following individuals for their 
critical support to make this project possible: 

Cyber Florida (Florida Center for Cybersecurity)
·	 Dr. James L. Welsh, Charmaine C. Beall, J.D., Dr. Simone Sellers, Dr. Candi Ring, and Courtney 

Wethington

Canvas Course Developers
·	 University of South Florida Innovative Education, Gloria Schramm, Dr. Kimberly Allison, 

and Jessica Brennan

Comic Book Developer
·	 Jamie Jones

https://www.fldoe.org/academics/career-adult-edu/career-tech-edu/curriculum-frameworks/2023-24-frameworks/business-management-administration.stml
https://www.fldoe.org/academics/career-adult-edu/career-tech-edu/curriculum-frameworks/2023-24-frameworks/business-management-administration.stml
https://www.fldoe.org/academics/career-adult-edu/career-tech-edu/curriculum-frameworks/2023-24-frameworks/business-management-administration.stml
https://digitalcommons.usf.edu/dit/
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What is Apple, after all? Apple is about people who think “outside the box,” people 
who want to use computers to help them change the world, to help them create 
things that make a difference, and not just to get a job done. 

—Steve Jobs, co-founder of Apple

Overview
How do you spend your free time? How do you communicate with friends? How do you complete 
schoolwork? How do you find the information you need? How do you buy things you like? What are 
some of your most prized possessions? What do some of the business celebrities you admire do? 
On completing school, what are some of the popular high-paying jobs in your town that you might 
be interested in doing? In the first half of the 21st century, Digital Information Technologies (DIT), 
or Information Technologies (IT) for short, are likely to be part of the answer to all these questions. 
Slowly but steadily, DIT has dramatically influenced our lives to the point where it is now necessary for 
all students to know the essentials of using DIT to improve their lives. This book, the accompanying 
materials, and the DIT course aim to do just that. At the end of this class, you should be able to explain 
to friends and family how computers work. You should also feel comfortable using computers to 
improve your own effectiveness. 

Information technologies are powerful because people crave information, and IT makes it easy for 
people to get this information. The world is teeming with information about who we are, where we 
live, and what we do to sustain ourselves. Until very recently, before the advent of computers in 
approximately 1990, this information was written on paper, published in newspapers or magazines, 
and stored in libraries and stacks of files in offices. In your own personal lives, you and your parents 
probably cherish family photo albums with printed photographs. Before computers, there was no 
easy way for people to share information with each other. Businesses did not have easy access to data 
about their own customers to understand larger patterns and take corrective actions.

Beginning in the 1990s, computers became popular, and starting in the 21st century, computers got 
connected to each other through the Internet, and the field of Information Technology (IT) was born. 
IT is the use of computers and networking technologies to store, process, and retrieve information. 
IT is now so important to organizations that IT investments, which include computers, networks, 
software, and employees are now one of the largest expenses for most organizations.

Regardless of what type of work you plan to do when you complete school, you will be expected to be 
as comfortable using IT effectively as you are using your first language. Doctors are expected to read 
and write electronic medical records as they interact with patients, CEOs, and business owners are 
expected to interpret reports generated by IT, and government staff is expected to work with citizen 
records as they respond to user queries. In turn, some of the most desirable jobs in the economy are 
emerging from this infusion of technology, which we will explore more in Chapter 3.

The Department of Motor Vehicles (DMV) is a great example of the impact of IT on our lives. See Figure 
1. Today, when you buy a car and go to the Department of Motor Vehicles (DMV) to get it registered, 
the clerk at the DMV office will record all the information about you and your car (make, model, VIN 
number) in a computer to establish your ownership of the car. 
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FIGURE 1 — At a typical DMV office, you interact with people who gather data 
and provide services.

Your data will be cleaned, processed, and moved across several computers and finally stored in a data 
center. See Figure 2. This data center will also hold similar data about all car owners across the state.

FIGURE 2 — A data center is a warehouse optimized for running thousands of 
computers. A typical data center can consume the power equivalent of a small 
town and provide backend IT applications for social media and mobile apps 
like maps and searches.
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How does IT help you and the DMV? Why should your state government invest millions of dollars each 
year to computerize the DMV? In 2020, there were 276 million vehicles registered in the US.1 The DMV 
needs to store information about all these vehicles and drivers safely. The DMV must also make the 
information available quickly when necessary. For example, when you buy a car, the DMV must make 
sure that the seller is the owner of the car and has the right to sell the car to you. When police officers 
stop drivers on the highway for speeding, it is very useful for officers to be able to check the driver’s 
license and car registration information. This keeps the roads safe for other drivers. Less interestingly, 
computerization also makes it easy for the DMV to send drivers automated reminders to make annual 
registration payments. Can you imagine doing all this across all 50 states in the nation without IT?

To pull off this feat of information technology, the DMV uses lots of expensive computers that are 
connected through complex networks and software programs that interact with the information 
stored in the system. They hire many trained people to maintain these data centers, upgrade 
hardware and software regularly, and maximize the efficiency of the DMV. These employees are very 
well compensated because their skills are valuable. The DIT course sets you on a path to acquire these 
skills so you can work in these roles across government and industry.

However, the DMV’s IT system (hardware, software, IT personnel, and processes) will be very different 
from that of the Department of Homeland Security (DHS) or any other organization for that matter. 
Even within organizations, IT systems evolve constantly based on how we want to gather information, 
what bits of information we want to gather, and what information has lost meaning over time. Some IT 
systems need to be highly secure, some are spread across the world, and some may be small enough 
to need just one employee and a desktop. 

Until around 2015, there was a distinction between 
personal electronic devices such as cell phones 
and office IT systems like PCs. But now with 
powerful smartphones and cheap mobile Internet, 
this distinction is disappearing. Employees expect 
business applications to be as user-friendly as 
consumer applications and consumer services to 
be as secure as business services. Employees can 
be responsive round-the-clock from work and 
home. Employees of the gig economy (e.g., Uber 
drivers, Door Dash delivery people, Amazon/FedEx 
drivers) use personal phones as their primary work 
devices to process orders. In this example, their 
personal mobile devices are part of the company’s 
IT system. See Figure 3. The Covid pandemic and 
the work-from-home trend have further reduced 
the distinction between personal and professional 
IT.

FIGURE 3 — Uber drivers use an app on their 
personal phones to select drives, communicate 
with passengers, navigate to locations, get paid, 
and gather feedback. Their phone is part of Uber’s 
IT system.

1	 Federal Highway Administration, Highway Statistics 2020, https://www.fhwa.dot.gov/policy​
information​/statistics/2020/mv1.cfm (accessed June 2023).

https://www.fhwa.dot.gov/policyinformation/statistics/2020/mv1.cfm
https://www.fhwa.dot.gov/policyinformation/statistics/2020/mv1.cfm
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How Information Technology Began
This section provides a quick tour through the history of how we have reached the current state of 
“information technology everywhere.” We show how innovative teams have responded to human 
needs and commercial incentives to create the technologies we take for granted today. If you find this 
interesting, we hope you will read more about these individuals and technologies on the Internet.

The history of information technology includes the history of computer hardware and software. 
Charles Babbage is credited with building the first mechanical computer in the 1820s. Over a hundred 
years later in 1946, a team at the University of Pennsylvania publicly reported the first programmable, 
general-purpose computer. It was called the Electronic Numerical Integrator and Computer (ENIAC). 
The ENIAC weighed 30 tons and took up 1800 square feet of space. See Figure 4. It supported most 
hardware and software components that modern programmers recognize. The ENIAC could read 
inputted data, hold information in memory, step through programming instructions, create and call 
sub-programs, loop through code, and print output.2 & 3

FIGURE 4 — A function table, interface for function table, and accumulator for 
an ENIAC are displayed.

The ENIAC didn’t have a lot of modern peripherals we take for granted now, such as monitors, 
keyboards, and printers. To use the ENIAC, programmers had to write instructions (code) into punched 
paper cards (cards with holes that could be read by computers). It took weeks of code-writing and 
debugging before the computer could do anything useful. The US Army funded the development of 

2	 The specifications of the ENIAC are available from the Smithsonian archives: https://library.
si.edu/digital-library/book/report-eniac-electronic-numerical-integrator-and-computer 
(accessed June 2023).

3	 The ENIAC page at the Computer History Museum has pictures and videos of the ENIAC 
computer and its key operators: https://www.computerhistory.org/revolution/birth-of-the-
computer/4/78 (accessed June 2023).

https://library.si.edu/digital-library/book/report-eniac-electronic-numerical-integrator-and-computer
https://library.si.edu/digital-library/book/report-eniac-electronic-numerical-integrator-and-computer
https://www.computerhistory.org/revolution/birth-of-the-computer/4/78
https://www.computerhistory.org/revolution/birth-of-the-computer/4/78
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the ENIAC to compute firing tables during WWII.4 Firing tables provided recommendations to gun 
operators on the optimal specifications to hit a target, taking into account terrain conditions, weapon 
wear-and-tear, ammunition type, etc.5 While the ENIAC was created to serve a specific military purpose, 
its general computing capabilities captured the imagination of the public.

The ENIAC was a computer like any modern computer, but it did not use software as we understand 
it today. Every instruction for every task was hard coded by experts. If the task was to be repeated, 
the instructions were written again on punch cards, which could take days. A lot of these instructions 
involved tasks such as reading data and writing outputs, which are common to all computer programs.

Eventually, these shared tasks were aggregated into computer programs called operating systems. 
The Operating System (OS) is the brain of the computer and controls all the parts of a computer. A 
computer mouse, keyboard, display monitor, motherboards, and storage drives are all components of 
a computer, and they act together as one computer only when the operating system recognizes them 
and orchestrates a symphony of coordinated actions to complete the task you tell the computer to 
perform. When you move your mouse, tab your screen, type on your keyboard, or make a phone call, 
it is the operating system that recognizes the action and tells the components how to act to bring 
about the desired outcome.

What Does an Operating System Do?

Operating systems are to computers what front offices are to schools.

Most complex entities offer a “front office” that makes it simple for users to 
request and offer services. At most schools, for example, the front office is where 
students report absences and get their schedules, teachers report grades and 
request supplies, and parents make inquiries. The front office staff are experts in 
handling these requests and orchestrating the necessary actions to complete 
these requests. The front office staff also ensures that any administrative 
requirements, such as student privacy, are protected as these actions are 
performed. Operating systems perform the same role for computers. They 
receive inputs from users and applications and coordinate all necessary actions 
until the appropriate output is presented to users.

Operating systems evolved rapidly in the 1960s and 70s. In 1971, AT&T, the dominant phone company 
at the time, built an operating system called Unix. See Figure 5. Unix and its variants were freely 
distributed across the world in the 1970s and 1980s, and some of the world’s best computer scientists 
and engineers volunteered their contributions to make Unix extremely capable. These experts 
were guided by the principle of using the “minimum number of keystrokes [to] achieve the maximum 

4	 If you’re looking for an interesting math project, or seeing how the military uses calculus, this 
article on the ENIAC may be useful: Harry L. Reed Jr, “Firing table computations on the ENIAC,” 
Proceedings of the 1952 ACM national meeting (Pittsburgh), May 1952 Pages 103–106, https://
dl.acm.org/doi/pdf/10.1145/609784.609796 (accessed June 2023).

5	 Examples of firing tables are at https://www.globalsecurity.org/military/library/policy/army/
fm/6-40/Ch7.htm (accessed June 2023).

https://dl.acm.org/doi/pdf/10.1145/609784.609796
https://dl.acm.org/doi/pdf/10.1145/609784.609796
https://www.globalsecurity.org/military/library/policy/army/fm/6-40/Ch7.htm
https://www.globalsecurity.org/military/library/policy/army/fm/6-40/Ch7.htm
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effort.”6 Because of their powerful capabilities and low to no costs, Unix and its variants including the 
popular Linux operating system, now power most computers around the world, including all major 
smartphones. Windows is another popular operating system, used extensively on desktops and in 
data centers.

FIGURE 5 — Scientists at AT&T Bell Labs created the Unix system, thereby 
laying the foundation for modern computers. Ken Thompson (seated) and 
Dennis Ritchie (standing) are credited with inventing Unix.

The Origin of Unix

Unix began as one developer’s attempt to support games on office 
machines.7

Ken Thompson used his spare time at AT&T Bell Labs to write nerdy computer 
games and developed software to support his game, Space Travel. Because 
the software only supported one user (Ken Thompson), the software became 
famous at the lab as Thompson’s Un-multiplexed Information and Computing 
Service, or Unics, and later was abbreviated as Unix. Eventually, Unix acquired 
capabilities for multiple users to share the resources of a central processor, so 
the Unix name is not really representative of the operating system’s single-user 
limitations anymore. But names stick, and the Unix name remains popular. The 
first edition of Unix was just 4,200 lines of code indicating how powerful good 
computer code can be. Even in these earliest editions, Unix included games 
such as Blackjack, and this contributed to its popularity.

6	 Peter Collinson, “On the design of the Unix operating system,” Hillside Systems—On the Design of 
the UNIX operating System, https://www.hillside.co.uk/articles/typing.html (accessed June 2023).

7	 Warren Toomey, “The strange birth and long life of Unix,” IEEE Spectrum, Dec 2011, pgs. 34–37, 
52–55.

https://www.hillside.co.uk/articles/typing.html
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A powerful economic force also contributed to Unix’s widespread adoption. While AT&T funded the 
development of Unix, 15 years earlier, in 1956, AT&T had reached an agreement with the federal 
government that gave it monopoly status on long-distance telephony. In exchange, AT&T agreed not 
to sell any product that was not directly related to long-distance telephony. Eventually, AT&T shared 
the source code to Unix with multiple organizations, and they released their adaptations to the world. 
One of the most popular of these adaptations was developed at UC Berkeley and was called Berkeley 
Systems Distribution (BSD) Unix. The licensing for BSD Unix allowed adopters to make their own 
modifications without releasing them back to the community. This was very useful to commercial 
vendors. Among the most popular current commercial releases tracing their lineage to BSD are the 
operating systems on all Apple products, including MacOS on laptops and iOS on smartphones. The 
popularity of Unix is the result of technology excellence and economic incentives. 

The Era of Personal Computers

Until the early 1980s, computers were too expensive 
for personal use. As the cost to manufacture computer 
components came down, IBM saw an opportunity 
to make small, self-contained personal computers 
(PCs) that had their own Central Processing Units 
(CPUs). Since Unix was designed for giant centralized 
machines and dumb terminals, there was a need for 
an operating system that could run on these personal 
devices. IBM partnered with Microsoft to create 
an operating system for personal computers. This 
operating system was called Disk Operating System 
(DOS). Although DOS wasn’t easy to use (users still 
needed to type commands manually on a line), the 
idea of owning a computer caught on, and the IBM 
PC started the PC revolution by becoming the world’s 
first popular personal computer.

While IBM was not the first to make a personal 
computer, its entry into the market in 1981 with 
its PC priced at $1565, significantly cheaper 
than others, revolutionized the market.
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The IBM PC and Florida

The IBM personal computer was invented in Florida.8 Boca Raton to be precise. 
Since 1967, IBM had operated a unit in Boca Raton to develop, build, and sell 
inexpensive computers. A team at this unit built the inexpensive personal 
computer (PC) by creating an open design where components from multiple 
vendors could interoperate. The IBM PC used processors from Intel, operating 
systems from Microsoft, and components from several other vendors. 
Competition among these vendors brought costs down, while the popularity of 
personal computers helped many of these suppliers become large companies 
themselves. As of 2022, Microsoft (valued at $2Tr) and Intel (valued at $130bn) 
are worth more than IBM itself ($118bn). As of 2022, IBM, Intel, and Microsoft 
employ over 600,000 people.

Along with inexpensive hardware, in the mid-1980s came user-friendly software. In 1985, Microsoft 
launched Microsoft Windows, an easy-to-use Graphical User Interface (GUI) based operating system. 
Microsoft also released Excel for financial calculations in 1985 and Word for text editing in 1989. 
Doug Klunder (Microsoft’s first college hire9) led the development of Excel and Charles Simonyi 
(the world’s first repeat space tourist10) led the development of Word. Both programs leveraged the 
special capabilities of graphical user interfaces and propelled personal computers to widespread 
adoption in businesses. Computers also turned into convenient home devices for everyday users 
to write letters, manage personal finances, communicate with friends and family, create music, and 
watch entertainment shows. Between 250 million and 350 million personal computers sell each year 
to meet this demand.

The Era of Networked Computers and the Internet

Communication is a very fundamental human activity and information exchange has been one of the 
most popular uses of computers. Computer engineers recognized this need for information exchange 
early on and developed technologies for computers to talk to each other. The initial networks were 
limited in scope, connecting computers located within an office, and allowing users within an office 
to send emails to each other and share expensive resources such as printers.

8	 Boca Raton Historical Society, https://www.bocahistory.org/ibm-boca-raton (accessed June 
2023).

9	 In 1992, Doug left software development and has since pursued a career as a lawyer, https://
alum.mit.edu/slice/heres-why-creator-microsoft-excel-left-software-career-work-civil-liberties 
(accessed June 2023). 

10	 Simonyi paid $20million for his first space trip, https://www.britannica.com/biography/Charles-
Simonyi; https://en.wikipedia.org/wiki/Charles_Simonyi (accessed June 2023). 

https://www.bocahistory.org/ibm-boca-raton
https://alum.mit.edu/slice/heres-why-creator-microsoft-excel-left-software-career-work-civil-liberties
https://alum.mit.edu/slice/heres-why-creator-microsoft-excel-left-software-career-work-civil-liberties
https://www.britannica.com/biography/Charles-Simonyi
https://www.britannica.com/biography/Charles-Simonyi
https://en.wikipedia.org/wiki/Charles_Simonyi
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Mother of All Demos11

One of the most famous demonstrations of technology happened on December 
9, 1968. Douglas Engelbart delivered a 90-minute demonstration of essentially 
all the personal networked computer technology we use today. The demo 
included networking, graphical user interfaces, web-like pages (hypertext), 
images, the computer mouse, video conferencing, and word processing. In 
about 20 years, the technology was available in stores. For its far-reaching 
impact, the technology industry gave it the name “mother of all demos.”

As networks grew, network effects emerged. To understand the network effect, imagine a village with 
just two telephones connected to each other by a wire. The telephones will not be very useful since 
they only connect two people in the village. Conversations with all other users happen outside this 
network. However, as more people in the village connect to the network, every telephone in the 
network becomes increasingly useful. The same telephone allows users to connect to more people in 
the village. The free increase in benefit to the community as more members join a network is called 
the network effect. 

The network effect generated powerful incentives within the industry to network computers. By 
1981, the core computer networking technology we use today was specified. Since that time, the 
development of computers is closely associated with the development of computer networks, the 
Internet, and the World Wide Web. 

The Internet and the World Wide Web

Since the beginning of the 21st century, computer networks have become robust and globally available 
like water and electricity. Users and businesses have taken advantage of this networking capability to 
share information and do business with people around the world. The global network of computers 
that share information with each other is called the Internet. Information on the Internet can be linked 
to any other information on the Internet and these links can be considered as a web of information. 
Therefore, the information shared on the Internet is called the World Wide Web.12

Information traveling on the Internet is like cars traveling on a highway system. The Internet is a 
vast network connecting many smaller local networks, in the same way that the highway network 
connects all local roads. You can start from any point and drive to any other point using the network 
of roads as long as the roads are connected. The World Wide Web enables the same capability for 
information. 

11	 “The Mother of All Demos,” Wikipedia; Video recording of the demo, https://dougengelbart.org/
content/view/209/ (accessed June 2023). 

12	 More visualizations, including videos of the evolution of the Internet are available from the 
Opte project, https://www.opte.org/ (accessed June 2023). The site has been maintained for 
over 15 years by Barrett Lyon, an artist and Internet enthusiast. Information on the site may be 
interesting and useful for projects in other classes, including how governments can strangle 
Internet access, https://www.opte.org/about (accessed June 2023).

https://dougengelbart.org/content/view/209/
https://dougengelbart.org/content/view/209/
https://www.opte.org/
https://www.opte.org/about
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Networks and Development

Until about 1870, the United States was about as economically advanced as 
the rest of the world. But by 1920, the United States had advanced decisively in 
comparison. Much of this is attributed to the construction of five networks—
water, sewage, electricity, roads, and telephones. By the end of the 20th century, 
the information network was added to this list of networks contributing to 
American prosperity.

The Internet is built by connecting two types of networks—small networks within buildings and large 
networks that connect these small networks. The small networks connecting workers inside an office 
building or a school are called Local Area Networks (LANs). The network at your school or home is an 
example of a LAN. LANs help the computers in an office share files, emails, printers, and the Internet 
connection with each other. The networks that connect these small networks to each other are called 
Wide Area Networks (WANs). WANs are typically large networks spread across a wide geographic area 
such as a state or country and are used to connect the LANs within corporate and satellite offices. 
WANs are typically operated by Internet providers such as Verizon, Frontier, and Spectrum and users 
pay subscription fees to access WANs.13

The Mobile Revolution

Computing technologies have evolved rapidly and 
the technology industry has succeeded in shrinking 
computers to the size of mobile phones. Soon after 
the PC became a household device, developments 
in related technologies like storage, battery capacity, 
screens, materials, and networking fueled the mobile 
revolution. As a result, the traditional phone is now 
mostly replaced by powerful computers called 
smartphones, which users around the world carry 
in their pockets and purses. While Windows was the 
dominant operating system for the personal computer 
era, two operating systems are dominant in the 
mobile era—Apple’s iOS and Google’s Android. Both 
these operating systems trace their lineage to Unix. 
While the iPhone’s iOS is a version of Unix, Android is 
based on Linux, a Unix-compatible operating system 
initially created in 1991 by Linus Torvalds when he 
was a student at the University of Helsinki in Finland.

Steven Jobs shows off the iPhone 4 at the 2010 
Worldwide Developers Conference.

13	 The universities in Florida operate a WAN called Florida Lambda Rail, https://www.flrnet.org/ 
(accessed June 2023) that connects them to each other and other research institutions around 
the globe.

https://www.flrnet.org/
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Moore’s Law

The availability of computers gave us the ability to design more powerful 
computers. The virtuous cycle was the basis of Moore’s law named after Gordon 
Moore, one of the founders of Intel, a computer chip pioneer. Gordon Moore 
noted that the number of transistors on a microchip doubled every two years. 
The transistor is the core component of a computer chip and is a tiny electronic 
device used to store and process information. Its size is measured in nanometers 
(one-millionth of the width of a human hair). To understand the kind of progress 
we have made, consider the fact that a cutting-edge computer microchip in 
1970 had about 2000 transistors in it, but the latest Apple M1 computer chip, 
released in 2020, has 114 billion transistors. 

Today, even street vendors with modest incomes in developing countries around the world own mobile 
phones; and people living in distant countries can be as accessible as your next-door neighbors, all 
thanks to the availability of free audio and video phone apps. You can use your phone to do office 
work while being entertained, whether at home or waiting in a line at a grocery store.

Women in Technology

The World’s First Programmer

Did you know that the person 
often regarded as the world’s first 
programmer was a woman, Ada 
Lovelace? Early on, women didn’t 
get sufficient credit for their work. 
The dedicated team of women 
programmers who worked on the 
ENIAC received recognition for their 
work only in the 1980s.

Women were the original “computers,” doing complex math problems by hand for 
the military before the machine that took their name replaced them.… During the 
1940s and 50s, women remained the dominant sex in programming, and in 1967 
Cosmopolitan magazine published “The Computer Girls,” an article encouraging 
women into programming. “It’s just like planning a dinner,” explained computing 
pioneer Grace Hopper. “You have to plan ahead and schedule everything so that it’s 
ready when you need it. Programming requires patience and the ability to handle 
detail. Women are ‘naturals’ at computer programming.”

—Caroline Criado Perez, Invisible Women, 2019
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However, the moment it became clear that there was money to be made in computers, the moment 
it became clear that programmers needed to be brilliant, men ended up replacing women as 
programmers. Women faced significant hurdles in getting hired as programmers. Clearly, women 
had the programming skills since they were already doing the job. However, we, as a society, have 
a brilliance bias14—we rarely see women as brilliant. Rather than trying to figure out an applicant’s 
suitability for a job, tech companies stereotyped male characteristics as brilliant—a nerdy attitude, 
unkempt hair and face, staying up all night to program, loitering on programming websites that often 
also have content that women may find offensive. Hiring managers failed to account for the fact 
that a girl programmer may look different and even express her love for programming differently. 
For example, the tech-hiring platform Gild combed through applicants’ social data to assess their 
suitability. 

According to Gild’s data, frequenting a particular Japanese manga site is a “solid 
predictor of strong coding.” Programmers who visit this site therefore receive higher 
scores. Which all sounds very exciting, but as O’Neil points out, awarding marks 
for this rings immediate alarm bells for anyone who cares about diversity. Women, 
who as we have seen do 75% of the world’s unpaid care work, may not have the 
spare leisure time to spend hours chatting about manga online. O’Neil also points 
out that “if, like most of techdom, that manga site is dominated by males and has 
a sexist tone, a good number of the women in the industry will probably avoid it.”

—Caroline Criado Perez, Invisible Women, 2019

But the bias against women doesn’t end at hiring. 

More than 40% of women leave tech companies after ten years compared to 17% 
of men. A report by the Center for Talent Innovation found that women didn’t 
leave for family reasons or because they didn’t enjoy the work. They left because of 
“workplace conditions,” “undermining behavior from managers,” and “a sense of 
feeling stalled in one’s career.” A feature for the Los Angeles Times similarly found 
that women left because they were repeatedly passed up for promotion and had 
their projects dismissed. Does this sound like a meritocracy? Or does it look more 
like institutionalized bias?

—Caroline Criado Perez, Invisible Women, 2019

14	 Caroline Criado Perez, Invisible Women, 2019.
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			   Chapter Terms and Definitions

Android: Mobile OS developed by Google and 
available as open-source software

Computer: A programmable computing device 
capable of receiving input, manipulating data, 
and outputting information

Computer Engineer: An individual that focuses 
on the research, design, and development of 
computer hardware and systems

Data: Representation of facts in a formalized 
manner suitable for communication, 
interpretation, or processing by humans or by 
automatic means

Data Center: Centralized location of servers and 
networking equipment that facilitates processing 
and storage of data

Disk Operating System (DOS): Early user-
oriented operating system created from a 
partnership between Microsoft and IBM

Dumb Terminal: A simple device consisting 
of a monitor and keyboard meant to facilitate 
communication to a separate computing device

Gig Economy: A labor market characterized by 
short-term employment, typically involving an 
intermediary platform

Graphical User Interface (GUI): Visual medium 
of interacting with computers

Hardware: The physical and often modular 
components of a computer system

Information Technology: Any equipment 
or system responsible for data manipulation; 
also refers to the disciplines of science and 
engineering that interact with these systems and 
data

IOS: Mobile OS developed by Apple, used in 
iPhones

IT Personnel: Technically proficient individuals 
capable of optimizing the use of technological 
resources and soft skills to assist organizations 
with their IT needs

Keyboard: A physical or digital device capable 
of communicating with a connected computer 
system through assigned key inputs

Linux: Highly versatile operating system created 
by Linus Torvalds

Microchip: Electronic components comprised of 
transistors and circuits

Microsoft Windows: A GUI-based operating 
system developed by Microsoft, which is one of 
the most popular computer operating systems 
globally

Mobile App: Application specifically developed 
to run on smartphones and other mobile 
computing devices

Moore’s Law: A “law” proposed by Gordon Moore, 
Intel co-founder, stating that the number of 
transistors in microchips would double every two 
years due to advancing computing performance

Motherboard: Computer component that 
connects various other pieces of computer 
hardware
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Mouse: An input device capable of detecting 
user manipulation to facilitate interactions with 
computer systems

Network Effect: Increase in benefit to a 
community as membership grows

Networks: Computers that are connected 
through either wired or wireless means with the 
purpose of sharing data

Operating System: Software that facilitates 
sharing, allocation, and effective utilization of 
computer resources

Smartphone: A small form factor computer 
combined with a mobile phone based around 
touch screen input

Software: Instructions that computer hardware 
can interpret and execute in order to achieve 
desired tasks

Storage Drives: Physical devices to store data

System: Separate components working together 
to fulfill a function

Unix: The early and powerful operating system 
built by Bell Laboratories
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		  	 Chapter Case

Anthony’s Learners Permit
Anthony finally turned 15 years old and he was ready for his Florida Learners Permit 
(restricted driver’s license). The permit was required for him to drive the old family 
car parked in the driveway of his house. He had just successfully completed the 
required online Drug and Alcohol (DATA) course and the Department of Motor 
Vehicle (DMV) Permit Test. This was the day he had waited for so long. 

Anthony opened up an Internet browser on his laptop and navigated to the Florida 
Learners Permit information guide (https://www.dmvflorida.org/learners-permit/) 
to verify he had everything ready to go before his parents would take him to the 
DMV to get his restricted license. As he looked over the website, he noticed an 
interesting statement: 

“After completing both the DATA Course and Permit Test you are then eligible to get a 
Florida Learners Permit. The DMV approved course and test providers automatically 
transmit your information to the DMV upon your completion.”

Anthony thought to himself, “I hope all of my online DATA course and Permit Test 
information gets transmitted to the DMV before my parents take me to get my 
license today.” 

As Anthony and his parents walked into the entrance of the local DMV office, he 
noticed that he was surrounded by technology everywhere. There were so many 
systems displaying and collecting information. All he could think about was how 
amazing the first drive with his new learner’s permit would be. 

Question 1:	 What kinds of technology do you think your local DMV office would 
use to issue Anthony’s learner’s permit? 

https://www.dmvflorida.org/learners-permit/
https://www.dmvflorida.org/learners-permit/
https://www.dmvflorida.org/learners-permit/
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The quality, relevance, and impact of the products and services output by the 
technology sector can only be improved by having the people who are building 
them be demographically representative of the people who are using them. 

—Tracy Chou, software engineer at Pinterest

Overview
Information technology now offers a range of attractive career options for workers with a wide variety 
of interests, skill levels, and career ambitions. See Figure 6. Some of these roles are highlighted in this 
chapter.
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Software Development

Perhaps the first career option that comes to mind when thinking of information technology is related 
to creating these technologies. The majority of these jobs fall in the category of software development. 
Software developers are the builders of the IT world, writing code and fixing errors in code (called 
debugging) to either create components for other software developers or applications for end users. 
There is a wide range of software developer roles, from simple to complex. Relatively simple roles 
might involve tasks such as using spreadsheets to display annual expense reports for companies. 
Where complex roles could involve tasks such as automating robots for drug development.15 Software 
developer roles include:

·	 Application development: these developers create user-facing applications that interact with 
people, take their input, generate reports, and help them make decisions. If you choose this 
field, you’d most likely either be a front-end developer and create user interfaces that people 
interact with when they open applications; or you’d be a back-end developer and create 
linkages between software applications and databases. Many programmers do both front-
end and back-end development to increase their versatility and the breadth of available job 
opportunities.16

·	 System software development: these developers build the core technologies used in servers 
to manage databases, email, and business transactions. They also take care of back-end 
processes like source-code control and network-related issues. 

·	 Mobile application development: these developers build applications for smartphones. This 
is an exciting field in which developers build applications optimized for small screens and 
powerful capabilities (e.g., cameras, payments) of smartphones and tablet computers. This 
field is growing every day as many potential applications are yet to be built. 

·	 Embedded developers create software to manage non-PC devices like cars, dishwashers, 
refrigerators, and Wi-Fi routers. Embedded software is written specifically with a device in mind 
and controls the overall operation of the device. Embedded software is usually optimized for 
simple operation, immediate startup, and minimal maintenance. Users typically pay for the 
software as part of the cost of the product.

Software is assisting human work in more and more areas, and the demand for software developers 
seems never-ending. Writing code and building applications is challenging, and most companies hire 
software developers who have an engineering or MIS (management information systems) background 
and know at least a few programming languages, so they can handle a variety of tasks.

15	 “AI: From Drug Discovery to Robotics,” Forbes Magazine, July 27, 2022 https://www.forbes.com/
sites/forbestechcouncil/2022/07/27/ai-from-drug-discovery-to-robotics/?sh=689994a33d7f 
(accessed June 2023).

16	 If you are interested in application development, we recommend W3Schools as the starting 
point, https://www.w3schools.com/ (accessed June 2023), and following their recommended 
learning trajectory.

https://www.forbes.com/sites/forbestechcouncil/2022/07/27/ai-from-drug-discovery-to-robotics/?sh=689994a33d7f
https://www.forbes.com/sites/forbestechcouncil/2022/07/27/ai-from-drug-discovery-to-robotics/?sh=689994a33d7f
https://www.w3schools.com/
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IT Infrastructure

All large organizations buy, deploy, 
and maintain their IT infrastructure, 
which includes hardware, software, 
and networking components. All these 
organizations have an IT Infrastructure 
group to keep systems up and 
running and to minimize losses due to 
unexpected downtime. See Figure 7. 
Some of the typical job roles supporting 
this field are systems administrators, 
user managers, network managers, 
and email administrators. Employees 
in these roles come from all academic 
backgrounds, including those with high 
school diplomas and associates degrees, 
and college degrees. Typically, industry 
certification in a specific technology helps with initial entry into the profession.

FIGURE 7 — IT infrastructure including data storage and cloud 
computing.

IT Support

IT support groups provide technical support to resolve issues related to computers, phones, networks, 
printers, and other devices. Support groups communicate with end users and sometimes act as the 
interface between users and software developers. Typical job roles in this field are support staff, 
support engineers, business analysts, and support managers. Employees in these roles also come 
from all academic backgrounds. Many university students work as IT support staff in the beginning 
of their careers. 

Data Management

This group focuses on storing, structuring, and retrieving data efficiently. They design databases to 
ensure data is accurate and available for decision-making and strategic planning activities. Typical job 
roles in this field are database administrators, data architects, data modelers, and cloud specialists. 
Organizations are now increasingly interested in using their available data to improve decision-making 
(e.g., which students may benefit most from scholarships), and new roles, such as data engineers and 
data scientists, are emerging. Data management involves a mix of general programming abilities and 
specialized data handling abilities (using programming languages like SQL). Employees in these roles 
typically come from engineering or MIS backgrounds.

Cybersecurity

Cybersecurity experts keep organizations safe from hackers and malicious users by constantly 
monitoring threats and taking remedial action. They ensure that all computers and embedded devices 
in the organization are running the correct versions of software and that unauthorized users cannot 
access systems. As employees can and often do reveal company secrets and information accidentally, 
cybersecurity experts must also train employees in security best practices to always keep one step 
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ahead of hackers. Cybersecurity roles include end-user 
training and network monitoring. Employees in these 
roles share many characteristics with employees in IT 
infrastructure. A critical difference is that employees 
in cybersecurity also need to be able to act under 
pressure when the organization faces an active 
cybersecurity threat.

Computer Forensics

Computer forensics is the collection and preservation 
of evidence from computers for presentation in courts of law. This field is becoming increasingly 
important for cops and investigators because computers are used to plan many crimes, for example, 
to locate targets, plan escape routes and communicate with collaborators. Computer forensic experts 
recover deleted files and track digital information to figure out how a computer, network, or cell 
phone was used in a crime. With a few keystrokes, they can collect the required proof to connect a 
criminal to a crime. Most police departments hire cybersecurity experts and many cops take college 
classes and upskill themselves to become computer forensics experts.

Internet Infrastructure

The increase in the number of Internet users and embedded devices presents many challenges and 
opportunities. In 1980 the Internet barely existed and had only about 200 users. See Figure 8. In 2030, 
about 7.5 billion people across the world will be connected to the Internet. 

Internet Users in the World

4,000,000,000
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2,000,000,000

1,000,000,000

		  0
Internet Users 	 1990	 1995	 2000	 2005	 2010	 2015

FIGURE 8 — Internet users over the past few decades

In addition, it is expected that there will be 30 billion devices and sensors capable of talking to each 
other and accomplishing tasks automatically. This network of Internet-connected devices is called 
the Internet of Things (IoT). IoT will require a reliable Internet connection and hardware to remain 
alert and functioning. This vast network will also require IoT infrastructure technologists, who are 
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expected to be in high demand. These employees 
are also expected to share many characteristics with 
cybersecurity and IT infrastructure employees.

Research and Development

As computing and networking become increasingly 
integrated with human life, research and development 
will be needed to make IT simpler to use, economical to 
own, secure to operate, and efficient in using resources. 
All this will require research and development in all 
areas related to IT, including hardware, software, 
algorithms, development practices, and user interactivity. While the number of jobs in R&D is not 
likely to be large, they will be significant drivers of IT growth and can be exciting places to work for 
people who enjoy exploration and experimentation.

Careers Supporting IT

Other than the specific job roles listed above, most 
organizations also have other roles in IT including 
business analysts, user-interface designers, architects, 
engineering managers, quality assurance engineers, 
testers, and many other roles supporting the core 
team of developers. All these are great career options.

Even if you do not have any interest in IT and do not 
wish to work in an IT company, you will need some 
level of familiarity with technology in any job in the 
modern age. For example, teachers are expected to 
know how to use email to communicate with parents, 
schedule meetings using online calendars, store data about students in Excel, share teaching materials 
using Google Cloud, and use web conferencing technologies to help students. We, therefore, believe 
that the lessons in this book are relevant for any career option you choose.

Skills Needed to Succeed in IT
The skills needed to succeed in IT are quite similar to the skills needed to succeed in any modern high-
performing team or organization. A few basic computer skills and awareness of common tools are 
expected. We broadly divide the IT skills required in the modern workplace into these five categories:

·	 Soft skills

·	 Organizational and project management skills

·	 Basic computer skills

·	 Familiarity with office tools

·	 Web and collaboration skills
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Soft Skills

To get any work done, you need to communicate, listen, manage time, honor your commitments, be 
respectful of others, and show empathy for your colleagues. These interpersonal skills are called soft 
skills and affect your ability to work effectively with other people in a modern workplace. Soft skills 
are less important at the time of starting a career. However, as you progress in your career and take 
responsibility for guiding colleagues and junior employees, soft skills become increasingly important, 
eventually becoming more important than core technology expertise. All the years of hard work trying 
to acquire technical skills may get derailed if you do not have the necessary soft skills to become a 
successful team leader. Empathy, compassion, honesty, and the ability to celebrate your coworkers’ 
successes make you a valuable partner and someone others will always want to have on their team. 

Even when other team members don’t share your opinion, you should be able to express yourself and 
disagree with others without being disagreeable. You should be able to regulate your emotions when 
receiving critical feedback and try to see the feedback as an improvement opportunity. Giving constructive 
feedback to help other team members grow is also an asset. These skills will help you in every walk of life, 
not just within the boundaries of your workplace. For those who have mastered soft skills, the workplace 
is an environment full of positivity, a place where you can be productive while having fun.

Organizational and Project Management Skills

Most modern jobs require dealing with complexity and shifting goals. Dealing with this requires 
organizational and project management skills. You may need to coordinate with your team and 
potentially even with vendors and customers to solve common problems. You may need to gather 
business and functional requirements and test cases. To see this in context, imagine you and a group 
of friends deciding to build a gaming PC. You will get together and define its capabilities, the amount 
of money you are willing to spend, and how soon you need to build the PC. You can think of the above 
parameters as your high-level requirements. High-level requirements are typically called business or 
product requirements. You can break the business requirements into more detailed requirements, 
like the type of CPU, amount of RAM, storage, the number of disk drives, and the size of the box. These 
are your lower-level or functional requirements. You can then define test cases that will ensure the 
computer works as expected once it is assembled. Typically, validation results are stored as test results. 
Once you have defined all your requirements (business, functional, and test cases), you will identify 
a list of tasks and the order in which they need to be accomplished to build the PC. For example, if 
you buy the box because it was on sale but the box doesn’t have space for all your components, you 
would either have to compromise on your PC capabilities or buy another box to accommodate the 
necessary components and throw away the box that you thought was a great buy.

Working with a team requires additional activities to ensure that each item completes on time. You 
must provide regular (daily, weekly, or monthly) updates to your team, management, and customers 
in order to deliver results most efficiently. Thankfully, you can take advantage of Excel and other 
project management tools to give yourself a head start. You will learn more about Excel in Chapter 9, 
“Introduction to Spreadsheets.”

Basic Computer Skills

In any modern workplace, you will usually be assigned a computer on your first day at work, which you 
will use to do most of your office work. You must know how to turn the device on, shut it down, connect 



30 Chapter 3—Careers in Information Technology

it to your office network, and install and upgrade software as directed by the company’s IT group. 
You must also be familiar with common peripherals like monitors, external keyboards, mousepads, 
cameras, and headphones. To be able to make copies of documents, you will need to connect to office 
printers, be aware of common printer settings, and know how to send files for printing.

As most of the work you do on your computer will be stored in files, you must know how to create 
files, save changes to files, and store files in the correct folders. You should know about common file 
extensions and what software program will open a particular file type. We will discuss more about 
files and file management in Chapter 6.

As a lot of meetings are scheduled online, you need to know how to create and accept meeting 
invitations using common calendaring tools. If a meeting is in a physical room, you will also need to 
know how to book a room and what hardware will be necessary for the meeting. 

While some of the above jobs may sound daunting, most offices have people who will help you with 
the initial setup and find solutions to malfunctioning hardware and software. For example, your IT 
support team can help you connect to your printer. The IT support team is responsible for ensuring 
that employees are productive with IT and don’t waste time fixing minor technical issues. 

Familiarity with Office Tools

Your office computer will most likely come equipped with some common office software like 
Microsoft Office, G Suite, and Outlook. You will use these tools to create documents, spreadsheets, 
and presentations, and to send and receive emails. Here’s a list of common office tools you should 
know how and when to use. You’ll learn more about these tools in later chapters.

Product Purpose

Microsoft Word and 
Google Docs

Write letters and create invoices, documentation, and job offers. 

Microsoft Excel and 
Google Sheets

Store data in rows and columns to record sales, do calculations, 
summarize information, and create reports and invoices. 

PowerPoint and 
Google Slides

Create presentations for colleagues, managers, and customers.

Outlook and Gmail Send and receive emails and manage meetings. 

Web Skills

Most jobs will expect you to be proficient in using 
the web to do your daily tasks. For example, you 
may have to use Google Maps to find directions 
to the nearest warehouse or factory. You may 
have to log in to a client’s accounts tool to 
submit your invoices. The starting point for each 
of these skills is the ability to launch a browser, 
organize commonly used links as bookmarks, log 
into websites, and follow instructions. Popular 
browsers are depicted in Figure 9.

FIGURE 9 — There are many popular browsers such as 
Google, Safari, Microsoft Edge, and Firefox.
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Wi-Fi Access

A web browser is going to be of no use unless your computer is connected to the Internet. Users 
now generally connect to the Internet using wireless networks, commonly called Wi-Fi. Most libraries, 
schools, universities, and even coffee shops offer free Wi-Fi. Wi-Fi is a wireless network that allows 
phones, laptops, and desktops to connect wirelessly to the Internet. Most Wi-Fi networks are password 
protected and available only to patrons. At any new location, you should be able to talk to the staff 
and get the Wi-Fi name and password. You will then need to select the correct Wi-Fi name on your 
computer from a list of available Wi-Fi networks and enter the appropriate credentials to join the 
network. See Figure 10.

FIGURE 10 — Clicking the  icon brings up a list of available Wi-Fi networks. In 
this example, the red rectangle highlights the names of the available networks.

Below are three Wi-Fi connection icons found on your computer and their meanings.

You are connected to Wi-Fi and the Internet.

!
You are connected to Wi-Fi, but there is no 
Internet connection.

You are not connected to the Internet. Click to 
see the available Wi-Fi networks.

Collaboration Skills

Most offices rely heavily on collaboration software for employees to connect with each other easily. 
Chat software like Microsoft Teams or Slack, and web conferencing tools like Zoom, Webex, and 
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Google Hangouts are popular. You are probably already using variations of these in your personal 
life on personal mobile devices to send messages to and meet with friends. WhatsApp, Discord, and 
FaceTime are other popular chat/collaboration/web-conferencing tools.

In the post-Covid world, technology jobs have become more flexible and can be onsite, remote, or 
hybrid. If a job is onsite, then you are required to go to work. However, if you get a remote job, you’ll be 
a virtual worker who must attend online meetings and be available on Teams or Slack to participate in 
discussions with your coworkers. The work-from-home trend that started with the Covid lockdowns 
is a novel development. It will be interesting to see how it affects employee productivity in different 
tasks and whether employees end up working longer hours, compensating for the comfort of home.

A career choice is one of the most important decisions you will make in your life. It will affect how 
you will be compensated, where you can work, how you will balance your life and work, and what 
you will do during most of your waking hours. Therefore, do your best to be deliberate about the 
choice. Before you make a career choice, assess your skills to understand your aptitude, likes, and 
dislikes. Being good at a hobby may not necessarily mean you’ll enjoy it as a career for decades. This 
is particularly true if the activity is not well compensated in the market. While making a career choice 
without accounting for your financial needs may not be smart, choosing a career option solely for 
money may also prove to be disastrous in the long run. This is particularly true if you do not like the 
hours, stress, or customer interactions involved in the job. If you are unsure of your career choices, 
consider volunteering for non-profit groups and joining school clubs related to your career choices. 
This will give you a better feel for the job roles associated with the field. Medical schools, for example, 
expect students to have spent considerable time volunteering within medical establishments to 
know what they are getting into.17 This is because they have experienced high drop-out rates in their 
programs when students join to find a high-paying career.

Students taking this class should consider a career in IT. If you are good academically, particularly 
in classes like math and science that require structured thinking, we believe you should consider 
careers in software or hardware development. You might like the work environment and find the work 
meaningful. Certainly, the jobs in this field offer good salaries and the number of jobs will continue 
to grow in the foreseeable future. See Figure 11. Also, the United States is a dynamic economy where 
60% of the jobs in 2018 did not exist in 1940.18 IT is even more dynamic, and we expect new job types 
to appear by the time you enter the workforce.

17	 Clinical volunteering, https://www.usf.edu/arts-sciences/health-professions/involvement/clinical-
volunteering.aspx (accessed June 2023).

18	 David Autor, David A. Mindell and Elisabeth B. Reynolds, “The Work of the Future: Building Better 
Jobs in an Age of Intelligent Machines,” MIT Press, ISBN 9780262046367.

https://www.usf.edu/arts-sciences/health-professions/involvement/clinical-volunteering.aspx
https://www.usf.edu/arts-sciences/health-professions/involvement/clinical-volunteering.aspx
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FIGURE 11 — STEM occupation growth.

You will most likely need postsecondary education to have a career in IT. Postsecondary education is 
any education you receive after high school. You should start planning for postsecondary education 
as soon as you are ready, probably as early as middle school. Gathering information may be the first 
step to figuring out the types of training, certifications, or degrees necessary to get to your goal. You 
can do the following to get a head start:

·	 talk to friends with similar interests;

·	 meet with your school counselor;

·	 talk to adults who work in IT;

·	 search on the web.

A few organizations do offer summer internships to school students with the idea of grooming future 
IT professionals. Both volunteering and internships can prove to be especially advantageous. If you 
are thinking about applying for a two- or four-year college, you’ll be able to make your resume stand 
out by pitching your past experiences.
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			   Chapter Terms and Definitions

Back-end Developer: Programmers who create 
linkages between software applications and 
databases

Business Analyst: A person responsible for 
managing information and synthesizing it 
to understand what decisions to take in the 
company

Cloud Specialist: Individuals who can advise 
businesses on cloud computing solutions

Computer: A programmable computing device 
capable of receiving input, manipulating data, 
and outputting information

Computer Forensics: Collection and 
preservation of evidence from computers for 
presentation in courts of law

Cybersecurity: Field of IT that encompasses the 
security of information technology using policies 
and procedures

Data: Representation of facts in a formalized 
manner suitable for communication, 
interpretation, or processing by humans or by 
automatic means

Data Architect: A person who develops the 
systems involved in data capture, storage, and 
analysis

Data Management: Ensure data security, 
reliability, and accuracy of data

Data Modeler: A person responsible for 
analyzing data and identifying relationships that 
can improve databases

Database: Software to store and retrieve 
structured data

Email Administrator: A person responsible for 
maintaining an organization’s email systems

Embedded Developer: Software developers 
who create software for non-PC devices; 
embedded software is written specifically with a 
device in mind

Front-end Developer: Programmers who create 
user interfaces that people interact with when 
they open applications and focus on the user 
experience

Hardware: The physical and often modular 
components of a computer system

Information Technology: Any equipment 
or system responsible for data manipulation; 
also refers to the disciplines of science and 
engineering that interact with these systems and 
data

IT Support: Individuals who provide technical 
support to resolve issues related to computers, 
phones, networks, printers, and related devices

Keyboard: A physical or digital device capable 
of communicating with a connected computer 
system through assigned key inputs

Network Manager: A person responsible for a 
firm’s network architecture

Networks: Computers that are connected 
through either wired or wireless means to share 
data
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Non-PC Devices: Commonly referred to as 
embedded systems, these are devices that 
contain computer hardware but are developed 
and programmed for specific functions

Programming Language: An integrated set of 
commands used to write software

Project Management: The efficient coordination 
of a business’s resources to accomplish its 
objectives

Smartphone: A small form factor computer 
combined with a mobile phone based around 
touch screen input

Soft Skills: Skills related to human interaction 
and reaction through communication and 
perception

Software: Instructions that computer hardware 
can interpret and execute to achieve desired 
tasks

Support Engineer: Engineers who develop, 
maintain, and troubleshoot software and 
hardware used within an organization

Support Manager: A person focused on helping 
end users with computer resources

System: Separate components working together 
to fulfill a function

Systems Administrator: A person responsible 
for the implementation, maintenance, and 
security of a firm’s computers

Tablet Computer: Larger and more powerful 
mobile computer than a smartphone

User Interface: Any medium that allows users to 
interact with computers

User Manager: A person responsible for 
managing computer privileges given to 
individuals within the organization
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		  	 Chapter Case

Anthony’s Learners Permit
Let’s look again at the case from Chapter 2.

Anthony finally turned 15 years old and he was ready for his Florida Learners Permit 
(restricted driver’s license). The permit was required for him to drive the old family 
car parked in the driveway of his house. He had just successfully completed the 
required online Drug and Alcohol (DATA) course and the Department of Motor 
Vehicle (DMV) Permit Test. This was the day he had waited for so long. 

Anthony opened up an Internet browser on his laptop and navigated to the Florida 
Learners Permit information guide (https://www.dmvflorida.org/learners-permit/) 
to verify he had everything ready to go before his parents would take him to the 
DMV to get his restricted license. As he looked over the website, he noticed an 
interesting statement: 

“After completing both the DATA Course and Permit Test you are then eligible to get a 
Florida Learners Permit. The DMV approved course and test providers automatically 
transmit your information to the DMV upon your completion.”

Anthony thought to himself, “I hope all of my online DATA course and Permit Test 
information gets transmitted to the DMV before my parents take me to get my 
license today.” 

As Anthony and his parents walked into the entrance of the local DMV office, he 
noticed that he was surrounded by technology everywhere. There were so many 
systems displaying and collecting information. All he could think about was how 
amazing the first drive with his new learner’s permit would be.

Question 1:	 What types of careers do you think are required for people to develop 
and manage the information technology used to issue Anthony’s 
learner’s permit?

https://www.dmvflorida.org/learners-permit/
https://www.dmvflorida.org/learners-permit/
https://www.dmvflorida.org/learners-permit/
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The city’s central computer told you? R2D2, you know better than to trust a strange 
computer! 

—C3PO, “Star Wars: Episode V—The Empire Strikes Back”

Overview
Never in history have we had so much knowledge stored, organized, and ready to be consumed 
with the click of a mouse or the tap of a button. If we step back for a moment and think about what 
is available on the web, we will be amazed by the information close at hand, all thanks to computers 
and the Internet. You can find the score of any weekend football game, the price of grain in Nebraska, 
the weather in Antarctica, the tide schedules in South Australia, and the outcome of an election in 
Britain by typing your question into any search engine. If you are so inclined, you could have someone 
explain to you the Theory of Relativity, how to lay a brick wall, how to plan a party, or how to edit 
genes. If you want to learn to play the piano, understand road regulations in Florida, or learn about 
mountaineering, you can do it all from the comfort of your couch. 

IT gives you more power in terms of access to knowledge than kings and emperors of yesteryears ever 
had. However, as with any powerful tool, you should know how to handle it with care and caution to 
avoid getting into trouble and not harming yourself or others. In this chapter, we will introduce some 
of the common sources of information online and evaluate their pros and cons.

Information Sources
Search engines are the most common source of online information. However, depending on 
your needs, there are also other information sources including review sites, multimedia sites, and 
educational sites. We will briefly introduce them here.

Search Engines

Search engines are software that allows users to 
search for information of interest. Search engines 
have been with us ever since the Internet became 
popular and have evolved to yield super-accurate 
results. Google as well as Microsoft have built their 
reputations and fortunes by providing answers 
to your questions, accurately and reliably. Both 
Google Search and Microsoft Bing constantly refine 
their algorithms and can even predict and propose 
suggestions to autofill your queries. Their search 
engines are integrated with extensive external 
databases to answer all sorts of questions in the 
most helpful way possible.
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The basic capability of a search engine is to find documents on the Internet that correspond most 
closely to the search term entered by the user. For example, if you search for “USF,” search engines 
locate all pages related to USF, sort the pages by their relevance to the search term, and display the 
results, with the most relevant results on top. Results for “USF” from two popular search engines—
Google and Bing—are shown in Figure 12. We see that the results are not identical, reflecting 
differences in the algorithms used by the two search engines to process searches.

FIGURE 12 — Search engine results will populate differently depending on 
the search engine used.
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Search Engine Revenue Models

The search results for USF show how search engines make money. In the results 
from Bing, the first result is labeled as an “Ad” and encourages users to check 
out Keiser University. Organizations pay search engines for placement in search 
results, and this is one of the most profitable businesses in modern times. If 
a few visitors searching for USF register for courses at Keiser University, the 
investment in the search ads can be profitable for Keiser.

Search engines are expanding their capabilities to offer a single point of entry for any information-
based capability. For example, if you search for the price of a ticket to fly from Tampa to San Francisco, 
search engines can fetch the prices from different airline databases and show them to you in a 
comparative list. If you search for sneakers, they will not only bring you information about sneakers 
but also show you the prices and availability in nearby stores. When you search for the weather in 
New York, the search engine may not have the information stored directly in its database, but it 
will query external services such as weather.com on your behalf and present the information. All 
these capabilities make search engines very powerful as we become more and more dependent on 
information. 

Recent developments in artificial intelligence have enabled powerful voice recognition capabilities 
in inexpensive consumer devices. See Figure 13. With the popularity of these hands-free devices and 
the increased accuracy of voice recognition, you don’t even need to type your question. You can just 
ask Siri for the local weather, Google for a stock price, and Alexa to order cereals for the family.

FIGURE 13 — Smart speakers.
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Search Engine Evolution

Search engines have evolved through four primary stages: (1) manually curated 
table of contents (e.g., Yahoo starting in 1994); (2) keyword-based indexes of 
webpages (e.g., Lycos, Excite, Alta Vista starting in 1996); (3) link-based ranking 
of webpages (e.g., Google starting in 1998); and (4) embedded goal-specific 
search engines (e.g., Amazon, TikTok starting in 2003). In 1994, Jerry Yang and 
Dave Filo began manually creating a hierarchical directory of websites to help 
users find interesting sites on different topics.19 Yahoo is credited with giving 
Amazon its first boost. Three days after Amazon was founded, Jerry Yang 
emailed Jeff Bezos asking for permission to list Amazon in the “What’s cool” 
section of Yahoo. Amazon received $12,000 worth of orders in the first week of 
being listed on Yahoo.

The National Science Foundation started the Digital Library Initiative (DLI) in 
1994 to simplify information finding on the nascent Internet.20 Several projects 
to index webpages based on keywords emerged from this and related projects 
and became popular between 1996–1999. Eventually in 1998, one of the 
DLI projects led to the basic technology used by Google. Instead of ranking 
webpages based on keywords, Google’s technology relies on the judgment 
of website authors to link to other websites. Such links are considered reliable 
indicators of a webpage’s relevance and are used to create the page rank.

In recent years, sites have begun to develop search engines customized to their 
needs. Social media sites such as TikTok have developed search engines to show 
what a user is most likely to be interested in watching next. Shopping sites 
such as Amazon have developed search engines that show the most profitable 
products that a user is likely to buy next.

Specialized Review Platforms

General search engines like Google and Bing are very good at pulling up relevant information from 
the web in response to a query. However, search engines do not generate information on their own. 
In recent years, several companies have recognized business opportunities in helping users generate 
content that meets some specialized information needs of other users. Typically, such User Generated 
Content (UGC) helps other users decide which products and services to buy. Companies that help 
users add their reviews to products and services are known as specialized review platforms. See 
Figure 14. Examples include Yelp for restaurants and TripAdvisor for travel destinations. Specialized 
review platforms also help businesses. G2 for example, is a popular specialized review platform for 
business software. Search engines have also begun facilitating such reviews. If you want to know 

19	 “History of Yahoo!,” https://en.wikipedia.org/wiki/History_of_Yahoo! (accessed June 2023).
20	 “On the origins of Google,” https://beta.nsf.gov/news/origins-google (accessed June 2023). The 

NSF award, which funded the work that eventually became Google, can be seen at https://www.
nsf.gov/awardsearch/showAward?AWD_ID=9411306 (accessed June 2023).

https://en.wikipedia.org/wiki/History_of_Yahoo
https://beta.nsf.gov/news/origins-google
https://www.nsf.gov/awardsearch/showAward?AWD_ID=9411306
https://www.nsf.gov/awardsearch/showAward?AWD_ID=9411306
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what others have to say about something, a specialized review platform might be a good starting 
point. For example, if you want to buy a car, check out a restaurant, research the quality of a business, 
find a good dentist, get more information about your current medication, or buy a new refrigerator, 
these review platforms can be of great help.

FIGURE 14 — Review platforms can help users decide which product to use 
or buy.

Specialized review platforms can be categorized into two broad types: those offering expert opinions 
and those publishing crowd-sourced reviews. 

Expert opinion platforms like WebMD, Consumer Reports, Edmunds.com, and Nolo.com hire experts 
in specific fields (health, household appliances, cars, laws) to write articles and reviews offering in-
depth information about products and services in their areas of specialty. 

Crowd-sourced review platforms gather information from users and use voting algorithms to identify 
the most relevant and useful reviews. One of Amazon’s secret recipes to success has been its extensive 
collection of user reviews on products. Yelp, a crowd-sourced review platform, collects diner feedback 
on restaurants and can quickly recommend a restaurant you might like. Since these sites aggregate 
a community’s feedback, you might end up with a greater diversity of opinions than those provided 
by experts.

As with any recommendation, you must keep an eye out for potential fraud and misdirection. The 
review platforms may be more favorable towards the products of their business associates. Another 
problem is fake reviews. As positive ratings lead to increased sales, product manufacturers are 
tempted to influence reviews. Be aware of the possibility that even Amazon and Yelp reviews might 
be written by ghost review writers compensated by product manufacturers. 

Public Wikis/Encyclopedias

Wikipedia, a great knowledge base on the Internet, is an open encyclopedia that allows users to 
edit content. Wikipedia is one of the most popular sites on the Internet with over 59 million articles, 
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and it has a large and passionate community constantly editing and updating articles to keep them 
up to date and accurate. On the other hand, paid encyclopedias, like Encyclopedia Britannica, are 
commercial products that curate articles written by subject matter experts.21 Investigations suggest 
that there is little observable difference in the reliability of information between the two.22 

Wikipedia’s Origins in St. Petersburg, FL23

Wikipedia was founded in St 
Pete, FL in 2003. The company 
combined founder James Wales’ 
love for encyclopedias with the 
Wiki technology created by Ward 
Cunningham in Portland in 1995. 
The wiki technology enabled users 
to edit pages on their own, which 
helped Wikipedia to grow and find a 
niche in the market between Yahoo’s 
manual hierarchy and Google’s 
automated search.

However, Wikipedia has had its share of issues and controversies. In 2005, the biography of an 
American journalist, John L. Seigenthaler, Jr., on Wikipedia falsely identified him as a conspirator 
in the assassinations of John F. Kennedy and Robert F. Kennedy. These claims survived Wikipedia’s 
community policing for 132 days. 

Since Wikipedia is based on the wisdom of the community, the less commonly accessed and reviewed 
portions of the site may have less accurate information than the more common ones. There is also 
potential for “mob activity” where a group of biased and motivated individuals influence the tone and 
content of an article. 

Online Training
Information sources are abundant on the Internet, which opens many learning opportunities. 
Educational opportunities are found in a variety of formats on the Internet. Online training has 
become very popular and can fit many learning styles.

21	 Encyclopedia Britannica’s subscription page, https://subscription.britannica.com/subscribe 
(accessed June 2023).

22	 Jim Giles, “Internet encyclopedias go head-to-head,” Nature, 438, pgs. 900–901 (12/14/2005), 
https://www.nature.com/articles/438900a (accessed April 2023). The article found that whereas 
Wikipedia had about four errors per item, Britannica had about three errors per item. Nature 
responded to Encyclopedia Britannica’s statement regarding the article in “Britannica attacks,” 
Nature, 440, pgs. 582 (3/29/2006), https://www.nature.com/articles/440582b (accessed June 
2023).

23	 The information in this section is from “An oral history of Wikipedia, the web’s encyclopedia,” 
https://onezero.medium.com/an-oral-history-of-wikipedia-the-webs-encyclopedia-
1672eea57d2 (accessed June 2023).

https://subscription.britannica.com/subscribe
https://www.nature.com/articles/438900a
https://www.nature.com/articles/440582b
https://onezero.medium.com/an-oral-history-of-wikipedia-the-webs-encyclopedia-1672eea57d2
https://onezero.medium.com/an-oral-history-of-wikipedia-the-webs-encyclopedia-1672eea57d2
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Informal Training Sites

In recent years, popular media and entertainment 
sites like YouTube have also become useful sources of 
information, particularly for tutorials on specific topics. 
Whether you want to troubleshoot your dishwasher, 
learn how to program in Python, or prepare for a job 
interview, you are pretty much guaranteed to find 
a suite of videos tailored to your specific need. As 
the videos are rated by the community (with likes, 
dislikes, and subscribes), the YouTube algorithm 
combines the search capabilities of a search engine 
with an understanding of the viewing habits of 
similar users. This enables YouTube to constantly 
tune its suggestions for videos most likely to solve 
your problem.24 You can also interact with the 
content provider by commenting on the videos and 
contributing further to the content.

Apart from the benefits of curation and ratings by the community, videos have a distinct advantage 
as a learning medium. You can rewind and watch the difficult parts multiple times, increase the speed 
if you are already familiar with the content, skip portions you understand, and watch content at your 
own convenience on a device of your choice. 

However, there are several caveats to using YouTube as a learning medium: 

·	 identifying the right training yourself can be difficult

·	 having the time and discipline to see the training through can be challenging

·	 not receiving any certification after the training is demoralizing.

The Internet offers a variety of learning 
opportunities.

Massive Open Online Courses (MOOCs)

Massive Open Online Courses (MOOCs) are online educational courses open to anybody in the world. 
These educational platforms are provided by individuals, organizations, and firms. Some MOOCs, like 
Khan Academy, focus on free courses and some, like Coursera, offer a mix of free and paid courses. 
Some MOOCs like EdX even offer proctored examinations and certificates of completion.

Many leading universities are experimenting with MOOCs to bring the expertise of their faculty to 
students around the world. MIT offers most of its class materials for free on MIT Open Courseware.25 
Several leading universities including MIT and Harvard are collaborating on a shared learning 
platform called EdX to offer free and low-cost courses.26 These universities are also exploring how the 

24	 For an overview of how YouTube develops its recommendations, refer to “On YouTube’s 
recommendation system,” by Cristos Goodrow, https://blog.youtube/inside-youtube/on-
youtubes-recommendation-system/ (accessed June 2023).

25	 MIT Open Courseware homepage, https://ocw.mit.edu/ (accessed June 2023).
26	 About the EdX platform, https://www.edx.org/about-us (accessed June 2023).

https://blog.youtube/inside-youtube/on-youtubes-recommendation-system/
https://blog.youtube/inside-youtube/on-youtubes-recommendation-system/
https://ocw.mit.edu/
https://www.edx.org/about-us
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EdX MOOC platform can be used to offer students low-cost credentials such as micro-bachelors and 
micro-masters.

Most MOOC classes tend to be structured and take you on a step-by-step journey from novice to 
expert. Whether you are interested in researching, furthering your career, or just learning, MOOCs are 
a great way to go and have, not surprisingly, exploded in popularity in recent years.

Training by Industry-Specific Organizations

Once you enter your chosen profession, your industry or vendor-specific platform will usually offer 
several training options. One such training that is currently quite popular is offered by Amazon 
for their Amazon Web Services (AWS) technologies. This training is available for free and is very 
popular among folks eager to become AWS experts.27 Similarly, other leading technology companies 
including SAP28 (for large business operations), Oracle29 (for Data management), and Cisco30 (for 
Network Administration) offer extensive training globally both online and in person. There are also 
certification programs offered by industry-specific organizations for general technology expertise 
such as Scrum Master (for product development), Program Manager, and Business Analyst, and these 
can be extremely helpful in acquiring the relevant skills and finding jobs in these roles.

Using the Web: Risks, Pitfalls, and Strategies 
Although the web makes it easy to find information, not every bit of data obtained online is equally 
reliable. Before you act on information received online, you should be aware of the deceptions and 
traps. Here are some things to keep in mind when evaluating information received from online 
sources.

27	 Amazon Web Services (AWS) training, https://www.aws.training/ (accessed June 2023).
28	 SAP training, https://training.sap.com/ (accessed June 2023).
29	 Oracle University, https://education.oracle.com/ (accessed June 2023).
30	 Cisco training, https://www.cisco.com/c/en/us/training-events/training-certifications.html 

(accessed June 2023).

https://www.aws.training/
https://training.sap.com/
https://education.oracle.com/
https://www.cisco.com/c/en/us/training-events/training-certifications.html
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Is the Source Reputable?

Print publications with patterns of incorrect information usually do not survive for long. Therefore, 
print publications with wide circulation (e.g., popular magazines and newspapers) generally put in 
considerable effort to ensure the correctness of the information. This is part of their gatekeeping 
role. Gatekeeping is the process that publications follow to select and present information to their 
readers.31 Mechanisms that increase the reliability of the information include hiring experienced 
editors and validating the reliability of sources. When you read something in a print publication, you 
can be reasonably confident that the publisher put in their best effort to ensure the information is 
correct.

However, many people who post information online are not trained to verify information. Therefore, 
online information has a greater likelihood of being incorrect than print information. It also does not 
cost money to post information on blogs, social media, and other online platforms, which leads to 
vast amounts of information getting posted. Online information can reach wide audiences through 
search engines and social media even if incorrect. Social media platforms such as Twitter are widely 
considered the “Digital Town Square.” What should a reader do to get reliable information from online 
sources?

One mechanism is being aware of the source’s reputation. As every high schooler knows, reputations 
take a long time to earn, and no time to lose. A reputation for correctness is, therefore, an indicator that 
the online source has mechanisms in place to validate information before publishing it. Information 
posted by reputable sources is more likely to be correct. Although it is hard to judge the reputability 
of an online source, you can take some precautions. Look up the business name of a source on search 
engines to check reviews in other places on the web. On social media, you can look up a user’s list of 
followers. Users followed by other reputable users are likely to be reputable themselves.32

Check the URL

Unethical businesses often create look-alike websites to confuse people and grab user credentials 
and sales. This is called website spoofing. Even if you think you are getting information from university 
websites, banks, or other well-known private institutions, you should double-check the URL to make 
sure you are where you think you are.33

Look at Multiple Sources

Checking out information on several websites will help you look at the problem/solution from 

31	 You can find more information about gatekeeping online. One overview article we like is 
“Gatekeeping Theory,” https://masscommtheory.com/theory-overviews/gatekeeping-theory/ 
(accessed June 2023).

32	 Twitter has a mechanism to verify user accounts, indicated by . You can read about the 
verification procedure at https://help.twitter.com/en/managing-your-account/about-twitter-
verified-accounts (accessed June 2023).

33	 There are many variants of spoofing. You can look these up online including at this article: Sagar 
Joshi, “What is spoofing? How to Protect Yourself Against It?” https://www.g2.com/articles/
spoofing (accessed June 2023).

https://masscommtheory.com/theory-overviews/gatekeeping-theory/
https://help.twitter.com/en/managing-your-account/about-twitter-verified-accounts
https://help.twitter.com/en/managing-your-account/about-twitter-verified-accounts
https://www.g2.com/articles/spoofing
https://www.g2.com/articles/spoofing
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different perspectives. One source might focus on the ease of use of a device while another may 
bring attention to its price. If you get the same information from multiple reputable sources, it is a 
good indication of its authenticity. For example, if several car review websites agree that the model 
you want to buy is safe, reliable, and a good value for your money, then you can feel assured about 
having made the right choice. 

What’s Beyond the Headline? 

As users are reluctant to pay subscription fees for online publications, there is increasing pressure on 
websites to earn revenues by drawing traffic and showing ads to visitors. A popular way to do this is 
by using attention-grabbing headlines that may have little to do with the content of the article. These 
headlines serve as clickbait to draw readers to the site, not to summarize the information on the page 
or explain nuances. Therefore, when consuming online information, do not rely on the headlines 
alone and make it a point to read all the available information in the article, not just the first few 
sentences. It is common to see subjective conclusions at the top with caveats and drawbacks buried 
near the end of the article. 

Is the Author an Expert in the Field?

Online ad revenues have created a business model for influencers. Influencers are people who are 
able to encourage potential buyers of a product or service by recommending items online, usually 
on social media. Influencers make money by ensuring their content is visible and by having a lot of 
followers. When you search for product recommendations, you are likely to come across content that 
is popular or promoted by influencers, but not necessarily accurate or relevant to you. What works 
for the influencer’s specific circumstances may not work for you. It is, therefore, useful to verify the 
expertise of the person handing out advice. For example, if you want information about a type of 
diet, a nutritionist is more likely to have studied the impact of the diet under a variety of conditions 
compared to a popular sports star who may have followed the diet under the strict supervision of a 
team of experts. 

Check Your Biases 

The ease of finding the information we like makes the Internet great at confirming our biases and 
dragging us into an echo chamber that magnifies our beliefs. As the World Wide Web has dramatically 
increased our ability to connect with others, even the most outlandish ideas and conspiracy theories 
can have large groups of enthusiastic subscribers, egging each other on. 

This is an issue, particularly with subjective opinions. There is a reason why we maintain our biases: 
either we aren’t aware of their existence or wholeheartedly believe in their authenticity. Before 
reaching out to the web to validate your opinions, you should take a moment to be honest with 
yourself and understand if you are actually willing to change your initial opinion. Are you looking for 
new information just to prove your point? Are you only seeking out people who’ll agree with you? 
Can you argue the issue from the perspective of those holding the opposing view? 
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Bounce Your Ideas With Others

It is always a good idea to discuss what you have found on the web with friends, family, and teachers. 
The power of the community to sift out good ideas from bad ones can never be underestimated. 

What Motivates the Source? 

Web sites and search engines increasingly make money 
by encouraging you to buy things. They are, therefore, 
motivated to prioritize displaying information for 
which they get paid. When you search for a particular 
laptop, for example, the first few search results are 
likely to be advertisements by competing merchants 
and not necessarily the best/cheapest places to buy. 
The burden is on you to check the results and pick the 
one that makes the most sense.

Similarly, if you search for insurance agents on a search 
engine, the first results are mainly advertisements 
from various insurance companies. When you click on 
any of the links, the advertiser pays Google a “click-
through” fee. Google stands to gain by showing advertisers who pay the most, not necessarily those 
with the best products and services. 

Therefore, it is useful to be on the lookout to understand if your source of information makes money 
by influencing your decision. Reputable sites clearly separate advertisements from other content, but 
others tend to blur the difference.

Search Tracking

Another pitfall of searching for things online is search tracking. Most search engines tend to hold on 
to queries and use them to gauge your potential needs, often showing targeted advertisements on 
other sites you visit in the future. Your information might be shared or sold to other Internet merchants, 
who will likely be storing the information in databases around the world. You might be surprised by 
related ads long after you have abandoned the primary search engine. We will cover more about this 
in Chapter 17 on “Ethical Issues in Information Technology.”
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			   Chapter Terms and Definitions

Algorithm: A systematic and logical sequence of 
steps designed to solve a problem 

Influencers: Individuals who have a large 
audience through a social media platform 

Massive Open Online Courses (MOOC): 
Open access educational courses available to 
participants using an online platform

Scrum Master: In the Scrum approach to agile 
project management, the team member whose 
responsibility is to effectively get the team closer 
to the goals and keep everyone on track 

Search Engine: An algorithm designed to find 
resources related to what is input into a search 
interface 

Social Media: A digital platform for interaction 
between people

Spoofing: Disguising the true or trusted identity 
of a person or device

Uniform Resource Locator (URL): The website/
address of a resource on the Internet.

User Generated Content (UGC): An individual’s 
content creation on platforms; platforms include 
Instagram, Twitter, or YouTube

Wiki: User-generated content on a digital 
platform that facilitates collaboration
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		  	 Chapter Case

Christopher’s Google Search
Christopher stepped off the school bus and started to walk home as he thought 
about the homework assignment his teacher had assigned him earlier that day. 
His teacher asked him to use a search engine to find information about the Florida 
state bird. He was to research the topic and think about how the search engine 
works.

Christopher sat down at his home computer, opened an Internet browser, and 
navigated to google.com. While on the Google search engine page, he typed the 
search term, “Florida state bird.” The top result displayed the following: 

“Wow!” Christopher yelled. “144,000,000 results in .84 seconds!”. “It looks like the 
Northern mockingbird is the Florida state bird.” Christopher thought to himself, “How 
did Google know to put this reference to the Florida state bird in front of 144,000,000 
other results?”.

To understand how the Google search engine worked to display the results, 
Christopher looked over Google’s Documentation website: 

https://developers.google.com/search/docs/fundamentals/how-search-works 

After he reviewed the information on the website, he realized that the Google 
search engine works in three stages, and not all pages make it through each stage. 
The stages include crawling, indexing, and then finally serving the search results. 

Question 1:	 Research the terms “crawling” and “indexing” as they relate to the 
topic “search engine.” Based on the results of your research, how do 
these terms help search engines work?

Question 2:	 The results of a search using Google can vary depending on how 
relevant the information is to the search engine user. According to 
Google, relevancy can be determined by many factors including 
information such as the user’s location, language, and device 
(desktop or cell phone). Why do you think Google considers this type 
of relevant information when displaying the results of a search?

https://developers.google.com/search/docs/fundamentals/how-search-works
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If you’re not looking toward the future or trying to improve the current technology, 
you’ll be left behind.

—Gwynne Shotwell, president of SpaceX

Overview
In the previous chapter, we saw how computers are used in organizations. In this chapter, we will 
introduce the common types of computers and provide an overview of the parts of a typical computer. 
This will allow you to compare computers with different specifications and make the right choices 
when selecting a computer for a specific task.

Microcomputers
A microcomputer is a small, standalone computer designed to be used by one person at a time. 
Almost all computers you have used so far are likely to fall in the category of microcomputers. 
Microcomputers are less expensive than large corporate computers designed to handle much 
heavier computational tasks. These corporate computers are also called servers. Microcomputers are 
also known as Personal Computers (PCs) and are typically used for personal tasks such as writing 
emails, searching for information on the web, creating documents, making presentations, updating 
spreadsheets, watching movies, listening to music, and playing computer games.

Microcomputers come in many formats. The most common types are desktop computers, laptops, 
tablets, mobile phones, and smartwatches on your wrist. 

While desktop computers bear no resemblance to smartwatches, both share surprisingly similar 
architectures. Both have similar hardware components such as memory, storage, input, output, and 
Central Processing Unit (CPU). Both also have similar software components including an operating 
system and applications that run on the operating system. 

Modern microcomputers can talk to each other and share information. When you snap a photo using 
your phone, it can become immediately visible on your desktop. Similarly, when you get a phone call 
or a message on your phone, it can pop up on your desktop, smartwatch, and phone simultaneously. 
We begin by taking a brief look at each type of microcomputer.

Desktop Computer 

A desktop computer is a microcomputer primarily 
designed to meet the computational needs of a single 
user at a fixed location. If you have a comfortable desk 
where you do most of your work and would like a 
computer to use on the desk without moving it around, a 
desktop computer may be ideal for you.

While laptops are very popular for their mobility, desktops 
continue to be very popular for several reasons. Desktop 
computers generally offer the best value for your money since the components in a desktop do not 
have to be optimized for size, weight, or power consumption. Also, since desktops don’t have to be 
light, small, or portable, they can typically use larger power supplies and bigger fans to support far 
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more powerful processors (CPUs) and video cards. They can be configured with multiple hard disk 
drives and optical disk drives, and support multiple peripherals like large external monitors, external 
speakers, microphones, and cameras. Also, since they are designed to be stationary, users can create 
setups with multiple peripherals and full-size keyboards that do not have to be dismantled each 
time the device is moved. For their economy as well as setup convenience, desktop computers are 
very common in organizations, particularly for office staff who do not need portable computers to 
deliver presentations or take notes in meetings. Desktops are also popular for gaming because they 
can simultaneously support the most powerful computing units, video cards, and highest-resolution 
monitors without the need to worry about optimizing battery performance.

One additional benefit of owning a desktop computer is the ease of upgrade. Desktops are enclosed 
in cases that are usually easy to open. Desktops typically offer expansion slots that you can use to 
add additional memory and Graphic Processing Units (GPUs) over time for a better video gaming 
experience. Since desktops are larger, they also have several extra ports (USB, USB-C, HDMI, audio, 
and memory card slots) readily available to add storage and connect peripherals. 

As desktops are stationary, they also typically last much longer because they do not encounter shocks 
from being tossed around. You are also not likely to misplace your desktop at your local coffee shop 
or drop it from your backpack. 

Typically, you’ll choose one of the two operating system dominating the desktop market—Microsoft 
Windows or Apple Mac OS. Microsoft desktops are generally less expensive and have a significantly 
larger share of the market compared to Apple Mac OS-based desktops.

Linux is also an option for a desktop operating system. Ubuntu is a version of Linux optimized for 
desktops and laptops.34 The lack of end-user applications such as Office and vendor-specific drivers 
for peripherals such as printers and cameras limit the usability of Linux desktops for many end users. In 
recent years, however, as web-based applications such as Office 365 and Google Docs gain popularity 
for most personal productivity tasks, Linux is becoming an increasingly viable option, particularly for 
enthusiasts.

Laptop

Laptops, small enough to fit in your lap, have a clamshell 
unit, a screen on the top half, and an integrated keyboard 
and trackpad on the bottom. The great advantage of a 
laptop is its portability, which allows you to work from 
anywhere–school, home, and coffee shops. In the post-
Covid world, with most offices offering hybrid work 
models, a laptop may be an indispensable possession 
offering you the ability to work from wherever you want. 
As laptop prices drop, colleges are increasingly requiring 
students to own a personal laptop for use in class.

Manufacturers aim to design laptops that are as light as possible and work all day without the need 
for an external power source. To optimize for portability, the components inside a typical laptop, 

34	 The open-source Ubuntu desktop can be downloaded here, https://ubuntu.com/download/
desktop (accessed June 2023).

https://ubuntu.com/download/desktop
https://ubuntu.com/download/desktop
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including the CPU, Random-Access Memory (RAM), storage, keyboard, monitor, camera, microphone, 
and speakers, focus on power efficiency and compromise on performance metrics such as speed to 
keep the unit light. As the CPU is optimized to use less power and minimize heat generation, it may 
not be as powerful as your desktop CPU. This can be noticeable in demanding tasks such as video 
conferencing, software development, or when working on large spreadsheets with a lot of formulae.

Powerful chips generate a lot of heat and drain the battery fast, so this design optimization makes 
sense. Also, laptops typically have expensive Solid State Drive (SSD) storage because SSDs consume 
little power and are lightweight. Laptop keyboards can also lack features common in full-sized 
keyboards such as a dedicated numbers keypad. 

However, the benefits of being able to sit at a park bench, airport, or meeting room, pull out your 
laptop, and work or be entertained far outweigh the performance compromises of laptops for most 
users. As laptops come with a built-in rechargeable lithium-ion battery, you won’t need to find a 
charging source for several hours, even with continuous use. To address some of the limitations of 
laptops, you can carry a mouse and headphones or wireless earbuds. Some people keep a full-sized 
monitor, keyboard, and mousepad connected to a docking station at their home or office, so the 
laptop easily converts into a full-fledged desktop when they work for long hours. 

Just like the desktop PC market, even the laptop market is dominated by Microsoft Windows and 
Apple Mac OS. As Apple manufactures its own hardware, a Mac PC will have Mac OS. However, 
since Microsoft licenses its operating system to other hardware manufacturers, you are likely to find 
Microsoft Windows on laptops manufactured by several manufacturers including Samsung, LG, Dell, 
HP, Acer, and others.

An increasingly popular laptop option, particularly for high school students, is the Chromebook. 
Chromebooks use an operating system developed by Google, which saves very limited data on the 
local device and uses data storage on the cloud instead. This reduces hardware needs on the local 
device, reducing costs significantly. This approach becomes increasingly effective as more and more 
applications move to the cloud. 

Tablet

A tablet computer (known simply as a tablet) is a 
microcomputer designed for portability and media 
consumption. They have screen sizes comparable to 
that of a laptop but lack the input/output capabilities 
of a laptop such as keyboards and mice. Instead, they 
use touchscreens for input and output, much like a 
smartphone. Tablets have the same components as 
other microcomputers—RAM, CPU, storage, microphone, 
camera, and speakers, and they connect to the Internet 
through Wi-Fi, just like most other portable devices. Some 
tablet models also support Internet connectivity over a 
cellular network. 

The motivation behind tablets is to have a basic computer that is inexpensive, can be carried easily, 
and be turned on quickly. If you want to watch cooking shows in your kitchen, read books in subway 
stations, or attend web conferences from airport lounges, a tablet may be the optimal device for 
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you. To make them as easy to use as phones, they rely on mobile operating systems like Apple IOS or 
Google’s Android. Touching and swiping the screen is a fun and engaging experience for most users. 

Today, there are about 5 billion mobile devices (smartphones and tablets) in the world. The two primary 
mobile OS makers (Apple and Google) have app stores where independent software developers 
offer games and applications. These app stores have unleashed the creative potential of software 
developers who build applications for tablets and smartphones. As a mobile phone or tablet user, 
you can access a tremendous array of games and all sorts of applications to enhance productivity, 
including apps to receive therapy, simplify communication, identify trees, improve vocabulary, and 
learn new languages.  

Smartphone

Smartphones are portable computers that connect to 
the Internet using cellular telephone networks. Apple 
kickstarted the smartphone era by launching the iPhone 
in 2007. While mobile phones with rudimentary Internet 
capabilities (e.g., messages and text-based web browsers) 
existed before iPhones, Apple managed to package almost 
all the capabilities of microcomputers into an easy-to-use 
device that you could use not only to make calls and send 
a text but also to run most microcomputer applications 
such as email, word processors, and spreadsheets. The 
iPhone brought together a purpose-built mobile OS 
based on UNIX, a touchscreen, and an App store, all into one easy package. 

Keep in mind, today’s smartphones are far more powerful than even the Apollo 11 guidance 
computers, which helped us land on the moon and return safely. At the core, a smartphone is 
also a microcomputer that has CPU, RAM, storage, display, speakers, and a microphone, with the 
touchscreen and microphone serving as primary inputs. The app stores (available in Apple’s IOS and 
Google’s Android) add to the versatility and usefulness of smartphones. Connectivity applications 
such as Snapchat and Instagram enhance the entertainment value of phones, particularly for younger 
users; the mobile versions of Zoom, Gmail, and Microsoft’s Office suite turn them into productivity 
tools; WhatsApp, Slack, and Discord ease casual communication. These applications, created by third-
party vendors, greatly enrich the value of smartphones. 

Before smartphones, we had feature phones that had a non-touch display, press-button-based inputs, 
and a set of built-in features. However, the smartphone is dynamic. You can add new apps, remove 
old apps, and play a newly released game by buying it on the app store. It is possible to download and 
use new applications because the Application Programming Interfaces (APIs) of mobile operating 
systems allow third-party software to integrate tightly with the phone’s software and hardware.

Smartphones have eliminated many electronic utilities. Since smartphones became popular, people 
have stopped carrying cameras and camcorders and even use their phones as a flashlight at night. 
Hotels are beginning to eliminate alarm clocks35 and it is becoming increasingly difficult to find radio 
clocks, which were standard fixtures in bedrooms for decades.

35	 Ben Schlappig, “Good Riddance: Marriott Looks to Cut Alarm Clocks,” https://onemileatatime.
com/news/marriott-cuts-alarm-clocks/ (accessed June 2023).

https://onemileatatime.com/news/marriott-cuts-alarm-clocks/
https://onemileatatime.com/news/marriott-cuts-alarm-clocks/
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Smartwatch

A smartwatch is a microcomputer that you can wear on your wrist. Smartwatches are the newest 
entrants to the microcomputer line-up. Smartwatches have RAM, internal storage, and a CPU. They 
either use their own cellular chips or pair with phones to connect to networks. Because of their size 
limitations, they don’t have a keyboard or mouse. But smartwatches make up for that shortcoming 
in other ways, primarily by leveraging their seamless connectivity 
with smartphones. Streaming services make it easy for you to save 
music on your watch. Because smartwatches use Bluetooth to 
connect with peripherals, you can put your earbuds on and go for 
a walk, while listening to your favorite songs streaming out of your 
watch. You can also make phone calls and send/receive messages 
while you are exercising and don’t have access to your phone.

The main unique selling proposition (USP) of smartwatches is 
their impact on health. As microcomputers closest to users and 
wrapped around wrists, smartwatches have the potential to 
accurately sense many health parameters. Current technologies 
already allow smartwatches to monitor heart rates, blood oxygen 
levels, body temperature, step count, and sleep cycles. Some 
smartwatches can detect a fall and automatically notify nearby 
emergency services. Other smartwatches can detect irregular 
heartbeats and remind you to get yourself checked.

The industry is working hard to add additional capabilities, including blood pressure and sugar 
monitors. If these efforts are successful, smartwatches could help mitigate many common lifestyle 
health issues like diabetes, blood pressure, and obesity. In the coming years, smartwatches may 
be our greatest asset in improving health. Some of you may be the ones to write future software 
applications that leverage the hardware capabilities of smartwatches to detect and monitor diseases.

Form Factor

The differences in the types of computers discussed in this section can also be 
described as differences in their form factors.36 Form factor is the term used to 
describe the physical size and shape of a computer device measured by outside 
dimensions.37 For many common components, the form factor is also used as 
an identifier for a class of components. For example, a 3.5” or 5.25” hard drive, 
or a 1U or 2U server. These specifications define the space needed to fit the 
components, not the drive’s storage capacity or a server’s processing capacity.

36	 Dwight Pavlovic, “Computer Form Factors: A Guying Guide,” https://www.hp.com/us-en/shop/
tech-takes/computer-form-factor-buying-guide (accessed June 2023).

37	 “What does form factor mean?” University Information Technology Services, https://kb.iu.edu/d/
ahvq (accessed June 2023).

https://www.hp.com/us-en/shop/tech-takes/computer-form-factor-buying-guide
https://www.hp.com/us-en/shop/tech-takes/computer-form-factor-buying-guide
https://kb.iu.edu/d/ahvq
https://kb.iu.edu/d/ahvq
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Architecture of a Microcomputer
Microcomputers (or computers for short) take signals from input devices, process these inputs in 
the CPU using instructions loaded in memory, and send the output to an output device. This general 
processing sequence is used to understand keyboard strokes. The general architecture of a computer 
was specified in 1945 in a report produced by the University of Pennsylvania for the US Military.38 The 
report is known in the industry as the Von Neumann report. Section 2 of the report is shown in Figure 
15. Remarkably, the basic computer architecture and the flow of input and output signals is almost 
unchanged since the original 1945 report.

FIGURE 15 — Von Neumann architecture of a computer.

We will now look at the computer hardware—the physical parts of a computer you can touch and 
feel. We will then examine the core parts of computer software—the instructions that tell a computer 
what to do.

Motherboard

The motherboard is the wiring that connects all the 
components of a computer. The motherboard of 
a computer is analogous to the layout of a city or 
town. The layouts of most towns and cities have well-
designed roads connecting homes, schools, parks, 
libraries, and office complexes. When a city or town 
is planned, the designers anticipate user needs and 
come up with an architecture to connect the different 
parts of the town and facilitate the quick movement 
of people and goods. They take into consideration the 
flow of traffic, utilities, and sewage to ensure the city 
roads do not get choked, and the residents don’t have The layout of a town.

38	 John Von Neumann, “First Draft of a Report on the EDVAC,” https://web.mit.edu/STS.035/www/
PDFs/edvac.pdf (accessed June 2023).

https://web.mit.edu/STS.035/www/PDFs/edvac.pdf
https://web.mit.edu/STS.035/www/PDFs/edvac.pdf
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to deal with electrical and plumbing disasters every few days. Traffic rules and signs are established 
for orderly movement. Once the architecture is laid out, and the parts built in accordance with the 
architecture, the town can continue to function like a well-oiled machine.

The motherboard does for a computer what the layout does for a city. The motherboard is a plan to 
place various computer parts (CPU, RAM, storage, input, and output devices) in the right locations 
and connect them to each other, so all the parts get the necessary power and can communicate with 
each other at their rated speeds. See Figure 16.

FIGURE 16 — A motherboard.

A motherboard not only has designated slots for the core components but it also distributes the right 
amount of power to each component. To dissipate the heat generated by high-performance CPUs, 
motherboards also have mechanisms to attach heat sinks and fans. The motherboard also has data 
paths called a bus to move data at high speeds between the components. The motherboard may also 
have expansion slots for you to add additional RAM (storage) and GPUs (Graphical Processing Units) 
to allow the computer to scale if needed.

CPU

The Central Processing Unit (CPU) is the brain of the computer and performs all the computations 
necessary to execute commands. Modern CPUs implement the Von Neumann architecture (Figure 
15). The core technological marvel that enables CPU capabilities is the transistor. A transistor is 
an electronic device that amplifies a signal. To create the binary behavior necessary for computer 
operation, the transistors used in computers are highly sensitive and effectively act as switches. When 
the input is low, these transistors block the connection (interpreted as 0) and when the input is high, 
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the transistors enable the connection (interpreted as 1).39 By rapidly switching between 0 and 1 as 
directed by the software instructions, transistors help CPUs perform the necessary computations for 
users. Modern CPUs have many transistors to do complex data processing. CPUs in popular computers 
today can have over 100 billion transistors.40

Transistors are one of the world’s most sustained innovations. In 1971, Intel’s first CPU, the Intel 400441 
had 2,300 transistors42 and cost $200,43 for a cost of $0.10/ transistor. The transistors in the Intel 4004 
were able to switch between 0 and 1 about 740,000 times per second. Performing each instruction 
took about 8 switches, and the Intel 4004 was able to complete about 92,000 instructions per second.44 
In 2022, the AMD Epyc 7773X45 chip has 26 billion transistors, and sells for ~$9,000, for a cost of 
$0.0000003 per transistor. While instructions are now considered a simplistic metric, this chip is likely 
to perform the equivalent of 1.8 trillion instructions per second. So, while the cost per transistor has 
fallen by a factor of 250,000 between 1971 and 2022, 
the capabilities have gone up by a factor of almost 
20 million. This revolution in costs and capabilities 
is the key enabler of digitally driven changes in our 
economy, which make a class like Digital Information 
Technologies relevant to our society.

CPUs tend to follow Moore’s law, the observation 
made by Gordon Moore (founder and CEO of Intel) in 
1965 that the number of transistors on a microchip 
doubles approximately every two years. This is seen 
in the graph in Figure 17, the growth in the number of 
transistors on microchips for 50 years since 1970. A Central Processing Unit (CPU).

39	 There are more detailed explanations online, e.g., “How Transistors Work—The Learning Circuit,” 
https://www.youtube.com/watch?v=R0Uy4EL4xWs (accessed June 2023).

40	 “Apple unveils M1 Ultra,” https://www.apple.com/newsroom/2022/03/apple-unveils-m1-ultra-
the-worlds-most-powerful-chip-for-a-personal-computer/ (accessed June 2023).

41	 “The Intel 4004 Microprocessor and the Silicon Gate Technology,” http://web.archive.org/
web/20211225184908/http://www.intel4004.com/ (accessed June 2023).

42	 “The Story of the Intel 4004,” https://www.intel.com/content/www/us/en/history/museum-
story-of-intel-4004.html (accessed June 2023).

43	 “Intel 4004,” Gunkies, https://gunkies.org/wiki/Intel_4004 (accessed June 2023).
44	 Margareet Rouse, “Intel 4004,” https://www.techopedia.com/definition/20057/intel-4004 

(accessed June 2023).
45	 “Nothing Stacks up to EPYC,” https://www.amd.com/en/products/cpu/amd-epyc-7773x 

(accessed June 2023).

https://www.youtube.com/watch?v=R0Uy4EL4xWs
https://www.apple.com/newsroom/2022/03/apple-unveils-m1-ultra-the-worlds-most-powerful-chip-for-a-personal-computer/
https://www.apple.com/newsroom/2022/03/apple-unveils-m1-ultra-the-worlds-most-powerful-chip-for-a-personal-computer/
http://web.archive.org/web/20211225184908/http://www.intel4004.com/
http://web.archive.org/web/20211225184908/http://www.intel4004.com/
https://www.intel.com/content/www/us/en/history/museum-story-of-intel-4004.html 
https://www.intel.com/content/www/us/en/history/museum-story-of-intel-4004.html 
https://gunkies.org/wiki/Intel_4004
https://www.techopedia.com/definition/20057/intel-4004
https://www.amd.com/en/products/cpu/amd-epyc-7773x
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FIGURE 17 — The exponential increase in transistor counts per microchips doubles every two years. 

This exponential growth has not only given us faster computers but has also made them smaller, 
cheaper, and less power-hungry. This has enabled form factors such as smartwatches and enabled even 
low-income people in developing countries to own computers and smartphones and communicate 
over the World Wide Web.

Buying Tip

Before you decide to buy a computer with the latest, most powerful CPU, you 
should keep in mind that the CPU is also typically the most expensive part of 
your computer. You may never utilize the power of the CPU if you plan to use 
the computer just to create Word documents and PowerPoint presentations, 
write emails, and browse the web. 

RAM

Random Access Memory (RAM) is much faster than all other kinds of storage devices like hard disk 
drives (HDDs), solid-state drives (SSDs), and optical drives.
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It is used to temporarily store computer instructions that need to be accessed frequently, along with 
the data processed by these instructions. For example, when you launch the Chrome browser, the 
CPU needs a place to temporarily store the Chrome program as well as the webpages you are viewing 
and track all the changes you are making. 

Memory Types

Memory comes in many types. In addition to RAM, modern CPUs also have 
extra-fast memory within the processor chip called the cache.46 The cache is 
designed for instructions and data to be readily available within the CPU for 
instant access. In fact, there are multiple levels of cache in modern processors 
as seen here.

As of 2020, the cache memory within the processor chip is 10–100 times faster 
than RAM memory.47 It takes 1–4 nanoseconds to retrieve data from the cache, 
and about 100 nanoseconds to retrieve data from RAM.

If you happen to open many tabs on your browser 
and end up consuming all the available RAM, your 
browser will become slow and might even crash. 
Computers try to augment RAM by using space on 
the hard drive as an extension of the computer’s RAM. 
This additional space is called the page file, or virtual 
memory.48 Since the hard drive is usually many times 
slower than the RAM, your computer’s performance 
could get noticeably slower as the page file use 
increases. In these cases, it is useful to open the Task 
Manager to kill some unused programs and free up 
RAM to regain computer speed. Computer memory (RAM).

46	 “Intel Processor Identification Utility—Windows Version,” download page, https://www.intel.
com/content/www/us/en/download/12136/intel-processor-identification-utility-windows-
version.html (accessed June 2023).

47	 “Latency Numbers Every Programmer Should Know,” https://colin-scott.github.io/personal_
website/research/interactive_latency.html (accessed June 2023).

48	 “How to Manage Virtual Memory (Pagefile) in Windows 10,” https://www.tomshardware.com/
news/how-to-manage-virtual-memory-pagefile-windows-10,36929.html (accessed June 2023).

https://www.intel.com/content/www/us/en/download/12136/intel-processor-identification-utility-windows-version.html
https://www.intel.com/content/www/us/en/download/12136/intel-processor-identification-utility-windows-version.html
https://www.intel.com/content/www/us/en/download/12136/intel-processor-identification-utility-windows-version.html
https://colin-scott.github.io/personal_website/research/interactive_latency.html
https://colin-scott.github.io/personal_website/research/interactive_latency.html
https://www.tomshardware.com/news/how-to-manage-virtual-memory-pagefile-windows-10,36929.html
https://www.tomshardware.com/news/how-to-manage-virtual-memory-pagefile-windows-10,36929.html
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Opening the Task Manager

In Windows, right-click the start (or Windows) button on your taskbar to access 
the Task Manager. In the Task Manager, the “Processes” tab will clearly identify 
the programs that are consuming the most memory and CPU. You can also 
open the Task Manager by using the “Ctrl+Shift+Esc” keyboard shortcut.

In Figure 18, the Google Chrome app is consuming the most memory.

FIGURE 18 — Task Manager on Windows.

RAM is typically measured in gigabytes (GBs). A byte is equal to 8 bits. A bit, the basic unit of computer 
information, is a binary digit and takes a value of either a 1 or a 0. For example, the state of a light 
bulb—on or off, can indicate a 1 or 0. All information, whether in text, photo, audio, or video format, is 
converted into binary format and represented as bytes. Once this translation happens the computer 
can store it in RAM and process it in the CPU. 

RAM is one of the most critical components to speed up a computer. Your RAM requirement is one of 
the key decisions you’ll need to make before purchasing a computer. 
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How Much RAM Do You Need?

Here are the RAM recommendations from Crucial, one of the leading 
manufacturers of RAM. 49 & 50

Generally, we recommend 8GB of RAM for casual computer usage and Internet 
browsing, 16GB for spreadsheets and other office programs, and at least 32GB 
for gamers and multimedia creators. How you use your computer influences 
how much RAM you need, so use this as a guideline.

If this is how you use your computer	     Here’s how much  
	 memory we recommend

Casual User
Internet browsing, email, listening to music, 	 At least 8GB 
or watching videos

Intermediate User
Internet browsing, email, Word Processing, 	 At least 16GB  
spreadsheets, running simple graphics  
programs, flash games, music, videos  
or multitasking

Professional User/Gamer/Graphic Designer
High-performance gaming, multimedia	 At least 32GB 
editing, high-definition video, graphic  
design/3D modeling, intensive multitasking

Unfortunately, RAM is only operational when it is powered. Even a 
momentary power loss clears up the contents in RAM.

There are a variety of RAM types.

49	 For enthusiasts interested in building their own computer, here’s a helpful article with some 
more details by Tony Polanco, “How much RAM do I need?” https://www.tomsguide.com/
features/how-much-ram-do-i-need-heres-how-to-know (accessed June 2023).

50	 “How Much RAM Do You Need For Your Computer Memory?” https://www.crucial.com/articles/
about-memory/how-much-ram-does-my-computer-need (accessed June 2023).

https://www.tomsguide.com/features/how-much-ram-do-i-need-heres-how-to-know
https://www.tomsguide.com/features/how-much-ram-do-i-need-heres-how-to-know
https://www.crucial.com/articles/about-memory/how-much-ram-does-my-computer-need
https://www.crucial.com/articles/about-memory/how-much-ram-does-my-computer-need
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RAM and a Worker’s Pocket of Tools51

You can think of RAM as being analogous to a worker’s pockets. The data and 
instructions in RAM are analogous to the tools a plumber or an electrician carries 
when performing tasks inside homes. The workers have the entire set of tools 
and supplies in their parked truck but it would take forever to complete any 
job if they had to go back to the truck every time they needed a screwdriver or 
tape. Instead, having these tools ready at hand speeds up their work. Similarly, 
having data and instructions at hand in RAM and cache helps the CPU speed 
up execution.

Storage

Computer storage is the technology that stores the software (e.g., operating systems and applications) 
and data on the computer. Storage is also popularly known as hard drives. A critical feature of storage 
technology that differentiates it from RAM is that 
applications and data are retained in storage even 
after the power is turned off. This ability to retain 
data for long periods without power or external 
connectivity allows you to store software and relevant 
data (e.g., documents, games, songs, and movies) in 
your computer throughout your school years and 
beyond. When the computer is powered on, the 
computer loads the operating system from storage 
into memory. As RAM cannot store data unless the 
computer is on, every computer comes with in-built 
secondary storage to keep your content safe when it 
is powered off.

Modern storage devices have reasonably large 
capacities and can store all the data and applications 
most users need. If your storage needs exceed the 
capacity of the built-in storage device, you have a few 
options. Most users connect external storage devices 
to augment the storage capacity of their computers. 
External storage is typically connected to your 
computer using a USB cable.

Cloud storage services such as DropBox, Box, OneDrive, 
iCloud, and Google Drive are also options to store 
personal data for a fee. Cloud services eliminate the 
risk of data loss. Cloud services like Backblaze52 offer 
even more comprehensive backup capabilities, saving 

Disk drives in a typical desktop computer.

External storage devices.

51	 Examples of holders for worker’s tools https://bucketboss.com/ (accessed June 2023).
52	 Backblaze offers cloud services, https://www.backblaze.com/ (accessed June 2023).

https://bucketboss.com/
https://www.backblaze.com/


Chapter 5—Microcomputers 65

all the files on a computer. Both external drives and cloud services can also be used to back up your 
data and move it between computers.

Your storage needs depend upon the kind of information you work with. If you work mostly with 
text, your typical Word document will be a few kilobytes (1 kilobyte = 1000 bytes) in size. Photos 
are usually larger, about 4–5 megabytes (1 megabyte = 1000 kilobytes or 1 million bytes) in size. 
Higher-resolution photos can be even larger. Audio files are comparable in size to photos, with each 
song typically taking up about 5MB (in compressed formats like MP3) and about 50MB in CD-quality 
uncompressed formats. 4k videos in current smartphones take up about 1 gigabyte (1 gigabyte = 
1,000 MB or 1,000,000 bytes) per minute. The table below shows the common prefixes for file sizes. 

Memory unit Description
Kilo Byte 1 KB = 1024 Bytes

Mega Byte 1 MB = 1024 KB
Giga Byte 1 GB = 1024 MB
Tera Byte 1 TB = 1024 GB
Peta Byte 1 PB = 1024 TB
Hexa Byte 1 EB = 1024 PB
Zetta Byte 1 ZB = 1024 EB
Yotta Byte 1 YB = 1024 ZB

Bronto Byte 1 Bronto Byte = 1024 YB
Geop Byte 1 Geo Byte = 1024 Bronto Bytes

HDD vs SSD vs Portable Flash Drives

There are two popular storage technologies currently 
in use—magnetic disks and solid state disks. Magnetic 
disks store data as changes in magnetization on tracks 
on a disk. Solid state disks (SSD) store data as the 
charge state of a transistor. Let’s take a quick look at 
each type of storage.

Magnetic disks, also called hard disk drives (HDDs), are 
a legacy technology that stores digital data on glass 
platters coated with magnetic material. Data is stored 
as the direction of magnetism of the material. HDDs 
have a reader head that can magnetize portions of the 
disk during the writing process and read the direction 
of magnetization during the reading process. The disks 
in an HDD spin as fast as possible, while the head writes 
or reads data on the disk. The weight of the rotating 
platter makes hard disks heavy, slow, noisy, and 
hungry for power. However, at the current time, HDDs 
are cheaper than SSDs and can store significantly more 
data than SSDs. So, if you plan to store a lot of media 
files (songs, movies, and games), hard disk drives may 
be a good secondary storage option for you.

A hard-disk drive (HDD).

Solid-state drives (SSD).
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Solid-state drives (SSDs) are a newer type of storage device that use transistors to store data. The 
transistors used in SSDs can save a charge even when not connected to power, enabling them to save 
data over long periods. SSDs do not have any moving parts, unlike HDDs. Not having any moving 
mechanical parts allows SSDs to be faster, longer lasting, and power efficient. Most newer computers 
come installed with SSDs as the primary internal storage. 

As of 2020, it takes 16,000 nanoseconds (16 microseconds) to read data from an SSD and 2,000,000 
nanoseconds (2 milliseconds) to read data from a hard disk drive.53 Thus, L1 cache is the fastest, L2 
cache is 4 times slower than L1 cache, RAM is 25 times slower than L2 cache, SSD is 160 times slower 
than RAM, and magnetic disks are 125 times slower than solid state disks.

A popular small version of an SSD is called a portable 
flash drive (also known as a USB stick). These devices 
are designed to be compact and are often given out 
as company swag for marketing purposes. If you plug 
the flash drive or USB stick into your computer, the 
operating system will automatically detect the USB 
key as a storage device and the contents of the key 
become available in your File Explorer. You can treat 
the USB key like a storage device into which you can 
add or remove files. USB sticks are useful when you 
want to move content from one computer to another. 

Flash drives are also called USB sticks or thumb 
drives.

File Safety With Portable Drives

Before you remove the USB stick or other external storage device from the USB 
port of your computer, you should remember to “Eject” to avoid corrupting the 
data on the device. To “Eject,” right-click on the USB drive in your File Explorer 
and select “Eject.” You’ll get a message stating it is now safe to disconnect the 
device. Properly removing the external device ensures that the operating 
system has cleaned up and closed files to avoid damaging the contents of the 
external storage device. 

Bus

The bus in a computer is a communication system that transfers data between a set of components. As 
we have seen, the components of a computer operate at vastly different speeds. Buses allow the CPU 
to operate at the highest speeds possible, without getting slowed down by the slowest components. 
The buses in the earliest computers were simply a set of wires connecting components. Developments 
in bus technologies have enabled CPUs to become significantly faster even as peripherals like printers 
and keyboards (and human users) have not evolved at a comparable pace. Modern micro-computers 
have several buses, each operating at its own speed.

53	 “Latency Numbers Every Programmer Should Know,” https://colin-scott.github.io/personal_
website/research/interactive_latency.html (accessed June 2023).

https://colin-scott.github.io/personal_website/research/interactive_latency.html 
https://colin-scott.github.io/personal_website/research/interactive_latency.html 
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Buses in General

The term “bus” is a general term for a shared connection that maintains uniform 
properties across its span to which several consumers are connected in parallel. 
Thus, the power distribution lines delivering power at a fixed voltage to 
electrical substations can be considered a distribution bus, and the power lines 
supplying power to homes in a neighborhood at the constant 120 volts and 60 
Hertz can be considered load buses. Similarly in a computer, each bus operates 
at the same clock speed and has the same data across its span at any given time.

GPU

A graphics processing unit (GPU) is a computing technology designed to run several small programs 
simultaneously. While modern CPUs have multiple cores and threads and can run tens of multiple 
programs in parallel, GPUs can run thousands of programs in parallel. The overall size of the processor 
chip is about the same in both CPUs and GPUs. While CPUs are organized as a small number of highly 
capable processors, GPUs are organized as many relatively simple processors with relatively limited 
capabilities.54 For most tasks, the complexity of CPUs is sufficient. However, for a small subset of tasks, 
mostly in image processing and machine learning (ML), there is a need to perform many simple 
operations in parallel. As image processing becomes popular for gaming and machine learning 
becomes popular for artificial intelligence, GPUs become increasingly popular. This is also reflected 
in the valuations of the principal CPU manufacturer, Intel ($120 billion),  and the principal GPU 
manufacturer, Nvidia ($400 billion).

A lot of young people use personal computers primarily to play video games. Over time, the games 
have become hyper-realistic and take place in a fantasy world where artificially created characters 
interact with each other. Complex lighting and shadow patterns on high-resolution monitors with 
fast refresh rates can make these games very realistic. For a while, CPUs were stretched thin dealing 
with complex gaming algorithms and high-resolution images designed to simulate a true-to-life 
experience.

The computing industry addressed the problem by introducing chips dedicated to processing 
graphics and rendering video content on the screen. These chips, known as GPUs, work in tandem 
with the CPU of the computer. The CPU handles the user input and does all the computations (e.g., Did 
two objects collide? What is the location of objects on the screen). So, the CPU is still the overall boss, 
but it can send video gaming/image processing workloads to the GPU, which does the computations 
needed to render each pixel (e.g., color, shading, brightness) in the frame.55 Modern high-resolution 
gaming monitors can have over 8 million pixels (3,840 x 2,160), and with frames refreshed 60 times a 
second (refresh rates), about 500 million computations are needed each second to display the images 

54	 Peter Ashman, “Why do CPUs have so few cores compared to GPUs?” https://qr.ae/pr8Rkp 
(accessed June 2023).

55	 “What role does the CPU, GPU, and RAM play during gaming?” https://www.quora.com/What-
role-does-the-CPU-GPU-and-RAM-play-during-gaming-I-know-their-functions-and-what-
they-do-but-what-are-they-responsible-for (accessed June 2023).

https://qr.ae/pr8Rkp
https://www.quora.com/What-role-does-the-CPU-GPU-and-RAM-play-during-gaming-I-know-their-functions-and-what-they-do-but-what-are-they-responsible-for
https://www.quora.com/What-role-does-the-CPU-GPU-and-RAM-play-during-gaming-I-know-their-functions-and-what-they-do-but-what-are-they-responsible-for
https://www.quora.com/What-role-does-the-CPU-GPU-and-RAM-play-during-gaming-I-know-their-functions-and-what-they-do-but-what-are-they-responsible-for
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on the screen.56 While this is a lot of computations, all 
the computations are similar and simple. These are a 
perfect fit for GPUs. Therefore, CPUs delegate these 
computations to GPUs for optimal performance.

GPUs themselves come in two formats: Integrated GPU 
(Figure 19) and Discrete GPU (Figure 20). Integrated 
GPUs look like just another chip on the motherboard 
and cannot be upgraded by the end user. On the 
other hand, Discrete GPUs can be purchased, replaced, 
and upgraded by the end user. It connects to the 
motherboard through an expansion slot on the PCIe 
bus and comes with its own cooling fans. Typically, 
Discrete GPUs are far more powerful than Integrated 
GPUs. 

The Two Formats of GPUs

FIGURE 19 — Intel’s integrated GPU.

FIGURE 20 — Intel’s Discrete GPU.

GPUs for Video Content Creation

Because GPUs were originally designed to handle fast/
high-resolution video rendering, they have become 
the go-to choice for video content creators, too. If 
you like to capture videos, edit them, and splice them 
with additional audio/video content, then a powerful 
GPU on your PC will make your video editing program 
much faster. Whether you are an anime creator, an 
Adobe Photoshop user, or a producer of content for 
educational purposes, you may consider buying a computer with a powerful GPU or adding one to 
your current system.

GPUs for ML and Crypto Mining

Even though GPUs were designed primarily for graphics and video rendering, data scientists working 
on machine learning (ML) models also found GPUs useful. The job of going through all photos 
uploaded by users to Facebook and removing objectionable content is a difficult and expensive task 
for humans. Facebook users upload more than 350 million photos per day. To manually view each one 
and determine if it is suitable for consumption can be daunting. Machine learning algorithms are an 
effective and cheap way to do the job. As most machine learning algorithms involve a lot of identical 
operations (addition and multiplication), GPUs are great ML use cases. 

During 2015–2022, crypto mining became very popular. In crypto mining, computers search for 
solutions to cryptographic problems for the right to add a block to a chain and get the reward 
associated with adding the block to the chain. GPUs can search far more options than CPUs in a given 
time. Therefore, during the recent crypto boom, it became difficult for regular users to purchase GPUs 
as they were in high demand by crypto miners, who were willing to pay premium prices for these 
GPUs.

56	 “What is Monitor Resolutions? Resolutions and Aspect Ratios Explained,” https://www.viewsonic.
com/library/tech/monitor-resolution-aspect-ratio/ (accessed June 2023).

https://www.viewsonic.com/library/tech/monitor-resolution-aspect-ratio/
https://www.viewsonic.com/library/tech/monitor-resolution-aspect-ratio/
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GPUs—The Florida Connection

One of the world’s leaders in GPU development is Nvidia. One of the three co-
founders of Nvidia is Chris Malachowsky, an alum of the University of Florida. 
He received a BS in EE from UF in 1986 and co-founded Nvidia with Curtis Priem 
and Jen-Hsun Huang in 1993. In 2020, he gifted $25 million to the University of 
Florida to build HiperGator AI, one of the world’s fastest AI supercomputers and 
made it available to students, researchers, and businesses across Florida.57

Input Devices

As computers are designed to interact with humans, they need a mechanism to take our commands 
and return responses. An input device is a medium through which we can provide actionable tasks 
for computers. Let’s look at some common input devices to understand them better. 

Keyboard

A keyboard is the primary input mechanism of a computer. Keyboard commands get translated into 
emails, chat messages, clicks on a browser screen, video game movements, or others depending on 
the program receiving the input. As the standard English keyboard has the letters Q, W, E, R, T, and Y 
on the top row, it is known as QWERTY. See Figure 21. This arrangement, designed for typewriters, was 
intended to avoid jamming typebars striking on paper and is, unfortunately, not the most efficient 
layout for modern computers.

FIGURE 21 — A standard English keyboard, also known as QWERTY.

For touch typists (those who type without looking at keys), the letters F and J have a small, raised dot. 
The dots are meant to help you place your forefingers on the keyboard before you begin typing.

57	 “UF Announces $70 Million Artificial Intelligence Partnership with Nvidia,” https://www.uff.ufl.
edu/your-impact/uf-announces-70-million-artificial-intelligence-partnership-nvidia/ (accessed 
June 2023).

https://www.uff.ufl.edu/your-impact/uf-announces-70-million-artificial-intelligence-partnership-nvidia/
https://www.uff.ufl.edu/your-impact/uf-announces-70-million-artificial-intelligence-partnership-nvidia/
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QWERTY vs Dvorak and the Path Dependence of History58

The QWERTY layout was designed to slow typists down to prevent key jamming 
in mechanical typewriters.59 This was done by placing the most popular keys, 
e.g., e, t, a in relatively awkward positions, as opposed to convenient locations 
in the center of the keyboard. Also, the QWERTY layout makes disproportionate 
use of the left hand, which is not the dominant hand for most people. However, 
the layout, created in 1873, became popular with typewriters.

August Dvorak created an alternate keyboard layout in 1936 to reduce finger 
movement for common words by placing common keys closer to the center of 
the keyboard, thereby increasing typing speed, reducing errors, and increasing 
comfort. However, the Dvorak keyboard never gained popularity despite its 
potential advantages. Another persistent historical artifact is the staggered 
arrangement of keys on different rows, which was done to accommodate 
the key levers from different rows. This staggering is not needed in electronic 
keyboards, but the design persists. Many modern designs can be traced to 
historical constraints that no longer apply. Identifying these opportunities to 
relax constraints is a potential avenue for innovation.

If you don’t want to adjust to the standard keyboard 
size, you may want to consider ergonomic keyboards 
designed to fit your fingers (see Figure 22). You can 
connect any new keyboard to your desktop or laptop 
through USB or Bluetooth.

FIGURE 22 — An ergonomic keyboard.

Mouse and Trackpad

If you look closely at your computer screen, you will see 
a small arrow like the one in Figure 23.

This arrow tells the computer where to focus. You can use 
your mouse/trackpad to shift the point of focus at any 
time. Your mouse/trackpad typically has two buttons, 
left and right. We use the left button to click and select 
objects, and the right button is used to open contextual 
menus that change based on your location. The mouse 
also has a wheel to scroll through multiple pages easily. 
If you have a wireless mouse, you can connect it to your 
device via Bluetooth software.

FIGURE 23 — Cursor arrow.

58	 “Dvorak keyboard layout,” https://en.wikipedia.org/wiki/Dvorak_keyboard_layout (accessed 
June 2023).

59	 However, also see Yasuoka, Koichi; Yasuoka, Motoko, “On the Prehistory of QWERTY,” https://
repository.kulib.kyoto-u.ac.jp/dspace/bitstream/2433/139379/1/42_161.pdf (accessed June 
2023).

https://en.wikipedia.org/wiki/Dvorak_keyboard_layout
https://repository.kulib.kyoto-u.ac.jp/dspace/bitstream/2433/139379/1/42_161.pdf
https://repository.kulib.kyoto-u.ac.jp/dspace/bitstream/2433/139379/1/42_161.pdf
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The mouse is popular with desktop computers and office 
areas with sufficient desktop space to move the mouse. 
Since laptops are often used in tight spaces (e.g., airport 
seats) with no room to place a mouse, most modern laptops 
come with touchpads to replace the mouse as a tactile input 
device. Touchpads or trackpads use a specialized surface to 
translate the position of a user’s fingers on the device to a 
location on the screen. The screens of modern smartphones 
also serve as touchpads.

Camera and Microphone

With the popularity of remote work in the post-Covid 
world, most employees use Zoom, Webex, GoTo, Teams, or 
Google Hangouts daily to join meetings and conferences. 
Often, you’ll be required to keep your video and audio on to 
participate and have the feeling of being in a room with other 
participants. All these programs depend on the camera and 
microphone on your computer to share your video and audio 
with other meeting participants. As online meetings become 
increasingly important for school and work, the quality of 
the camera and microphone are becoming increasingly 
important differentiators of laptops. If these devices are 
not satisfactory, you can buy and connect an external high-
resolution camera and a high-fidelity microphone to your 
computer to improve your remote-working experience.

 

Join a video call or participate in a video 
conference using a webcam.

Output Devices

After a computer accomplishes your tasks, the output 
devices will communicate the outcome of the actions. A 
monitor is the primary output medium that you will interact 
with all the time, whether you watch a movie on Netflix, type 
an email to a friend, or work on a spreadsheet.

Since you will spend most of your time on the computer 
looking at the monitor, the monitor has a significant impact 
on your end-user experience. Fortunately, most modern 
monitors provide excellent performance at an affordable 
price. Some extra monitor features may come at a price. For 
example, touch screens are interesting, but they also consume more power and add weight to the 
laptop cover. Similarly, large screens are useful during work but reduce portability. It is, therefore, 
useful to carefully assess your needs before you select a monitor.60

 

The screen of a laptop is its primary 
visual output.

60	 Scharon Harding, “How to Buy a PC Monitor,” https://www.tomshardware.com/reviews/monitor-
buying-guide,5699.html (accessed June 2023).

https://www.tomshardware.com/reviews/monitor-buying-guide,5699.html
https://www.tomshardware.com/reviews/monitor-buying-guide,5699.html
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To improve your productivity, you can attach more than one display screen to your computer (see 
Figure 24). You can use the HDMI or USB-C ports on your computer to connect multiple displays.

FIGURE 24 — The use of two screens can improve productivity.

Speakers

Most Laptops and PCs come with built-in speakers to play audio. Most laptops today have very good 
sound output, including some models that use four speakers to produce rich, realistic sound. It is also 
becoming increasingly common for users to use earbuds or headphones to minimize disturbance to 
nearby users. Further, to improve the quality of sound, particularly if you watch videos on YouTube 
or listen to music on Spotify, you may attach your high-fidelity speaker through the USB ports or use 
Bluetooth to connect to wireless earbuds.

Conclusion
Have you ever opened the outside case of a desktop to peek at the inside parts? The inside looks like a 
tightly placed collection of parts, which may be confusing at first glance (see Figure 25). But now that 
you know the key parts of a computer, you should be able to recognize most parts. If your computer 
is too outdated or slow, you may even explore opening it up and adding memory to make it faster 
and last longer.
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FIGURE 25 — Computer internals.

To make these hardware parts work in a coordinated manner, computers have software that tells 
these hardware components what to do. While the operating system (Microsoft Windows, Apple 
Mac OS, or Linux) is the main software acting as the brain of the computer, you’ll generally need to 
install many other end-user applications (e.g., Chrome, Snapchat, Instagram, DropBox, Google Maps, 
Spotify, Paint, Snagit, and others) to turn the computer into a versatile assistant.

As seen in Figure 26, end users interact with applications that request the operating system to have 
the hardware to perform the needed tasks to meet user needs.

Any software program is a collection of instructions to the CPU to perform a task. These instructions 
are expressed in binary code for the CPU to perform the required operations. Afterward, the output 
is conveyed to us through the correct output device, which translates the 1s and 0s into images, 
sounds, and text.

FIGURE 26 — The overall architecture of a computer.
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			   Chapter Terms and Definitions

Bit: A binary digit and a unit of computer 
information; a bit takes a value of either a 1 or a 0

Bluetooth: A technology designed for 
exchanging data wirelessly between electronic 
devices over short distances

Bus: In a computer, a bus is a communication 
system that transfers data between a set of 
components

Byte: A byte consists of eight binary digits and 
is commonly used to store various types of data, 
such as text, images, audio files, and program 
code

Central Processing Unit (CPU): An electronic 
circuitry component of a personal computer that 
is designed to interpret, process, and execute 
instructions from hardware or software programs

Computer Architecture: The way a computer 
is designed, including its various hardware 
components and how they work together 
to perform tasks; it determines the overall 
functionality and performance of the computer 
system

Crypto Mining: Using the computational power 
of a computer to solve complex problems that 
produce money in the form of cryptocurrency 
such as bitcoin

Gigabyte: A unit of digital information that 
represents one billion bytes; it is commonly used 
to measure the storage capacity of computer 
memory and storage devices, such as hard disk 
drives, solid-state drives, and memory cards

Graphical Processing Unit (GPU): Electronic 
circuit technology designed to speed up the 
creation of images displayed on a device such as 
a computer monitor

Hard Disk Drive (HDD): A type of computer 
storage device that uses rotating disks coated 
with magnetic material to store data permanently

High Definition Multimedia Interface (HDMI): 
A hardware connection technology designed to 
transmit digital audio and a video signals through 
a cable between HDMI-compatible devices

Input Device: A device such as a computer 
mouse or keyboard that delivers data and can 
manipulate the components of the computer

Keyboard: Concerning computer peripherals, 
a physical or digital device capable of 
communicating with a connected computer 
system through assigned key inputs

Machine Learning (ML): Programmed 
parameters where data is passed through 
statistical models in which the model increases 
accuracy with more data; this presents itself in 
the form of intelligence that is artificial

Moore’s Law: A “law” proposed by Gordon Moore, 
Intel co-founder, stating that the number of 
transistors in microchips would double every two 
years due to advancing computing performance

Motherboard: A computer component that acts 
as a dock, is responsible for controlling the core 
computer processor, and connecting various 
other pieces of computer hardware



Chapter 5—Microcomputers 75

Mouse: Regarding computer peripherals, a 
hand-held input device capable of detecting 
user manipulation through motion to facilitate 
interactions with computer systems

Optical Drive: A type of computer hardware 
that uses lasers to read data from or write data to 
optical discs, such as CDs, DVDs, and Blu-ray discs

Output Device: Computer hardware such as a 
computer monitor or mobile device screen that 
is designed to convert information into a visual 
display easily understood by humans

Personal Computer (PC): Also referred to 
as a microcomputer; a device that processes 
computing functions that serve one or multiple 
personal or business purposes

Portable Flash Drives: Small, portable devices, 
easily connected to a computer via USB ports, 
that store digital data using flash memory

Random-Access Memory (RAM): Sometimes 
called the memory of a computing device such 
as a smartphone or PC; a component within a 
computing device capable of temporarily storing 
data that can be accessed by the CPU whenever 
processing is required

Smartphone: A portable computer that 
can connect to the Internet through cellular 
networks and offers a range of features such as 
web browsing, email access, social media apps, 
multimedia playback, and various downloadable 
applications

Smartwatch: A microcomputer that you can 
wear on your wrist

Solid-State Drive (SSD): A type of computer 
storage device that has no moving parts and uses 
flash memory to store data permanently

Transistor: A basic electronic component used 
in computer architecture to amplify and switch 
electronic signals; it acts as a tiny switch that 
controls the flow of electrical current by using 
a small voltage input to control a larger current 
output

Universal Serial Bus (USB): A standard used 
by the computing industry to specify how the 
hardware in devices can connect, communicate, 
and supply power across personal computers

Wi-Fi: Wi-Fi is a wireless networking technology 
that enables electronic devices, such as 
computers, smartphones, and tablets, to connect 
and communicate with each other via a wireless 
medium
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		  	 Chapter Case

Gaming Consoles Yesterday, Today, and Tomorrow
Atari is a company founded in 1972 that developed an iconic gaming console that 
enabled millions of users to play games such as “Pong,” “Asteroids,” “Centipede,” 
and “Missile Command.” According to atari.com, “Atari played an integral role 
in the development of the arcade game, game console, and personal computer 
industries.” In 1977 Atari released the Atari 2600 gaming console (also called the 
Atari Video Computer System), which featured microprocessor-based hardware that 
included swappable gaming cartridges capable of storing Kilobytes (KB) of gaming 
information. Additionally, the gaming console included a motherboard that could 
control hardware components such as a CPU, RAM, input devices (joysticks), and 
output devices. 

More than 50 years have passed since Atari was founded and gaming consoles today 
have been innovated far beyond the computing capabilities of the 1977 Atari 2600. 
Use the Internet to research any gaming console system (for example, Microsoft 
Xbox, Sony PlayStation, etc.) of your choice. Answer the following questions based 
on the results of your online research: 

Question 1:	 List the hardware specifications for the gaming console of your 
choice. Be sure to list as many hardware components as you can (ex. 
CPU, memory, input devices, output devices, etc.). After listing each 
hardware component, briefly describe what the component is used 
for. Finally, provide a weblink to document where you retrieved the 
information. 

Question 2:	 Write a short paragraph describing what you imagine gaming 
consoles will be capable of doing 50 years in the future. 
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Basically, our goal is to organize the world’s information and to make it universally 
accessible and useful. 

—Larry Page, co-founder of Google

Overview
File management is about creating an organized structure to store information on your computer 
for easy retrieval and use. As more and more of our information becomes digital and ends up in our 
digital devices—e.g., school assignments on laptops, photos on smartphones, emails in the cloud—it 
becomes increasingly important to create an organized structure to store this information, so it is 
available when needed. After all, what is the point of taking that keepsake picture with a friend if you 
can’t find it later when you need it?

Think of file management as a small-scale/personal version of Google. Google’s vision statement 
is “to organize the world’s information and make it universally accessible and useful.”61 Both file 
management and Google involve organizing and managing large amounts of data, even if the 
methods are different. File management involves developing good habits in naming and organizing 
files on a computer. Google uses complex algorithms to organize the vast amounts of data that it 
collects from around the world. The end goals are the same. Both file management and Google aim 
to make data easily accessible later. As ChatGPT puts it, “in many ways, file management is doing for 
your computer what Google aims to do for the Internet.”62

Taking a few minutes to learn how your computer organizes files and to develop good file management 
practices may be one of the best investments you make in learning to use your computer effectively. 
This chapter will show you how. Experienced computer users consider their file manager as the 
starting point of any work. Microsoft computers have File Explorer for file management. Similarly, 
Finder—also known as Mac Desktop Experience—is the default file manager on Mac computers. The 
icon for Finder63 is “Happy Mac,”64( ).65

Information management in the computer context is called file management because all information 
on computers is made available to end users as files. Files have properties such as names, last modified 
date, size, etc. These properties help with information location and retrieval. In the rest of this chapter, 
we use information management and file management interchangeably.

61	 “About Google,” https://about.google/ (accessed June 2023).
62	 “How is file management analogous to what Google does?” https://chat.openai.com/chat 

(accessed June 2023).
63	 For more on the origins of some of these icons, you may like this article in Quartz magazine 

about Susan Kare, the designer for the original Mac icons, https://qz.com/1666437/mac-icon-
designer-susan-kare-explains-the-inspiration-for-her-designs (accessed June 2023).

64	 “Finder (software),” Wikipedia, https://en.wikipedia.org/wiki/Finder_(software) (accessed June 
2023).

65	 “Get to know the Finder on your Mac,” https://support.apple.com/en-us/HT201732 (accessed 
June 2023).

https://about.google/
https://chat.openai.com/chat
https://qz.com/1666437/mac-icon-designer-susan-kare-explains-the-inspiration-for-her-designs
https://qz.com/1666437/mac-icon-designer-susan-kare-explains-the-inspiration-for-her-designs
https://en.wikipedia.org/wiki/Finder_(software)
https://support.apple.com/en-us/HT201732
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Why Manage Files?
To have a sense of balance and order and to be 
efficient in your home, you need to have some 
basic organization skills to find what you need in 
the jumble of things. For example, look at some of 
the many things you have in your home: table lamp, 
desk, paper clips, speakers, camera, side tables, 
fans, shirts, pants, towels, toasters, vacuum cleaner, 
sewing kits, hangers, shoes, watches, keyboards, 
bags of chips, bottles of syrup, saltshakers, tea bags, 
rolling pins, and coffee makers. Do you instantly 
know where to go if you want a clean towel?

Would you go to the bedroom looking for a kitchen 
knife? Not unless you have some sinister plan for which you hid the kitchen knife under the mattress, 
right? Imagine if everything you have in your home were to get placed in a pile in the center of your 
living room. Would you be able to grab a can opener and a tin of chickpeas from the heap to prepare 
dinner? Probably not. It might be easier for you to go to a store and buy food than spend an hour 
looking for the can opener and chickpeas. 

Having a well-organized home and pantry will not only save time but also energy and money. A place 
for everything, and everything in its place, as the saying goes.

A file management system does for your computer what home organization does for your physical 
items at home. File management involves creating folders and subfolders for information, categorizing 
your information appropriately, and saving information as files in the right folders with a consistent 
file-naming convention. Having a good naming convention for files and folders is very helpful to 
identify what’s inside. Imagine having to open a bunch of files to figure out which one has the 
homework questions for a math assignment due tomorrow. You could easily end up spending more 
time searching for the file than you might’ve spent doing the assignment.

The technology industry has spent considerable effort trying to understand how users work with 
information and has attempted to make it as simple as possible to perform common operations. By 
following users around their offices, early researchers found that file management involves not only 
information retrieval, but also information reminder. Users keep documents on their desks not just to 
find them, but also to remind them of tasks that they need to do.66 Researchers also found that correctly 
classifying information was challenging for most users. For example, for any given school year, should 
you have folders like assignments, notes, or should you have folders like Math and English? As a result 
of this complexity, users tend to dump information into unorganized piles. These findings have led to 
metaphors such as “desktops,” designed to facilitate reminders and automatic classifications by date, 
file name, and other parameters. We explore the common file management utilities and operations 
in the rest of this chapter.

Since file management is a core function of an operating system, file management utilities come 
bundled with the operating system. While we focus on the file management utilities in the common 

A good example of home organization is a well 
organized kitchen pantry.

66	 Malone, T., “How Do People Organize Their Desks? Implications for the Design of Office 
Information Systems,” ACM Transactions on Office Information Systems, 1(1), 99-112 (1983).
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operating systems–Windows (File Explorer) (see Figure 27) and MacOS (Finder) (see Figure 28)—other 
operating systems offer similar utilities and support similar operations. For example, Nautilus, the file 
manager in Linux, looks and feels much like the file managers you see in this chapter.

FIGURE 27 — Windows File Explorer.

FIGURE 28 — Mac Finder.
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Using File Managing Utilities
The most common file operations involve creating, storing (saving), finding, opening, emailing, 
moving, and deleting files. You may occasionally need to do bulk operations on files to avoid wasting 
time by handling them one at a time. For example, you may want to reorganize all your music files, so 
they are grouped by artist and album rather than by the year of release. Or you may decide that you 
no longer need your 7th grade notes and projects and want to delete them all to make space for new 
assignments. It would be efficient to select a group of files and perform bulk operations on this group 
of files rather than try to move, copy, or delete them one at a time. File management supports all 
these common tasks. In addition, file management also supports restoring files deleted by accident.

As mentioned earlier, Microsoft’s file manager is called File Explorer. In versions of Windows before 
Windows 10, File Explorer was called Windows Explorer.67 The first File Explorer was released in 1995 
as Windows Explorer with Windows 95. The file manager on MacOS is called Finder and was released 
in 1984. The capabilities of these file managers have improved substantially over time.

Opening the File Managers
On Windows, you can launch File Explorer by clicking the Windows icon () and typing File Explorer 
in the search bar (see Figure 29). To open File Explorer, you can also use the keyboard shortcut, press 
E while holding the Windows key, ( + E). On the Mac, you can open the Finder by clicking the Finder 
icon in the Dock ( ), or by using the shortcut, Command + Option + Space Bar (⌘ + ⌥ + ␣).

Given how useful file managers are, most users find it great to have a quick way to access file 
managers. The most effective way to set this up on Windows is to press the Windows key () or click 
the Windows icon () on the desktop, scroll through the list of programs to Windows System, expand 
the group by clicking on it to find the icon for File Explorer. You can now right-click the File Explorer 
icon, select “More” and select “Pin to Taskbar.” The File Explorer icon will now show up at the bottom of 
your desktop, and you can click on the icon anytime you want to open File Explorer. On the Mac, the 
Finder icon is typically located in the Dock by default.

67	 Please do not confuse File Explorer with Internet Explorer, which was the earliest version of the 
web browser made by Microsoft and was used for surfing the Internet.
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FIGURE 29 — Searching for File Explorer on Windows.

File Manager Components

When File Explorer opens, you will see a “Quick Access” section on the left-hand side (the first box 
in Figure 30). Here you’ll find your frequently used folders, including “Desktop,” “Documents,” and 
“Downloads.” If you have installed any cloud storage service (e.g., DropBox), you may also see a link 
to that folder in your “Quick Access” menu. On the right (Section 3 in Figure 30), you will see all your 
recently accessed folders and files.

Click on any folder on the left side of File Explorer (sections 1 or 2 in Figure 30) and the contents of 
that folder will appear on the right-hand side (section 3).

One item on the left in File Explorer is of particular interest—”This PC.” Clicking “This PC” (highlighted 
as section 2 in Figure 30) brings up the storage layout of your PC, including the internal and external 
disk drives. If you plug in a USB storage, a smartphone, or smartwatch, it will show up as a separate 
device in this section. 
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FIGURE 30 — File Explorer components.

Device-Centric vs Storage-Centric Views in File Managers

While they do the same task, the Windows’ File Explorer and the Mac’s Finder 
have slightly different views of the computer. While File Explorer is storage-
centric, Finder and all versions of Unix are device-centric. On Windows, each 
storage device gets a unique letter as a top-level identifier. By convention, the 
hard drive with the operating system gets the “C:” identifier. The next storage 
device gets “D:” and so on. If you connect your smartphone to your Windows 
PC, it may get the “P:” top-level identifier.

On Macs, the entire computer, with all attached storage devices, is seen as 
one top-level entity, identified by the “/” label. All attached storage is said to 
be mounted on the computer and are typically accessible under the “/mount” 
folder. Finder provides a friendly user interface to simplify locating these 
external storage devices.



84 Chapter 6—File Management

File and Folder Properties
A file is the basic chunk of information available to computer users and applications.68 A folder is a 
container for a group of files and other folders. Files and folders have several properties that allow 
users and applications to locate and use the correct files and folders.

Names

Perhaps the most important property of a file or folder is the name. All files and folders are identified 
by human readable names. File names should help you easily identify the contents of the file. This is 
like labeling a notebook to be able to tell what’s in it. Before a file or folder can be created, it needs 
a name. To simplify the user experience, all applications have default methods to assign file names, 
even if the user does not provide one. For example, Microsoft’s Office Suite uses the first few letters 
in the file to create the default file name. Image programs assign default file names such as “Untitled.
png.” As you can see, while these file names allow the files to be created, they are not very useful 
to find the file later. For this reason, one best practice in computer use is to develop a file naming 
convention and to use it consistently.

For files that only you are likely to use, a simple convention of naming files by their title or purpose is 
sufficient. For example, “hamlet_shakespeare.pdf” would be a suitable name for a personal copy of the 
public domain version69 of the famous play. “assn1_english_classx.docx” would be a suitable name for 
your first assignment in the English Class in grade X. If you are likely to have multiple copies of Hamlet, 
you may like to disambiguate the files by adding the source of these files, e.g., “hamlet_shakespeare_
gutenberg.pdf” and “hamlet_shakespeare_w3.pdf.” Remember, the goal of the file name is to help 
you quickly locate and identify the file years later, when the context is no longer fresh in your mind.70

For files that are likely to be used by multiple users, it is useful to develop a convention that makes it easy 
for all users to quickly organize and locate the files. A simple convention can be to include the project 
name, group/subsection name, and the name of the author. For example, if your English teacher asks 
you to submit assignments, it will greatly help the teacher locate and grade the assignments if each 
student adopted a convention to include their own names as well as the name of the assignment in 
their submission. For example, “assn1_english_classx_johndoe.docx,” “assn1_english_classx_janedoe.

68	 According to Wikipedia, the word “file” to refer to a basic chunk of information on a computer 
comes from the earliest days of computers in the 1940s. Program instructions were written on 
punch cards and all cards associated with a program were carefully kept in a file. Similarly, the 
data associated with a program was also written on punch cards kept in a separate file. You can 
imagine computer operators using language such as “load the program from the file.” This name 
has stuck. “Computer file,” Wikipedia, https://en.wikipedia.org/wiki/Computer_file (accessed 
June 2023).

69	 E.g., William Shakespeare, Hamlet, Prince of Denmark, Project Gutenberg, https://www.gutenberg.
org/ebooks/1524 (accessed June 2023).

70	 You may have noticed that the examples use lower cases for all file names. This is a matter of 
personal preference. Many webservers are configured to be case sensitive and when files are 
to be uploaded to the web, it is often easier to just type the file names in lower case. Since the 
authors frequently upload files to a case sensitive webserver, they use lower cases for simplicity. 
Develop and follow your own convention for file names. 

https://en.wikipedia.org/wiki/Computer_file
https://www.gutenberg.org/ebooks/1524
https://www.gutenberg.org/ebooks/1524
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docx” and so on. This naming convention will also help the teacher pull up the assignment a month 
later if a student had a question about their grade.71

The file name should not be too long and should avoid characters that have special meanings for the 
operating system. These are called reserved characters. Long file names can be difficult to read in file 
managers. Consider separating different sections of the file name with an underscore to make it easy 
to read, as we have done in the examples. 

Since your file could be read by users in different operating systems, each with its own set of special 
characters,72 it is generally best to stick to letters, numbers, and underscores (_) in file names. The 
special characters you should avoid in file names include the following:73 

<	 (less than);

>	 (greater than);

:	 (colon);

“	 (double quote);

/	 (forward slash);

\	 (backslash);

|	 (vertical bar or pipe);

?	 (question mark);

*	 (asterisk).

We also recommend avoiding spaces in file names, e.g., “hamlet_shakespeare.pdf” is preferable to 
“hamlet shakespeare.pdf.” While spaces are not fatal, web browsers often replace spaces with “%20”74 
and it is possible to miss the characters following a space if they get hidden by column separators in 
file managers. Spaces are just enough of a nuisance that avoiding them is usually a good idea.

Parts of File Names

A file name has two parts. The actual name you chose for the file and a short name identifying the file 
type. The two parts are separated by a “.” The short name is known as the extension. For example, in 
“hamlet_shakespeare.pdf,” “hamlet_shakespeare” is the file name and “pdf” is the file extension.

71	 For more detailed examples, including the file naming conventions used at Disney, please see 
“Jason Boone, “Speed Up Your Workflow with Good File Naming Practices,” https://blog.frame.
io/2018/10/22/file-naming-conventions/ (accessed June 2023).

72	 The rules for Windows are in the article “Naming Files, Paths, and Namespaces,” https://learn.
microsoft.com/en-us/windows/win32/fileio/naming-a-file (accessed June 2023).

73	 “What characters are forbidden in Windows and Linux directory names?” https://stackoverflow.
com/questions/1976007/what-characters-are-forbidden-in-windows-and-linux-directory-
names (accessed June 2023).

74	 Learn more about this here: “%20 in URL—What Does it Mean? [Answered],” https://www.
raymond.cc/blog/decoding-percent-with-numbers-encoding-in-urls/ (accessed June 2023).

https://blog.frame.io/2018/10/22/file-naming-conventions/
https://blog.frame.io/2018/10/22/file-naming-conventions/
https://learn.microsoft.com/en-us/windows/win32/fileio/naming-a-file
https://learn.microsoft.com/en-us/windows/win32/fileio/naming-a-file
https://stackoverflow.com/questions/1976007/what-characters-are-forbidden-in-windows-and-linux-directory-names
https://stackoverflow.com/questions/1976007/what-characters-are-forbidden-in-windows-and-linux-directory-names
https://stackoverflow.com/questions/1976007/what-characters-are-forbidden-in-windows-and-linux-directory-names
https://www.raymond.cc/blog/decoding-percent-with-numbers-encoding-in-urls/ 
https://www.raymond.cc/blog/decoding-percent-with-numbers-encoding-in-urls/ 
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The operating system uses the file extension to 
determine the application program required to 
open the file. This is called file associations and is 
used in all modern operating systems.75 This use 
of the file extension is like peeking inside your 
kitchen pantry and being able to distinguish a box 
of Cheerios from Rice Krispies without opening 
all cereal boxes. For example, your computer 
will typically use Microsoft Word to open a word 
document by looking at the “.doc” or “.docx” 
extension. Similarly, your computer can recognize 
an image file by the “jpg,” “png,” “gif,” or other 
extensions that identify them as images and display 
the file using a program that can handle images.

For user convenience, file managers typically hide file extensions. However, it is useful to see them if 
you prefer to have greater control over your files. If you don’t see file name extensions when you view 
files in File Explorer, do the following:

1)	 Open File Explorer

2)	 Under “View,” select the “File name extensions” check box as shown in Figure 31.

The cover should tell you what’s inside.

FIGURE 31 — Enabling file name extensions in File Explorer.

75	 A good article on file associations is Tim Fisher’s “How to Change File Associations in Windows,” 
https://www.lifewire.com/how-to-change-file-associations-in-windows-2624477 (accessed 
June 2023).

https://www.lifewire.com/how-to-change-file-associations-in-windows-2624477
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Extension File type
aac, adt, adts, cda, m4a, mp3, wav Audio Files
mdb, accdb Microsoft Access Database File 

(before and after Access 2007)
bmp, gif, jpg, jpeg, png Image Files
csv Comma-separated File
doc, docx Microsoft Word Document
exe Executable Program File
htm, html Hypertext Markup Language File
jar Java Architecture File
mov, mp4, mpeg, wmv Video Files
pdf Portable Document Format File
ppt, pptx Microsoft PowerPoint Format (before/ 

after PowerPoint 2007)
tmp Temporary Data File
txt Unformatted Text File
xls, xlsx Microsoft Excel Workbooks (Before 

and after Excel 2007)
zip Compressed File

This table shows a list of common file name extensions and the associated file formats.

File Extensions and File Associations

While file extensions simplify the identification of the right program to open 
a file, they are not required to open a file with the correct associated program. 
For example, you can rename a Word document and remove the “.docx” file 
extension. Double clicking the file will no longer automatically start Word and 
open the file in it. However, if you open Word and select the file, it will open just 
fine. File extensions are just a convenient shortcut to help the operating system 
select the right application.

Locating Files
File managers also help you locate, move, delete, or open files easily. Both Microsoft’s File Explorer 
and Apple’s Finder show file names, folder structures, disk drives, and frequently accessed files and 
folders. Imagine if you spent hours working on a file but have no idea where you put it. Worse, say 
you don’t even remember the name of the file. Before you give up and begin to redo your work, you 
should try these two main techniques to locate files on a computer: navigation and search.
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Navigation

Navigating to the correct folder to find a file will not be difficult if you have a systematic way of 
naming folders and subfolders. As discussed earlier, the folder structure is akin to having a process 
to store things in your house to easily locate what you want. Ideally, to find spoons and forks quickly, 
you should have a space for “spoons and forks” and remember to store all your spoons and forks in 
the space. 

In short, navigation relies on labeling folders (storage areas) correctly and placing files in the correct 
folders. A few minutes invested in developing a naming convention you want for your files and folders 
can save hours of lost and wasted time and energy.

File Paths

In the computer world, finding a file relies heavily on the address of the file. The address, aka (also 
known as) path, is the location where a file is stored relative to the top level of storage on the computer. 
As you navigate from one folder to another in File Explorer, you can see the current address in the 
address bar at the top of the file manager (highlighted as a blue rectangle in Figure 32). In the address 
bar, you can see the path taken to get to the downloads folder is This PC → Local Disk (C:) → Users 
→ Public → Public Downloads.

FIGURE 32 — File paths displayed graphically (top) and as text (bottom).



Chapter 6—File Management 89

The path of the above folder is written as C:\Users\Administrators\Downloads. The backslash is a 
separator that represents a “contains” relationship. In this example, the C Drive (C:) contains a folder 
called Users, which in turn contains Administrator, which contains Downloads.

Search

If you cannot find a file by navigation, file managers also support search operations. The powerful 
search feature will look through all the accessible storage media, both internal and external, to find 
the file. 

1)	 Enter the name of the file in the search box (see Figure 33).

2)	 Press “Enter” on your keyboard to begin searching.

FIGURE 33 — Begin searching in File Explorer by entering the file name in the search box.

You can also specify a search criterion to narrow down the search and find the file more quickly. Just 
as you can find a favorite lost pen more easily if you know where you last used it, you can tell the 
computer where the file might be located to make it easier to find. For example, if you know that your 
file is in the Documents folder, you should select the Documents folder, but not any of the subfolders, 
to have the best chance of finding the file. File Explorer has a “search ribbon” (highlighted in Figure 34) 
with many options to narrow your search criteria.

FIGURE 34 — The search ribbon in File Explorer can be used to narrow your search criteria.
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Narrow searches are faster because they filter out more options. It is, therefore, better to specify as 
much of the file name and extension as possible, if you happen to remember it.

If you have an estimate of when you last worked on the file, you can search for files by their modification 
dates. To do this, click on “Date Modified” to specify a date range of when you think you last modified 
the file (see Figure 35).

FIGURE 35 — The “Date Modified” option in File Explorer can help further narrow a search.

If you know the type of file you are looking for, you can limit your search to files of that type. To do so, 
click on “Kind” and specify the type of file you are looking for (see Figure 36).
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FIGURE 36 — The “Kind” dropdown is another way to narrow a search in File Explorer.

You can also specify the “Size” of the file to further narrow the search criteria (see Figure 37).

FIGURE 37 — The “Size” dropdown is another option to narrow the search criteria.
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Check your results to find your file (see Figure 38). If you do not see your file, you should change the 
search criteria. You may be searching for the file in the wrong folder, or you may not have the correct 
file name. If you are not sure about the file name, specify only the part you remember. Also, you may 
want to specify a generic folder name (a level or two above in the folder hierarchy) to avoid missing 
the file. This will slow the search considerably but increase the likelihood of finding the file.

FIGURE 38 — Search results in File Explorer.

System Generated Folders
For end-user convenience, operating systems create default locations to store files. All computers 
using the same operating system will use these default locations. It is, therefore, very useful to be 
aware of some of the common locations where the operating system (e.g., Microsoft Windows) stores 
files of each type. 

Location Type of Content
Users This top-level folder contains folders for all users with 

accounts on the computer. Each of these user-specific 
folders is called the home folder for the user and is named 
after the user’s ID. Files associated with a user are placed 
within the user’s home folder by default.
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Location Type of Content
Desktop The default screen you see when you boot your computer. 

All the files you see on the default screen can be found in 
the folder called “Desktop.” The desktop view adopts the 
metaphor of a physical desktop to visually display files of 
interest. This is a sub-folder within the user’s home folder.

Downloads Any time you download files from the Internet (e.g., 
using a browser or from an email), they get stored in the 
Downloads folder. This is also a sub-folder within the 
user’s home folder.

Pictures Default location for images you create or photos you 
upload to your computer. This is also a sub-folder within 
the user’s home folder.

This PC This is the top level of storage in File Explorer. Every folder/
disk drive/storage media on your computer is contained 
in This PC.

C:, D:, E: Every storage media recognized by your computer is 
given a letter name. For example, the internal disk drive 
that has your OS is C drive (represented by C:). When you 
plug an external USB drive, it might show up as a D drive 
(represented by D:)

Dropbox, Box, 
Google Drive

Cloud storage systems like Dropbox create their own 
folder within the user’s home folder. You can access your 
cloud files in this folder. If you make any changes to files in 
this folder, these changes will get synchronized on cloud 
storage. More on cloud-based file management later in 
this chapter.

Desktop/
Recycle Bin

All the files you delete are temporarily stored in the Recycle 
Bin on your Desktop. If you accidentally delete any file on 
your computer, you can always go to your Desktop, open 
the Recycle Bin folder, and restore the previously deleted 
file. To clean your computer to have more space, you can 
permanently delete files in the Recycle Bin.

Program Files All the programs you install on your computer (Microsoft 
Office, Word, Excel, Chrome browser, etc.) are stored in 
the Program Files folder.

Program Data If a program needs to store data on your computer, the 
data will be in C:/Program Data. For example, if you are 
using a database software, typically the software will be in 
C:/Program Files/<Database Vendor>/<Software Name>, 
and the actual data will be in C:/Program Data/<Database 
Vendor>/<Data>.
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File Operations

Renaming Files and Folders

All file managers (e.g., File Explorer, Finder) make it easy to rename files and folders. There are multiple 
ways to rename a file using File Explorer:

1)	 Select the file you want to rename by clicking on it (single click). Then click the “Rename” 
button in the Home ribbon at the top. A text box will open for the new name.

2)	 Alternately, after selecting any file in File Explorer, right-clicking on the file name with your 
mouse will open a context-menu that gives you options to “Cut,” “Copy,” “Delete,” and “Rename.” 
(See Figure 39 and Figure 40.) 

Two step process of renaming a file/folder. 

FIGURE 39 — First step—Right-click on the file/folder.  

FIGURE 40 — Second step—Type in the editable textbox to rename.



Chapter 6—File Management 95

Use the same file-renaming technique to rename 
folders. Select a folder by clicking on it in File Explorer, 
then right-click your mouse to open the context menu 
that offers options to manipulate the folder.

Most application programs also give you menu 
options to rename files. You can save a copy of a file 
under a different name if you select “Save As” or “Save 
a Copy” under the “File” menu option (see Figure 41).

FIGURE 41 — Select “Save As” to save with a 
new name.

Copying Files

By copying a file, you create a duplicate. Copying is 
useful in many situations. For example, you may want 
to make a copy and start working on it to preserve the 
original file. You may also like to copy files to a backup 
storage device. There are several ways to copy files. 
Some of the most common ways are presented here.

If you are working on a file in an application program, using the “Save As” option under the “File” 
menu allows you to save the file using a new name in the current location or anywhere else in the 
computer’s file system (Figure 41).

You can also use the “Copy” and “Paste” features of your file manager to copy a file and paste it in any 
location. In File Explorer, navigate to the file location, identify the file you want to copy, select it, then 
right-click for the context menu, and choose “Copy” (Figure 42).
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FIGURE 42 — The “Copy” option in File Explorer.

Once you copy a file, it is in the computer’s memory. You can then tell the computer what to do with 
it. To paste it in any location, navigate to the correct folder in File Explorer, click anywhere in the white 
space of the folder, right-click to open the context menu, and choose “Paste” (Figure 43).
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FIGURE 43 — If a file is in memory, right-clicking in the white space in a folder will open the context-menu option to paste.

Copying files to memory is not limited to one file. You can also copy a folder containing many files and 
paste it in any location. You can also copy and paste multiple files. To select files to copy, just press 
the “Ctrl” button on your keyboard as you click on the files you want to copy. Then right-click on any 
selected file to bring up the context menu and select “Copy.” The OS will now have the collection of 
all selected files in its memory. Right-clicking on an empty space in a folder will bring up the context 
menu for this folder and selecting “Paste” will paste these selected files into the target folder.

Keep in mind, copying is an overwrite operation. Every time you copy something to memory, it erases 
the previously copied content in memory. Only the last “Copy” (a file, a folder, or a collection of files) is 
in memory during the copy and paste process. After copying File A, if you decide to click on File B and 
choose “Copy,” then the computer has File B in its memory. If you paste, you will paste File B. 

Moving Files

Moving a file transfers the original file to a new location. Whereas the copy and paste operation creates 
multiple copies of a file, moving files transfers the original file to a new location. Multiple copies 
are not created. Moving files is useful in many situations, including reorganizing files, or transferring 
from a computer’s hard disk to a cloud storage folder. File managers support multiple mechanisms to 
move files.
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Rhyming with “copy and paste” is the “cut and paste” operation to move file. The process to cut and 
paste is the same as the copy and paste operation. Locate the file you want to move, right-click on 
your file to bring up the context menu and choose the “Cut” option. Once you choose the “Cut” option, 
the file is in the memory of the computer and has been marked for deletion from the original location. 
Navigate to the new folder and click anywhere in the white space of the folder. Then right-click on 
your mouse to bring the context menu and choose the “Paste” option to transfer the file to the new 
folder. The file will also be deleted from the old location.

The cut and paste technique works with folders as well as files. Just like with the copy and paste 
operation, you can move a group of files and/or folders by first selecting multiple files by pressing 
“Control” (“Ctrl”) and clicking on each file you want to move. Once highlighted you would use the cut 
and paste process to move all the files and/or folders to a new location.

You can also use a drag and drop operation to move files and folders. To drag and drop easily, open 
two File Explorer windows and set them up side-by-side. To do that, open a File Explorer window. 
Then open a second File Explorer window by choosing the “Open new window” option under the 
“File” menu (Figure 44). You can resize the two File Explorer windows, if needed, so they are both 
visible on your computer. This can be done by clicking in the corner or on the edge of the window 
and dragging it so it becomes larger or smaller as needed. In one window, open the source folder that 
contains the files you want to move and in the other open the target folder where you want to move 
the files.

FIGURE 44 — The “Open new window” option opens a new Explorer window.

Once you select the files you want to move by clicking on them in the first File Explorer window, hold 
the left mouse button and drag the files to the desired folder in the second File Explorer window. You 
will see the files being removed from the source window and being added to the target window.
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Using the Drag Operation to Copy and Paste

A variant of the cut and paste drag operation allows you to “copy and paste.” To 
copy and paste files using the drag and drop option, hold the “Ctrl” key along 
with the left mouse button. This use of the “Ctrl” key to switch between the copy 
and cut operations is a common use of the “Ctrl” key.

Deleting Files

It is good practice to delete files regularly to save space, reduce clutter, and make it easier to find what 
you are looking for. One common reason to delete files is to get rid of redundant copies of photos or 
videos. Purging unnecessary media files not only saves a lot of space, but also makes it easier to find 
interesting pictures. If you are worried about losing important information, you can create a suitably 
named folder such as “Unwanted Files” and then organize all unnecessary files in easily identifiable 
subfolders within it. 

To delete a file, click on the file in the file manager, right-click your mouse on the file to bring up the 
context menu, and choose the “Delete” option. Another way to delete a file or a collection of files is to 
first select them in the file manager, then click the “Home” tab on the File Explorer ribbon. Clicking on 
the “Delete” option will delete all the selected files (see Figure 45). 

FIGURE 45 — The “Delete” option is under the “Home” menu.

Restoring Files

If you accidentally delete a file and want to get it back, the operating system offers a neat trick to save 
your day. When you delete a file, it is flagged as deleted, no longer visible to you in the file manager, 
and gets moved to Recycle Bin in Windows and Trash on Macs. The Recycle Bin, like Trash, is a giant 
trash can that holds all your deleted files. In Windows systems, you can find the Recycle Bin on your 
Desktop. You can also click the Windows Start icon and type “Recycle Bin” (see Figure 46).
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FIGURE 46 — The Recycle Bin in Windows.

If you have many deleted files in the Recycle Bin, you can use the column headers to click and sort. 
You can sort by “Name,” “Location,” “Date Deleted,” and “Size,” or use the search box to find files by 
name. Right-click on any file to get the context menu to view file properties, restore, or permanently 
delete the file. 

FIGURE 47 — The Recycle Bin’s context menu offers several options. Also, check out the Recyle Bin Tools on the 
ribbon.
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On the ribbon under the “Recycle Bin Tools” menu, you have the option to completely empty the bin 
or restore all or selected items (see Figure 47).

You should consider emptying your recycling bin periodically. Right-clicking on Recycle Bin on 
Windows or Trash on Mac and selecting “Empty” permanently gets rid of all the deleted files from the 
computer.

File Compression and Decompression
File compression is the process of rewriting a file to a smaller size. File compression is very useful in 
many situations. Imagine if it takes an hour to download a music file over the Internet; you desperately 
need to send an email that has a huge attachment; or it takes forever to copy a large file to a USB 
stick—file compression is the common solution to all these problems. When a compressed file is to 
be read, decompression utilities can restore the contents of the file.

File managers include utilities to compress and decompress files. Compression works not only for 
files, but also for folders. When a folder is decompressed after transfer, the entire folder structure 
along with the contents are regenerated just the way the files were at the time of compression. 

To compress a file or folder in File Explorer, select the file or folder, then right-click to bring up the 
context menu. Choose “Send to” and then “Compressed (zipped) folder” (Figure 48). This will apply 
the file compression algorithm and create a significantly smaller file. A new compressed file called 
My_Important_files.zip is created without impacting the original folder in any way. To restore the 
original contents from the compressed file, just select the zipped file and right-click to bring the 
context menu. Choose “Extract All” to decompress the folder and rebuild the file structure.

FIGURE 48 — Files can be compressed using File Explorer.
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The extent of compression is called compression ratio. The compression ratio depends upon the 
algorithm used, the data type,76 and the type of file. Typically, media files (e.g., video, audio, images) 
can be compressed to a greater extent than text files such as Word and Excel files containing characters 
and numbers.

Lossy vs Lossless Compression

There are two general approaches to data compression—lossy and lossless. 
Lossy compression algorithms can remove some data from the original file 
to reduce its size. The original data cannot be recreated by decompressing a 
file compressed using a lossy algorithm. Lossless compression preserves all 
the original data in the file and all the original data can be recovered upon 
decompression. The zip compression algorithm we have discussed in this 
chapter is a lossless compression algorithm. Compression algorithms used in 
business typically need to be lossless.

Lossy compression algorithms can typically achieve very high levels of 
compression. Lossy compression is typically used in media files by removing 
features in audio, video, and images that are less noticeable to our senses. 
Almost all the media you consume, including Netflix, Spotify, Apple Music etc. 
use lossy compression though this is not noticeable because our eyes and ears 
do not notice any difference. Lossy compression is also used to transmit data to 
your Bluetooth earbuds. So, if you subscribe to a lossless audio service, you will 
need to get special headphones that do not compress audio in its journey from 
the device to the earpiece.

File Backup
File backup, or data backup, is the process of creating and storing a copy of data in such a way that 
the copy may be used to restore the original in case of data loss. At the end of the day, your computer 
is an appliance, just like your dishwasher or a refrigerator. You must always consider the possibility of 
losing all the critical files on your computer at any time. While the computer may run for years at end, 
it may refuse to start on any given day, without any notice.

Data on computers can become inaccessible for various reasons. A computer has moving parts, like 
fans, power supplies, disk drives, and accessories like cameras, microphones, speakers, and printers. 
These parts can fail from mechanical shocks or the heat generated by the processor.

What is the solution to protecting critical data files on your computer? The common procedure is to 
periodically copy critical files and folders into a USB stick or an external drive that can be reconnected 
to a new computer when the old one dies. However, this manual process of copying into external 
storage may not work well if you have hundreds of files. It also requires considerable discipline to do 

76	 A good comparison of several compression algorithms is at “Comparison of Brotli, Deflate, Zopfli, 
LZMA, LZHAM and Bzip2 Compression Algorithms,” https://cran.r-project.org/web/packages/
brotli/vignettes/brotli-2015-09-22.pdf (accessed June 2023).

https://cran.r-project.org/web/packages/brotli/vignettes/brotli-2015-09-22.pdf
https://cran.r-project.org/web/packages/brotli/vignettes/brotli-2015-09-22.pdf
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manual backup on a regular basis. Cloud storage, covered in the next section is potentially a great 
alternate solution to protecting critical data.

Industrial Backups

Data backups in the industrial environment can get very complicated very fast. 
When your computers are serving large numbers of customers, not only do you 
have to worry about these computer devices failing, but you also must also 
worry about power supplies to these devices, as well as the connectivity of 
these devices to the Internet. For this reason, TV broadcasters have developed 
a complicated solution. They maintain battery backups, which are backed up 
by redundant generators that are supplied by diesel fuel sources from multiple 
vendors. The broadcasters also maintain multiple connections to the Internet, 
deliberately choosing providers with non-overlapping connections to the 
Internet. By taking these precautions, a natural disaster such as a hurricane 
does not bring the station down.

Cloud-Based File Management
Cloud-based file management is the process of storing data with a service provider off-site while 
still being able to work with the data as if it were stored on the local computer. Cloud-based file 
management has many uses, including file safety, security, and convenience. Having files on your 
computer is problematic in many ways. There is no easy way to share a file on your computer with 
colleagues. Imagine sharing photo albums stored in your computer with family members spread 
across the globe. What if you and your friends wanted to work on the same file? Would you mail the 
document and wait for others to make their changes one by one? What if you needed to revert the 
file to an older version that was better in some respects? What if you wanted to see the incremental 
changes you made to a file in the past year?

The solution to all these problems is cloud-based 
file management. Recent solutions like Dropbox, 
Box, Google Drive, and OneDrive offer cloud-
based file management services that are very 
convenient technically and economically. These 
services take care of backing up data, so users do 
not have to worry about device failures. 

Dropbox is a popular cloud-based file management 
system. After you create an account at dropbox.
com and install the software on your computer, 
Dropbox will show up as a folder on your desktop 
(see Figure 49). 

You can treat Dropbox like any other folder on 
your computer. Under the Dropbox folder, you 
can create folders, subfolders, and files. As you 
create or modify a file, a copy of the file is sent to 

FIGURE 49 — Once an account is created, the 
Dropbox folder will appear in File Explorer.
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the Dropbox servers in the cloud, where your file is backed-up magically without any effort on your 
behalf.77

If you have multiple computers, you can install Dropbox on all the machines and connect them to 
the same Dropbox account. Any change you make to one computer’s Dropbox folder appears on all 
other computers. Cloud-based file management has taken away the headache associated with saving 
and sharing files manually. You simply put all your critical files in a Dropbox folder, and they are there 
for all your friends on the Dropbox servers. If a computer dies and you buy a new computer, you only 
need to install Dropbox on the new computer and log in to the application with your Dropbox user-id 
and password. Within minutes, all your files will show up on the new computer in the Dropbox folder. 

If you go on a vacation and forget to bring your computer, you can go to any computer at an Internet 
café, open a browser, go to www.dropbox.com, and login to access all your files (see Figure 50). Your 
online Dropbox account will show who has access to files. You can even look at the entire version 
history of any file, see what changes were made when, and revert to any older version.

FIGURE 50 — You can also view your Dropbox folder online, which can be very convenient when away from your 
desk.

To share any file with others, right-click on the file to bring up the context menu and select “Share.” 
(See Figure 51.)

77	 You may like to see the original video created by Drew Houston, the founder of DropBox, describing 
the service, “Dropbox Original MVP Video,” https://www.youtube.com/watch?v=qxFLfY7_Gqw 
(accessed June 2023).

https://www.youtube.com/watch?v=qxFLfY7_Gqw


Chapter 6—File Management 105

FIGURE 51 — It is easy to share a file or folder in Dropbox with others.

While Dropbox is designed for regular consumers, Box is designed more for organizations. Box focuses 
on integrating tightly with the security systems of universities and companies. Employees can use 
their company credentials to use Box and send files to other employees for review and approval.

OneDrive is Microsoft’s alternative to Dropbox. Typically geared for enterprises and Office 365 users, it 
also offers versioning and collaboration capabilities and a way to access files across many computers. 
Just like Dropbox, OneDrive appears as a folder on your computer. All the files stored in the OneDrive 
folder are backed up into cloud servers and can be accessible by others, based on sharing rules.

Google Drive is the online cloud file storage system from Google and iCloud is the equivalent from 
Apple. Like Dropbox, Box, and OneDrive, these systems also offer cloud back up, versioning, and 
sharing capabilities.

A tradeoff for the ease of using a cloud-based file management are the expenses associated with 
these services. Once you are out of the free-trial period or use more storage than offered for free, you 
will have to sign up for the service and pay a subscription fee. This model of using software services 
for a fee is referred to as SaaS (Software as a Service). SaaS is becoming increasingly popular among 
companies as it saves companies the headache of buying and maintaining software and hardware. 
For a suitable rental fee, SaaS services can be valuable for a wide range of organizations.78

Task or Activity Manager
You are likely to run into many situations where you’d want to know how your computer is performing—
which applications are consuming too much power, memory, CPU, processing, or network bandwidth. 
Operating systems have utilities that help users manage, monitor, and troubleshoot the applications 
running on computers. On Windows, the utility is called Task Manager and on Mac, the utility is called 
Activity Monitor. 

78	 For an alternate view of the economics of SaaS and cloud-based file management, particularly 
when companies grow big, you may like to read this article about DropBox and their use of 
Amazon Web Service. Sarah Wang and Martin Casado, “the Cost of Cloud, a Trillion Dollar 
Paradox,” https://a16z.com/2021/05/27/cost-of-cloud-paradox-market-cap-cloud-lifecycle-
scale-growth-repatriation-optimization/ (accessed June 2023).

https://a16z.com/2021/05/27/cost-of-cloud-paradox-market-cap-cloud-lifecycle-scale-growth-repatriation-optimization/
https://a16z.com/2021/05/27/cost-of-cloud-paradox-market-cap-cloud-lifecycle-scale-growth-repatriation-optimization/
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To open the Task Manager on Windows, you can press the Windows key () and type “Task Manager.” 
Alternately, use the keyboard shortcut, “Ctrl+Shift+Esc.”

FIGURE 52 — Windows Task Manager offers a different view of the applications running on the computer.
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As you can see in Figure 52, the Task Manager provides great visibility into all applications running 
and the resources consumed on the computer. Like in File Explorer, you can right-click any process 
to pull up the context menu. A useful operation in the context menu of the Task Manager is the 
option to “End Process.” If you have an application that is not responding to user input, this is the most 
straightforward mechanism to end that application, and if needed, to restart it. Figure 53 shows Mac’s 
Activity Monitor, which performs similar functions.79

FIGURE 53 — Activity Monitor on Mac offers similar functions as Windows Task Manager.

79	 “Activity Monitor User Guide,” https://support.apple.com/guide/activity-monitor/welcome/mac 
(accessed June 2023).

https://support.apple.com/guide/activity-monitor/welcome/mac
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			   Chapter Terms and Definitions

Activity Monitor: A utility provided by the 
Macintosh operating system that is designed 
to report how your Macintosh computer is 
distributing and processing disks, memory, or 
network communication

Cloud-Based File Management: The process of 
storing data with a cloud service provider while 
working with the data as if it were stored on the 
local computer

Copy and Paste: To transfer text or some other 
type of content, such as an image to another 
location in the same or different document; for 
example, in Microsoft Windows this can be done 
with “Control + C” to copy and “Control + V” to 
paste content

Cut and Paste: Similar to copy and paste, but 
instead of leaving the original text or content 
intact, the original content is removed and 
transferred to a new location

Drag and Drop: Using a mouse button to click 
and hold onto a software object such as an image 
or file, drag it across the screen, and then release 
the button to relocate the object

File Backup: The process of creating and storing 
a copy of data in such a way that the copy may 
be used to restore the original in case of data loss

File Compression: A process that reduces the 
space a file takes up in storage and increases 
the speed in which it can be transferred from 
one computer to another; for example, a ZIP file 
contains one or more files from a folder that has 
been compressed

File Decompression: The process of restoring 
a compressed file, such as a ZIP, to its original 
content form

File Extension: After the name of a file, followed 
by a period is a sequence of letters that indicate 
the format of the file; operating systems use the 
file extension to locate a default program that 
will be used to open and execute the file

File Management: Creating an organized 
structure to store information on your computer 
for easy retrieval and use

File Manager: The User Interface (UI) in which 
you can interact with the files and store them

File Operations: A computer operating system 
allows for the manipulation of files; such as 
create, edit, and delete

File Path: The absolute directory on a computer 
where a file is located; for example, the absolute 
file path for a file named hello_world.docx 
located in the Documents folder of a Microsoft 
Windows computer could be: C:\Users\Clinton\
Documents\hello_world.docx

Mac Finder: The file manager UI used by the 
Macintosh operating system

Recycle Bin: Where Microsoft Windows stores the 
files deleted by a user before they are permanently 
removed; it offers an opportunity for a user to 
recover files before they are permanently deleted
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Task Manager: A utility provided by the Microsoft 
Windows operating system that is designed to 
report how your PC is distributing memory, disk 
space, and processing applications

Trash: Where Macintosh stores the files deleted 
by a user before they are permanently removed; 
it offers an opportunity for a user to recover files 
before they are permanently deleted

User Interface (UI): Any medium that allows 
users to interact with computers

Windows File Explorer: The file manager UI used 
by the Microsoft Windows operating system



110 Chapter 6—File Management

		  	 Chapter Case

Ian’s Research Paper File
It was a Saturday morning and Ian’s sister needed to borrow his laptop for one day. 
Ian’s laptop had an application program installed that his sister needed in order to 
complete her 10th grade science project. This meant Ian had to start writing his 
research paper using Microsoft Word on his mom’s laptop. He knew he wouldn’t 
be able to finalize it on Saturday and wanted to finish it using his personal laptop 
on Sunday, after his sister was done with her project. Once he finished writing his 
research paper, he had to submit the final version to receive his grade. It had to be 
on the cloud-based storage system before his writing class started on Monday at 
9:00 a.m. 

Based on the above scenario, what recommendations do you have for Ian given the 
following questions: 

Question 1:	 What possible file extensions would be used to write Ian’s research 
paper? 

Question 2:	 What should Ian do to save the work he partially completed on his 
research paper file after using his mom’s laptop on Saturday? 

Question 3:	 What should Ian do to save his research paper after completing it 
using his personal laptop on Sunday? 

Question 4:	 What cloud-based storage should Ian use to submit the final version 
of his research paper for his Monday class and how will his teacher 
access the file? 
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If we want America to stay on the cutting edge, we need young Americans to master 
the tools and technology that will change the way we do just about everything.

—Barack Obama, former President of the United States

Overview
In the chapters so far, we have talked about different types of computers and the important components 
of computers. We are now ready to introduce how these computers are used. Though computers were 
created to perform complex calculations, such as the correct angle to position a gun to hit a specific 
target and to find the correct trajectory to return safely to Earth from the moon, most users do not 
have such exotic uses for computers. Most folks own computers to work on assignments, prepare 
reports, calculate business profits, communicate with collaborators, or even just for entertainment, 
such as listening to music, watching videos, or playing games. In the next set of chapters, we will 
provide an overview of the most common categories of computer applications used in business. 
These applications help you create and process information and are called productivity applications. 
They include word processors, spreadsheets, presentations, and communication utilities such as 
email. 

What Are Productivity Applications?
If you have ever watched plumbers, carpenters, or electricians at work, you might have noticed one 
common thing about all of them: their collections of tools. They must be extremely familiar with 
their tools to be good at what they do. They often reach for the right tool in their pocket without 
even looking. When they see a problem, they know exactly which tool to reach for and how to use it. 
They are so dependent on their toolset they carry backups of their core tools in their trucks. The best 
carpenter is useless without a saw, hammer, and drill. The best plumber in the world can’t fix a leak 
without a wrench at hand.

Productivity applications play a similar role in the world of information. Productivity applications on 
computers enable users to create, process, and distribute information across the world. The Internet, 
computers, and productivity applications enable groups of widely dispersed individuals to share 
information seamlessly. You could have team members spread across the globe in different time 
zones, working on different parts of the same document simultaneously. 

Productivity applications have enabled the globally connected world we live in. The car you are driving 
today was probably designed in California, manufactured in Japan, shipped to a port in Mexico, and 
delivered to a dealership in Florida. This distributed design, manufacturing, shipping, retail, and sales 
were made possible because of productivity applications that let different companies and teams 
seamlessly share information. Every aspect of our lives, including healthcare, banking, housing, food, 
and entertainment, is possible because millions of people around the world can work with each other 
using documents, spreadsheets, databases, emails, calendars, and chat applications. To participate 
in this ecosystem, create a document, build a database of expenses, make a presentation, send an 
invoice to a vendor, meet a customer, or quickly ask a colleague a question, you need to know which 
tool to reach for and how to use it. The next few chapters will introduce you to all the commonly used 
tools in the business workplace.
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Documents
The basic information product is a digital document. A digital document is a collection of text and 
images organized meaningfully. Whether you receive a college admission letter, your semester report 
card, or the sale deed of a car regardless of whether you receive it in printed form in the mail or 
electronic form online, it was likely generated and stored as a digital document using one of the 
productivity applications we will discuss. This textbook also exists as a digital document, albeit a very 
large one, and is broken into many parts.

Working with digital documents is probably the simplest use of computers. Productivity applications 
that are used to create digital documents 
are called word processors. The two most 
popular word processing productivity 
applications are Microsoft Word80 and 
Google Docs.81 Microsoft Word, or just 
Word, is the more traditional word 
processing software and is typically used 
by enterprises. Word documents are 
identified by the .doc or .docx extension. 
Any computer that has Microsoft Word (MS 
Word) or a compatible application will let 
you open and work on Word documents.

Google Docs on the other hand is browser 
based and designed with a focus on 
collaboration. Multiple team members can work on different sections of a Google Docs document at 
the same time. In recent years, MS Word has also become available in a browser-based version with 
comparable collaboration capabilities as part of the Office 365 set of productivity applications.

A simple Word document.

Google docs ribbon.

Word processors are simple to use, but most users only use the most basic capabilities. With just a little 
bit of effort and instruction, you can leverage the powerful capabilities of word processors such as 
fonts, paragraphs, lists, numbering, styles, sections, layouts, tables, pictures, colors, headers, footers, 
and templates. These are built into all modern word processors to easily create beautiful documents 
with a consistent look and feel. You can highlight critical bits of information and improve readability 
by formatting paragraphs and sections with ease.

80	 Microsoft 365 home page, https://www.microsoft.com/en-us/microsoft-365/word (accessed 
June 2023).

81	 Google Docs home page, https://www.google.com/docs/about/ (accessed June 2023).

https://www.microsoft.com/en-us/microsoft-365/word
https://www.google.com/docs/about/
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Documents and Microsoft

In 2021, Microsoft’s operating income was $83 billion.82 Of these profits, $29.7 
billion came from the “Productivity and Business Processes” segment, which 
includes Office 365. Microsoft got its start in productivity applications with 
word processing when Charles Simonyi joined Microsoft in 1981. Simonyi had 
developed the Bravo WYSIWYG (What You See Is What You Get) editor at Xerox 
PARC labs. Simonyi started the productivity applications group at Microsoft, 
which has remained one of the most successful software groups of all time. In 
an interview in 2020, the 70-year-old billionaire said that he is currently working 
on the Microsoft Whiteboard productivity application and goes to work every 
day.

In the programming world, Simonyi is known for developing the Hungarian 
notation83 for naming computer program elements such as variables and 
functions.84

Portable Document Format (PDF)

The ease of editing is one of the primary motivations to use digital documents. However, there are 
times when you want to send a document to others who are not authorized to modify it. For example, 
when you return a purchased item to Amazon, they give you a shipping label with a special barcode. 
Amazon doesn’t want you to modify the shipping label because it has a special barcode that helps 
Amazon identify the item and correctly process the return to issue a refund. Therefore, shipping 
labels are read-only documents. For correct handling, these documents should have the same form 
regardless of the printer and the operating system used. To accomplish the above task, you can save 
documents in a format known as the “Portable Document Format,” or PDF.

Most forms including college applications, loan forms, tax forms, and club membership forms are 
distributed in PDF format. Word processors such as Microsoft Word and Google Documents can 
save documents in PDF format. In most applications, the simplest way to create a PDF version of the 
document is to print the document and select Adobe PDF as the printer.

The most popular application to view PDF documents is Adobe’s Acrobat Reader software,85 which is 
available for most operating systems.

82	 Trended Historical Financials, https://www.microsoft.com/en-us/Investor/earnings/trended/
yearly-income-statements.aspx (accessed June 2023).

83	 A great article for the motivation of the Hungarian notation, with generalizable ideas for many 
life contexts. Joel Spolsky, “Making Wrong Code Look Wrong,” https://www.joelonsoftware.
com/2005/05/11/making-wrong-code-look-wrong/ (accessed June 2023).

84	 Charles Simonyi, “Hungarian Notation,” https://learn.microsoft.com/en-us/previous-versions/
visualstudio/visual-studio-6.0/aa260976(v=vs.60)?redirectedfrom=MSDN (accessed June 2023).

85	 Adobe Acrobat Reader can be downloaded from here, https://www.adobe.com/acrobat/pdf-
reader.html (accessed June 2023).

https://www.microsoft.com/en-us/Investor/earnings/trended/yearly-income-statements.aspx
https://www.microsoft.com/en-us/Investor/earnings/trended/yearly-income-statements.aspx
https://www.joelonsoftware.com/2005/05/11/making-wrong-code-look-wrong/
https://www.joelonsoftware.com/2005/05/11/making-wrong-code-look-wrong/
https://learn.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-6.0/aa260976(v=vs.60)?redirectedfrom=MSDN
https://learn.microsoft.com/en-us/previous-versions/visualstudio/visual-studio-6.0/aa260976(v=vs.60)?redirectedfrom=MSDN
https://www.adobe.com/acrobat/pdf-reader.html
https://www.adobe.com/acrobat/pdf-reader.html
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“View and Print Anywhere” Motivation for PDF86

The portable document format was created in 1993 by a team led by John 
Warnock, a co-founder of Adobe, one of the world’s leading software companies. 
The challenge at the time was to create a simple format that would look the same 
on any display, printer, etc., and demand minimal computer processing power. 
In 2008, Adobe opened up the specifications to the International Organization 
for Standards (ISO). Since then, most computer applications have introduced 
the option to save their output as PDFs.

Spreadsheets
A spreadsheet is a specialized digital document in which data is arranged in rows and columns for 
use in business calculations. Imagine if you maintain your expenses in a notebook on pen and paper. 
If you accidentally entered the wrong number, you would have to redo all calculations to find your 
current balance. If you wanted to find the value of expenses in a different currency, you would have to 
change every number in the list individually. Every time the currency rate changed; you would have 
to redo the calculations.

Spreadsheets simplify and even automate these and similar tasks, so users can focus on their business 
problem, not on the calculations. Spreadsheets not only give you predefined formulas to use for 
calculations but also allow you to create your own formulas. If you change the input values, the output 
is recalculated automatically. Similarly, the output data will change if you change the formulas.

As an example of the convenience of using spreadsheets, Figure 54 is a home mortgage calculator. 
You just input your initial loan amount, interest rate, and the loan start and end dates. The spreadsheet 
automatically calculates your monthly payments based on predefined formulas. As you change your 
input values, all the output values (monthly payments in this case) change automatically. This allows 
you to focus on your home purchase options based on your budget, without worrying about the 
calculations or their accuracy.

86	 John Warnock (founder of Adobe), “Camelot,” https://web.archive.org/web/20090304134754/
http://www.planetpdf.com/planetpdf/pdfs/warnock_camelot.pdf (accessed June 2023).

https://web.archive.org/web/20090304134754/http://www.planetpdf.com/planetpdf/pdfs/warnock_camelot.pdf
https://web.archive.org/web/20090304134754/http://www.planetpdf.com/planetpdf/pdfs/warnock_camelot.pdf
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FIGURE 54 — Home Mortgage calculator.87

While spreadsheets are as simple to use as word processors, for proficient users they can also be 
the most technical of productivity applications to use. Advanced features such as Pivot Tables can 
help you aggregate your data by different parameters and identify patterns. For example, would you 
like to know whether the donations you collect for your school band come in on Sundays or from a 
particular zip code? Pivot Tables can help you aggregate the data by days or locations and show you 
totals for each category.

Spreadsheets are also great at filtering, sorting, and visualizing88 data. A common workflow you can 
employ to present your business to stakeholders is to first capture your data in a spreadsheet, use the 
spreadsheet software to create appropriate graphs to describe the data, and then use these graphs in 
your documentation and presentations. Figure 55 shows an example.

87	 The spreadsheet can be downloaded from https://templates.office.com/en-us/mortgage-loan-
calculator-tm02802352 (accessed June 2023).

88	 For an overview of common chart types, please see https://support.microsoft.com/en-us/office/
available-chart-types-in-office-a6187218-807e-4103-9e0a-27cdb19afb90 (accessed June 2023).

https://templates.office.com/en-us/mortgage-loan-calculator-tm02802352
https://templates.office.com/en-us/mortgage-loan-calculator-tm02802352
https://support.microsoft.com/en-us/office/available-chart-types-in-office-a6187218-807e-4103-9e0a-27cdb19afb90
https://support.microsoft.com/en-us/office/available-chart-types-in-office-a6187218-807e-4103-9e0a-27cdb19afb90
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FIGURE 55 — Example spreadsheet graph.

Excel from Microsoft and Sheets from Google are the two leading spreadsheet productivity 
applications used today. Almost every business uses spreadsheets. Likely, your school uses several 
spreadsheets to keep track of students and their activities. It may not be an exaggeration to say that 
while “America runs on Dunkin,”89 businesses run on spreadsheets. It is estimated that almost a billion 
people use spreadsheets to manage data. Any time you are working with data at school, whether for 
an assignment or personal management, we highly recommend using spreadsheets and exploring 
one new capability each time. This will help you not only manage your data more efficiently but also 
improve your own skills in one of the most important productivity applications.

VisiCalc and the Killer App90

A killer app (application) is a computer application that is so desirable that 
it drives purchases of much more expensive technology.91 VisiCalc, the first 
popular spreadsheet software, is widely considered the world’s first killer app. 
It was created in 1979 by Dan Bricklin and Bob Frankston for Apple Computers 
and sold for $100. However, it was so useful that users bought Apple Computers 
costing over $2,000 just so they could use VisiCalc. Eventually, Lotus 1-2-3 from 
IBM and then Excel from Microsoft became the dominant spreadsheets.

89	 “Dunkin’ Donuts Launches New Advertising Campaign ‘America Runs on Dunkin’(sm),’” https://
news.dunkindonuts.com/news/dunkin-donuts-launches-new-advertising-campaign-america-
runs-on-dunkin-sm (accessed June 2023).

90	 Luke Dormehl, “Today in Apple history: Apple II gets its first ‘killer app,’” https://www.cultofmac.
com/460680/apple-ii-killer-app-visicalc/ (accessed June 2023).

91	 “Killer application,” https://en.wikipedia.org/wiki/Killer_application (accessed June 2023).

https://news.dunkindonuts.com/news/dunkin-donuts-launches-new-advertising-campaign-america-runs-on-dunkin-sm
https://news.dunkindonuts.com/news/dunkin-donuts-launches-new-advertising-campaign-america-runs-on-dunkin-sm
https://news.dunkindonuts.com/news/dunkin-donuts-launches-new-advertising-campaign-america-runs-on-dunkin-sm
https://www.cultofmac.com/460680/apple-ii-killer-app-visicalc/
https://www.cultofmac.com/460680/apple-ii-killer-app-visicalc/
https://en.wikipedia.org/wiki/Killer_application
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Presentations
Presentations are digital documents that combine text, graphics, and media (audio and video) for 
display to an audience. While documents are great at organizing detailed textual information and 
spreadsheets are great at analyzing numerical data, neither of them is suited for presenting to a large 
gathering. Documents and spreadsheets are largely designed to be viewed by individuals on their 
own personal devices, at their own personal pace.

Presentations, on the other hand, are designed to 
be viewed by a large audience at a pace set by the 
speaker. Typically, a presenter provides additional 
details about each slide during the presentation. 
Therefore, presentations focus on holding 
the viewer’s attention through visual appeal, 
consistency, visual contrast, and other story-telling 
elements.

Whether you want to present to management, 
customers, or colleagues, you want to hold their 
attention and get your message across. Microsoft 
PowerPoint92 and Google Slides93 are the two most 
popular presentation software applications today 
and can help you quickly put together slides that 
look professional and convey information. Prezi94 
is another popular presentation application, with 
some unique presentation formats. A slide is a 
single page of a presentation. Presentations are 
also sometimes called slide decks because a stack 
of printed slides looks like a deck of large cards, 
and the action of going through the slides in a 
presentation is like going through cards in a deck. In 
a typical presentation, one or more adjacent slides 
convey one point to the audience. You can embed 
summarized information from your analysis into 
slides, including images, graphs, and charts. As you 
move from one slide to the next while presenting 
to an audience, you tell a story that explains what’s 
on the slides. Slides transition seamlessly from one to the next, and you can make content pop up on 
the screen to highlight important bits.95

A slide presentation.

 

A standard presentation slide template that can be 
customized to your needs.

92	 PowerPoint home page, https://www.microsoft.com/en-us/microsoft-365/powerpoint 
(accessed June 2023).

93	 Google Slides home page, https://www.google.com/slides/about/ (accessed June 2023).
94	 Prezi home page, https://prezi.com/ (accessed June 2023).
95	 For a humorous take on common presentation mistakes, check out https://www.youtube.com/

watch?v=MjcO2ExtHso (accessed June 2023).

https://www.microsoft.com/en-us/microsoft-365/powerpoint
https://www.google.com/slides/about/
https://prezi.com/
https://www.youtube.com/watch?v=MjcO2ExtHso
https://www.youtube.com/watch?v=MjcO2ExtHso
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One great feature of PowerPoint is its ability to serve as an outline of ideas. When working on a complex 
document for the first time, you can begin by organizing ideas in a presentation. The presentation 
can then be saved in outline format (rtf ), which can be opened in a word processor. Next, content can 
be populated within each outlined section and you can be assured that the ideas will flow smoothly 
since they have already been organized in a logical sequence.

Modern presentation software creates beautiful slides by default. However, when presenters do not 
make the effort to deliver an engaging presentation, it can get monotonous and tedious for the 
audience. In business, this is seen as being subjected to a form of torture, particularly when successive 
speakers deliver weak presentations. “Death by PowerPoint” is a colloquial term used to criticize 
presentations that are so poorly planned or executed that they fail to effectively communicate their 
ideas to the audience.96

PowerPoint Origins

Robert Gaskins and Dennis Austin created PowerPoint for Apple computers in 
1987.97 Microsoft bought their company within months of the software’s release. 
Robert Gaskins maintains an excellent website describing PowerPoint’s origin 
story,98 with several original design documents. Some documents are great 
reads, including the first two-page concept proposal,99 and a more detailed 
description.100

Email
Messages distributed electronically from one 
computer user to one or more recipients and stored 
on a central server are called electronic mail, or email 
for short. Email was introduced in the 1970s and 
soon became popular in universities and businesses. 
Until email became widely available, documents 
were saved in paper form and stored in locked 
cabinets.  Most large offices had systems like this. 
To find a document and get it approved by others, 
you had to go to the cabinet room, locate the file 
in the correct cabinet, and walk with the file to the 

A physical filing repository.

96	 This definition comes from chatGPT, https://chat.openai.com/chat (accessed June 2023).
97	 “Microsoft PowerPoint,” https://en.wikipedia.org/wiki/Microsoft_PowerPoint (accessed June 

2023).
98	 Robert Gaskins Home Page, https://www.robertgaskins.com/ (accessed June 2023).
99	 Robert Gaskins, “Sample Product Proposal,” https://www.robertgaskins.com/powerpoint-

history/documents/gaskins-powerpoint-original-proposal-1984-aug-14.pdf (accessed June 
2023).

100	 Robert Gaskins, “Presenter,” https://www.robertgaskins.com/powerpoint-history/documents/
gaskins-powerpoint-summary-and-review-1986-jul-15.pdf (accessed June 2023).

https://chat.openai.com/chat
https://en.wikipedia.org/wiki/Microsoft_PowerPoint
https://www.robertgaskins.com/
https://www.robertgaskins.com/powerpoint-history/documents/gaskins-powerpoint-original-proposal-1984-aug-14.pdf
https://www.robertgaskins.com/powerpoint-history/documents/gaskins-powerpoint-original-proposal-1984-aug-14.pdf
https://www.robertgaskins.com/powerpoint-history/documents/gaskins-powerpoint-summary-and-review-1986-jul-15.pdf
https://www.robertgaskins.com/powerpoint-history/documents/gaskins-powerpoint-summary-and-review-1986-jul-15.pdf
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approvers to get them to sign on it. Email and related technologies have greatly simplified this process 
now. In fact, it is often said that most forms now reside in users’ emails.

Email enables you to put a message together easily, attach a file or two along with the message for 
review or approval, and send the message to as many people as you like with the click of a button. The 
people who receive your email can make changes to the document, if it is not read-only, and send the 
document back to you as an attachment. In a matter of minutes, you can get your document approved 
even if your approvers are thousands of miles away. Email helps you disseminate information in an 
instant, magically overcome the limitations of the physical workspace, and allows us to work as a 
worldwide team.

Good email etiquette is simple to learn and a very useful skill to develop. There are several articles 
online101 and most of them share similar ideas about email etiquette.102 Most people will form their 
first impression of you from your introductory email. Being polite, using correct spelling and grammar, 
using a pithy subject line, and staying brief are all likely to help people form the best impression 
about you and make it more likely that they will take your requests seriously.

Microsoft’s Outlook and Google’s Gmail are two popular email services.

Email as the Internet’s Killer App

We introduced spreadsheets as the killer app for personal computers. Email 
has proven to be the killer app for the Internet.103 Email services are generally 
free for personal users and relatively inexpensive for business users. However, 
most users buy computers primarily to communicate using email. Though a lot 
of personal information exchange has moved to instant messaging in recent 
years, email continues to be the preferred mode of communication outside 
close family and social circles.

Calendar
Calendars are charts that show how your time is organized by hours, days, weeks, and larger units such 
as months and years. Digital calendars leverage the capabilities of computers to simplify managing 
your time and collaborating with people (Figure 56). If you want to meet friends for a movie, you 
typically reach out to them and ask them if they are free to meet on a particular evening at a particular 
location. This is an easy problem to solve if there are just a few people involved and there is no rush 
or urgency to the task. Now imagine trying to meet groups of coworkers several times a day and 
multiple days of the week to complete a critical project. Even if all your colleagues were right in front 
of you, it would take a bit of time to find a slot that might work for everyone. You could spend all your 

101	 A good example is David Fallarme, “How to Write an Effective Email,” https://blog.hubspot.com/
marketing/email-writing-for-international-teams (accessed June 2023).

102	 Jeff Su, “How to Write Better Emails at Work,” https://hbr.org/2021/08/how-to-write-better-
emails-at-work (accessed June 2023).

103	 A nice article describing this phenomenon is Chris Preimesberger, “30 Years Ago: How Email 
Rose to Become the No. 1 Killer App,” https://www.eweek.com/enterprise-apps/30-years-ago-
how-email-rose-to-become-the-no.-1-killer-app/ (accessed June 2023).

https://blog.hubspot.com/marketing/email-writing-for-international-teams
https://blog.hubspot.com/marketing/email-writing-for-international-teams
https://hbr.org/2021/08/how-to-write-better-emails-at-work
https://hbr.org/2021/08/how-to-write-better-emails-at-work
https://www.eweek.com/enterprise-apps/30-years-ago-how-email-rose-to-become-the-no.-1-killer-app/
https://www.eweek.com/enterprise-apps/30-years-ago-how-email-rose-to-become-the-no.-1-killer-app/
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time coordinating the meetings if you did not have calendaring software to solve the problem for 
you. 

FIGURE 56 — A user’s Outlook calendar showing free and busy periods.

Calendaring software helps you schedule meetings for specific times, create agendas for meetings, 
and add the people you want to include from your list of contacts or the organization’s directory. 
You can even book resources like rooms and projectors and clarify which attendees are required and 
which ones are optional. As the software allows you to check when your colleagues are busy with 
other meetings and when their calendar is free, folks are likely to accept your invitation if you find a 
good time when everyone is free.

After you send the meeting invitation, the software will let you see who has accepted or rejected 
the meeting invitation. The software also sends reminders of upcoming meetings, so people don’t 
accidentally miss meetings. 

Though the most popular calendars are Microsoft’s Outlook and Google’s Calendar, smartphones 
also have fully functional calendar applications natively built into the operating system. These are 
increasingly popular, particularly for personal use.

Web Conferencing
Web conferencing refers to any online interaction that approximates the information-sharing 
experience of an in-person meeting. The use of web conferencing was limited in business, until 
the Covid pandemic. As we emerge from the Covid pandemic, web conferencing is the hero of the 
moment, along with vaccines. Holed up in their homes, office workers were able to retain their jobs, 
take care of their families, and meet family and friends, all thanks to web conferencing tools. 
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Web conferencing has been around in some form 
since the introduction of webcams in the 1990s.104 
However, the covid pandemic and the resulting 
isolation forced everyone to become familiar with 
and rapidly adopt this technology. The major vendors 
in this technology—Zoom, Webex, BlueJeans, GoTo 
Meeting, Teams, and Google Hangouts—offer similar 
features including the ability to schedule meetings, 
invite others, launch meetings, and allow others to join 
using a URL. You can join the meeting on your phone 
or use your computer’s microphone and speakers. If 
you turn on your camera, you will be visible to other 
meeting participants and be able to have face-to-face 
conversations. Participants can share their screens and present information, just the way they would 
in a conference room.

A very useful feature added recently to popular web conferencing software is the ability to record 
meetings and share the recording with participants and those who may have missed the meeting. 
Recordings can also be used to go over discussions that were not clear when presented at the meeting.

In the post-Covid world, most calendaring software 
is also integrated with web conferencing software 
such as Zoom and Teams to allow you to schedule 
meetings. In most offices, it has become business as 
usual (BAU) to “Schedule a Meeting” in calendaring 
software such as Outlook and add Zoom or Teams 
meeting details, including phone numbers, meeting 
times, and meeting participants. The software sends 
the meeting invite automatically, including a meeting 
link and the agenda of the meeting (Figure 57).

A web conference in progress.

FIGURE 57 — A typical meeting invitation in 
Calendar.

104	 For the origin story and its association to laziness, please see “The First Webcam Was Invented to 
Check Coffee Levels Without Getting Up,” https://petapixel.com/2013/04/03/the-first-webcam-
was-invented-to-check-coffee-levels-without-getting-up/ (accessed June 2023).

https://petapixel.com/2013/04/03/the-first-webcam-was-invented-to-check-coffee-levels-without-getting-up/
https://petapixel.com/2013/04/03/the-first-webcam-was-invented-to-check-coffee-levels-without-getting-up/
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As an invitee, you can choose to “Accept/Reject” any invitation. You could also mark the invitation 
“Tentative” if you are uncertain (Figure 58).

FIGURE 58 — Accepting/Rejecting a meeting invitation in Calendar.

Chat
Chat refers to real-time online communication. Online chat is very popular among family, friends, 
and social circles and has even gained popularity within business environments. If you use Facebook 
Messenger, WhatsApp, Snapchat, Signal, or Telegram to stay in touch with family and friends, then 
office chat apps will not be difficult to use. Chat capabilities are built into most web conferencing 
applications. Slack and Microsoft Teams are the two most popular office chat apps that organizations 
use to facilitate informal conversations between employees (Figure 59). A common feature of business 
chat apps is building channels of communication with select teammates on a topic or a common 
project. Through the channel, all team members interested in a topic or working on a project share 
files, screenshots, and messages.

As the chat history is preserved, you and your team members can search through the history to find 
something you discussed in the past or links you shared with each other. The generous use of emojis 
and gifs makes chat a fun way to stay in touch with your team. Not surprisingly, for many businesses, 
chat is increasingly popular, while email is increasingly used for more formal communications.

All popular chat apps now also offer mobile phone versions of their software, so you can seamlessly 
jump from your computer to your phone and continue the conversation.
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FIGURE 59 — Slack is a popular chat application.

Office 365 and Google Suite
In the next few chapters, we will look at each of the productivity applications in more detail. Most 
users typically pick one of the two sets of productivity applications—the Microsoft Office 365 Suite105 
or the Google Workspace Suite.106 Apple also has a comparable set of productivity applications (Pages 
for word processing, Numbers for spreadsheets, and Keynote for presentations). Each of these sets of 
productivity applications has comparable capabilities for most users. The individual applications (e.g., 
Word, Excel, PowerPoint) within a suite tightly integrate with each other, so users can copy and paste 
information seamlessly from one application to the other, preserving formatting and other details 
for ease of use. Often, the choice of office suite is made by the organization based on several factors 
including pricing, features, etc.

Bundling

The distribution of productivity applications as a set of separate but tightly integrated applications is 
called bundling. Applications within a bundle typically have similar user interfaces and mouse actions, 
making it easy for users to transfer what they have learned from one application in the bundle to 
another. Vendors offer strong discounts to customers who buy office suites as a bundle because it 

105	 Microsoft Officer 354 home page, https://www.office.com/ (accessed June 2023).
106	 Google Workspace home page, https://workspace.google.com/ (accessed June 2023).

https://www.office.com/
https://workspace.google.com/
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reduces competition for their products. Once a user pays for a bundle, they are less likely to pay for 
another bundle or another individual application. This has, therefore, become a common practice in 
the industry.
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			   Chapter Terms and Definitions

Bundling: The distribution of productivity 
applications as a set of separate but tightly 
integrated applications

Digital Calendar: A calendar accessed through 
a computing device such as a PC or smartphone

Digital Document: A collection of text and 
images organized meaningfully using a digital 
medium 

Email: Messages distributed electronically from 
one computer user to one or more recipients and 
stored on a central server

Email Etiquette: The utilization of accepted 
standards and practices when communicating 
through email

Killer Application: A computer application that 
is so desirable that it drives purchases of a much 
more expensive technology

Online Chat: Real-time online communication 
using an interface designed to send and receive 
text 

Portable Document Format (PDF): A digital 
document format created for easy and reliable 
sharing of digital documents

Presentation: Digital documents that combine 
text, graphics, and media (audio and video) for 
display to an audience

Productivity Application: Software applications 
that help users create and process relevant 
information

Spreadsheet: A specialized digital document in 
which data is arranged in rows and columns for 
use in business calculations

Web Conference: A meeting facilitated by 
productivity applications that provide video 
collaboration

Word Processor: Software application designed 
to aid the user in creating digital documents 
focused on language and formatting
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		  	 Chapter Case

A Teacher’s Work is Never Done
Teachers must manage a wide variety of tasks during their daily work lives to stay 
productive at school. They are responsible for many different activities to ensure 
students from various backgrounds and levels of literacy are educated in a safe 
and productive environment. Teachers are very busy people and work hard to help 
students succeed. Here is a list of some of the daily work activities your teachers are 
responsible for: 

·	 Develop, assign, and grade instructional content such as homework and 
tests.

·	 Supervise students in the classroom to ensure they are learning in a safe 
and productive environment.

·	 Organize the supplies and resources necessary for class lectures and 
presentations.

·	 Plan educational activities and events.

·	 Ensure a clean and orderly classroom. 

·	 Prepare and distribute progress reports and report cards.

·	 Schedule parent-teacher meetings.

A teacher’s work is never done….

Question 1:	 Take a close look at the list of daily work activities your teachers are 
responsible for. List three types of applications that will help your 
teachers be more productive. Explain why each application will help 
your teachers be more productive with their daily work activities. 

Question 2:	 If you were a school teacher, what type of work activity do you think 
would be the most difficult? Now, describe how and what type of 
application could help you improve the productivity of that difficult 
task. 
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Lesson From MS Word: Either “Be Bold” OR “Be Italic.” Because the world doesn’t 
notice the “Regular ones”!!!

—Akhil Tiwari, software engineer

Overview
A word processing application is a software program that lets you create new digital documents and 
open and update existing digital documents. Google Docs and Microsoft Word (part of Office 365) 
are the most popular word processors. If the document was created by Microsoft Word, it will have 
an extension of either .doc (older versions) or .docx (newer versions). Since Word documents are so 
ubiquitous, most productivity applications are able to open documents created in Word. You can 
also change document formats, for example, by uploading a Word document to Google Docs and 
downloading a Google Docs file as a .docx document.

When you think of a document with information on it, you generally imagine long lines of text, 
separated by paragraphs. Any simple text editor, like Notepad, could create that. However, there are 
times you want your document to be attractive with colors, line spacing, special fonts, hyperlinks, 
and references. For business documents, you may like to have the document reviewed by your peers 
before you send it out. You may want to do a spell check, fix awkward grammatical errors, and improve 
the vocabulary in the document. If your colleagues review and make changes to your document, you 
want to track the changes and comments and be able to compare different versions to make the 
collaborative work more manageable. 

If you are building a pamphlet for your garage sale on paper, you may have to spend a lot of time 
drawing lines, creating images, adding captions, and highlighting and underlining text. However, if 
you have a word processor, you might be able to use a preexisting template, saving a ton of time and 
energy while also creating a more attention-grabbing pamphlet. Templates can also help you to not 
miss any of the important elements such as the time and place of the sale. 

If the document is especially long, say you are writing a novel or a thesis using a word processor, 
you can number your pages, add header and footer information, and have chapter headings. An 
automatically created table of contents at the beginning of the document will enable readers to jump 
easily between chapters. When you are ready to print your document, you might want to adjust the 
layout, orientation, and margin size. The print-preview feature of your word processor will allow you 
to see how the printed sheets will look before you begin printing, hopefully saving printer ink and 
paper. 

The two most popular word processing software applications in the market are Word from Microsoft 
and Docs from Google. Microsoft Word, a paid software program, is found in most offices. On the 
other hand, Google Docs is free and browser-based. If you have Gmail, you already have access to 
Google Docs.

In this chapter, we will introduce you to the core capabilities of word processors. We encourage you 
to explore these and other more sophisticated capabilities of word processors as you complete your 
school and college assignments.
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Getting Started
To use Word, you can either launch the word 
processing software first and then open a 
document. Or you could double-click on 
an existing document with a .doc or .docx 
extension. The operating system will use 
its file associations to open Word and the 
document within the software application’s 
window. To launch Word, you can click on 
the Microsoft Start button, then type “Word” 
in the search box. This should bring up the 
icon with the Word application logo. If you 
select the icon, the Word application opens. 
This is the standard procedure to open any 
application.

Typing the URL https://docs.google.com in the location bar of your browser will bring up all your 
Google documents (Figure 60). Alternatively, go to Gmail, then click on the dots next to your name in 
the top right corner to see all the apps, including Docs.

Windows users can search for the Word application by 
typing “Word” in the search box.

FIGURE 60 — Recent Google documents.

Most Word processing applications offer preformatted templates for common documents such as 
invitations, resumes, certificates, and brochures. Using these can save a lot of time. So, before you 
start a new document, make sure to check out all the existing templates and save yourself the effort 
of formatting a blank document all by yourself. (Figure 61)

https://docs.google.com
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FIGURE 61 — A wide variety of preformatted templates are offered in both Google Docs (top) and Microsoft Word 
(bottom).

Essential File Operations
A few essential operations are common to all productivity applications. These involve saving the data 
you have worked on while using the application and exchanging the data with other users. Printing 
is another common operation as some readers may want printouts (also called hard copies) of your 
documents to read at leisure. We begin by introducing these operations.

Save

When you begin working on a digital document, it is useful to first save the file in a suitable location 
with a useful name. Once you do that, both Microsoft Word and Google Docs can integrate with their 
cloud services (OneDrive and Google Docs) and automatically save (Auto Save) documents as you 
work on them. So, if you did a bunch of work and closed your laptop without saving your document, 
your unsaved work will still be safe. If you save your work to a cloud service folder, the document 
is typically saved to the cloud to to avoid using local space. You can mark the file to also be saved 
locally, which is useful if you plan to work on your documents even when you are not connected to 
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the Internet (for example, on a flight or at a camp). The latest version of the document will then get 
uploaded to the cloud once you connect to the Internet.

As old-time users of productivity applications, who have lost a considerable amount of work from 
power outages and other computer mishaps, the authors of this book reflexively use the “Ctrl+S” 
keyboard shortcut after almost every sentence to save their document, not relying on any automated 
saving features.

Print

Quite often, we need to make physical copies of documents. We may want to distribute documents as 
flyers, share them with friends, or simply wish to highlight, annotate, and take notes on them. Word 
processing software offers integrated print functionality. When you choose to print the document, 
you will get the print options based on the printer connected to your computer. 

The standard print dialog gives you options to choose how many pages to print, which pages to print, 
and how many copies to make. You can select the paper size, margins, and whether to have single- or 
double-sided output. The print dialog also typically gives you a preview of the final output so you 
can confirm that the document looks exactly as you expect before you begin the printout. (Figure 62)

FIGURE 62 — Google Doc users can select from a range of options when printing.

Export

Productivity software, including word processing software, also gives you the ability to export your 
files to other useful formats. Portable Document Format (PDF) is a popular and free document format 
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maintained by International Organization 
for Standardization (ISO). When you save 
your Word or Google Doc in this format, 
it becomes a Read-Only version of your 
document that can be shared with others. 
Other popular output formats include 
webpages (.html) and plain text (.txt). The 
.html export option allows you to use word 
processors to save brochures and similar 
projects as webpages.

Google Docs also allows you to download 
your document as a .docx (Microsoft Word 
compatible) file, .pdf (Adobe Acrobat 
compatible) file, or as a .html (a webpage). 
You can even download your document 
as an Electronic Book (.epub) that can be 
opened by electronic book readers like 
Kindle or Nook. (Figure 63)

These basic file operations allow you to 
create digital documents and save and distribute them. We now introduce some basic features of 
word processors that are designed to make it easy for you to create content.

FIGURE 63 — Google Docs allows users to download 
multiple file formats increasing the compatibility of files 
when sharing.

Creating Content
Have you tried to read a document that has nothing but plain printed text, page after page? Reading 
such a document can be a tortuous task! Even when you go to buy a car, sign papers for a home 
mortgage, or apply for a student loan, the sheer amount of text on paper can be intimidating. Word 
processors offer numerous capabilities 
to create content that is easy to read. We 
introduce these capabilities in this chapter, 
starting with the ability to affect individual 
characters, and ending with the ability to 
affect the entire document.

Fonts

Fonts refer to text of a particular shape, style, 
and size (Figure 64). For example, the style 
of the famous Coca-Cola logo comes from a 
font called the Spencerian font. This font was 
created in 1840 by Platt Rogers Spencer and 
was the standard writing style in American 
business until the typewriter replaced hand-

FIGURE 64 — Google Doc users can select from a wide 
range of fonts depending on the type of document they 
are creating. 
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written documents for business writing.107 Perhaps due to the popularity of the font at the time of 
the company’s founding, the early Ford logo also used the Spencerian font. Using the right font can 
improve readability and also convey emotions. For example, Apple created a custom font for use in 
its Apple Watch to improve the readability of text on small screens.108

When choosing a font, knowing the basic categories is useful. This will help you decide which font 
is best for your document.109 You can combine fonts to make your information stand out. Default 
choices in most word processors will serve you well.110

Serif Fonts

Serifs are small decorative tapers added to the beginning and end of letters. Serif comes from the 
Dutch word “shreef,” which refers to a line or stroke of a pen.111 Letters in serif fonts include serifs 
in their style. Since serifs take effort to create if written by hand, serif fonts appear formal and are 
perceived to indicate maturity and authority. 
Serif fonts are popular for print publications 
of magazines and novels.112 It is considered 
accepted wisdom that serif fonts are easier 
to read on paper since the serifs guide the 
eye as it navigates blocks of text. Look at the 
letter T closely in different serif fonts (Times 
New Roman, Georgia, and Courier) to see 
the serif embellishments.

This text is in Times New Roman 

This text is in Georgia

This text is in Courier

Popular serif fonts.

Sans-Serif Fonts

Sans is French for “without.” Sans-serif 
fonts are fonts that don’t have serif 
embellishments. Sans-serif fonts are 
considered more modern and are often used 
in digital publications. The default font for 

This text is in Arial

This text is in Calibri

This text is in Verdana

Popular sans-serif fonts.

107	 “Spencerian script,” https://en.wikipedia.org/wiki/Spencerian_script (accessed June 2023).
108	 Alissa Walker, “Apple Debuted a Brand-New Custom Typeface With Its Watch,” https://gizmodo.

com/apple-debuted-a-brand-new-custom-typeface-with-the-appl-1632606916 (accessed 
June 2023).

109	 You can read more online, for example see, “The Fundamentals of Font Psychology,” 
https://99designs.com/blog/tips/font-psychology (accessed June 2023).

110	 An article with some recommendations is, “Best Practices of Combining Typefaces,” https://
www.smashingmagazine.com/2010/11/best-practices-of-combining-typefaces/ (accessed 
June 2023).

111	 “Font Readability Research: Key Differences Between Serif Vs Sans Serif Font,” https://geniusee.
com/single-blog/font-readability-research-famous-designers-vs-scientists (accessed June 
2023).

112	 For a few example fonts, please see “The Best Fonts for Magazine Design: Editorial, Crisp & 
Memorable,” https://creativemarket.com/blog/best-magazine-fonts (accessed June 2023).

https://en.wikipedia.org/wiki/Spencerian_script
https://gizmodo.com/apple-debuted-a-brand-new-custom-typeface-with-the-appl-1632606916
https://gizmodo.com/apple-debuted-a-brand-new-custom-typeface-with-the-appl-1632606916
https://99designs.com/blog/tips/font-psychology
https://www.smashingmagazine.com/2010/11/best-practices-of-combining-typefaces/
https://www.smashingmagazine.com/2010/11/best-practices-of-combining-typefaces/
https://geniusee.com/single-blog/font-readability-research-famous-designers-vs-scientists 
https://geniusee.com/single-blog/font-readability-research-famous-designers-vs-scientists 
https://creativemarket.com/blog/best-magazine-fonts
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Google Docs is Arial, a sans-serif style, as Docs, are typically used online. On the other hand, Microsoft 
defaulted until recently to Times New Roman, a serif font, probably because Microsoft evolved at a 
time when it was more common to print documents. In recent years, the default font in Microsoft 
Word has been Calibri, a sans-serif font.

Script Fonts

Script or cursive fonts mimic handwritten 
text. You will typically see them in invitations, 
such as a wedding invitation, an invitation 
to the opening of a golf course, or other 
documents intended to appear highly 
personalized.

The US Constitution was written by hand113 in 
a distinctive style. The cursive font capturing 
the style is called “Gouverneur Morris of 
Pennsylvania’s hand,” after Gouverneur 
Morris, who is considered the penman of the 
Constitution.114

Modern operating systems include many 
fonts by default. You can apply any available 
font to any written text by highlighting the 
text and selecting the font from the “Home” 
menu of most productivity applications. 
You can also add fonts to your computer 
by downloading them from online font 
libraries.115 Font files typically have the “.ttf” 
file extension, indicating a “true-type” font.116 
True-type fonts use technology that makes 
them look sharp at any size. These files can 
be dropped to the fonts panel in settings 
(Figure 65) to be added to the computer, so 
they are available to all applications.

You’re invited to a party — Segoe 
Script

You’re invited to a party — Lucinda 
Handwriting

You’re invited to a party — French Script

You’re invited to a party — Brush Script

Script fonts.

FIGURE 65 — Additional fonts can be added to the Windows 
operating system via font libraries.

113	 For some font analysis, please see https://www.dafont.com/we-the-people.font (accessed June 
2023).

114	 “Gouverneur Morris,” https://en.wikipedia.org/wiki/Gouverneur_Morris (accessed June 2023).
115	 Microsoft’s font library is at https://learn.microsoft.com/en-us/typography/. Google maintains a 

popular font library at https://fonts.google.com/ (accessed June 2023).
116	 True-type was a technology developed by Apple and licensed to Microsoft, https://en.wikipedia.

org/wiki/TrueType (accessed June 2023).

https://www.dafont.com/we-the-people.font
https://en.wikipedia.org/wiki/Gouverneur_Morris
https://learn.microsoft.com/en-us/typography/
https://fonts.google.com/
https://en.wikipedia.org/wiki/TrueType
https://en.wikipedia.org/wiki/TrueType
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Points and Pixels

Points were the unit of measurement for printing on paper. When computer 
displays became popular, measurement units needed to adapt to the limitations 
of screen resolutions. A unit of measure called pixel was developed that defined 
font sizes in terms of screen resolution. “Pixel” is an abbreviation for “picture 
element.” It is the smallest dimension that can be manipulated through software 
on the monitor. This means that if the monitor capabilities change, the actual 
size of a pixel on the screen will change.

To display fonts at the same size regardless of display or page size—for most 
word processing or printing—one pixel typically refers to a fixed size of 1/96 
inch. Since one point = 1/72 inch, a standard conversion between pixels and 
points is 12 points = 16 pixels.117

When using a font, you can fine-tune several 
properties including weight (bold or not), 
italics, as well as size. Font sizes are typically 
specified in points. 1 point is 1/72 inch. 
Most users find a font size of 11–12 points 
to be the most convenient to read. Figure 66 
shows the font panel in Word (you can reach 
it from “Home” → “Font”), showing several 
other variants including strikethrough and 
superscript. A general rule for font use is to 
select a readable font for the document and 
use bold, italics, colors, and other variations 
selectively to draw attention to the text. Too 
much variation becomes very confusing to 
the reader. 

FIGURE 66 — Within Microsoft Word’s “Font” panel, users 
can select and edit specific details regarding selected fonts.

Spacing

Spacing is the distance between lines and 
paragraphs of text. Appropriate spacing 
makes it easier for the reader to consume 
information. Less spacing makes the text 
difficult to read, but more spacing can 
waste paper or simply require unnecessary 
scrolling. The right spacing balances these 
conflicting needs. Spacing is a paragraph-level property. Figure 67 shows the spacing options in 
Google Docs and Word.

117	 A nice article explaining these units and their origins is Gordan Banjac, “Difference Between Pixel 
(Px) and Point (Pt) Font Sizes in Email Signatures,” https://blog.gimm.io/difference-between-
pixel-px-and-point-pt-font-sizes-in-email-signatures/ (accessed June 2023).

https://blog.gimm.io/difference-between-pixel-px-and-point-pt-font-sizes-in-email-signatures/
https://blog.gimm.io/difference-between-pixel-px-and-point-pt-font-sizes-in-email-signatures/
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FIGURE 67 — In Google Docs, you can find “Line & paragraph spacing” under the “Format” tab (top). In Word, users can 
edit spacing in the “Paragraph” submenu (bottom).
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To change spacing in Microsoft Word, select any text, then right-click, and choose the paragraph 
option. You will see a toolbox that has the option to adjust the spacing between lines and paragraphs. 

For readability, we recommend a spacing of at least 1 line (called single-space) and an additional 
spacing of 6 points between paragraphs, to distinguish paragraphs from each other.

Indentation and Alignment

Indentation and alignment are useful options to consider to improve readability, draw attention to 
content, and generally create a professional document. (Figure 68)

Indentation is the space between the margin and the beginning of the text. The most common 
indentation is called first line indent where the first line of the paragraph has additional space relative 
to the rest of the paragraph. For example, this paragraph has a first-line indent of 0.25”. First-line 
indents are considered indications of continuity and are typically used to indicate to the reader that 
the idea in the paragraph is related to the idea in the previous paragraph.118

Another common indentation is called hanging indent. The hanging indent is the inverse of a first-
line indent, whereby all lines except the first line are indented. For example, this paragraph has 
a hanging indent of 0.25”. Hanging indents are commonly used in references and allow the eye 
to easily skim through a list of references to quickly find articles by an author since the hanging 
indent offsets the author’s name from the rest of the text.119

You can also indent both the left and right sides of a paragraph. This can be a powerful 
visual cue, for example, to indicate that the text is reproduced verbatim from a source, 
or is a quote from a source, etc. This paragraph has an indention on both sides of .5”.

Alignment is the orientation of the edges of paragraphs. Text can be left-aligned (the left edge of 
the paragraph is flush with the left margin), right-aligned, centered, or justified (both the edges of 
paragraphs are flush with the respective margins as in this paragraph). Different languages have their 
own indentation and alignment rules. In Arabic, the text is aligned right, and in English, it is aligned 
left. 

118	 A good description is written by Louise Harnby, “When to indent text: Laying out narrative and 
dialogue in fiction,” https://www.louiseharnbyproofreader.com/blog/when-to-indent-text-
laying-out-narrative-and-dialogue-in-fiction (accessed June 2023).

119	 This article, “When Do You Indent a Paragraph?” has some recommendations from the style 
manuals, https://www.grammarly.com/blog/great-indentation-debate (accessed June 2023).

https://www.louiseharnbyproofreader.com/blog/when-to-indent-text-laying-out-narrative-and-dialogue-in-fiction
https://www.louiseharnbyproofreader.com/blog/when-to-indent-text-laying-out-narrative-and-dialogue-in-fiction
https://www.grammarly.com/blog/great-indentation-debate
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FIGURE 68 — In Google Docs, alignment and indentation options are located under the “Format” tab. 

Justified text looks neat in print; therefore, most newspapers use justified text. However, the justified 
text also creates additional spaces between words, which can hurt readability. Therefore, the left-
aligned text is often considered a good choice.120

Lists

You may need to create a list if you go shopping, want to jot down 
the names of invitees, or need to have the supplies for the chemistry 
lab handy in one place. Word processing software helps you quickly 
create bulleted or numbered lists with automatic renumbering in 
case you change your mind and want to remove or reorder items. 
Bulleted list items are not numbered and should be used if the 
items are not in any specific order. On the other hand, numbered 
lists work well if you want to jot down instructions that are in a 
sequence. For example, it will make sense to use a numbered list 
to write down the lab instructions for a chemical reaction. Each list 
item can have its own list, creating a list within a list, called nested 
lists. In most word processors, lists are accessible from the “Home” 
menu.

•	 Animals

o	 Cat

o	 Dog

o	 Horse

•	 Birds

o	 Eagle

o	 Sparrow

•	 Fish

o	 Shark

o	 Salmon

An example of a nested list.

120	 Justification is explained in, Aaron White, “Justify vs Align: Getting Started with Type Layout 
in InDesign,” https://www.shutterstock.com/blog/justify-vs-align-guide-to-type-alignment 
(accessed June 2023).

https://www.shutterstock.com/blog/justify-vs-align-guide-to-type-alignment
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Styles

Creating digital documents with a consistent 
look and feel requires selecting combinations 
of the parameters we have discussed so 
far—fonts, spacing, indents, alignment—
as well as several other parameters we 
have not discussed and which you will 
discover as you use word processors. The 
use of styles can really help you if, for 
instance, you would like one combination 
for text, another for headings, another for 
quotes, and another to emphasize certain 
sentences. Most users simply select words, 
sentences, or paragraphs and use the word 
processor interface to apply the appropriate 
fonts, spaces, etc. This works, but is a very 
inefficient way to create documents, and 
does not leverage a powerful feature of 
word processors—styles.

Styles are combinations of formatting 
features that can be applied to text to 
instantly change its appearance. By learning 
about styles and using them consistently, 
you will greatly improve your productivity 
in creating digital documents. For example, 
in creating this text, we defined a style 
we named “Body Text Keep,” which used 
Garamond font, size 12pt, single-spaced 
with 12pt space between paragraphs. By 
defining this style, we could simply apply 
the style to any paragraph to make it look 
identical to every other paragraph using this 
style. Later, we decided to use a different 
font for the text, so all we needed to do was change the font in the style definition and it was applied 
to the entire book.

Another advantage of styles is that they are hierarchical. For example, if we define a style for “Captions,” 
and the style is based on “Body Text Keep,” any changes to “Body Text Keep” will propagate to the 
“Caption” style. If we change the font of “Body Text Keep” from Garamond to Helvetica, the font for 
“Captions” will also change to Helvetica. This becomes a powerful feature for documents to remain 
consistent even with substantial changes to individual parameters.

We have used styles throughout this text, and it has greatly simplified our work.

Styles serve another meaningful purpose. There is a special class of styles called “Headings.” Word 
processors can build a table of contents easily from a document that has been correctly styled with 

In Word the “Apply Styles” menu allows users to define 
styles that can be quickly applied. In the “Modify” submenu, 
users can further define specific style details.
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headings. The software goes through the document to pull headings and subheadings that will show 
up as links in the table of contents. Figure 69 shows a list of styles defined in Google Docs.

FIGURE 69 — Google Docs provides users with preformatted paragraph styles.

Check out the comprehensive list of styles 
Microsoft offers in the “Styles Gallery” on the 
“Home” tab of Word (Figure 70).

FIGURE 70 — Word has many preformatted styles users can 
choose from, each with a specific purpose detailed under 
the style. 

Tables

Readers can grasp complex data far more 
easily if it is presented in a tabular form as 
opposed to plain text. Tables are also useful 
to highlight trends and sudden increases 
or decreases in values. Below is an example 
of a partial roster of players of high school 
football teams playing a game. The table 
elegantly captures the roles of each team 
member, which would be very difficult to 
capture in plain text.
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Role Coastside High Bayside High

Quarterback Alex Johnston Conan Morrison

Left tackle Angel Howard Daryl Gilliam

Left guard Arthur Smith Edmund Day

Center Ben Knight Harold Sloan

Quarterback Ryan Carter Jack Walker

All word processors make it easy to work with tables. You can format tables and add and remove 
columns in no time. They also give you the ability to create tables from predefined templates (e.g., 
Figure 71).

FIGURE 71 — Google Docs offers users table templates, allowing users to quickly create tables based on needs.

To format a table in Word or Google Docs, just right-click on the table to bring up a context-sensitive 
menu that lets you add/remove rows and columns and change the look and feel of the borders. 

Captions

A convenient feature that further improves the usefulness of tables and other objects inserted into 
documents is captions. A caption is a title or brief explanation that is added to tables, figures, and 
other objects. For example, “Figure 72 — Word processing applications allow users to format specific 
details of tables, increasing customizability.” is the caption to the next figure. Captions have three 
special features that make them very useful: 1) word processors add a sequence number to captions 
by default; 2) word processors add the caption style to captions by default to give them a distinctive 
appearance; 3) captions can be referenced later in the document. We show how to do this in the next 
section.
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FIGURE 72 — Word processing applications allow users to format specific details of tables, increasing customizability. 

To add a caption to a table or figure in Word, 
select “References” → “Insert Caption.” This 
brings up the dialog in Figure 73. You can 
select one of the existing labels or add a 
new label. Each label has its own series of 
sequence numbers.

FIGURE 73 — Users can add captions to tables and figures 
to help explain their work. 

References

A powerful, but very underused capability 
in word processors is to insert references to 
captions. When you insert a table or figure 
in a document, you almost always want to 
refer to it in the document. Most users type 
in the caption label and sequence number 
into the document. But this is fragile. If 
you add, remove, or modify captions, the 
sequence numbers will get updated and the references will be incorrect. Word processors offer a 
powerful and convenient way to leverage your computer’s capabilities to refer to captions correctly 
using the “insert references” feature.
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To insert a reference, select “Insert” → 
“Cross-reference” to bring up the dialog in 
Figure 74. In the reference type selector, 
select the caption, e.g., figure or table, and 
select the information to refer to in the 
“Insert Reference to” selector. Selecting 
“label and number” adds the right reference 
such as “figure 23” to the caption selected 
in the “For which caption” selector. Now, the 
word processor will ensure that the caption 
numbering is automatically updated even 
when you move captions around. 

FIGURE 74 — The “Cross-reference” menu allows users to 
add references to figures, tables, or paragraphs.

Insert Menu

Captions and references are examples of 
specialized information that can be inserted 
into documents. You can explore the 
different options in the “Insert” menu such as 
pictures (images), shapes (arrows, triangles), 
bookmarks, text boxes, fields, and symbols.

One interesting option in the insert menu 
is symbols (“Insert” → “Symbol” → “More 
symbols”). This brings up the dialog in 
Figure 75. You can insert almost any non-
alphabetic character into the document 
from this dialog. We have used this dialog a 
lot in this book, for symbols such as , ⌘, 
and →.

Keyboard Shortcuts

One very useful capability of word processors 
that greatly improves productivity is keyboard shortcuts. Keyboard shortcuts are key combinations 
that give immediate access to specific functions in a computer program. Here are some keyboard 
combinations we have used extensively in this book.

Alt+I+N+C	 Insert caption

Alt+I+N+R	 Insert reference

Alt+I+S		 Insert symbol

Ctrl+Alt+1/2/3	 Apply heading style 1/2/3

FIGURE 75 — Word allows users to add symbols to 
documents via the “Symbols” menu.
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Page Layout

We now introduce page-level features of word processors. The basic page-level property is the page 
layout. The page layout of digital documents is the arrangement of margins, content, and orientation 
of the page. As you create your document, it is useful to pay attention to how it will be consumed, so 
you can specify the layout for best readability. Is it a letter that you will print and mail out? If so, the 
layout should have a margin at the top to accommodate the organization’s logo and the dimensions 
of a standard letter-sized sheet of paper. Is it a pamphlet that you will distribute at the mall? If so, 
you might want the layout to support folding the page into three sections. Is it a documentation 
manual that will be printed and made into a spiral-bound book? If so, the layout should support a 
wide internal margin where the spiral binding will go. Or will it be your magnum opus debut novel 
that will be read by millions of fans? If so, the layout should reflect the trim size recommended by the 
publisher.121 Thankfully, word processing software makes it easy to specify the layout of the document 
and modify it as needed, so you can quickly get the outcome you desire.

Orientation

Page orientation is how the rectangular 
dimensions of the page are placed for 
normal viewing. Whether the page should 
be horizontally or vertically oriented is 
important to consider. There are two possible 
orientations—portrait and landscape. In 
portrait orientation, the height of the page 
is greater than the width. This nomenclature 
comes from the standard appearance of a 
portrait where the height is greater than the 
width to capture the face and upper body 
in the picture. On the other hand, a page 
with a landscape orientation has a greater 
width than height. This nomenclature also 
comes from the visual arts where landscape 
photographs are typically wider than they are tall.122 If you are making a coffee-table book with 
wonderful, wide photos, you may want to use the landscape format. Any word processing software 
will allow you to change the orientation of a document easily. 

Users can change a document’s orientation in Google Docs 
to suit the purpose. 

Other Page Layout Properties

Other than orientation, you should also consider the page size, margins, headers, footers, indentation, 
and spacing of your pages. If you want to print your pages on standard printer paper, you may want 
to choose 8.5 inches by 11 inches as your page size (if you are in the U.S.) or A4 in some other parts 
of the world. 

121	 “How to Choose a Trim Size: A Guide to Standard Book Sizes,” https://www.masterclass.com/
articles/a-guide-to-standard-book-sizes (accessed June 2023).

122	 “Page Orientation,” https://en.wikipedia.org/wiki/Page_orientation (accessed June 2023).

https://www.masterclass.com/articles/a-guide-to-standard-book-sizes
https://www.masterclass.com/articles/a-guide-to-standard-book-sizes
https://en.wikipedia.org/wiki/Page_orientation
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Headers and Footers

Headers and footers are informational text that is 
separated from the main content and appears at 
the top or bottom margins of a page. It is common 
to have headers and footers in long documents, 
like textbooks, novels, company quarterly reports, 
and product documentation. You may have noticed 
headers and footers as page numbers at the bottom 
of the page or as chapter titles at the top of the 
page. Headers and footers are typically unchanged 
throughout sections of a piece of work and help 
guide readers through large documents. Headers 
and footers are also commonly used to promote 
organizational branding by including the company 
name, author name, or company logo. Headers and 
footers not only give the document a professional 
and consistent look but also make it easy to identify 
and restore missing pages.

Headers and footers are accessible from the “Insert” 
menu in most word processors. Figure 76 shows the 
“Insert” menu in Google Docs showing the “Headers 
and Footers” option. 

As with all other word processing features that 
leverage the computer’s capabilities, headers and 
footers are updated as you update your document. 
For example, as you write, word processing software 
will automatically update page numbers when you 
add or remove pages.

FIGURE 76 — Header and footer editing options 
are available in all word processing applications.

Word processing applications allow users to 
integrate images in their documents to support text.

Image Editing

No doubt, images make your document more 
readable and convey information far more 
intuitively than words. If you are writing a school 
essay about your cute pet, Alma, it makes sense to 
include a picture of Alma along with a description 
of how she looks. Both Google Docs and Microsoft Word make it easy to insert photos, either from 
the web or from your computer’s hard drive (“Insert” → “Pictures” as in Figure 77). If you right-click 
the image, you will get a context menu that lets you format the image to adjust its border, colors, and 
transparency. You can crop the image to a size you like and adjust other properties like brightness, 
contrast, and aspect ratio (the ratio of its width to height). Experiment with these properties to 
develop a personal style you like. Once you insert images, they become part of your document and 
will be there on the printed pages.



Chapter 8—Word Processors 151

FIGURE 77 — Word processing application allow users to insert images from 
multiple sources including their PC, stock images, and online pictures. 

As we will discuss in Chapter 17 on ethics, if you insert pictures from the web, make sure to not use 
any copyrighted content without the owner’s permission. If you choose to create your own image, 
you can take advantage of drawing tools available in Docs and Word, including shapes, arrows, text 
boxes, flowcharts, and banners.

Shapes

To create your own drawing in Google Docs, go to the “Insert” tab and select “Drawing” and “New.” In 
Word, use “Insert” → “Shapes” (Figure 78). After you are done adding shapes and images to the new 
palette, the drawing gets inserted into your document the moment you save and close the palette. 
Both Google Docs and Word offer a wide range of shapes to let you create your own drawing.

FIGURE 78 — Word allows users to add shapes to documents, which can 
improve clarity. 
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Revision and Proofreading
Whether you are writing high school essays, emailing a colleague, or working on your thesis, your 
work will improve tremendously through revision. Your first draft is likely to contain spelling mistakes, 
grammatical errors, and poorly structured ideas and sentences. As you revise the document and have 
your colleagues review your work, it will get consistently better. For example, this textbook went 
through several rounds of revision as the authors and teachers revised the contents. Word processing 
software provides several powerful tools to help with the revision and proofreading process. We 
introduce some of the commonly used tools in this section.

Track Changes

Track changes is the ability of word processors to keep track of any changes to a document. Tracking 
changes allows you to share your updates with reviewers and view their comments and updates. 
Word processors clearly indicate any changes and make it easy for authors and reviewers to accept or 
reject the suggested changes.

In Word, under the “Review” tab, there is “Track Changes” that can be enabled by clicking on it (Figure 
79). Once track changes is on, Word will highlight any changes made to the document, so editors of 
the document can view, accept, or reject changes. When track changes is enabled, Word processors 
use different colors to highlight the text inserted by different authors. The keyboard shortcut to toggle 
track changes on or off is “Ctrl+Shift+E.”

FIGURE 79 — Word allows users to track their changes throughout their document. This is especially useful when 
collaborating with others. 
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When you are ready to accept/reject the changes made by your reviewers, you can see the comments 
and changes by selecting “All Markup” from the dropdown next to “Track Changes.” To see your original 
document, just select “Original.” You can also see the final clean document with all the changes made 
by your reviewers by selecting “No Markup.” When you have accepted or rejected the changes and no 
longer want to track changes, turn it off by clicking the “Track Change” button again.

Google Docs offers a slightly different 
mechanism to track changes. The “Editing” 
dropdown in the top right side of the ribbon 
has “Editing,” “Suggesting,” and “Viewing” 
modes. (Figure 80)

The “Viewing” mode is “Read-only,” so you 
cannot accidentally make changes. In the 
“Editing” mode, make sure to undo changes 
if you insert words you don’t want. The 
suggesting mode is analogous to track changes 
in Word. In the “Suggesting” mode, any text 
you type is highlighted in a green box and 
your suggestions show up in a comment box 
next to the document. You or any other editor 
of the document has the option to “Accept” or 
“Reject” the change. If you click “Accept,” the 
text will get inserted into the body of the document, and it will get removed if you click “Reject.”

Using track changes will greatly simplify your ability to work with friends on collaborative projects.

FIGURE 80 — Google Docs offers users three different 
editing modes, each with their unique rules and 
limitations. 

Comments

A comment is a remark or observation. Adding comments to a document is like scribbling notes 
on the side of a physical book. Word processors support comments to allow reviewers to comment 
on a document in a non-intrusive way. While comments in physical books are typically reminders 
you make to yourself about something you noticed on the page, comments in word processors are 
typically used by reviewers to exchange observations with each other to improve the document. 
Typical comments may include suggestions to add examples, simplify language, reduce length, etc.

To comment, just go to the spot where you want to add a comment and choose the “Comment” 
option under the “Insert” menu in both Word and Docs. Alternatively, you could highlight any text 
and right-click to comment (Figure 81). The keyboard shortcut to add a comment is “Ctrl+Alt+M.”
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FIGURE 81 — Word users can highlight text and insert comments making collaboration easier. 

Find and Replace

Find and replace is a pair of powerful features that lets you find and highlight all occurrences of 
a particular word or phrase. In Google Docs, you can launch these features by going to “Edit” and 
selecting “Find and Replace.” (Figure 82) You can replace words or phrases one at a time or all 
occurrences at once. This feature is useful when trying to avoid overusing the same word many times. 
For example, if you discover that you have misspelled a name, you can fix the spelling throughout 
your document with the click of a button. “Advanced Find & Replace” also allows you to find all forms 
of a word. So, if you look for “dance,” the software will highlight all occurrences of dance, danced, 
dances, and dancing. If you choose to match the case of a word you want to find, the tool will do a 
case-sensitive find. For example, if you look for “print,” it will ignore Print, PRINT, and prinT. 
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FIGURE 82 — The “Find and Replace” feature in Google Docs makes replacing words in documents quick and efficient. 

In Word, you have the search icon (a magnifying glass) on the top right-hand side of the “Home” 
ribbon. Once you click on the icon, you get an option to type the word/phrase you want to find. 
(Figure 83)

FIGURE 83 — The “Search” feature in Word allows users to quickly find key words in documents and highlights all 
occurrences of the key word.

Of course, the keyboard shortcut “Ctrl+F” works in almost every application to open the find dialog. 
In Word, “Ctrl+H” opens the find and replace dialog.
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Spelling and Grammar

As you become comfortable with word processors, you can begin focusing on using their more 
sophisticated capabilities to improve your writing and remove common errors. Spelling and grammar 
tools use AI techniques to catch spelling and grammar errors and suggest potential fixes. Both Google 
Docs and Microsoft Word provide comprehensive spelling and grammar checkers, inbuilt thesaurus, 
and word-count monitors. In Google Docs, select “Spelling and grammar” under the “Tools” tab. 
(Figure 84)

FIGURE 84 — The “Spelling and Grammar” feature in Google Docs allows users to review documents. 

Once you run the “Spelling and grammar” checker by selecting it, the system will pop a suggestion 
box with recommendations, and you have the option to “Ignore” or “Accept” recommendations. If you 
accept any suggestions, the changes are applied immediately.

Not surprisingly, word processing software has difficulty with names of people, places, and things. 
But you have the option to add new words to your “Dictionary” to ensure the software remembers 
the words as acceptable words (nouns) and ignores future occurrences of these spellings. (Figure 85)

    

FIGURE 85 — When using the “Spelling and Grammar” feature, users can choose to accept or ignore spelling 
recommendations. A user can also add new words to the dictionary.

By default, both Google Docs and Microsoft Word have the “Check for Grammar and Spelling” enabled. 
As you type, the software constantly scans and highlights mistakes, allowing you to fix spelling and 
grammar on the fly.
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Thesaurus

A thesaurus is a useful tool when revising an essay 
or any creative work. Repeating words makes 
your work look immature and monotonous, so 
it is useful to avoid repeating words unless you 
are doing it deliberately for stylistic reasons. You 
can take advantage of the in-built thesaurus in 
Google Docs and Word to add variety and color. 
In Google Docs, highlight any word and select 
“Tools” → “Dictionary” to find the meaning and 
synonyms. Results appear as shown in Figure 86.

In Microsoft Word, you can achieve the same 
effect by selecting a word and then choosing 
the “Thesaurus” option under the “Review” tab 
(Figure 87).

These tools to check spelling, grammar, and 
find-and-replace words are tremendously useful 
to polish up your work, remove redundancy, 
and make the text more enjoyable for readers.

FIGURE 86 — The dictionary in Google Docs can be 
found under the “Tools” tab and will show the results of 
your chosen word making it easy to reference. 

FIGURE 87 — Similar to the Dictionary in Google Docs, 
the Thesaurus in Word allows users to find definitions 
of words. 

References
Most documents are created to convey an 
idea to the reader. In addition to appearance 
and general readability, references to prior 
work can further enhance the credibility of the 
information presented. References also help 
readers locate related information to learn more 
about the topic if needed. Now we introduce the 
essential capabilities of word processors to help 
you enhance your documents with references. 

Citations and Bibliography

A citation is a reference to a source of information. 
A bibliography is a list of information sources 
(books and articles) used in the document. 
For almost any writing, and particularly for 
books, theses, or other detailed documents, 
you will need to reference and build upon the 
work already done in the field. If you refer to 
research, news sites, or books that are accepted 
as reputable sources, the ethical thing to do is 
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add citations to prior work to give credit to 
the original creator of the content. This will 
also allow your readers to go deeper into 
that topic by reading the original source.

Both Google Docs and Microsoft Word 
provide ways to add citations in an industry-
standard format and to refer to them 
throughout your document. In Google 
Docs, you can start creating your collection 
of citations by launching “Citations” under 
the “Tools” tab. Once you select the style 
(MLA, APA, or Chicago), you can select 
“Source type” and “Accessed by” (how to 
access the source). You can give the ISBN of 
a printed book or the link to the online copy 
of the article. Once you have your library 
of citations, you can go to the place where 
you want to make a citation and insert 
the citation in your document. To create a 
bibliography at the end of your document, 
move your cursor to the end and insert all 
the cited works with a click. (Figure 88)

Microsoft Word also offers a similar 
framework to create citations under the 
“References” tab. The “Citations” tool here 
offers many styles and is feature rich and 
comprehensive. You can even cite films, 
interviews, patents, and articles presented 
at conferences. FIGURE 88 — In Google Docs, “Citations” can be found 

under the “Tools” tab. Your citations are organized in a 
library and gives users the option to insert a works cited 
section to the document. Hyperlinks

Hyperlinks are shortcuts in a document to 
other parts of the Internet. If you embed 
hyperlinks in your documents, any reader 
clicking on that link will go to the target 
location. For example, to put a hyperlink 
pointing to the University of South Florida, 
select any text, then right-click to bring 
up the context-sensitive menu, and select 
“Link” (Figure 89).

In Microsoft Word, a new screen opens 

FIGURE 89 — Word users can quickly embed links by right 
clicking words.
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(Figure 90). Once you enter the location address and click “Ok,” the selected text will get highlighted. 
Make sure the link works by clicking on the highlighted address. 

FIGURE 90 — Word users must enter a web address to embed it to the highlighted words.

If you take a printout of the document, the readers will see “University of South Florida” in blue but 
won’t really be able to see the underlying URL. If you want readers to see the web location, you 
may want to type the entire URL (https://www.usf.edu/) as part of the text of the document. Word 
processing software can recognize links and usually make them appear in blue font to indicate 
hyperlinks. When clicked, a new browser will open and take you to the address. 

Hyperlinks are not limited to external websites. They can also be set to go to different sections of 
the same document. One of the simplest ways to do so is to use heading styles. Word processors 
greatly simplify navigating to headings. For example, when you use Google Docs or Word, you can 
use formatting styles like Heading 1, Heading 2, Heading 3, and others for sections of interest. Now, 
you can use the “Place in this document” option as shown in the left menu of Figure 91 to bring up a 
list of headings in the document and link to any of these headings. This is particularly useful if your 
document is large and requires a lot of scrolling to get from one section to another. Links from one part 
of the document to another can simplify navigating the document. For example, if your document 
is about different car models, you can organize the information about each car in one place with a 
heading for each car. For example, you can use the Heading 1 style for the headings of Land Rover, 
Jaguar, Mercedes, and Audi. Now, wherever you wish to help readers navigate to information about a 
car, you can add a link to the car. For example, if you are writing the section on Audi and want to have 
a link to Jaguar so readers can look up competing models, simply right-click on the text, and choose 
“Insert Link” to bring up the dialog in Figure 91 (which is the same as the dialog in Figure 90).

https://www.usf.edu/
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FIGURE 91 — Users can also embed links to headings and different sections in their document. 

In the popup screen, choose “Place in This Document” and then select the “Jaguar” under headings. 
This will insert a link to “Jaguar.” If you “Ctrl-Click” the newly created link, you will go to the section that 
has information on Jaguar cars.

Bookmarks

Bookmarks are locations in your document that you want to identify for future reference. Bookmarks 
in digital documents serve the same purpose as physical bookmarks. They are an alternate mechanism 
to headings to refer to locations elsewhere in the document. An advantage is that they do not force 
you to adopt predefined heading styles.

Linking to another section of the same document is always a two-step process—first, identify the 
targets using heading styles or bookmarks, and next, link to the target from anywhere in the document. 
Using our previous example on cars, which used headings, if we wanted to use bookmarks, we could 
bookmark some cars, e.g., Fiat, Honda, Kia, and Toyota. Then to link to Toyota from somewhere in the 
section on Honda, select the text you wanted to be linked, then right-click, and choose “Link” to bring 
up the same popup screen as before. This time, choose “Place in This Document” and select “Toyota” 
under “Bookmarks” (Figure 92).

FIGURE 92 — Bookmarks allow Word users to link web addresses to different sections in the same document.
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Footnotes

A footnote is additional information found at the bottom of the page. Footnotes give you an easy way 
to share more information about a term or phrase used in the document without distracting readers 
from the flow of the document. For example, if you are using a term that may be unfamiliar to some 
readers, you can insert a footnote to add an explanation. If you insert a footnote using any popular 
word processing software, you will typically see a superscript next to the term that informs the reader 
to check the end of the page for more information. We have used footnotes extensively in this text to 
add context or to point readers to related articles online.

To insert a footnote in Google Docs, go to the “Insert” tab and choose the “Footnote” menu. That will 
insert a superscript next to the term and take you to the bottom of the page, where you can type your 
explanation. Footnotes are sequenced to guide the readers to the correct explanation, in case you 
have more than one footnote for a page.

If you are using Microsoft Word, you can insert a footnote by going to the “References” tab and 
selecting “Insert Footnote” (Figure 93). This adds the footnote as shown in Figure 94. One variant of 
footnotes is endnotes. Endnotes show up collectively at the end of the document, unlike footnotes 
that show up separately on each page.

FIGURE 93 —The “References” tab in Word allows users to insert footnotes in their documents. 

_____________________
1  An Artificial Intelligence based chat and search system accessible at https://openal.com/blog/chatgpt/

FIGURE 94 — Footnotes appear at the bottom of a page. 

Table of Contents

A table of contents is usually found in the beginning of a document 
and lists all the chapters and subsections and the page numbers 
where they are found. You must have seen these in every textbook, 
novel, or magazine you have read. The table of contents serves two 
purposes even in physical books. It not only lets the readers easily 
find the page number of a chapter so they can quickly go to it, but 
it also gives them a high-level overview of the book. 

When using a word processor, tables of content are “live.” You do 
not have to physically flip pages to go to the beginning of a chapter. 
You can simply “Ctrl-click” any heading in the table of contents to 
jump directly to that location. Word processing applications also 
allow you to build a table of contents easily. Their only requirement 
is that you use heading styles consistently in your document.

A table of contents allows readers 
to identify key sections of a 
document or book. 
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Once you mark all your chapter titles as headings, you can go to the beginning of your manuscript 
and insert a table of contents. In Google Docs, the process is as simple as going to the “Insert” tab 
and selecting the “Table of Contents” menu. In Word, you can find “Table of Contents” under the 
“References” tab. In both cases, you get several options for the look and feel, each with a different 
way of organizing your chapters and subheadings. Once you select the look and feel you want, the 
software automatically identifies all the headings and creates a table of contents, reflecting the 
heading hierarchy, complete with page numbers (Figure 95). 

FIGURE 95 — Word processing applications allow users to create tables of content by indexing headers and page 
numbers. 

As you add, move, and remove sections in your document, you can update the table of contents 
by right-clicking on the table and getting the context-sensitive menu. In Google Docs, choose the 
“Update table of contents” menu (Figure 96). In Word, you can select “Update Field” to see the popup 
screen with options to update the “Table of Contents.” Any time you update the table of contents 
(sometimes abbreviated as a TOC), it will refresh to show the latest chapter titles, subheadings, and 
page numbers of your manuscript. 
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FIGURE 96 — Word processing applications allow users to quickly update the table of contents.

Keyboard Shortcut to Update Fields and Tables of Content

One favorite keyboard shortcut of the authors is to easily update all fields and 
the table of contents. We first use “Ctrl+A” to select the entire document. Then 
use “F9” to update all fields including the table of contents.

Mail Merge
Mail merge is the ability of word processors to create identical documents personalized for each 
recipient, and to automatically email them to each recipient if needed. For example, a teacher may 
want to send the same letter to each student or their parents. A small business owner may want to mail 
holiday greetings and promotional letters to a thousand customers with their addresses printed on 
envelopes. Or, a teacher may like to use the same format to email individual grade letters to students. 
If you did the job manually, you would spend many hours writing letters and you would also need to 
be very careful to not make mistakes.
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The “Mail Merge” feature of word processing software makes the job easier and cleaner. It combines 
the formatting abilities of word processors with the organizing abilities of spreadsheets to give you a 
one-click method to create thousands of personalized letters or emails. You create the letter-template 
in Word (Figure 97 top) and the list of recipients in Excel (Figure 97 bottom). Then, follow a few easy 
steps under the “Mailings” tab in Word to connect the two and create the documents or emails. Here 
are the steps to use the mail merge feature in Microsoft Word. 

1)	 Write the letter you want to mail to everybody in a Word document.

FIGURE 97 — In Word, users must first create a template of the letter or email they wish to send (top). Then in Excel, a 
list of recipients must be created (bottom).

2)	 Prepare the list of people you want to mail. If you have a thousand business contacts, you 
should have an Excel sheet with a thousand rows of data. Just make sure to create a header 
row that describes the data in that column (First Name, Last Name, Company Name, Business 
Address, City, State, Zip Code, etc.). 
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FIGURE 98 — In Word, users should then choose to use an existing list of contacts. 

3)	 Go to the Word document that has your letter. Pick “Select Recipients” under the “Mailings” tab 
and choose the existing Excel file that has the recipients (Figure 98). You could also type a new 
list of people if you wanted. Now all the recipients of the letter are accessible in your Word 
document. Use “Insert Merge Field” to insert the name of your recipient and any other fields in 
appropriate places to personalize the letter (Figure 99). 

FIGURE 99 — Use the “Insert Merge Field” to set up the template. Any fields 
required to complete the letter can be inserted. 

4)	 Once you are done inserting fields into the Word document, you can use “Preview Results” to 
see the output. Clicking on “Preview Results” again will take you back to the original document.

5)	 You are now ready to go. When you are ready to print or email the documents, choose either 
“Print Documents” or “Send Email Messages” under “Finish & Merge.” The word processor will 
connect to your printer and print the documents, or connect to your email and send the emails. 
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			   Chapter Terms and Definitions

Find and Replace: A pair of powerful features 
that lets you find and highlight all occurrences of 
a particular word or phrase within a document

Font: Text characters of a particular shape, style, 
and size

Footer: A text region at the bottom of the page 
that is reserved for content such as the name of 
the document, chapter heading, or page number

Footnote: A small text reference that appears 
at the bottom of a page; it usually references 
specific content on a page and is labeled with a 
number

Header: A text region at the top of the page that 
is reserved for content such as the name of the 
document, chapter heading, or page number

Indentation: The space between the margin and 
the beginning of the text

Keyboard Shortcut: Key combinations that 
give immediate access to specific functions in a 
computer program

Mail Merge: The ability of word processors to 
create identical documents personalized for 
each recipient, and to automatically email them 
to each recipient if needed

Page Layout: The arrangement of margins, 
content, and orientation of the page in a digital 
document

Spelling and Grammar: This feature analyzes 
your document and gives suggestions for 
spelling, grammar, and stylistic issues

Styles: Styles are combinations of formatting 
features that can be applied to text to instantly 
change its appearance

Table of Contents: A list of chapters or another 
type of content sections included within a 
document; it typically appears near the beginning 
of a document and can be based on the headings 
listed throughout the document

Template: A document that has preconfigured 
styles and other content elements; these 
elements can include formatting, styles, text, and 
graphics for specialized purposes such as a job 
resume or business letter

Word Processor: An application program that 
can create, open, print, and update documents; 
the application contains text editing features that 
are designed to enhance text or other supported 
media within the document; examples include 
Microsoft Word and Google Docs
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		  	 Chapter Case

My First Resume
Matthew was finally old enough to get a job and make some money to save or buy 
the things he wanted. Finding a part-time job while he was still in school was a lot 
harder than he thought. He searched the Internet for job opportunities and asked 
all his friends where they worked. No matter where he searched or who he talked 
to, one thing was in common. Matthew needed to write a resume that he could 
hand to anyone who may want to hire him. It seemed like such a simple task, but 
Matthew wasn’t sure where to start. He needs some advice on how to create his 
first resume. 

Question 1:	 Locate the templates available for a word processing application 
that you have access to. Search the templates for a “Resume.” Review 
the “Resume” template of your choice. List and describe all the word 
processing features used in the “Resume” template.

Question 2:	 Use the “Resume” template in your word processor application to 
create your own resume. As you fill out the template, be sure to use 
the application to check your spelling and grammar. Verify the print 
layout of your resume. Save the resume and print a copy. After you 
complete your resume, write a short narrative describing what you 
would recommend Matthew do to create his first resume.
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Data visualization transforms data into powerful visualizations and provides 
tactical, operational, and strategic insights. No longer merely a spreadsheet, 
business intelligence visualizations can be used for everything from providing 
analysis of cybersecurity patterns, to managing workplace efficiency for global 
companies.

—Jason Beres, Sr. VP of Developer Tools at Infragistics

Overview
Spreadsheets are electronic documents that help users to manipulate data. While word processors 
and email are probably the most used productivity applications, much of the world’s business runs on 
spreadsheets. This is because spreadsheets are productivity applications designed to store numbers. 
Spreadsheets make it easy to visualize data and identify trends in that data. Any teacher tracking 
student grades will find it easiest to do so using spreadsheets. Student clubs will find it easiest to track 
contributions and expenses if they use spreadsheets. You may not use spreadsheets every day of your 
life, but your most valuable information is likely to be stored on spreadsheets.

For precisely this reason, spreadsheets were the killer app for computers in business. Just as email 
encouraged consumers to buy computers and get Internet connectivity, spreadsheets made it 
worthwhile for businesses to buy computers to track how they were doing. Steve Jobs credits the first 
spreadsheet program, VisiCalc, as being the driver for early Apple sales.

Dan Bricklin came up with the idea of a visual calculator in 1978 while doing his MBA at Harvard.123 
He initially visualized the user interface of spreadsheets as the cockpit display in aircraft but settled 
on the current row-column format to enable human-friendly names to be applied to data elements. 
Dan first called his program “Calcu-ledger” but eventually changed it to VisiCalc for Visual Calculator. 
Dan’s business partner, Dan Fylstra, also an MBA from Harvard, and one of the earliest software 
publishers, demonstrated the VisiCalc program to Steve Jobs.124 Almost a million copies of VisiCalc 
were sold at about $100 each, driving sales for Apple, as well as the adoption of computers in business. 
Subsequently, Mitch Kapor and Jonathan Sachs created Lotus 1-2-3,125 which was bought by IBM, and 
Microsoft came out with Excel. VisiCalc eventually lost its lead in the market.

Of all the applications and technologies discussed in this book, the ability to use spreadsheets 
productively is perhaps the most marketable skill. No one will hire you strictly because you can 
write emails or documents. But there is a good chance your expertise in spreadsheets may make you 
extremely valuable for some organizations.

123	 See Dan’s website for his own detailed account of how he came up with the idea of a spreadsheet, 
http://www.bricklin.com/ and http://www.bricklin.com/history/saiidea.htm for the initial idea 
(accessed June 2023).

124	 Steve Jobs’ recollection of the story, “The History of Spreadsheets, from VisiCalc to Causal & 
beyond,” https://callmefred.com/the-history-of-spreadsheets/ (accessed June 2023).

125	 Computer History Museum profile of Mitch Kapor, creator of Lotus 1-2-3, https://computerhistory.
org/profile/mitchell-kapor/ (accessed June 2023).

http://www.bricklin.com/
http://www.bricklin.com/history/saiidea.htm
https://callmefred.com/the-history-of-spreadsheets/
https://computerhistory.org/profile/mitchell-kapor/
https://computerhistory.org/profile/mitchell-kapor/
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What is a Spreadsheet?
A spreadsheet is a computer program that represents information in rows and columns and makes 
it easy to perform calculations with the data.126 In a typical spreadsheet, each column represents a 
different category of data and each row represents a record. For example, a spreadsheet for a sports 
club membership would have one row per student, and one column each for data such as first name, 
last name, sport of preference, email address, phone number, etc.

Spreadsheets are further divided into cells, organized in rows and columns. Rows are numbered and 
columns are named by alphabets, so any unique cell is defined by its row number and column letter. 
For example, in Figure 100, the cell outlined in white is B6, which indicates column B and row 6. The 
column letter always comes first in a cell reference. 

FIGURE 100 — Spreadsheets allow users to organize data efficiently, making it a crucial aspect of businesses. 

Spreadsheets are the workhorses in business for a wide range of tasks, such as budgeting, financial 
forecasting, and data analysis. Spreadsheets include built-in formulas for all the data processing tasks 
common in business. For example, the formula PMT(0.05/12, 60, 3000) will calculate the monthly 
payment for a car costing $3,000 to be paid off in 5 years (60 months) at an annual interest rate of 5% 
(monthly interest rate of 5%/12).127

When working with data, spreadsheets have capabilities that make them far more powerful compared 
to tables in word processing documents. Whereas word processor tables require you to do manual 
calculations on cells of data, spreadsheets allow you to type in a formula to process data from other 
parts of the same spreadsheet or even other spreadsheets. An added advantage of spreadsheets is 
that the results of the formulas will change automatically if any of the input data changes.

Let’s check out a couple of example spreadsheets. Say you are a real estate investor renting out 
multiple properties. To help you focus on your customers and properties instead of your financials, you 
can create a spreadsheet and enter your rental income and maintenance expenses, using formulas 

126	 Spreadsheet definition, adapted from https://www.britannica.com/technology/spreadsheet 
(accessed June 2023).

127	 The payment will be $56.61 per month, for a total payment of $3,396.82. In other words, the 
spreadsheet calculation shows that the buyer will pay almost $400 in interest as the cost of the 
car loan.

https://www.britannica.com/technology/spreadsheet
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to have the spreadsheet automatically calculate the profit/loss from each property as well as the 
overall profit/loss of your company. The spreadsheet will also easily highlight any unusual expenses 
or revenues (Figure 101).

FIGURE 101 — Spreadsheets can benefit a wide range of industries and be customized depending on user needs. 

As another common example, say you are a stock market investor. You can track your portfolios 
by entering the names of companies in your portfolio, the number of shares in each company, the 
purchase price of each share, and today’s market price. Formulas in your spreadsheet can calculate 
your profile/loss for each group of shares, the total profit/loss, and the percent weight of each stock 
by purchase price and by the current market price. This can help you identify winners and losers 
in your portfolio and manage your investments accordingly. Figure 102 shows an example adapted 
from a popular investment management spreadsheet (DR 179).128

FIGURE 102 — Users can track investments using spreadsheets.

128	 DR 179 refers to episode 179 of the Dough Roller podcast. The spreadsheet was introduced 
by the podcast host, Rob Berger, on his podcast in May 2015, https://www.doughroller.net/
podcast/ (accessed June 2023).

https://www.doughroller.net/podcast/
https://www.doughroller.net/podcast/
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In addition to convenient formulas, 
spreadsheets also offer a variety of 
visualization tools like charts and graphs 
that can be used to represent and analyze 
data in intuitive and user-friendly ways. 
Additionally, just like word processing 
software, spreadsheets also support 
collaboration and sharing to allow multiple 
users to work simultaneously on the same 
spreadsheet. Figure 103 shows the portfolio 
distribution (column J) of the spreadsheet 
in Figure 102 as a pie chart. Appropriate 
visualizations can help users get a sense of 
the data. FIGURE 103 — Users can visualize data in spreadsheets. 

Managing Spreadsheets

Managing spreadsheets is much like managing word processing documents. To create a new 
spreadsheet using Google Sheets, go to sheets.google.com and click on “Blank” to open a new sheet. 
To open an existing worksheet, you click on the sheet among your files. Once you have a spreadsheet 
open, you could also create a new one by using the “File” → “New” → “Spreadsheet” menu option. 
You can save any open worksheet the same way you save any electronic document, by clicking on the 
“File” menu and then selecting “Save.” If you would like to change the name of the spreadsheet while 
saving, give the saved spreadsheet the preferred name and choose where you want to save it in your 
Google Drive.

You can share the spreadsheet with colleagues by clicking on the “Share” button and entering the 
email addresses of your colleagues. This will allow your colleagues and friends to access and edit the 
spreadsheet from their own Google accounts.

Spreadsheets typically provide templates for common tasks like managing a monthly budget, a 
team roster, or weekly time sheets. These templates have a predefined look and feel and appropriate 
formulas. Generally, these templates are available from the “File” → “New” dialog as a “Template 
Gallery.” Figure 104 shows the user interface for Google Sheets (top) and Microsoft Excel (bottom).

http://sheets.google.com
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FIGURE 104 — Users can create blank sheets or select a preformatted template. 
(Google Sheets-top; Excel-bottom)

Menu Options

Both Excel and Google Sheets 
provide many menu options to 
simplify complex operations to 
organize and manage data and 
generate output. For example, 
Google Sheets has a standard 
toolbar to format cell contents, 
including font size, currency 
signs, indentation, and 
background color. The “File” 
menu in Google Sheets is used 
to perform file management 
operations, like creating new 
files or opening existing files 
(Figure 105). 

The “Edit” menu in Google 
Sheets is used to copy, paste, 
and find and replace. “View,” as 
the name suggests, is used to 
manage the visible content on 
the screen. “Insert” has options 
to insert rows, cells, columns, 
charts, pivot tables, images, 
and drawings in documents. A 

   

FIGURE 105 — The “File” tab (left) in Google Sheets has a wide variety of 
options and stores many commonly used ones. The “Insert” menu (right) in 
Google Sheets allows users to edit rows and columns.
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common use of the insert menu is to insert charts. If you go to the “Data” menu in Google Sheets, you 
can sort and filter data, set up data validation, cleanup, and perform other operations with the data 
in the spreadsheet. 

As in Google Sheets, Microsoft Excel is feature-rich, allowing you to manipulate data in complex ways 
(Figure 106). The “Insert” tab is also used in Excel to insert images, charts, rows, columns, shapes, and 
pivot tables. 

The “Formula” tab in Excel has many predefined formulas that you can use to perform mathematical, 
financial, and other calculations. You can use the features under the “Data” tab in Excel to import data, 
sort and filter data, remove duplicate values, and set up data validation rules. Under the “View” tab, 
you have options to change the grid layout and freeze different sections of the document. If your 
document has macros (programs to automate spreadsheet tasks), you can view your macros from the 
view menu, and also record new macros. 

FIGURE 106 — In Excel the “Insert” tab (top) displays many features for editing the spreadsheet and adding elements, 
while the “Formula” tab (bottom) helps users preform calculation.

Entering Cell Data

While word processing documents are 
freeform, spreadsheets are structured and 
divided into cells. Once you click on a cell, the 
text you type will stay within the boundaries 
of that cell. 

Spreadsheets are smart and do their best to 
understand what you are entering and give 
appropriate suggestions. One nifty feature 
that helps you copy data or generate a 
series is called autofill. Autofill is the ability 
of spreadsheets to extend a data series (e.g., 
numbers, dates, or text) to neighboring 
cells. Autofill is accessed from the autofill 
handle. If you click on a cell, you will see a 
tiny square box in the lower right corner. This 
is the autofill handle. If you put your mouse 
on the autofill handle, the mouse pointer 
will turn into a cross sign indicating that it is 
ready to autofill. You can drag the cross sign 
to autofill data in neighboring cells. 

The autofill handle in a highlighted cell is located in the 
bottom right corner.

Users can drag the autofill handle to other cells to populate 
data. 
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The autofill concept works across rows too. You can even autofill series across rows and columns at 
the same time (Figure 107). To create an initial series, just enter the first few numbers of the series, 
select the cells, then drag the autofill handle to extend the series. 

FIGURE 107 — Users can autofill multiple rows and columns at the same time by creating an initial copy. 

Autofill can also help you enter a series of 
dates (Figure 108).

Copy/Paste is another great way to enter 
data in spreadsheets. You can copy from any 
location on the web, another spreadsheet, 
or another section of the same spreadsheet 
and paste the data into your spreadsheet. 
When you paste data into a spreadsheet, the 
software will convert the data appropriately 
into cells and rows. If you copy data from 
another spreadsheet, just highlight the 
cells to copy and right-click to bring up the 
context-sensitive menu. You can then either 
cut or copy the selected data and paste it into 
the desired location in your spreadsheet. 

When you paste data in a spreadsheet, you 
have the option to paste just the data values 
or bring along the associated formulas, 
references, and formatting from the source 
spreadsheet. To take advantage of the 
various pasting options, right-click on your 
spreadsheet and choose “Paste Special” 
(Figure 109). 

If your data is in the CSV format, you can 
import it into spreadsheets by choosing 
the import option, generally accessed from 
“File” → “Import” (Figure 110). Excel offers 
a dedicated “From Text/CSV” button in the 
“Data” tab to import CSV. The spreadsheet 
software will let you select any existing data 
source and then walk you through a step-by-
step import process. Data import is useful 
when you collect data from different sources 

FIGURE 108 — Users must create an initial template with 
dates that the autofill feature will use (top). Then the user 
can highlight the cells and auto fill (bottom).

FIGURE 109 — In Google Sheets, users can access special 
pasting options depending on the formatting of the cell. 

FIGURE 110 — Users can import compatible file types into 
an existing spreadsheet. 
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to create your own unified spreadsheet. For example, to create a spreadsheet to plan club meetings, 
you may import club member names from your membership directory and import meeting locations 
from the county’s parks listing.

Row and Column Titles

Row and column titles, also known as labels, are the names/headers that appear at the beginning of 
each column/row in a spreadsheet. These labels are very useful and you should be deliberate about 
their values. Not only do labels make spreadsheets easy to understand, but they are also used to 
identify and describe the rows and columns of data in charts, tables, and other outputs. For example, 
in a spreadsheet containing sales data, the column titles might be different time periods, such as 
“Month,” “Year,” or “Region,” or categories, such as “Sales,” “Profit,” or “Cost.”

FIGURE 111 — When creating labels, users should be concise and clear to ensure 
values are properly represented and the spreadsheet is easy to understand. 

The table in Figure 111 shows Planned and Actual expenses and the column titles are Planned, Actual, 
and Diff. The items for which the cost is tracked, such as Food, Gifts, and Health/medical, are the row 
titles. Column titles are used in conjunction with row titles to provide a complete picture of the data 
in a spreadsheet. Titles can be especially useful when working with complex data sets to help readers 
make sense of the information.

Formatting Cells and Worksheets

To make data easy to comprehend, spreadsheet software provides extensive formatting options. As 
spreadsheets grow large, these formatting options become increasingly critical to understand the 
data. Figure 112 shows some data without formatting. Even though it is a very simple spreadsheet, it 
is difficult to understand what the data says without any formatting.
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Expenses Planned Actual Diff
Totals 0
Food 0 0 0
Gifts 0 0 0
Health/medical 0 0 0
Home 950 1000 -50
Transportation 0 0 0
Pets 0 0 0
Utilities 0 0 0
Travel 0 0 0
Debt 0 0 0
Other 0 0 0
Custom category 1 0 0 0
Custom category 2 0 0 0
Custom category 3 0 0 0

FIGURE 112 — While the data is understandable, 
formatting helps improve clarity and usability. 

  

FIGURE 113 — When data in a spreadsheet 
application is formatted, it becomes easy to identify 
the key features. 

Now let’s use some formatting options and update the same table by adjusting the font size, text 
color, background color, and header elements. You can also include currency symbols and comma 
separators and have the negative numbers show up in a different color. Suddenly, the same data set 
not only looks pretty but also becomes easier to digest (Figure 113).

To format cells in Google Sheets, 
select the cells you want to format 
and choose the “Format” menu 
option. If your cells have numbers, 
you can choose the “Number” option 
and select any one of the available 
formatting options for numeric, 
financial, and date values. You can 
also set the font size, alignment, and 
how data should wrap in a cell.

In Microsoft Excel, you can select the 
cells you want to format, right-click 
to open the context menu, and select 
the “Format Cells” menu option. A 
window opens where you can specify 
several formatting options including 
number display and the look and feel 
of the cells—alignment, font, border, 
or fill (Figure 114).

FIGURE 114 — Excel provides users with many options to format 
cells. 
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Styles

Just as in word processing software, 
styles in spreadsheets are a collection 
of predefined formats that give your 
document a consistent look and 
feel. If you want all your numbers 
to have a currency symbol, two 
decimal places of accuracy, and 
appear in red if negative, you could 
apply the formatting features one 
at a time, which might turn out to 
be cumbersome and error-prone. 
Alternatively, if you are using Excel, 
you could pick an existing “Cell/Table” 
style from the “Styles” group under 
the “Home” tab and apply the selected 
style to cells and tables (Figure 115). 

If the existing styles don’t meet your 
needs, you can create a new style by 
clicking on “New Cell Style” or “New 
Table Style” (Figure 116). Once you 
format the new style by opening the 
formatting window and selecting all 
the features you want, you can give 
the style a new name and reuse the 
style to format any cell or table in your 
sheet. 

If you like the formatting of a cell 
and want to copy it, click on that cell, 
then go to the styles dropdown and 
select “New Cell Style” (Figure 117). 
All the styling features of the cell are 
preselected for you. Just give the style 
a name and use it wherever you want 
unless it is copyrighted material.

FIGURE 115 — Excel offers a wide variety of cell styles. 

FIGURE 116 — Users can create their own cell styles.

FIGURE 117 — Excel allows users to copy formatting used in an 
existing spreadsheet.

Themes

Spreadsheets offer themes to let you 
have a consistent look and feel with 
respect to the choice of colors, fonts, 
cell borders, and background colors. 
Changing a spreadsheet’s theme will 
change the fonts, colors, and effects 
across the entire spreadsheet. In Excel, 
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the “Page Layout” tab has a themes menu with many 
predefined themes (Figure 118). Google Sheets has 
“Themes” under the “Format” menu with a range of 
themes and the ability to customize existing ones. 
As with other properties of spreadsheets, you can 
also change existing themes and create new ones. 

Merging and Splitting Cells

Merging cells allows you to combine multiple 
adjacent cells into one cell. This technique is 
particularly useful when creating a header row for 
a table in a spreadsheet (Figure 119). 

In the “Expenses Table,” even though all the rows 
have the same number of cells, the title row 
appears to be a single cell because several cells 
have been merged to create one cell for the title. 
To merge cells in a spreadsheet, you can select 
the cells that you want to merge and then use the 
“Merge Cells” command. This will combine the cells 
into a single cell and adjust the formatting of the 
merged cell to match the formatting of the first cell 
in the selection. In Google Sheets, you find “Merge 
cells” under the “Format” menu and Microsoft Excel 
has various options to merge and unmerge cells on 
the ribbon under the “Home” tab (Figure 120).

FIGURE 118 — Excel offers users a wide range of 
themes that can be quickly applied. 

Expenses Table

Totals
Planned Actual Diff

$1,000 $1,050 -$50
Food $350 $375 $25
Gifts $300 $300 $0
Health/Medical $350 $375 $25

FIGURE 119 — Headers can be created by merging 
cells.
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FIGURE 120 — In Google Sheets (top), the merge cell feature is in the format menu. In Excel (bottom), the merge cell 
feature is under the home tab.

Keep in mind though that you can’t merge cells 
that don’t form a proper rectangle, as in Figure 121.

If things change, you can use the “Split Cells” 
command to split a merged cell back into its 
original cells. This can be useful if you want to make 
changes to the individual cells within the merged 
cell. 

FIGURE 121 — These cells can’t be merged as they 
don’t form a rectangle or square. 

Hide and Unhide Columns and Rows

Spreadsheets can easily expand to fill many 
columns and rows. But your monitor typically only 
allows a few rows and columns to be visible at a 
time. Spreadsheets have an interesting capability 
to hide rows and columns to allow you to focus on 
the columns and rows of interest. To hide a column 
in Google Sheets, simply click on the column letter 
at the top of the spreadsheet and choose “Hide” 
(Figure 122). If you are using Excel, go to the “Cells” 
group under the “Home” tab and click “Format.” 
In the “Visibility” section, you will see “Hide” and FIGURE 122 — Users can hide columns to better 

manage large volumes of data.



182 Chapter 9—Introduction to Spreadsheets

“Unhide.” You can also click on the column 
or the row header to select a column or row, 
then right-click to bring the context menu 
and select “Hide” or “Unhide.” 

When columns or rows are hidden, you 
will see a break in the sequence of column 
headers or row numbers. In Figure 123, 
column G is missing. Clicking on the gap will 
unhide the column. In our experience, it is 
far more common to need to hide columns 
than to hide rows.

FIGURE 123 — Users can hide columns to better manage 
large volumes of data.Page Layout Options

Users often want to print out spreadsheets 
to present to managers or other decision-
makers. Spreadsheets allow you to format 
and preview the spreadsheet for printing. The 
page layout determines how a spreadsheet 
will look when printed. As a spreadsheet 
is a collection of cells organized into large 
numbers of rows and columns, printing it 
can be a challenge unless you set it up well. 
To solve the problem, spreadsheet software 
gives you page layout options that will allow 
you to have a presentable look when you 
print it on paper or view it as a PDF. There 
are many ways to get to the “Page Layout” 
option and many features to consider. In 
Excel, click on the “Page Layout” tab, then 
in the “Page Setup” group, click the “Dialog 
Box Launcher” in the bottom right corner to 
bring up the page setup dialog (Figure 124).

You can also make a few quick choices 
directly from the “Page Layout” menu 
options (Figure 125).

FIGURE 124 — In Excel users can change the page layout to 
make their data easier to print or export. Opening the “Print 
Titles” launcher (top) allows users to specify “Page Setup” 
requirements (bottom).

FIGURE 125 — Excel page layout options. 
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Here are a few things to consider to make your spreadsheet visually appealing.

Page orientation: Just like word processing software, spreadsheets can have either portrait 
(vertical) or landscape (horizontal) orientation. In Excel, the “Page Layout” tab has menu options 
to set the orientation. In Google Sheets, when you select “File” → “Print,” you see a “Print Preview” 
of the pages and have the option to adjust the paper size, orientation, headers and footers, grid 
visibility, alignment, and other properties.

Page size: You can specify whether you want to print/export your spreadsheet to PDF as a letter 
sized, A4 sized, or any of the other standard or customized paper sizes. 

Margins: You can adjust the size of the margins to have the look you want.

Headers and footers: You can add headers and footers to the top and bottom of each page. 
In Excel, go to the “Insert” tab and click on the “Header & Footer” menu to insert headers and 
footers. As mentioned earlier, in Google Sheets you can add headers and footers, page numbers, 
workbook tiles, and other information when you try to print the document. 

Page breaks: You can insert page breaks to control where the spreadsheet gets divided across 
multiple pages when it is printed/exported.

Gridlines: If you want, you can choose to display gridlines on the printed/exported version of 
the spreadsheet.

Scaling: You can adjust the scaling of the spreadsheet to fit it on a specified number of pages by 
making it a percentage of its original size.

Formulas and Functions

You can supercharge your spreadsheet by employing formulas and functions to calculate values using 
the data in cells. Formulas are simple. When you write a formula in a cell, you begin with the equals (=) 
sign and specify the cells to use for the calculation and what operations to perform on the data. For 
example, if you want to add the values in cells A1 and B1, you could type the following formula in any 
cell “=A1+B1.” The result will get displayed in the cell where you type the formula.

If you have a table with your daily expenses, you can use a formula to calculate the sum of all your 
expenses. The total cell in Figure 126 has the sum of expenses (=B13+B14+B15+B16). As you enter the 
formula and press “Enter,” you will get the total. As you change the data in cells, the calculations change 
automatically, which makes spreadsheets a 
very powerful tool. If you want to calculate 
the average daily expense over a month, 
you can add the daily total expense for a 
month and divide it by the number of days 
in the month. As soon as you enter a new 
set of values for the next month, you will 
immediately get the new daily average. 

Spreadsheets also have powerful functions 
ranging from simple functions like Sum, 
Average, Count, Max, and Min to complex 
engineering, statistical, math, and financial 

FIGURE 126 — Spreadsheet formulas allow users to quickly 
perform calculations with the help of visual aids. 
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functions. To use the sum function to 
add your expenses in Figure 126, just 
type =SUM(B13:B16). To access the “SUM” 
functions in Google Sheets, select a range 
of cells and click “Insert” → “Functions”→ 
“SUM.” In Excel, functions are located under 
the “Formulas” tab and are further organized 
by financial, logical, text, date & time, math 
& trig, and other menu options (Figure 127).

FIGURE 127 — Both Excel (top) and Google Sheets (bottom) 
offer a range of formulas to perform calculations. 

Charts and Images

Charts offer a graphical representation of 
data and can help analyze data in a more 
meaningful and visually appealing way. 
You might not see a pattern or discrepancy 
by staring at 1000s of numbers, but a chart 
can bring out anomalies to the forefront 
quickly. In the language of British journalist 
and author David MacCandless, charts 
allow you to use the language of the eyes 
(pictures) along with the language of the 
mind (numbers), greatly speeding up data 
comprehension.129

To create a chart, select the data that you 
want to include—a range of cells or a 
table—then use the charting tools in the 
spreadsheet software. In Google Sheets, 
you can use the “Insert” → “Charts” option 
to bring up an interactive tool that lets you 
pick the chart type you want (Figure 128). 
Bar charts, line charts, pie charts, and scatter 
plots are each suited for different types of 
data and can help you visualize information 
in different ways.

It is important to identify the chart type 
that will be most useful for a given task. 
For example, if you are trying to chart your 
school expense in Figure 128, let’s consider 
some options. 

FIGURE 128 — Navigate to the chart menu to select a chart 
type. 

129	 The beauty of data visualization, TED talk by David MacCandless in 2010, https://www.ted.com/
talks/david_mccandless_the_beauty_of_data_visualization. David also maintains a website 
with novel visualizations at https://informationisbeautiful.net/ (accessed June 2023).

https://www.ted.com/talks/david_mccandless_the_beauty_of_data_visualization
https://www.ted.com/talks/david_mccandless_the_beauty_of_data_visualization
https://informationisbeautiful.net/
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Expense data can be compared using bar charts.

   
Pie charts allow users to visualize percentages.

A line chart is a good choice for showing trends over time, and a scatter plot is good at showing the 
relationship between two variables. So, if you wanted to compare your expenses against an average 
student’s expenses, you may consider a scatter plot (Figure 129 and Figure 130).

  

FIGURE 129 — A table of expenses. 

   

FIGURE 130 — Scatter plots allow users to compare 
two or more sets of data. 

Once you create a chart, you can customize it by changing the appearance and layout of the chart 
and adding labels, titles, and data markers. 

Benefits of Charts

Charts can give users a quick visual summary of large volumes of data. A well-known example to 
demonstrate the utility of charts was published in 1973 by Yale statistician Francis Anscombe and is 
popular as Anscombe’s Quartet.130 The quartet consists of 4 sets of 11 numbers each, with very different 
distributions but almost identical statistical properties. While the differences are not readily apparent 
from the data, the differences are immediately apparent from a chart. The data and their charts are 
shown below. The mean and variance of y for each series are 7.5 and 4.125. The example is meant 
to show that though numerical data is considered precise, and charts are considered approximate, 
charts help with analysis and detecting the underlying phenomena.

130	 Anscombe, F. J. (1973). “Graphs in Statistical Analysis,” American Statistician. 27 (1): 17–21. See also 
the Wikipedia page on “Anscombe’s Quartet” at https://en.wikipedia.org/wiki/Anscombe%27s_
quartet (accessed June 2023).

https://en.wikipedia.org/wiki/Anscombe%27s_quartet
https://en.wikipedia.org/wiki/Anscombe%27s_quartet
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I II III IV
x y x y x y x y

10.0 8.04 10.0 9.14 10.0 7.46 8.0 6.58
8.0 6.95 8.0 8.14 8.0 6.77 8.0 5.76

13.0 7.58 13.0 8.74 13.0 12.74 8.0 7.71
9.0 8.81 9.0 8.77 9.0 7.11 8.0 8.84

11.0 8.33 11.0 9.26 11.0 7.81 8.0 8.47
14.0 9.96 14.0 8.10 14.0 8.84 8.0 7.04
6.0 7.24 6.0 6.13 6.0 6.08 8.0 5.25
4.0 4.26 4.0 3.10 4.0 5.39 19.0 12.50

12.0 10.84 12.0 9.13 12.0 8.15 8.0 5.56
7.0 4.82 7.0 7.26 7.0 6.42 8.0 7.91
5.0 5.68 5.0 4.74 5.0 5.73 8.0 6.89

Anscombe’s Quartet data series

The series is plotted in Figure 131. It becomes immediately clear that the series is describing different 
phenomena and that there are outliers in some data series that merit further investigation.

       

FIGURE 131 — Anscombe’s Quartet showing how graphs make differences in data patterns readily apparent.

Images

While charts are graphs created based on 
the data in your spreadsheet, images are 
pictures you can directly insert into your 
spreadsheet. In Google Sheets, you can click on 
any cell and then choose “Insert” → “Image.” 
If you choose to insert the image in a cell, 
then it is constrained by the dimensions of 
the cell. If you choose to insert it over cells, 
then the picture floats on top of cells and can 
be sized independently of the underlying 
cells. In Excel, you can go to the “Insert” tab and click on the pictures menu to insert pictures in your 
spreadsheet. Inserting images adds organizational branding to spreadsheets.

Google Sheets offer users the ability to insert images over 
cells or in cells.

Share and Collaborate

Just like word processing documents, you can share spreadsheets with others in your team, so more 
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than one person can view and edit the 
spreadsheet in real-time. In Google Sheets, 
you will see the “Share” button on the top 
right side of your screen.

Clicking “Share” will open a window 
where you can enter your team members’ 
email addresses and make them viewers, 
commenters, or editors.

As the names imply, editors can edit the 
content, commenters can add comments, 
and viewers can see the changes. 

If you use an online version of Excel 
(OneDrive, SharePoint, or Excel for the 
web), you can share it with teams, and the 
changes made by each member will be 
visible to others.

The Share button in Google Sheets allows users to send 
copies or collaborate on spreadsheets. You can specify 
the level of permissions shared users have regarding the 
document.Analyzing and Organizing 

Data

Division
Sub-
Division

Product 
Number

Number 
of Units

per 
unit

east 1 1111 140 $10
west 2 1111 21 $9
west 3 1111 18 $12
east 3 1111 16 $8
west 1 1111 11 $10
east 4 1111 11 $9
west 3 2222 16 $12
west 2 2222 15 $10
east 2 2222 15 $11
west 1 2222 12 $10
east 3 2222 12 $9
east 4 2222 12 $9
east 1 2222 10 $9
east 2 2222 9 $13

Filters

If you have a humongous spreadsheet, you may find it useful to look at a narrower set of data to 
focus your attention on one or two aspects of the data. By applying a filter, you can choose which 
rows are visible and which ones are hidden. 
Keep in mind, filtering doesn’t change the 
underlying data. Only the data set that 
matches the filtering criteria gets displayed. 
When you remove the filters, you will have 
the original spreadsheet with all the rows, 
just as before.

For example, you may have your company’s 
sales data for every Division, Sub-Division, 
and product (Figure 132). If you want to 
focus only on the data for your Division, 
Sub-Division, or product, setting up a filter 
may be a great idea. 

In Google Sheets, click on the filter icon and 
select “Create new filter” view. Then click on 
the column header of any column to filter 
data (Figure 133). 

Price 

FIGURE 132 — When working with large sets of data, users 
may choose to filter specific columns. 
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FIGURE 133 — Google Sheets provides users the ability to filter data, making large datasets easier to use.

To create a filter on the division column, 
click on the column header “Division.” If you 
only want to see sales data for the West 
Division, you should deselect “East” and click 
“Ok” (Figure 134). When you create filters in 
Google Sheets, the sidebars change in color 
to indicate that a filter is in place (Figure 
135).

You could create additional filters on top of 
an existing one. For example, if you wanted 
to only see a particular Sub-Division within 
your Division, you can create a filter on 
the “Sub-Division” column (Figure 136). 
Removing the filters will bring the original 
data and the color changes back to normal. 

To filter in Excel, select any cell within the 
range of data. Then go to the “Data” tab and 
click on the “Filter” menu. On the column 
headers, you will see the option to filter.

FIGURE 134 — Once in the “Create new filter” view of 
Google Sheets, users can filter columns of data.

FIGURE 135 — Once a filter has been established, you only 
see the data you are interested in.

FIGURE 136 — Users can filter multiple columns at the 
same time.

Sorting 

Sorting organizes data in an ascending or 
descending order and facilitates searching 
for data. Some spreadsheet operations such 
as VLOOKUP and Remove Duplicates also 
expect data to be sorted. For example, if 
you have a list of students with First Name, 
Last Name, City, and GPA in a spreadsheet, 
it may be useful to group all the students in 
a city together. Just sort the data by City to 
reorganize the underlying data and see all 
the students from one city in one place. If 
mayors want to award the top-performing 
students in their cities, they can sort by City 
and then by GPA to figure out which students 
will receive awards. If you choose to sort 
from the largest to the smallest (descending 
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order), the student with the highest GPA will be at 
the top. 

Just like Filtering, Sorting doesn’t alter the 
underlying data. What you change is how rows get 
ordered compared to the other rows in the data 
set.

To sort by Division in Google Sheets, we simply 
select the column and then do “Data” → “Sort” 
(Figure 137). 

If you want to do more complex sorting (first by one 
column, then by another), in Google Sheets simply 
select the cells that comprise your data set and 
choose “Data” → “Sort Range” option. “Advanced 
range sorting options” will let you sort by as many 
columns as you like (Figure 138). 

In Excel, go to the “Data” tab and click “Sort” to open 
the “Sort” window and sort by as many columns as 
you like. Don’t forget to select the checkbox “My 
data has headers,” if your top row has headers. This 
will make sure only the data gets sorted, not the 
headers. 

Division
Sub-
Division

Product 
Number

Number 
of Units

Price 
per unit

east 1 1111 140 $10
west 2 1111 21 $9
west 3 1111 18 $12
east 3 1111 16 $8
west 1 1111 11 $10
east 4 1111 11 $9
west 3 2222 16 $12
west 2 2222 15 $10
east 2 2222 15 $11
west 1 2222 12 $10
east 3 2222 12 $9
east 4 2222 12 $9
east 1 2222 10 $9
east 2 2222 9 $13

Division
Sub-
Division

Product 
Number

Number 
of Units

Price 
per Unit

east 1 1111 140 $10
east 2 1111 21 $9
east 3 1111 18 $12
east 3 1111 16 $8
east 1 1111 11 $10
east 4 1111 11 $9
east 3 2222 16 $12
east 2 2222 15 $10
west 2 2222 15 $11
west 1 2222 12 $10
west 3 2222 12 $9
west 4 2222 12 $9
west 1 2222 10 $9
west 2 2222 9 $13

FIGURE 137 — Unsorted sales data of a company 
(top); Data sorted by Division (bottom). 

FIGURE 138 — In Google Sheets, users can 
simultaneously sort multiple columns by utilizing 
the “Advance range” sorting options.

Conditional Formatting

Conditional formatting allows you to apply 
formatting, such as cell shading and text color, to 
cells based on conditions. This can be useful in 
highlighting important information or for making 
data easier to read and understand. You can use a 
formula or a set of rules to determine which cells 
should be formatted. 

Going back to our company sales data, let’s say we 
want to highlight any sales of more than 15 units 
in green and those with less than 10 units in red. In 
Google Sheets, select the cells you want to format, 
then choose “Format” → “Conditional Formatting” 
(Figure 139). In the conditional formatting window, 
make sure the cells you want to format are selected, 
then create rules to see the formatting results 
(Figure 140). 

In Excel, the “Conditional Formatting” menu is 
under the “Home” tab. Just select “Highlight Cells 
Rules” and create the conditional formatting rules 
you want. 
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FIGURE 139 — Conditional formatting helps 
identify cells that meet specific requirements.

Division
Sub 
Division

Product 
Number

Number 
of units

Price 
per 
unit

west 2 1111 21 $9
west 3 1111 18 $12
west 3 2222 16 $12
west 2 2222 15 $10
west 1 2222 12 $10
west 1 1111 11 $10
east 1 1111 140 $10
east 3 1111 16 $8
east 2 2222 15 $11
east 3 2222 12 $9
east 4 2222 12 $9
east 4 1111 11 $9
east 1 2222 10 $9
east 2 2222 9 $13

FIGURE 140 — Users can specify colors to 
represent cells that meet specific criteria. 

Pivot Tables

A pivot table is a useful tool to quickly summarize and 
analyze large amounts of data to see patterns and 
trends. Manually analyzing the data in a spreadsheet 
with 1000s of rows spread across tens of columns 
can be a daunting task. If you want to see patterns, 
compare the impact of different columns, or group 
data in categories, you may need to put in months of 
painstaking work. Using pivot tables, you can simply 
select all your data, transpose it to a pivot table, select 
columns to categorize on, filters to apply, and choose 
the summarizations you want. The software will do 
the calculations and give you a pivot table summary 
report. If you don’t like the outcome or if you want to 
change your filtering, grouping, or summarization parameters, you can do so and immediately see 
the outcome. 

Additional Resources

Spreadsheets have a wide range of capabilities for a wide array of applications. To become proficient 
at using spreadsheets, consider using them anytime you are working with numbers. Like any skill, 
practice will improve your ability to leverage this highly valuable technology.

Several influencers share valuable Excel tips on social media sites, including Twitter. Some threads the 
authors can recommend are below:

15 Excel tips: https://twitter.com/FluentInFinance/status/1611807041399705600

Search by hashtag for Excel: https://twitter.com/hashtag/excel.

https://twitter.com/FluentInFinance/status/1611807041399705600
https://twitter.com/hashtag/excel
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			   Chapter Terms and Definitions

Cell: A cell is a single element in the worksheet 
that has a value, some text, or a formula

Chart: A type of visualization shaped like a pie 
and used to analyze data in an intuitive and user-
friendly way

Column: Represents categories of data and the 
cells are named by alphabet vertically

Conditional Formatting: A spreadsheet feature 
that allows you to apply formatting options, such 
as cell shading and text color, to cells based on 
conditions

Data: Information used for reasoning, discussion, 
or calculation

Filter: A spreadsheet feature designed to narrow 
a set of data based on specific criteria so that you 
can choose which rows are visible and which 
ones are hidden

Formula: A feature that performs specific 
calculations or other actions on the data in the 
spreadsheet

Function: A set piece of code built into a 
spreadsheet that performs certain predefined 
actions; examples include SUM, AVERAGE, 
COUNT, MIN, and MAX

Pivot Table: A useful tool to quickly summarize 
and analyze large amounts of data to see patterns 
and trends

Row: Represents a record of data and the cells 
are numbered horizontally

Sorting: A spreadsheet feature that organizes 
data in an ascending or descending order and 
facilitates searching for specific data

Spreadsheet: A computer program that 
represents information in rows and columns, and 
makes it easy to perform calculations with the 
data
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		  	 Chapter Case

Sports Tracking Spreadsheet
Kenny needed to take on a volunteer project to help with his future chances of 
getting a college scholarship. Most of the college scholarships he was interested in 
applying for required that he have a minimum number of documented volunteer 
hours. Thankfully, a local non-profit youth sports management organization 
needed to create a spreadsheet that would help track students who sign up for 
various youth sports. 

Kenny offered to help the organization create the spreadsheet in exchange for 
documented volunteer hours. The manager of the organization agreed to the 
project and Kenny was ready to apply his spreadsheet skills. 

The spreadsheet required the tracking of the following data: 

·	 Student First Name

·	 Student Last Name

·	 Student Age

·	 Student Grade

·	 Student School

·	 Telephone Number

·	 Sport (Volleyball, Basketball, Softball, Baseball, Soccer, or Football)

Question 1:	 Considering the data required in the list above, create a spreadsheet 
in a spreadsheet application you have access to. Add at least 10 
rows of data to your spreadsheet. Once you add all the data to the 
spreadsheet, what is the average age for all the students? What 
formula did you use to calculate the average age? 

Question 2:	 Add a chart to the spreadsheet that illustrates the total number 
of students for each sport. Which sport has the highest number of 
students? What formula did you use to count the total number of 
students for each sport?
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Presentations aren’t about the presenter; they’re about the audience and what the 
audience needs.

—Simon Raybould, author of “Presentation Genius: 40 Insights  
from the Science of Presenting”

Overview
A presentation is an electronic document that conveys information to an audience. Robert Gaskins 
got the idea131 of software to create “slides of text and graphics in a graphical, WYSIWYG environment, 
then outputting them to 35-mm slides, overhead transparencies, or video displays and projectors… 
[t]he presentation would spring directly from the mind of the business user, without having to first transit 
through the corporate art department.”132 Before working on PowerPoint, as a student, Gaskins had 
worked in the computer lab at Berkeley as a graphics consultant. Gaskins began working on the 
software, initially called Presenter, in July 1984, and continued working on it with two colleagues, 
Dennis Austin and Tom Rudkin, and released PowerPoint on April 20, 1987, for Mac computers. Three 
months later, in July 1987, Microsoft bought their company, Forethought Inc, for $14 million. 5 years 
later in 1992, Microsoft released PowerPoint 3.0, which in Gaskins’ words, realized his initial vision 
for the product.133 The first public presentation from a laptop to project video from PowerPoint took 
place on February 25, 1992, in Paris. Since then, presentation software is used at virtually all business 
meetings to improve communication.134 Students use presentation software in a variety of creative 
ways to create flyers, brochures, and other electronic documents.

What is a Presentation Application?
A presentation application allows users to create and display presentations. Presentations are usually 
made up of a series of slides or pages, each containing text, charts, images, and videos. Both word 
processors and presentation applications create electronic documents with unstructured content. The 
difference is in the goals and intended audience. Word processors create self-contained documents 
that have all the detail necessary for a single reader to understand the information without any 
external aids. This book is an example of a document created with a word processor. Presentation 

131	 The 2-page original concept for PowerPoint is at https://www.robertgaskins.com/powerpoint-
history/documents/gaskins-powerpoint-original-proposal-1984-aug-14.pdf (accessed June 
2023).

132	 How PowerPoint was created, David Pescovitz, https://boingboing.net/2017/11/01/how-
powerpoint-was-created.html, accessed from David Gaskins’ website at https://www.
robertgaskins.com/ (accessed June 2023).

133	 A highly recommended site that describes the PowerPoint origin story is Robert Gaskins’ website 
at https://www.robertgaskins.com/ (accessed June 2023).

134	 For an important counterpoint to the use of presentations to facilitate business meetings, read 
why Bezos banned the use of presentations at Amazon, and what they do instead at https://
twitter.com/JonErlichman/status/1573096127389474816?lang=en. This is business legend and 
there are several articles online describing this approach. An example is https://www.foleon.
com/blog/why-jeff-bezos-banned-powerpoint-from-meetings (accessed June 2023).

https://www.robertgaskins.com/powerpoint-history/documents/gaskins-powerpoint-original-proposal-1984-aug-14.pdf
https://www.robertgaskins.com/powerpoint-history/documents/gaskins-powerpoint-original-proposal-1984-aug-14.pdf
https://boingboing.net/2017/11/01/how-powerpoint-was-created.html
https://boingboing.net/2017/11/01/how-powerpoint-was-created.html
https://www.robertgaskins.com/
https://www.robertgaskins.com/
https://www.robertgaskins.com/
https://twitter.com/JonErlichman/status/1573096127389474816?lang=en
https://twitter.com/JonErlichman/status/1573096127389474816?lang=en
https://www.foleon.com/blog/why-jeff-bezos-banned-powerpoint-from-meetings
https://www.foleon.com/blog/why-jeff-bezos-banned-powerpoint-from-meetings
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applications are used to create electronic documents that support a talk given by a presenter to a 
large audience, by making it easy to display visual information. The slide decks your teacher will use 
in class to present the information in this textbook are created using a presentation application.

Typically, when a speaker presents information or teaches in front of an audience, they use slides 
to display graphics, statistics, and other related information that adds context to the talk. Often 
this information is difficult to describe verbally, but easy to present visually. Popular presentation 
applications include Microsoft PowerPoint, Google Slides, and Apple Keynote. These applications are 
feature-rich, providing tools to create and format text, images, and other media, to design a consistent 
look and layout of the presentation.

Slides

A presentation slide is a single page of a presentation. The term “slide” originated from the days of 
overhead projectors, when an enhanced image was projected onto a screen that the audience could 
see from a distance. Even with the advent of computers, the term slide remains popular. Presentations 
are sometimes called slide decks. Unlike a page in a document, which is typically intended to be 
read by someone in a personal setting, a slide is intended to be used in a shared setting, either on a 
conference call such as Zoom or in a conference room in front of an audience. 

Adding, Deleting, and Reordering Slides

If you have Microsoft software, you can click on any existing presentation or open PowerPoint to 
create a new presentation. If you use Google Slides, just go to slides.google.com. You can either 
open a blank presentation or pick a template from the wide selection of templates available in both 
PowerPoint and Google Slides (Figure 141 shows an example). 

FIGURE 141 — Choosing a layout for a new slide in PowerPoint.

https://docs.google.com/presentation/u/0/
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To add new slides to your presentation in PowerPoint, go to the “Home” tab, click “New Slide,” and 
then pick any layout you want. In Google Slides, go to the “Insert” menu and select “New slide” (Figure 
142). You will notice new slides inherit the same color scheme as the existing slides. We will discuss 
later in this chapter how you can change the layout and theme of your slides. 

FIGURE 142 — Adding a new slide in Google Slides. 

To delete any slide in PowerPoint or Google Slides, 
select the slide, then right-click on your mouse to 
bring the context menu, and then select “Delete 
Slide” (Figure 143). Once you have finished creating 
your slides, you may want to rearrange the slides 
based on inputs from colleagues and friends. In the 
pane on the left (called the slide thumbnail pane), 
you can see thumbnails of all your existing slides. 
To move slides around, just click the thumbnail 
of the slide you want to move, then drag it to the 
new location. You can also select multiple slides by 
holding “Ctrl” while you click the slides you want 
to move, and then drag them as a group to a new 
location. The slide thumbnail pane is very useful to 
organize your slides.

FIGURE 143 — Users can delete a slide by right-
clicking on the slide to bring up the menu that has 
“Delete Slide.”
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Formatting Slides

You can customize how your presentation looks by changing the theme, layout, and background of 
your slides. 

FIGURE 144 — Themes are displayed on the right pane of Google Slides. 

Themes offer a predefined set of colors, fonts, and visual effects for the presentation. Themes give your 
presentation a unified, professional look. For most presentations, one of these predefined themes will 
work very well. To change the theme in Google Slides, go to the “Slide” menu, then select “Change 
theme.” The right pane will show a variety of themes you can choose from (Figure 144). Selecting any 
theme will change the theme of all your existing slides (Figure 145). In PowerPoint, go to the “Design” 
tab to select from the list of available design themes.

FIGURE 145 — Google Slides users can change their themes using the toolbar. 
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Layout determines how information is 
arranged on a slide. Typically, there is a single 
theme for the entire presentation, but the 
layout changes from slide to slide based on 
the type of information you want to present. 
For example, in a typical presentation, the 
first slide has a layout appropriate for a title 
slide to introduce the presentation to the 
audience. By default, this first slide has a 
place to enter the title and subtitle of the 
presentation, along with the name of the 
presenter. Most themes offer multiple layout 
options for the same task. You can use any 
of these layouts to communicate your 
message.

The slides following the title slide have 
different kinds of content and there are 
various layouts to choose from to present 
this content. In the simplest case, you may 
just have a text box in your slide if you are 
planning to write a paragraph. You may want to use a two-column layout if you plan to compare 
the performance of two different products. In PowerPoint, you have the option to select a layout 
when you add a new slide. You can also change the layout of any slide by clicking the slide and then 
right-clicking on the mouse to bring the context menu. Select “Layout” to get all the available layout 
options (Figure 146). In Google Slides, you have the option to “Apply layout” under the “Slide” menu 
(Figure 147). Of course, you can change the layout of the slide manually, too. For example, if you want 
to remove a text box or an image from your slide, just select the text box or image and click delete. 

The first slide is usually the title slide.

  

FIGURE 146 — PowerPoint users can change 
the layout by right-clicking and selecting a 
new layout.              

FIGURE 147 — Google Slides users can also change 
the layout of any slide. 
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The background refers to the area behind the 
slides. It can be a solid color, a pattern, or a picture. 
The purpose of the background is to set the tone 
and style of the presentation and to help create 
a cohesive look. You can use the background to 
reinforce your presentation’s theme or to support 
your overall message. You can customize the 
background for a single slide or all the slides in 
your presentation.

To change the background in Google Slides, just 
select the slide you want to change, right-click 
on your mouse to bring the context menu, and 
then select “Change background” (Figure 148). 
You can also go to the “Slide” menu and select 
“Change background.” The process to change the 
background is similar in PowerPoint. You can select 
the slide, bring up the context menu, and select 
“Format Background” (Figure 149). Once you select 
the kind of background you want, you could apply 
it to the selected slide or to all the slides in your 
presentation. The “Design” tab in PowerPoint also 
offers you the option to “Format Background” and 
apply it to the selected slide or all the slides in your 
presentation. 

FIGURE 148 — Editing the background of a slide 
allows users to insert pictures. 

FIGURE 149 — PowerPoint users can also edit backgrounds and insert images.

Presentation Design Tip

As you discover presentation software features such as backgrounds and layouts, 
it is very tempting to use them indiscriminately across your presentation. 
However, too many changes in visual design can quickly become jarring and 
draw viewers’ attention away from the core message you are trying to convey. 
Use your judgment so your design elements enhance your message, not distract 
from the message you want to convey. 
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Adding Content

Once you insert a slide, you can add content to the slide by listing your ideas and inserting charts and 
videos to illustrate your point. Charts and videos serve the additional purpose of ensuring folks don’t 
fall asleep in the middle of your presentation. Keep in mind, you do not want to create verbose slides 
with paragraphs of text. These slides become unreadable to most. You should have just enough words 
to convey your core message, without boring your audience with details. For additional information, 
you can refer audience members to websites or other documents that have the necessary context. For 
example, your slide can say that “club membership grew by 16% this year” and present all necessary 
details in your talk or supporting documents.

Adding text is easy. Most slide layouts have text boxes where you can enter text. How many text 
boxes are there depends on the layout of the slide. In the slide in Figure 150, there are two rectangular 
text boxes, one small box that serves as the header of the slide and the other large one for the main 
content. This is perhaps the most common layout used in presentations.

FIGURE 150 — Text boxes allow users to customize the location of text in 
individual slides. 

Sometimes you may want to add additional text boxes to your slide. In Google Slides, go to the 
“Insert” tab and then click on the “Text box” (Figure 151). Click and drag on the slide to create a text 
box. Similarly, in PowerPoint, go to the “Insert” tab and click on the “Text Box” icon in the “Text” group. 
You can then click and drag on the slide to create a text box.
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FIGURE 151 — Text boxes can be added and removed to meet user needs.

You may want to create bulleted and numbered lists in text boxes to make your point succinctly. To 
create a list in PowerPoint, just go to the “Home” tab and click on the “Bulleted List” or “Numbered List” 
in the “Paragraph” group. Similarly, in Google Slides, just click on the bulleted or the numbered list 
icon in the ribbon and select the format you want (Figure 152). A bullet point or number will appear 
on the slide. Press “Enter” to create a new bullet point or number. 

FIGURE 152 — There are several list formats to choose from.

Both Google Slides and PowerPoint allow you to insert shapes, images, tables, charts, headers, and 
footers. In PowerPoint, the ribbon of the “Home” tab has many different shapes in the “Drawing” group 
(Figure 153). You can choose to fill the shapes if you want with color and add texture and gradients. In 
PowerPoint, under the “Insert” tab, you have the option to add tables, charts, slide numbers, headers, 
and footers. 

FIGURE 153 — PowerPoint allows users to select and draw shapes to enhance a presentation. 
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When you add shapes and text boxes to your 
slide, it is useful to ensure that the shapes 
on the slide don’t go out of sync with each 
other. The simplest way to do this is to group 
shapes. Grouping preserves the individual 
shapes but treats the group as one object 
while rearranging. To group shapes, select the 
shapes by clicking on the shapes while holding 
the “Ctrl” button, then right-click to bring the 
context menu, and choose “Group” (Figure 
154). A very common group is a shape object 
and the associated text box label.

In Google Slides, you have the shapes icon on 
the ribbon, which offers a variety of shapes, 
arrows, callouts, and equations (Figure 155). You can also go to the “Insert” tab to add shapes, tables, 
charts, diagrams, and images. Text boxes can also be added over shapes to create a narrative. You can 
group and align several shapes to create a consistent look.

FIGURE 154 — Grouping shapes helps create complex 
images that can be reused later

FIGURE 155 — Google Slides also allows users to insert and create shapes (top). By layering shapes and combining 
with text boxes, users can create unique layouts (bottom).
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Inserting media content is also easy in Google Slides and PowerPoint. In Google Slides, go to the 
“Insert” tab and search for any video on YouTube, the Internet, or your local drives. Once you find the 
video you want, selecting it will insert it into your slide. Similarly, in PowerPoint, under the “Insert” 
tab, you can use the “Video” button in the “Media” group to select videos from your device, YouTube, 
or other online sources.

Presentation Applications as Drawing Tools

Presentation applications are one of the best drawing tools available, though 
unfortunately, their drawing abilities are highly underrated. Between shapes, 
connectors, alignment tools, grouping, and related capabilities, you can create 
almost any kind of drawing using presentation tools.

Business Elements: Charts, Graphs, Tables, and Spreadsheets

You can make the data in your presentation stand out by adding tables, charts, graphs, and 
spreadsheets. There are many ways to add tables to slides. In PowerPoint, just go to the “Insert” tab, 
click on the “Table” button, and find several options to create a table (Figure 156). You can select 
boxes representing columns and rows to tell the software how many columns and rows you want. 
Otherwise, you can select the “Insert Table” option and input the number of rows and tables you want.

FIGURE 156 — Tables can be inserted into slides. 
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Once you have your table, you can go to the “Table Design” tab and select any of the available Table 
Styles. You can change the border style to either highlight or minimize the table borders. The “Effects” 
button allows you to add special effects, including Cell Bevel, Shadow, and Reflection (Figure 157). 

FIGURE 157 — Table effects personalize how data is displayed and can be attention grabbing. 

You can also link an Excel spreadsheet to your PowerPoint slide to make sure that the data in your 
slide gets updated every time you change your spreadsheet. To do this, go to the “Insert” tab and 
then click on “Object” in the “Text” group. In the “Insert Object” window, select “Create from file” and 
make sure to select the checkbox (“Link”) to link the two objects (Figure 158). Once you click “Ok,” 
the spreadsheet will get inserted into your slide. Anytime you change your Excel file, the data in your 
presentation will also get updated. This is particularly useful when working with rapidly changing 
data and ensures the data and charts are up to date.

FIGURE 158 — Linking Excel files to presentations keeps data and charts up to date. 
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Working with tables in Google Slides is also 
relatively simple. You can create a table in Google 
Slides by choosing the “Table” option under the 
“Insert” tab. To link an existing spreadsheet to a 
slide, just open both the slide and the spreadsheet. 
Copy the data in the spreadsheet and make sure to 
select “Link to spreadsheet” before you paste it on 
your slide (Figure 159). 

Adding charts and graphs is important to make your 
presentation stand out. Presentation applications 
have basic charting capabilities to help you create 
charts without first plotting them in spreadsheets. 
If you are using PowerPoint, simply go to the “Insert” tab and select the type of chart you want. A 
sample chart, as well as the data associated with the chart, will get added to the slide (Figure 160). To 
replace the sample data with your own, paste your data or change the sample data manually. 

FIGURE 159 — Users can also copy the data from 
a spreadsheet and paste it into their presentation.

FIGURE 160 — Users can create graphs and visualizations in the presentation 
application. 

Right-clicking on the chart will bring up the context menu to let you change labels, chart type, and 
data. For more extensive controls and to work with large quantities of data, you could copy charts 
created in Excel and paste them in PowerPoint. You will have the option to link the PowerPoint chart 
to Excel, which can be great if you want the chart in PowerPoint to change every time you change 
the data in Excel. Otherwise, you could choose to embed an Excel chart into a slide, which makes the 
chart a part of the presentation and disconnects it from the original source data. You can edit the data 
associated with the chart in PowerPoint, and it will be saved with the presentation.
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You can insert a chart just as easily in Google Slides by going to the “Insert” tab and selecting the 
“Chart” menu option and the chart type you want. Both the chart and the sample data will get inserted 
into your slide. You can change the data and labels to customize your chart. For more extensive 
capabilities, you can also insert a chart from an existing Google Sheets file and link the two, so the 
chart in Google Slides gets updated whenever you update the data in the spreadsheet (Figure 161). 

FIGURE 161 — Google Slides can also import charts (Step 1—top; Step 2—bottom).
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Linking and Embedding135

Linking and embedding are two different ways of displaying information that 
has been created in a different program (often a spreadsheet). Embedding 
creates a copy of the original data in the document and removes any association 
between the document and the data source. Linking retains the data in the 
original spreadsheet and uses the document or presentation just for display.

In practice, linking requires great care since the links can get broken if either the 
document or spreadsheet is moved from their locations.

Sharing, and Printing Slides

Sometimes you may need to share your slides with your colleagues to get their feedback before your 
slides are ready to be presented to customers or 
stakeholders. If you want to share Google Slides, 
you can do that by clicking on the “Share” button 
in the top-right corner of your screen. You can 
also use the “Share” option under the “File” tab 
and set up your colleagues and friends as editors, 
commenters, or viewers. Once your presentation is 
final, you may want to make it available to everyone 
by choosing to “Publish to the web” (Figure 162). 
If you choose the “Publish to the web” option, you 
can select the “Auto-advance” option to make sure 
the slides move forward automatically.

To share PowerPoint slides with others, you could 
send the slides as an email attachment. Otherwise, 
you could also upload the file to a cloud storage 
service such as OneDrive, Google Drive, or Dropbox 
and share the link with your audience. The third 
option is to upload the file to an online presentation platform such as Slideshare, Prezi, or PowerPoint 
Online and share the link with others. 

FIGURE 162 — Publishing a presentation enables 
users to share their finished slides.

135	 For more information on linking and embedding, please lookup related articles online. One 
such article is from 2010 at Microsoft’s website https://support.microsoft.com/en-us/office/
linked-objects-and-embedded-objects-0bf81db2-8aa3-4148-be4a-c8b6e55e0d7c (accessed 
June 2023).

https://support.microsoft.com/en-us/office/linked-objects-and-embedded-objects-0bf81db2-8aa3-4148-be4a-c8b6e55e0d7c
https://support.microsoft.com/en-us/office/linked-objects-and-embedded-objects-0bf81db2-8aa3-4148-be4a-c8b6e55e0d7c
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Often, while delivering in-person presentations, 
speakers like to distribute printed copies of their 
slides to everyone in the audience, to help them 
make notes while the presentation is going on or 
to refer to the slides at their leisure. When you print 
your slides, you could choose to print your slides 
as handouts or outlines (Figure 163). Handouts 
let you print multiple slides per page, usually in 
a format that is easy for people to take notes on. 
In PowerPoint, you can choose to print anywhere 
from one to nine slides per page. You can also 
include space for notes or include speaker notes. 
Outlines are a way to print the text from your slides 
in a document format. This is useful for people who 
want to follow along with the presentation or for 
people who want to read through the presentation 
before or after it is given.

FIGURE 163 — Users can print slides to create 
handouts.

Outlines as a Power Tool for New Document Creation

One very powerful but underrated use of presentation applications is creating 
document outlines. In the normal workflow, users create documents describing 
a plan in the greatest possible detail, then create a presentation to describe the 
plan to an audience. This sequence can also be reversed. You can start with the 
presentation and use the bullet lists and slide rearranging features to create 
your presentation as an outline of your document. The outline exported from 
the presentation application will be an electronic document with slide titles 
and bullets. You can now fill in each section to create the complete document. 
This is a very effective way to create a new document when you are still trying 
to develop the structure of the document.

To see all the formatting options for handouts (to decide the layout, the number of slides per page, 
page numbers, headers, footers, and background styles) go to the “View” tab and check out the 
“Handout Master” (Figure 164). “Notes Master” will let you customize how your presentation will look 
when printed with notes. 
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FIGURE 164 — PowerPoint can help you choose the best format for handouts. 

When you are ready to print or export a PowerPoint presentation, just to go the “File” menu and select 
“Print.”

Google Slides also has similar options to print or export your presentation in the form of handouts 
and outlines.You can download Google Slides as PowerPoint slides or as a PDF document. Once you 
have the slides in PowerPoint or PDF, you can use the print option to create handouts or outlines. The 
“Print” option in Google Slides lets you choose the number of slides per page and whether to include 
notes or not. 

Delivering the Presentation
When you are done creating and ordering your slides and have prepared them for sharing with others, 
you may have the opportunity to deliver the presentation to an audience. One of the first things you 
may want to add is speaker notes for your slides. Speaker notes are a list of important talking points. 
Speaker notes can be added to slides in Google Slides as well as in PowerPoint to help you remember 
things you want to talk about during the presentation. In PowerPoint, click on “Notes” in the bottom-
right corner to add notes. In Google Slides, clicking on the three dots at the bottom of the page 
will bring a box to enter speaker notes. Otherwise, you could go to the “View” tab and select “Show 
speaker notes.” 

You can add a few elements to make features in your presentations interesting. One such feature is 
transitions between slides (Figure 165). To add transitions in PowerPoint, go to the “Transitions” tab 
and select the type of transition you want. If you are presenting at a children’s birthday party, your 
transitions may have sound effects. But formal presentations in business contexts tend to be more 
sober affairs. Flashy visuals are seen as lacking in seriousness. Once you select the type of transition 
you want, you can choose to apply it to all slides by clicking “Apply To All.” If you are at a trade show 
and want to run slides continuously, you may choose to advance slides automatically after a certain 
time rather than move slides manually with “On Mouse Click.” In Google Slides, add transitions by 
clicking on the “Transition” button on the ribbon. 
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FIGURE 165 — PowerPoint (top) and Google Slides (bottom) allow users to select and edit transitions.

Not all presentations are in-person. With many organizations switching to remote work due to the 
changes and adaptations required as a result of the Covid pandemic, many meetings and presentations 
are now delivered on Zoom, Google Meet, or Skype. Whether online or live, when you present in 
front of a large audience, you may want to ensure that your laptop or mobile device can successfully 
connect to the projector, display, or meeting software. Make sure to practice a few times to avoid a 
panicky, stressful situation on the day of the presentation.

Once you are ready to present, you will need to switch to the presentation mode in the presentation 
application. The presentation mode removes all editing controls and uses the entire viewing area to 
display the slides. In presentation mode, you can move slides manually or automatically. In PowerPoint, 
you have the “Slide Show” tab with many different options to present. To start the presentation, go 
to the “Start Slide Show” group and select “From Beginning” or “From Current Slide.” If you select “Use 
Presenter View,” you will see the notes and several other presentation options on a second display 
connected to your computer while you present. This can be very useful since you may want to have 
access to your notes while presenting but don’t want to show them to others. The presenter view 
also gives you access to the taskbar while you are presenting. In Google Slides, begin presenting by 
clicking on the “Slideshow/Presenter” button in the top-right corner (Figure 166 top). You have the 
option to give the URL of the presentation to your audience so they can ask questions that will show 
up on your screen as they are typed in (Figure 166 bottom). You can address the questions at the end 
or immediately as they appear on your screen. 
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FIGURE 166 — In Google Slides the presenter view helps to increase viewer engagement, removes most of the editing 
tools from the display (top), and allows questions during the presentation (bottom).

Learning to Deliver Great Presentations

Thus far, we have described the important elements of creating and delivering a presentation. As you 
create your own presentations, it is useful to pay attention to what makes presentations successful. 
Since the primary purpose of presentations is to communicate with an audience, it is important to use 
consistent font sizes, styles, and colors throughout your presentation. Bullet points and numbered 
lists help organize and present information clearly and concisely. Headings and subheadings help 
structure your content and make it easier for your audience to follow along. Also, images, charts, and 
other types of graphics help illustrate your points and make your presentations more engaging.

Experts have shared several tips online for creating and delivering great presentations. A very good 
starting point is the TED talks playlist on how to create great presentations. It is available at https://
www.ted.com/playlists/574/how_to_make_a_great_presentation.

https://www.ted.com/playlists/574/how_to_make_a_great_presentation
https://www.ted.com/playlists/574/how_to_make_a_great_presentation
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FIGURE 167 — Choosing the appropriate mix of color, content, and general aesthetic is crucial to creating impactful 
slides. 

Here are a few suggestions to create impactful slides (Figure 167):

1.	 Add data and remarks to make your point clearly and briefly

2.	 Explain complex concepts or ideas by providing visual aids—images, charts, graphs, and 
videos—to help your audience understand and retain information.

3.	 Create an appealing presentation that captures and holds the audience’s attention and helps 
them stay engaged.
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			   Chapter Terms and Definitions

Background: Refers to the area behind the slides

Embedding: Creates a copy of the original data 
in the document and removes any association 
between the document and the data source

Layout: Determines how information is arranged 
on a slide

Linking: Retains the data in the original 
spreadsheet and uses the document or 
presentation just for display

Presentation: An electronic document that 
conveys information to an audience

Slide: A single page of a presentation used to 
visually display content intended to be used in a 
shared setting

Slide show: A presentation mode in the 
presentation application that removes all editing 
controls and uses the entire viewing area to 
display the contents of the slides

Theme: A predefined set of colors, fonts, and 
visual effects that can be used for the presentation

Transition: A feature is used in presentations 
to apply special visual or audio effects when 
advancing one slide to another
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		  	 Chapter Case

Amber’s Business Presentation
Amber was preparing for a Future Business Leaders of America (FBLA136) high 
school competition. FBLA is the largest business Career and Technical Student 
Organization in the world. Each year, FBLA helps over 230,000 members prepare 
for careers in business. Its mission is to inspire and prepare students to become 
community-minded business leaders in a global society through relevant career 
preparation and leadership experiences.137

Amber was competing in the category, “Introduction to Business Presentation.” Her 
task was the following: 

You are trying to raise money to attend a business leadership training program 
in New York City. This would be a week-long summer program that will cost 
$2,000. You will prepare a presentation that can be used in front of potential 
sponsors from your community. Be sure to include why you should attend, 
and the benefit you will receive and bring back to your school.138

Question 1:	 Maybe you aspire to be a future leader or perhaps you may not. 
However, consider for a moment that you will be participating in this 
competition with Amber. Create a presentation using a presentation 
application you have access to that meets the requirements described 
above. Be sure to apply a theme, background, and professional 
layout. 

Question 2:	 Considering that you are petitioning your community to sponsor 
the funding needed to pay for the summer program, add at least 
one “business element” to your presentation. Describe the “business 
element” and why you added it to your presentation.

136	 Future Business Leaders of America, FBLA, High School, https://www.fbla-pbl.org/divisions/
fbla/ (accessed June 2023).

137	 Future Business Leaders of America, FBLA, Mission, https://www.fbla-pbl.org/about-fbla-pbl/ 
(accessed June 2023).

138	 This sample scenario was taken from FBLA website, which describes the “Introduction to 
Business Presentation” competition category. 

https://www.fbla-pbl.org/divisions/fbla/
https://www.fbla-pbl.org/divisions/fbla/
https://www.fbla-pbl.org/about-fbla-pbl/
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To not have an email address is the digital equivalent of being homeless. Without it 
you can’t shop online, bank online or engage with social media.

—Dela Quist, email marketing leader and founder of Alchemy Worx

Overview
Email is the method of sending, receiving, and organizing messages using a computer. Barely a few 
decades ago, the only way to send messages and documents was to mail them physically at the post 
office (or use courier services like FedEx and UPS). Email transformed the way we communicate. It 
allowed us to send and receive messages and documents instantaneously, regardless of the physical 
location of the sender or the receiver. Along with services like instant messaging and video calling, 
email spurred global e-commerce by breaking geographical barriers and allowing friends and family 
to stay in touch on a day-to-day basis for little to no cost. To mail a letter through the postal service, 
you needed to write the letter or take a printout of the letter, put it in an envelope, attach stamps, and 
write the mailing address on the envelope. If you have access to a smartphone or computer, emailing 
is much easier. You only need to know the email address of the person you want to email, then type 
the message, and include any documents you want to attach to the message. Clicking the “Send” 
button will instantly transfer the email from your inbox to the receiver’s inbox, while you continue to 
work on your computer. 

Email is critical for students and adults in the modern world. As a high schooler, you probably receive 
important notifications from your school and are required to submit assignments through email. 
These days, most job applications are sent and received through email because email not only helps 
deliver information and documents but also serves as a permanent record of your interactions. When 
you shop online for clothes or use food delivery services, you may get an email or a text message 
that you can refer to for details or in case of a disagreement with the other party. A critical feature 
of email, compared to instant messaging, is that emails are stored in virtual mailboxes, and have the 
advantage of never getting lost, unless deleted deliberately. In most cases, depending on your email 
provider,139 you will be able to restore even deleted messages from the Trash folder for a while.

Email Origins
Message passing was one of the first uses of computers. The earliest electronic communication 
systems were like leaving a note on a user’s desk. Users could leave a message in a specific folder 
on another user’s computer, who would then open the message at their convenience.140 When the 
Internet became available, users wanted to send messages to anyone connected to a computer. 
This introduced the need for consistent ways of doing several things, such as identifying computers, 
identifying users on computers, and packaging messages. In 1972, Ray Tomlinson used the “@” 
symbol already available on computer keyboards to create the simple “user@computer” convention 

139	 Even after you delete an email, service providers go through a detailed process to ensure the 
email is deleted from all their servers. Google’s policies are described at, “How Google Retains 
Data We Collect,” https://policies.google.com/technologies/retention (accessed June 2023).

140	 Ian Peter, “The History of Email,” Net History, http://www.nethistory.info/History%20of%20
the%20Internet/email.html (accessed June 2023).

https://policies.google.com/technologies/retention
http://www.nethistory.info/History%20of%20the%20Internet/email.html
http://www.nethistory.info/History%20of%20the%20Internet/email.html
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for identifying users and computers, a convention that lives on to this day.141 In 1973, Tomlinson142 
co-authored RFC 561,143 a simple three-page document that standardized the email fields we still 
use today, such as “FROM” “SUBJECT.” In 2011, on the occasion of MIT’s 150th anniversary, The Boston 
Globe rated Tomlinson the fourth most significant inventor from MIT.144

As email gained popularity, accounting for as much as 75% of all Internet traffic in the early days, 
protocols and applications emerged to make it easier for users to send and receive email. This chapter 
describes these applications in detail.

The Impact of Email
The popularity of email is based on its unique ability to meet the human need to communicate.145 
Email has even had a significant impact on the business world. The dot-com boom of 2000, one of the 
greatest financial manias of all time, can be associated with email. In one of the best-known books on 
market manias,146 author Charles Kindleberger has attributed the dot-com bubble to email and related 
technologies. The book states that “events that lead to a [financial] crisis start with a ‘displacement,’ 
some exogenous, outside shock to the macroeconomic system.” In other words, a financial mania 
begins with some unanticipated event that has a great economic impact. Further, to describe the dot-
com mania, the book states that “the shock in the United States in the 1990’s was the revolution in 
information technology and new and lower-cost forms of communication and control that involved 
the computer, wireless communication and email.” The popular adoption of email led to an entire 
financial bubble!

Email Technologies
Emails use a combination of technologies to work. End users have software called mail clients to read 
and write emails and manage their mailboxes. Service providers use software called mail servers to 
store and deliver emails on behalf of end users. We discuss email clients and their use in this chapter. 

141	 Google paid homage to this creative use of the “@” symbol on Oct 29, 2021 in “As Email Turns 
50, the @ Symbol Continues to Fuel Collaboration,” https://workspace.google.com/blog/
productivity-collaboration/celebrating-50-years-of-email (accessed June 2023).

142	 Internet Hall of Fame on Ray Tomlinson, https://www.internethalloffame.org/inductee/
raymond-tomlinson/. The four-minute video on the page is worth watching, https://youtu.be/
kJp0NHkBIAY (both accessed June 2023). 

143	 Abhay Bhushan, Ken Pogran, Ray Tomlinson and Jim White, RFC 561, “Standardizing Network 
Mail Headers,” https://www.rfc-editor.org/rfc/rfc561 (accessed June 2023).

144	 “MIT 150,” Wikipedia, https://en.wikipedia.org/wiki/MIT150 (accessed June 2023).
145	 As an example, most of the gadgets shown in Star Trek focused on communication, Sarah 

Kessler, “8 Star Trek Gadgets That Are No Longer Fiction,” https://mashable.com/archive/star-
trek-gadgets (accessed June 2023).

146	 C.P. Kindleberger and R. Aliber, Manias, Panics, and Crashes: A History of Financial Crises, 5th ed. 
(Wiley, 2005).

https://workspace.google.com/blog/productivity-collaboration/celebrating-50-years-of-email
https://workspace.google.com/blog/productivity-collaboration/celebrating-50-years-of-email
https://www.internethalloffame.org/inductee/raymond-tomlinson/
https://www.internethalloffame.org/inductee/raymond-tomlinson/
https://youtu.be/kJp0NHkBIAY
https://youtu.be/kJp0NHkBIAY
https://www.rfc-editor.org/rfc/rfc561
https://en.wikipedia.org/wiki/MIT150
https://mashable.com/archive/star-trek-gadgets
https://mashable.com/archive/star-trek-gadgets
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Mail Clients

A mail client is a software program that allows you to send, receive, and manage electronic messages 
(emails). Mail clients get messages from a mail server and display them to the user, allowing users to 
read, compose, send emails, and move emails between folders. All operating systems now include an 
email client. New users can set up their email accounts during initial setup.

Most modern mail clients are integrated with 
personal productivity applications including 
tools for calendaring, contact management, 
and task management. For example, when you 
use Outlook (a desktop mail client), it will have 
a tab for managing mail, another for managing 
calendar events, and another for managing 
contacts (Figure 168). Similarly, if you use Gmail 
(Google’s browser-based mail client), you will also have access to Google Calendar and Google 
Contacts. 

The mail client typically communicates with the mail server using a protocol called Internet Message 
Access Protocol (IMAP). A protocol is a precise specification of the interactions between communicators. 
Protocols govern every aspect of communication between computers. The IMAP protocol is used by 
mail clients to synchronize messages between your local computer and the server. When you delete 
an email on your email client, IMAP ensures that the email is also deleted from your mailbox on the 
server, operated by your Internet service provider or mail service. If you have multiple computers 
connected to the same email account on the server (for example, on your phone, and your desktop), 
IMAP ensures that an email deleted on one device is also deleted from all other devices. Similarly, an 
email read on one device is also marked as read on all devices connected to the same email account 
because IMAP helps the server inform all connected devices about the state of every message on the 
server.

Figure 168 — Tabs for mail, calendar, contacts, and 
tasks in Outlook (a popular email client).

Protocols Create Efficiency and Precision

In TV shows or movies, you may have heard cryptic conversations between 
police officers over the radio, or between members of a medical team before a 
procedure. These conversations are generally very different from typical social 
conversations. Most of the time, you don’t understand the conversation. Yet you 
may also have noticed that these cryptic conversations obey well-defined rules, 
with well-defined meanings for every word using in the conversations, and are 
relatively quick and error-free. These cryptic conversations are an example of 
protocols.147

When you compose an email and hit “Send,” your mail client sends the message to your mail server, 
which then forwards it to the recipient’s mail server. When the recipient logs into their mail client, 

147	 This example to explain protocols is from L. Pouzin and H. Zimmermann, “A tutorial on protocols,” 
Proceedings of the IEEE, 1978. 66(11): pp. 1346–1370
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their mail client requests their mail server for all new messages and their mail server delivers your 
message along with all other new emails to the recipient’s mail client for display (Figure 169).

Figure 169 — Email system architecture.

Desktop Mail Clients
Some of the most popular desktop mail clients are:

1.	 Microsoft Outlook—A widely used email client part of the Microsoft Office suite.

2.	 Mozilla Thunderbird—This open-source email client is from the Mozilla Foundation.

3.	 Apple Mail—The default email client for Apple’s macOS operating system.

4.	 Gmail—Google’s web-based email service can be used as a desktop client through the use of 
a web browser.

These desktop mail clients work by connecting to the mail server using the appropriate protocol and 
downloading the email messages to the desktop. The client provides a user-friendly interface for 
managing email accounts and messages, as well as tools for composing and sending new messages.

Mobile Mail Clients

As smartphones are handy and easy to use, some people end up using mobile 
mail clients as frequently, if not more frequently, than desktop mail clients. 

1.	 Gmail—Google’s email service allows users to access Gmail accounts 
and manage emails directly from mobile devices.

2.	 Apple Mail— The default email client for Apple’s iOS devices, it allows 
users to manage email accounts from iPhones and iPads and serves as 
the default email client for Apple’s IOS devices.
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3.	 Outlook—Microsoft’s email client is available on both iOS and Android 
devices. It allows users to manage multiple email accounts, including 
Microsoft Exchange, Gmail, and others.

4.	 Yahoo Mail— Yahoo’s email service is available as a mobile app for iOS 
and Android devices. It allows you to access and manage your Yahoo 
email account directly from mobile devices.

Receiving, Creating, and Forwarding Mails

The most popular email services—Gmail, Office 365, Yahoo Mail, and Apple Mail—are all free and 
easy to use. If a recruiter you met a few days ago told you to check your email for their response, you 
may be inclined to check your email every few minutes, whether you are at the mall or a park and 
have no access to computers. Isn’t it great that you can check your email using your smartphone? As 
with most other features, there are multiple ways to check and receive messages. Some email clients, 
like Outlook, have both desktop and web versions. Once your desktop Outlook is set up, you just 
need to open Outlook to receive all the latest messages. However, if the desktop Outlook application 
is giving you trouble for some reason or you do not have your 
own machine with you, you could go to outlook.com using any 
computer and log in with your user-id and password to receive 
and send messages. 

If you use Gmail, you probably already know that you can access 
it from anywhere if you have a phone or a computer with an 
Internet connection.148 To access your Gmail using a computer, 
just type Gmail.com in the location bar of your browser and 
enter your user-id and password as directed.

Once you log in to Gmail, all your received emails will be visible 
in the Inbox. The other important folders you may need to 
access frequently are Sent, Drafts, Trash, and Spam. All email 
clients have some version of these folders with the same or 
similar names (Figure 170). As the names suggest, the Sent folder will have all your sent messages; 
Drafts will have the messages you composed but did not send; Trash will have all the messages 
you deleted; and Spam will have all the emails that the system has determined to be unwanted or 
unsolicited. Whenever you want, you can go back to a draft message, reword it, and send it out. Emails 
in the Trash folder will remain there for a period of time that depends on your email provider. If an 
email was mistakenly moved to the Trash folder, you can easily restore the message to your Inbox.

It’s useful to regularly check your Spam folder, particularly if you’re expecting an important email, 
to make sure that your legitimate emails have not ended up there by mistake. Email providers use 
machine learning algorithms to determine which emails are unwanted and unsolicited—phishing 
scams, messages from unknown senders, or messages containing malicious content. These algorithms 
can mistakenly label useful emails as spam.

In order to access or use Gmail, 
you must first create an account 
or sign in. 

148	 To hear about Gmail’s origin story, particularly how Gmail was released by its creator Paul Buchheit 
in one day, visit Aarthi and Sriram’s podcast episode page, https://www.aarthiandsriram.com/p/
the-man-who-created-gmail (accessed June 2023).

https://www.aarthiandsriram.com/p/the-man-who-created-gmail
https://www.aarthiandsriram.com/p/the-man-who-created-gmail
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FIGURE 170 — Folders are used to filter, archive, and delete email. Gmail folders (top) and Outlook folders (bottom).

To send an email to friends or colleagues, you only need their email addresses. In Gmail, clicking 
on the large “Compose” button in the top-left corner will open a new email window where you can 
enter the email addresses of your friends/colleagues in the list of recipients, write a subject, which is 
a summary of your email, and type your message in the body of the email. If you want to send a copy 
of your email to others, enter their addresses in Cc (carbon copy) field. The Bcc (blind carbon copy) 
field lets you send a copy of your email to people without other recipients being able to see the Bcc 
recipients’ email addresses. This is a very useful feature if you want to send an email to a group of 
people without revealing their email addresses to each other. 
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You can also attach files and photos to your 
email by clicking on the “Attach File” icon (a 
paperclip at the bottom) and then selecting 
files and photos (Figure 171). Finally, you 
just need to click the “Send” button to send 
the email to your recipients. Outlook and 
other email clients work similarly. Clicking 
on the “New Email” button (Figure 172) 
opens a window where you can enter 
the email addresses of recipients, add 
attachments (Figure 173), type your message and subject, and send the email by clicking on the 
“Send” button.

FIGURE 171 — When composing an email in Gmail, you can 
also attach files. 

FIGURE 172 — Similar to other email clients, in Outlook you can create new emails by clicking on the new email 
button. 

FIGURE 173 — Editing your email message, header, addresses, and attaching files in Outlook. 

Reading an email is as easy as clicking on the email in your Inbox (Figure 174). If you have any 
attachments in the email you have received, you can click on the attached file to view the attachment. 
Keep in mind, clicking on attachments from unknown senders can be dangerous as they may 
have malicious content. Though modern mail clients perform various checks to identify malicious 
attachments, you are the victim if your computer gets damaged or your information gets stolen. We 
will discuss this further later in this chapter. Once you have opened an attachment, you can download 
and save or print (Figure 175). 



Chapter 11—Email 223

FIGURE 174 — Attachments sent or received in Outlook are highlighted. 

FIGURE 175 — Once attachments are downloaded, printing and editing can take place. 

To make sure you don’t miss attachments sent with an email, both Outlook and Gmail prominently 
highlight the name and the document type of the attachments (Figure 176). 

FIGURE 176 — Attachments sent or received in Gmail are highlighted. 

After you finish reading the email, you can reply to the sender of the email by clicking on the “Reply” 
button. When you open any email, you have received in Gmail, you will see the option to “Reply,” 
“Reply all,” and “Forward” at the bottom of your message (Figure 177). You can also click on the dots 
in the top-right corner to open a context-sensitive window that will let you “Reply,” “Reply to all,” and 
“Forward.” As the names suggest, clicking on “Reply” (this is also represented with an arrow pointing 
to the left) will open a new email that has the email address of the sender in the “To” field and the 
original message from the sender quoted in the body of the message. You can also add additional 
recipients. Then type your reply and click the “Send” button. Clicking on “Reply to all” opens a new 
email with the sender’s email address and the email addresses of all other recipients of the original 
email in the “To” field. You must use “Reply to all” only when your reply is relevant to everyone on the 
email to avoid bombarding and annoying people with unnecessary emails. 
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FIGURE 177 — Gmail and similar clients allow users to reply, replay to all, or forward emails. 

Sometimes you may need to print an email. Thankfully, printing any message in your Inbox is easily 
achieved by clicking on the printer icon or using the print option in the context-sensitive window. In 
Outlook, right-clicking on your mouse will open a context-sensitive window that has the print option 
(Figure 178). You can also use the “File” tab at the top to print email messages. 

FIGURE 178 — Outlook and similar clients allow users to print emails by right-clicking on messages. 

The option to “Forward” message lets you send an email message you have received in your Inbox to 
others. Clicking on the “Forward” button (sometimes it is an arrow pointing to the right), will open a 
new email with the original message quoted in the body of the mail. You just need to add the list of 
recipients, type your message, and click the “Send” button to forward the email. 
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Organizing Email into Folders

We saw in the “File Management” chapter that folders 
are the essential mechanism to organize information 
on computers. Email also supports folders to organize 
email. By default, most mail services include an Inbox 
folder for all received mail; a Sent folder for all emails 
you send; and a Deleted or Trash folder for emails we 
delete. In addition to these folders provided by the 
email system, you can create folders to meet your 
needs. To create a new folder, right-click on a folder to 
bring up the context menu to create a new subfolder 
(see Figure 179).

To move email between folders, click the email in 
the inbox and drag and drop it into the folder of 
your choice. With a judicious choice of email folders, 
messages can be easily located.

FIGURE 179 — Creating new folders 
and subfolders in Outlook can aid in file 
management.

Mail Labels

Motivated by its search heritage and leveraging its superior search abilities, Google adopted the 
principle of “search over structure” to organize email. Google adopted the concept of using labels 
to organize email.149 Labels are tags that can be added to any email message.150 In Gmail’s approach, 
all messages remain in their default folders—inbox for incoming email, sent for outgoing messages, 
spam for undesired mail. Users can search messages by text, date, attachments, etc. To organize email, 
users can attach labels to a message by right-clicking the email and selecting one or more labels to 
attach to the message.

Though folders probably feel intuitive, arguments in 
favor of labels include the ability to attach more than 
one label to a message, and ease of locating messages 
using search compared to navigating folders to locate 
a message.

Gmail already gives you a few folders like Spam and 
labels such as Promotions and Social where emails 
are directed automatically. You can also easily create 
new labels depending upon your needs, such as Sales, 
Utilities, or Action Required. These can be added using 
the “create new label” menu item (Figure 180). The new 
labels will appear in the menu on the left. Once you 
create the label, you can right-click on any email to 

FIGURE 180 —In Gmail, labels can be 
created to organize emails.

149	 Google Workspace Learning Center’s page for “Organize and Find Emails,” https://support.
google.com/a/users/answer/9260550 (accessed June 2023).

150	 A useful page about labels, “Gmail Labels; Everything You Need to Know,” https://hiverhq.com/
blog/gmail-labels (accessed June 2023).

https://support.google.com/a/users/answer/9260550
https://support.google.com/a/users/answer/9260550
https://hiverhq.com/blog/gmail-labels
https://hiverhq.com/blog/gmail-labels
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bring up the context-sensitive menu and attach the label to the message. The message can now be 
found in the inbox as well as by selecting the label in the menu on the left.

As always, creating too many labels can also make it difficult for you to remember and categorize 
emails. A small set of well-selected labels is more than sufficient in most cases.

Mailing Lists

A mailing list is a feature used in email systems that allows messages sent to one email address to be 
delivered to another email address or a group of addresses. For example, you can create a list called 
“students@example.edu” that forwards emails to all students in the school, without having to include 
individual email addresses in the message. Your teacher may use a mailing list to inform all students 
and parents in the class about an upcoming activity. Your school principal may use a mailing list to 
inform all students in the entire school about an issue. Universities routinely use mailing lists for 
announcements to students, faculty, and staff. Mailing lists make email an extremely powerful service.

However, the convenience of mailing lists also results in everyone receiving tens of emails—personal, 
official, advertisements, and others—every day. This can make your inbox unmanageable and 
important emails difficult to find amidst the clutter. 

Mail Filters and Rules

Fortunately, some email clients, like Outlook, help you deal with email clutter by allowing you to 
create email filters to automatically move emails matching specific criteria to a folder and some, like 
Gmail, let you apply labels. This way, those emails don’t clutter your Inbox. 

To create a filter in Gmail, go to “Settings” (the gear icon in the top-right corner) and select the “Filters 
and Blocked Addresses” tab (Figure 181). Clicking on “Create a new filter” brings up a window where 
you can enter the filtering criteria. Once you select your criteria, click on Search to see the emails that 
will get filtered by the criteria. When you are happy with your filtering criteria, you can click “Create 
Filter” and decide what you want to do with the filtered emails—for example, move them to the 
“deleted items” or some other folder automatically. 
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FIGURE 181 — Creating a new filter in Gmail (Step 1–top) and (Step2–bottom).

Outlook and other email providers also offer similar features to allow you to filter emails. In Outlook, 
right-click on any email to categorize it into any of the available categories. 

Filters are called rules in mail clients such as Outlook. To create a rule in Outlook, just go to the “File” 
tab and click on “Manage Rules and Alerts.” A popup window opens allowing you to create new rules 
and modify existing ones (Figure 182).
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FIGURE 182 — In Outlook, email rules can be created to help automate processes. 

For example, you could automatically divert emails from mailing lists to a folder called “Lists” that you 
open once a week. This way, emails from your teachers that require your immediate attention will not 
get buried under promotional emails. 

Managing Signatures

An email signature is information that is automatically added at the end of an email. Signatures typically 
include contact information or personal touches such as a favorite quote. Creating signatures for your 
emails saves you the effort of typing basic details every time you send an email. This is particularly 
useful if you send emails to customers and would like to have your name, address, phone number, 
email, and company logo in the emails you send. 

To create signatures in Outlook, go to the “File” menu and select options. In the Outlook “Options” 
window, select “Mail” from the left-hand menu and scroll down to the “Signatures” section. In the 
“Signatures” dialogue box, you can click on “New” to create a new signature (Figure 183). 
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FIGURE 183 — The Outlook Signature and Stationery menu window allows users to create and edit signatures.

You can have a different signature for new 
messages compared to replies and forwards. 
To add a signature or change the signature of 
an email, go to the “Insert” tab at the top and 
click on “Signature.” Choose the signature 
you want to insert in your email (Figure 184).

To create signatures in Gmail, go to your 
account and click on the gear icon in the 
top-right corner of the page. Select “See all 
settings.” This brings up the familiar settings 
menu that we saw in Figure 181 when 
creating email filters. In the “General” tab, go 
down to “Signature” and create a signature 
by giving a name to your signature and adding the signature text (Figure 185). As in Outlook, Gmail 
also allows you to create separate signatures for new emails compared to replies/forwards. You must 
save the signatures by clicking on “Save Changes” at the bottom of the page to activate the signatures. 

FIGURE 184 — To insert a created signature in Outlook, go 
to the signature function under the Insert tab.
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FIGURE 185 — In Gmail, users can create email signatures under general settings. 

Email Sensitivity, Security, and Delivery Options

At times, you may want to send an email that is 
personal or confidential. Email clients can help 
maintain some level of privacy by disabling the 
common methods used to distribute messages, 
such as forwarding and printing. Users can still take 
screenshots of your messages and send those out if 
they choose, but only with additional effort.151 

In Gmail, you can use the confidential mode to 
protect sensitive information, so the recipients 
cannot forward, copy, print, or download messages. 
You can also require your recipients to receive a 
passcode from Google to see the message and set 
an expiration date for the message. To invoke these 
options, in the “Compose” email window, click on 
the “lock” icon at the bottom (Figure 186) to open 
the “Confidential mode” window (Figure 187). 

FIGURE 186 — Clicking on the lock icon at the 
bottom of the Compose email window in Gmail 
opens the email sensitivity option.

151	 For more information about Gmail’s confidential mode, see “Protect Gmail Messages With 
Confidential Mode,” https://support.google.com/a/answer/7684332?hl=en (accessed June 
2023).

https://support.google.com/a/answer/7684332?hl=en
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Similar options exist in Outlook. You can change 
the importance and sensitivity of an email—mark 
it “Personal,” “Private,” or “Confidential.” To access 
these options, when you open a new email window, 
go to the “Options” tab. Clicking on “More Options” 
will open the “Properties” window that has a range of 
security settings and delivery options (Figure 188). 
You can also make sure the email is not delivered 
before a certain date and set an expiration date for 
the message. 

FIGURE 187 — In Gmail, users can send confidential 
emails to protect information. 

FIGURE 188 — Under the Options tab in Outlook, users can change the importance, sensitivity, and delivery options 
of an email.
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Email Contacts

Contacts are people you communicate with. They are usually 
family, friends, and business associates. Contact management 
features of productivity applications allow you to save phone 
numbers, email addresses, mailing addresses, and other relevant 
information about your contacts for ready access. Most email 
services and clients let you save contacts and create groups 
of contacts to make it easy to send emails to your colleagues 
or friends. In Gmail, you can access contacts by clicking on the 
“Google Apps” icon in the top-right corner of the screen (it looks 
like a square made of nine smaller squares152) Figure 189. Click on 
“Contacts” to open the contacts manager. You can add and delete 
contacts. You can also group contacts by labeling them. You can 
create a label called Friends and add all your friends to it (Figure 
190). When you want to send an email to your friends, just type 
“Friends” in the To or Cc field to send an email to all your friends. 
This feature is tremendously useful when you send emails to 
contact groups frequently. 

FIGURE 189 — The contacts 
feature in Gmail helps to increase 
your efficiency when sending 
emails to colleagues. 

FIGURE 190 — In Gmail, changing the label of your email contacts allows you to add them to groups.

Automated Messages

A frequent need in work environments is to know when a recipient is busy or out of the office and unable 
to respond promptly to emails. This allows email senders to take alternate measures to complete their 
tasks. Email services allow you to send automated replies in these situations. Automated messages 
are preconfigured responses to all incoming messages. Automated messages tell folks emailing 
you that you are unable to reply—for example when you are on vacation or outside of the reach 
of the Internet. A best practice for automated messages is to share the contact information of your 
colleagues who cover for you while you are unable to respond to messages. This allows senders to 
reach out to your colleagues for any assistance to complete their tasks.

Since automated messages are commonly used when users are on vacation, they have come to be 

152	 This is called a waffle. For some context on the use of food icons on websites, see “How Did Food 
Get In My Website and Digital App?” https://bluezoocreative.com/2013/10/navigation-trends-
hamburgers-waffles-and-breadcrumbs/ (accessed June 2023).

https://bluezoocreative.com/2013/10/navigation-trends-hamburgers-waffles-and-breadcrumbs/
https://bluezoocreative.com/2013/10/navigation-trends-hamburgers-waffles-and-breadcrumbs/
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known as vacation responders, vacation messages, or simply out of office messages. To turn your 
vacation responder on in Gmail, click on the “gear” icon in the top-right corner and access settings. 
Under the “General” tab, scroll down to the “Vacation responder” and turn it on. You can set the start 
and the end dates of the vacation response and type your Subject and Message (Figure 191). 

FIGURE 191 — Gmail allows users to set up vacation responders.

Outlook and other email clients 
also have similar capabilities. 
To set your vacation response 
in Outlook, go to the “Files” tab 
and then click on the “Automatic 
Replies” tile to access the 
window that allows you to set 
automatic replies (Figure 192).

This completes our discussion 
of email. Email is one of the 
core technologies enabling our 
digital world, particularly at 
work. Email’s convenience and 
efficiency help professionals 
exchange information and 
speed up decision-making. 
Email’s archiving capabilities 
make it a valuable record-
keeping tool in organizations. 
Effective email use can greatly 
improve your productivity.

FIGURE 192 — Outlook allows users to set automatic replies.
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Using Calendars to Schedule Meetings and Tasks

We now introduce calendars. Calendars are productivity 
applications that help individuals and teams manage 
their schedules, appointments, and tasks. Calendars 
allow users to create and manage events; view schedules 
in various formats, daily, weekly, or monthly; schedule 
meetings; and share their calendars with colleagues or 
clients. Calendars are typically integrated with email, so 
we will discuss calendars alongside email.

To access Gmail’s calendar, open your Gmail and click on 
the “calendar” icon on the right pane (Figure 193). If the 
calendar opens as a pane to the right of the Gmail Inbox, 
you should click on the “Open in new” tab icon to make it 
easier to see your entire weekly calendar. 

If you want to schedule a meeting with others, click on 
the “Create” button and select “Event” (Figure 194). Since 
the Covid pandemic, videoconferencing capabilities have become tightly integrated with calendars. 
Google Calendar allows you to add Google Meet video conferencing to any meeting with up to a 
hundred attendees. You can click on “More options” to open a detailed window where you can enter 
the message you want to send to your attendees, specify the meeting and notification time, and add 
the location. When you click on “Save,” the meeting is added to your calendar and an email with the 
event information is sent to all invitees. This email is called a meeting invite. The email has options for 
the receiver to add the event to their calendar. 

FIGURE 193 — Gmail users can access a 
built-in calendar.
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FIGURE 194 — Creating an event in Google Calendar. Step 1(top)—create the event. Step 2 (bottom)—add details 
about the event.
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As you see in Figure 194, you can make the meeting recurring or non-recurring. Setting up a recurring 
meeting is useful if you plan to meet the same group of people regularly. For example, if your student 
club meets at the same time and place each week, setting up the club meetings as a recurring 
appointment can easily put all the club meetings for the year on every club member’s calendar with 
just one click. 

Microsoft’s Outlook software is also integrated with calendaring software that allows you to schedule 
audio and video meetings and create appointments to remind yourself of specific tasks. Click on “New 
Meeting” to open a window where you can specify all the details about the meeting, including the 
date and time of the meeting, recurrence, required attendees, optional attendees, location, and the 
message your attendees will receive (Figure 195). In businesses, Outlook is typically integrated with 
Zoom or Teams to allow you to create video meetings with ease as part of the event creation.

FIGURE 195 — Creating a new meeting in the Outlook calendar. Step 1 (top)—create the New Meeting. Step 2 
(bottom)—add details about the meeting.
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Clicking on the “Required” or “Optional” button of the meeting window opens another window—the 
address book—where you can pick the email addresses of your attendees and even book a location 
for your meeting (Figure 196). 

FIGURE 196 — Outlook users can utilize the address book to filter attendees.

If you are scheduling a meeting with your colleagues, you may have partial access to their calendars 
to be able to see when they are free. This allows you to schedule a meeting at a time that works for 
everyone. Click on the “Scheduling Assistant” tab to see when your attendees are free or busy in a 
grid format (Figure 197). Bold colors indicate times when a person is busy and gridlines indicate times 
when they may be free. You can change the time of your meeting or the day of your meeting to make 
it easy for others to attend. In Figure 196, both the required and optional attendees are free at 2:30 p.m. 
on Monday (January 30th). Once you pick a time that works for everyone, you can go to the “Meeting” 
tab and send the invitation.
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FIGURE 197 — The Outlook Scheduling Assistant can help users avoid scheduling conflicts.

Email Security
Before we close the chapter, it is useful to draw your attention to a few security concerns related 
to email. Most cybersecurity issues arise from individuals trying to reach your computer to steal 
information. Since email is a mechanism for users (including malicious users) to reach you, email has 
emerged as an important cybersecurity vulnerability. According to the data breach investigations 
report published by Verizon, over 80% of all computer breaches involve the human element.153 We 
highlight a few important cybersecurity considerations below. 

153	 The 2022 Verizon data breach investigations report can be accessed at https://www.verizon.
com/business/resources/reports/dbir/ (accessed June 2023).

https://www.verizon.com/business/resources/reports/dbir/
https://www.verizon.com/business/resources/reports/dbir/
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Phishing Attacks

Since we keep a lot of valuable personal information and company secrets digitally, cybercriminals 
have much to gain by tricking you into allowing them to use your credentials to steal information. 
Perhaps the most common method to do so is phishing. Phishing is the use of emails that appear to 
be from reputable companies but are designed to get users to reveal personal information, such as 
passwords and credit card numbers. A common method is to send emails that appear to be from a 
bank or ecommerce site asking you to refresh your credentials. When you click on the link and log 
into the site, the operators get your credentials, which they can use to make purchases using your 
account.

Phishing attacks come in the form of deceptive emails or text messages that may ask you to install 
software or divulge personal information. The attacks are increasing in frequency and getting more 
sophisticated and dangerous, so it is important to be watchful when you receive a suspicious email 
or text from an unknown person. Don’t be fooled by shopping and tax deals or shipments you are 
about to receive unless you are sure about the senders. Sometimes, you may also receive a phone 
message that lends credibility to the email or text message, adding to the urgency of the request. To 
get your personal information, criminals also create fake websites that look exactly like well-known 
and reputable government or business websites. The result of a successful attack can be disastrous.

In a notable case, Facebook and Google lost over $100 million in a phishing scam where a person in 
Lithuania tricked employees into wiring money to his bank account.154 This just goes to show that 
nobody is above these scams, not even people working in tech companies themselves. 

Spear Phishing

A spear phishing attack is more sinister and malicious because it is targeted at a particular individual. 
The cybercriminals often do their homework on social media; they know who you are—may know 
the names of your family members, managers, and friends. They may use your manager’s social media 
posts to make the attack even more directed. Let’s say you work in the purchasing department of a 
company and receive an email from your boss directing you to buy supplies in a hurry—to create a 
temporary invoice, approve it, and send $1000 to an account. The attacker may even customize the 
message and say, “I talked to our director, Jane, who is at her daughter’s wedding. She’s good with 
it and will sign off when she comes back to work next week.” In this example, the hacker knows that 
your manager is traveling, and his boss is at her daughter’s wedding and won’t be back at work for 
some time. The criminals might even have hacked your boss’s email account and were just waiting for 
the perfect moment (when he is traveling, and his boss is at an important event) to send the email 
from his address. 

Targeted attacks can be particularly difficult to detect, so it is important to spend some time and 
pay attention to small details, like the tone of the request. Have you ever received a request like that 

154	 This is the case of Evaldas Rimasauskas, who was prosecuted in 2019. You can read about it 
at https://www.reuters.com/article/us-cyber-fraud-tech/lithuanian-pleads-guilty-in-u-s-to-
massive-fraud-against-google-facebook-idUSKCN1R12FB (accessed June 2023).

https://www.reuters.com/article/us-cyber-fraud-tech/lithuanian-pleads-guilty-in-u-s-to-massive-fraud-against-google-facebook-idUSKCN1R12FB
https://www.reuters.com/article/us-cyber-fraud-tech/lithuanian-pleads-guilty-in-u-s-to-massive-fraud-against-google-facebook-idUSKCN1R12FB
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from your manager/friend in the past? Run the request by your manager or someone similar. Just like 
banks and other institutions that use multiple ways to authenticate users, even you should employ 
relevant means to validate unusual requests by talking to others or running the request by specialists 
who deal with cybercriminals regularly.155 

Emails Don’t Go Away

Your email communication serves as a system of record from a legal perspective. When you send a 
mail, a copy of it is retained on your provider’s email servers as well as at the receiving end. Even if 
you delete sent emails, they remain on the servers and in the inboxes of your recipients. As only you 
are expected to be able to send emails from your address, any message you send is a written record 
of your intent and is admissible as digital evidence in most courts. Therefore, before you send out an 
email, always remember the permanence and system of record aspect of emails. Also, it is important 
to re-read important emails a few times for tone, intent, and accuracy. The written word generally 
appears less polite than the spoken word. When in doubt, be extra polite when writing emails.

Because of the ease with which we can send emails, we sometimes end up writing things we may 
regret later. Emails do not communicate your facial expressions. You may call your boss “a tough boss” 
jokingly in his presence. However, writing the same thing in an email may take on a serious note and 
may be construed as rude or even threatening. Many people make a rule of never sending an email in 
anger. If you do type an angry email, let it sit there for a day or two before you hit the “Send” button.

155	 A colleague of one of the authors of this book, a professor at a university, became a victim of 
a phishing attack and lost $500. He was asked to buy iTunes in a hurry as a birthday gift. These 
attacks are all around us.
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			   Chapter Terms and Definitions

Attach File: A feature in the email client that 
allows users to share files through email messages

Desktop Mail Client: Desktop mail clients 
connect to mail servers, downloads email 
messages, and display them to the user on 
desktop computers

Draft (Email Folder): A folder within the email 
client where messages that are created but not 
sent are stored

Email Address: Email addresses are uniquely 
assigned or created by users, and are used to 
send emails to specific users or parties

Email Contact: A list of colleagues, friends, or 
other users, found within the email client, that 
have previously interacted with your email 
address, are saved as email contacts

Forward: To send an email to someone else or 
a different address after you have received it; 
forward allows you to type in a whole new set of 
recipients

Internet Message Access Protocol (IMAP): 
Provides ease of access to emails from any location 
or device without the need of downloading it to 
your hard drive

Inbox: A repository, within the email client, for all 
received emails

Mail Client: A software program that allows you 
to manage and send electronic messages (emails)

Mail Server: Servers tasked with handling the 
data and traffic of email client users; these servers 
handle the backend operation of email clients

Messages (Emails): Electronic forms of 
correspondence that allow users to communicate 
and share files through the Internet

Mobile Mail Client: Mobile mail clients offer 
portable connection to mail servers and the 
ability to download and display email messages 
by utilizing mobile computing devices

Phishing Attack: An attempt to steal information 
from victims through the use of social engineering 
techniques and various communication channels

Reply: To answer; reply only sends the new 
message to the original sender

Reply All: To answer; reply all sends the new 
message to the original sender and all other 
recipients on the To and Cc lines

Scheduling Assistant: Email scheduling 
assistants help users identify availability for 
meetings, this allows users to schedule in advance 
while increasing attendance

Send: The action of an email client sending a 
message to the mail server, which then forwards 
it to the recipient’s server

Sent (Email Folder): After you send an email 
message, you might want to find that email; your 
email service stores those messages in the Sent 
Items folder

Signature: Email signatures allow users to 
customize personalized messages that are 
appended to the end of emails, and typically 
contain the users name and contact information
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Spam (Email Folder): A folder, within the 
email client, where messages that are deemed 
unwanted or unsolicited are sent

Spear Phishing: An attack used to steal the 
personal information of a specific target or person; 
the defining characteristic of spear phishing is 
that the attack is targeted for a specific purpose; 
named after a phishing method

Trash (Email Folder): Items that you delete are 
moved to the Trash folders, but aren’t permanently 
deleted until those folders are emptied
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		  	 Chapter Case

I’m Admitted to USF!
Carl is ready to graduate high school and has applied for admission to the University 
of South Florida. He has waited weeks to hear from the admissions office and today 
he finally received an email in the inbox of his high school account. Take a close 
look at the following email:

Question 1: What information in this email is unusual and what kind of attack is 
this? Why is the information unusual?

Question 2: Why do you think there is a link in the email asking Carl to fill out a 
Federal Student Aid application? 
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It may not always be profitable at first for businesses to be online, but it is certainly 
going to be unprofitable not to be online.

—Esther Dyson, investor, philanthropist

Overview
The Internet has been around since the early 1970s. In the early years, the Internet only supported plain 
text and using the Internet required users to learn the precise syntax of several computer commands. 
For example, to send an email to user jane@example.com required users to type the command: mail -s 
“mail subject” jane@example.com <<< “Mail body.” Most users found this too challenging and the 
only users on the early Internet were computer science researchers at universities.

This changed in 1989 when Sir Tim Berners Lee proposed and demonstrated an information 
management system in 1989 based on hyperlinks.156 Users could click on links to navigate to other 
pages.157 By 1993, Tim Berners Lee158 had specified the first version of HTML, which made information 
sharing as easy as clicking a link on a page. During December 1992–March 1993, Marc Andreesen (a 
student) and Eric Bina (a graduate) of the University of Illinois at Urbana-Champaign (UIUC), both 
working at the National Center for Supercomputing Applications (NCSA) at Urbana-Champaign, built 
the Mosaic web browser.159 They also added the “img” tag to html to handle images160 and released 
the web browser to the Internet. The browser soon became immensely popular and acquired the 
status of a killer application that popularized the Internet.161 Sites like Yahoo offered directories for 
users to find content on the emerging World Wide Web.

Since then, the Internet has become increasingly user friendly as HTML has improved,162 adding 
support for images and videos. This has made the Internet and World Wide Web a powerful force 

156	 This overview is from CERN, the birthplace of HTML and HTTP https://home.cern/science/
computing/birth-web/short-history-web (accessed June 2023).

157	 The first webpage, created by Sir Tim Berners Lee is at http://info.cern.ch/hypertext/WWW/
TheProject.html (accessed June 2023).

158	 Wikipedia’s page on Tim Berners Lee is at https://en.wikipedia.org/wiki/Tim_Berners-Lee 
(accessed June 2023).

159	 NCSA also published one of the first HTML tutorials. It is a simple document, perhaps the best 
introductory documents to learn HTML. An entire generation of enthusiasts, including the 
authors of this book learned HTML from this document. It is archived at http://seismo.berkeley.
edu/~rallen/resources/html/HTMLPrimerAll.html (accessed June 2023).

160	 Marc Andreesen’s message of Feb 25, 1993, proposing the img tag is at, http://1997.webhistory.
org/www.lists/www-talk.1993q1/0182.html (accessed June 2023). An interesting feature of 
this thread is that Time Berners Lee responds to the proposal by suggesting that the tag is 
unnecessary

161	 You can read about Eric Bina on Wikipedia at https://en.wikipedia.org/wiki/Eric_Bina (accessed 
June 2023). and on MIT at https://lemelson.mit.edu/resources/marc-andreesen-and-eric-bina 
(accessed June 2023).

162	 A quick overview of the evolution of HTML is at https://www.washington.edu/accesscomputing/
webd2/student/unit1/module3/html_history.html (accessed June 2023).

mailto:jane@example.com
mailto:jane@example.com
https://home.cern/science/computing/birth-web/short-history-web
https://home.cern/science/computing/birth-web/short-history-web
http://info.cern.ch/hypertext/WWW/TheProject.html
http://info.cern.ch/hypertext/WWW/TheProject.html
https://en.wikipedia.org/wiki/Tim_Berners-Lee 
http://seismo.berkeley.edu/~rallen/resources/html/HTMLPrimerAll.html
http://seismo.berkeley.edu/~rallen/resources/html/HTMLPrimerAll.html
http://1997.webhistory.org/www.lists/www-talk.1993q1/0182.html
http://1997.webhistory.org/www.lists/www-talk.1993q1/0182.html
https://en.wikipedia.org/wiki/Eric_Bina
https://lemelson.mit.edu/resources/marc-andreesen-and-eric-bina 
https://www.washington.edu/accesscomputing/webd2/student/unit1/module3/html_history.html
https://www.washington.edu/accesscomputing/webd2/student/unit1/module3/html_history.html
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for information sharing and commerce, no longer limited to specialized users familiar with exotic 
computer commands. Today over 5 billion people, over 60% of the world’s population, use the Internet, 
primarily because HTML and related technologies have made it easy, inexpensive, and meaningful for 
anyone anywhere in the world to access the web.

This chapter introduces HTML, the primary end-user technology used on the web.

What is HTML?
HTML (Hypertext Markup Language) is the standard markup language used for creating webpages 
and web applications. A markup language is a 
computer language that is used to apply layout and 
formatting conventions to a text document. The 
HTML markup language makes text on webpages 
more interactive and dynamic. HTML allows us to 
specify the placement of images, tables, links, etc. 
on webpages using simple text descriptions. HTML 
provides the structure and content of a webpage, 
specifying how text, images, hyperlinks, tables, 
and other media should be displayed on a browser. 
When you visit a website, say http://www.google.
com, returned is an HTML page (Figure 198). Your 
browser can understand the page specifications 
defined in HTML and is able to render it as a 
webpage that you can see and interact with.

Hypertext163, 164 means “text within text.” In the context of the World Wide Web, hypertext refers to text 
with a link to another page within it. Hypertext is the Internet’s way to link two or more webpages 
(HTML documents) with each other.

Figure 198 — The Google homepage is an example 
of an HTML page.

163	 The term “hypertext” has a Florida association. It was coined by Ted Nelson in 1965. In 1963, 
when he got the idea, Nelson was documenting research at the John C. Lilly Dolphin lab in 
Miami (https://web.archive.org/web/20150506080854/http://hyperland.com/TNvita) (accessed 
June 2023). Hypertext was defined as “A body of written or pictorial material interconnected in 
such a complex way that it could not conveniently be presented or represented on paper.” Nelson 
could foresee that “[hypertext] could grow indefinitely, gradually including more and more of the 
world’s written knowledge.” Hypertext was seen as a file system that, unlike file systems such 
as those used in Windows and Macs, “[allowed] file contents to be arranged any-which-way, and 
in any number of ways at once.” Unfortunately, Nelson’s lack of technical expertise prevented 
him from implementing the idea. Modern hyperlinks are seen as one-sided versions of Nelson’s 
proposed two-sided links. Ted Nelson’s hypertext idea may have greatly influenced the design of 
modern personal computers, https://archive.nytimes.com/bits.blogs.nytimes.com/2007/12/11/
when-big-blue-got-a-glimpse-of-the-future/ (accessed June 2023).

164	 Nelson, Theodor Holm (August 1965). “Complex information processing: a file structure 
for the complex, the changing and the indeterminate.” ACM ‘65: Proceedings of the 1965 
20th National Conference. ACM: 84–100. doi:10.1145/800197.806036, https://dl.acm.org/
doi/10.1145/800197.806036 (accessed June 2023).

http://www.google.com
http://www.google.com
https://web.archive.org/web/20150506080854/http://hyperland.com/TNvita
https://archive.nytimes.com/bits.blogs.nytimes.com/2007/12/11/when-big-blue-got-a-glimpse-of-the-future/
https://archive.nytimes.com/bits.blogs.nytimes.com/2007/12/11/when-big-blue-got-a-glimpse-of-the-future/
https://dl.acm.org/doi/10.1145/800197.806036
https://dl.acm.org/doi/10.1145/800197.806036
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To see the HTML code that defines the page, you can right click on your webpage (on most browsers 
such as Google Chrome or Mozilla’s Firefox) and choose “View Page Source.” This will bring up text 
specification of that webpage. (Figure 199).

FIGURE 199 — Users can view the webpage source to see the website’s HTML 
text (top). The HTML text in the bottom image is crucial to the operation and 
display of Google’s web browser.

HTML has been an Internet standard since 1993, and all common browsers (e.g., Google Chrome, 
Apple Safari, Microsoft Internet Explorer, and Mozilla’s Firefox) understand HTML. So, when you visit 
any page written in HTML, say http://www.google.com, on any browser, they all receive the same 
text, and the page looks the same on all these browsers. For example, the Google home page looks 
the same on all browsers.165

HTML is a crucial part of the web and forms the foundation of all webpages. HTML uses tags to define 
elements. Tags can have attributes to further describe elements. These tags and attributes are used 
to create the visual and semantic structure of a webpage. Though HTML is primarily designed for 
machines to interpret, as you will see in this chapter, its simplicity makes it easy even for humans to 
understand the content. 

165	 Browsers introduce minor individual tweaks, for example in their choice of default fonts. 
Commercial websites are tested for performance on all browsers to account for these tweaks. 
But for the purposes of this book, we treat all browsers as identical.

http://www.google.com
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Virtually all information and tools are presented to end users as webpages. You access your school 
resources on the web, check email on the web, track bank accounts on the web, your teachers enter 
your grades on the web, and so on. All these webpages are created using HTML. Therefore, HTML is a 
foundational technology that all modern professionals will find useful.

In this chapter, we will review the basic elements you need to know to create HTML pages and review 
the editors that make it easy to build webpages. If you find this chapter interesting and would like 
to learn more about HTML and creating webpages, you should also take advantage of free online 
tutorials like W3Schools to learn HTML in more detail,166 as it is not possible to cover all tags and 
attributes in a chapter.

Structure of an HTML Page

HTML is a simple language. It essentially encloses 
text within tags to tell the browser how to render 
the enclosed text. For example, the browser will 
render <b>this is bold text</b> as this is bold 
text. <i>this is italicized text</i> will be rendered 
as this is italicized text. You don’t need fancy editors 
to create an HTML page. You could create an HTML 
page by typing HTML commands on a notepad 
and saving the file as .html (a file with an html 
extension). All HTML pages follow the same basic 
structure. They contain a DOCTYPE declaration at 
the top, followed by an HTML section. The HTML section comprises of a HEAD and BODY. Figure 200 
shows a basic example.

The contents of Figure 200 are interpreted by the browser as follows:

DOCTYPE Declaration: This is the first line of an HTML page, and it tells the browser what kind 
of document to expect, particularly, which version of HTML.

HTML tag: All code in HTML is declared using tags. A tag is a special keyword that is enclosed 
by <>. The HTML tag defines the start and end of an HTML document. Everything in the HTML 
document is nested within the opening and closing HTML tags, i.e., between <html> and </
html>. Tags are closed with the “/” symbol in the tag, Thus, </html> indicates the end of the 
section that began with the <html> tag.

Head tag: The head tag contains information about the HTML document that is mostly not 
displayed to the user. This section includes the title of the page, any information about the 
page such as author information and version history (this is often called meta information), 
information about the look and feel (called stylesheets), and information about user interactions 
(specified using a language called JavaScript). You can also include additional description and 
relevant keywords about your webpage within the head tag, so search engines can more easily 
identify your page. The only content within the head that is displayed to the user is information 
within the title tag, which is displayed as the title of your browser tab.

Figure 200 — The basic structure of an HTML page 
includes the DOCTYPE, HEAD, and BODY.

166	 The W3Schools HTML tutorial is at https://www.w3schools.com/html/default.asp (accessed 
June 2023).

https://www.w3schools.com/html/default.asp
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Body tag: The body tag contains all the content that is displayed to the user. This includes text, 
images, links, and other HTML elements. When you build your HTML page, you will spend most 
of your time within the body. This is also the section we discuss the most in this chapter.

Elements in HTML

Like most electronic documents, webpages have text, images, tables, and links to other pages. The 
text may be bold, italicized, and use different font sizes. You might see ideas listed as bullet points 
or numbered lists. You may also see forms, with different input elements for you to fill in. You can 
represent each of these elements with HTML tags and build a complex HTML page that asks users to 
enter data and then sends the inputted data to a server for further action.

Here are a few essential tags to get you started. 

·	 The paragraph <p> tag is used to define a block of text as a paragraph. The text within the <p> 
tag is displayed as a separate paragraph, with a line break before and after it (Figure 201). The 
text within the paragraph tag can include any type of content, such as text, images, links, or 
other HTML elements.

FIGURE 201 — Using the <p> tag creates a paragraph. 

When creating a paragraph, you could use attributes to further specify the kind of paragraph 
you want. To create a paragraph with text in red color, try this:

<p style=“color:red;”> This is a red paragraph.</p>

·	 Heading tags: Headings are the essential mechanism to create structure within pages. HTML 
supports headings with six levels of headings, ranging from <h1> to <h6>.167 The <h1> tag 
represents the main heading on a page and is typically used for the page title, while the other 
headings <h2> to <h6> are used for subheadings. It is best practice to not skip heading levels, 
i.e., subsections of <h1> should use <h2>, not <h3> or <h4> etc. Figure 202 shows an example.

167	 Headings have another use, they indicate the organization of the page to assistive technologies. 
You can read about this at https://www.w3.org/WAI/tutorials/page-structure/headings/ 
(accessed June 2023).

https://www.w3.org/WAI/tutorials/page-structure/headings/
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FIGURE 202 — Heading tags are useful for separating titles and subheadings. 

·	 Bold <b> tag is used to bold text. 

·	 The underline <u> tag is used to underline text.

·	 The delete <del> or <strike> tag is used to visually strikethrough text (Figure 203). 

FIGURE 203 — Strikethrough tags are useful for visualizing text that is no longer relevant. 

·	 The subscript <sub> and superscript <sup> tags are used to display text as subscript or 
superscript (Figure 204). These tags can be helpful to display scientific formulas. 

FIGURE 204 — Subscript tags are useful when displaying chemical formulas.

Adding Links

Hyperlinks are the unique distinguishing feature of HTML. Hyperlinks allow you to click on a link on 
a page and immediately navigate to another page that could be hosted anywhere in the world. The 
<a> tag stands for “anchor” and allows you to add hyperlinks to an HTML page. 
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The <a> tag has a required attribute to specify the target page. The target page is specified using the 
href attribute, giving the URL of the page or the resource you want to link. For example, to create a 
link to the homepage of the New York Times website, you can use the code shown in Figure 205:

FIGURE 205 — An anchor tag allows users to link web addresses.

When this code is rendered on a web browser, the user can click on “The New York Times” to go to the 
website.

Adding Images

You can add images to your HTML page with an <img> tag. Like the <a> tag, the <img> tag also has 
a required attribute, tht specified the image file to be displayed. You need to have the source (src) 
attribute to give the location of the image, so the browser can get the image and display it on the 
webpage. Optionally, you can also have other attributes like width and height parameters to tell the 
browser how large the image should be on the page (Figure 206).

Images draw the attention of visitors. So, not surprisingly, company logos, background images, and 
advertisements are carefully and tastefully designed to draw the attention of visitors and convey the 
right message about the site to them.

FIGURE 206 — Users can add images and adjust the image size in HTML. 
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Creating Lists

To create lists in HTML, such as a list of things to buy, places to visit, or people to invite, HTML offers 
two options—bulleted lists and numbered lists. You have the <ul> tag for unordered (bulleted) lists 
and the <ol> tag for ordered (numbered) lists. You can indicate the list items with the <li> tag and 
nest lists within lists (Figure 207). 

FIGURE 207 — Nested lists using bulleted or numbered lists in HTML make it easy for users to identify sections. 

Creating Tables

To display structured data, such as price lists, club memberships, class enrollments etc., HTML supports 
tables. Tables are created using the <table> tag. Tables have some additional necessary elements to 
specify rows and cells. The <tr> and <td> tags define the rows and cells of the table, respectively. 
You can also use the <th> tag to define table headers, which are typically bolded and centered. A 
<table> will have one or many <tr> tags, indicating the rows in the table. Each <tr> in turn encloses 
many <td> tags, indicating the cells within the row. The <td> tag represents a cell and encloses the 
contents of the cell (Figure 208).
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FIGURE 208 — Users can create tables in HTML to help organize data. 

Creating Forms

Forms are the principal mechanism to get user inputs on webpages. Creating forms on webpages 
is exciting because it allows your users to interact with the webpage and submit information for 
processing. Almost all your favorite webpages have forms where data can be entered. Through forms, 
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users can enter text, numbers, dates, and upload 
files. Users can also press buttons, tick checkboxes, 
and choose radio buttons. The Google.com 
homepage, probably the most famous webpage in 
the world, is just a simple form with an input field 
where you can enter your search query. The page 
is essentially a form with a text input element and 
two buttons (Figure 209).168

Forms are created using HTML code. Later in this 
chapter, we will see how they can be styled and 
customized using CSS stylesheets. When a user 
submits a form on an HTML page, the data is sent to a server for processing or storage in a database. 
For example, when you search for “Movies to watch” on Google.com, your input into the form is taken 
and sent to a Google server. The server then responds with the answer to your search query.

Forms are used in a variety of contexts. Common forms include login and registration forms, search 
forms, contact forms, feedback forms, and e-commerce checkout forms. They are an essential part of 
web development and enable webpages to collect data, provide a personalized user experience, and 
perform various actions based on user input.

Forms are created using the <form> tag. Every form also has multiple <input> tags to specify the kind 
of input you want from the user. These <input> elements can be text, number, file, or image. Each of 
these can be specified by choosing the right value for the “type” attribute of the <input> tag. The data 
collected in a form is sent to the server for processing using the action attribute of the form tag.169

In the example in Figure 210, we have a simple form to collect the first name and last name of the user. 
When the “Submit” button is pressed after entering the first and last names, the form data will be sent 
to the processor located at server_submit.php. The processor will respond after processing the name, 
for example by saving it in the database, and customizing the response with the name, etc.170 

Figure 209 — Google.com has one input field and 
two buttons allowing users to interact with the 
webpage and the server. 

168	 The ‘I’m feeling lucky’ button on Google’s home page has an interesting history. Most users do not 
use it, but it is a founder favorite. You can read about it at https://www.howtogeek.com/847170/
googles-im-feeling-lucky-explained/ (accessed June 2023) and https://content.time.com/time/
business/article/0,8599,685801,00.html (accessed June 2023).

169	 Forms generally use the capability of HTTP (hypertext transfer protocol) to upload data from the 
browser to the server. This is specified using the POST method attribute of the FORM tag. We 
ignore this detail in this book.

170	 The ids (unique Id) of elements you see in the form help the processor associate inputs with the 
fields. These ids should, therefore, be unique for forms to work as expected. 

https://www.howtogeek.com/847170/googles-im-feeling-lucky-explained/
https://www.howtogeek.com/847170/googles-im-feeling-lucky-explained/
https://content.time.com/time/business/article/0,8599,685801,00.html
https://content.time.com/time/business/article/0,8599,685801,00.html
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FIGURE 210 — Users can create multiple forms in HTML to collect different types of input. 

To create a multi-line input element, use the tag “textarea.” You can also specify how wide and tall this 
text box should be using “rows” and “cols” attributes.

To create a dropdown that allows users to select from a list of things, you can use the select tag 
(Figure 211). 

FIGURE 211 — Using the select tag, users can create dropdown menus in HTML. 

There are additional form input types to handle common input scenarios. A radio button is a great 
choice if you want to give users multiple choices, but you want them to pick only one option. The 
concept of a radio button dates to radios that had 
mechanical buttons to select a station. You could 
only select one button at a time. If you pressed 
another button, then the previously pressed 
button would pop out automatically. This concept 
has carried over to HTML forms and such selectors 
are called radio buttons, tracing their lineage. So, 
even though you may see many options, selecting 
a new option will deselect your previous choice. 
Figure 212 shows an example.

HTML forms are similar to car radios. Both can have 
multiple buttons/fields to receive input.
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FIGURE 212 — Similar to actual radio buttons, even HTML radio buttons can only allow one input at a time, clearing 
the previous options. 

The “Checkbox” element in HTML derives its name 
from paper forms with checkboxes. You can select 
one or many checkboxes. Similarly, creating a 
“Checkbox” element in HTML will allow your users 
to select one or more choices (Figure 213). 

Checklists make receiving user input simple while 
recording the data.

FIGURE 213 — Users can create checklists in HTML by using the checkbox element. 

If you want users to enter a date, you may want to use the “Date” element. Your browser will recognize 
this element and display a calendar (Figure 214). Once a date is selected, the browser updates the 
field with the selected date.
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FIGURE 214 — Date fields include inputs for the day, month, and year. 

Cascading Style Sheets (CSS)
The HTML we have created thus far is functional, but 
bland. We now look at CSS, which is the standard 
way to make webpages stand out with color and 
design. CSS stands for Cascading Style Sheets and 
is used to describe how HTML elements are to be 
displayed on screen, paper, phones, iPads, or in 
other media. The design of CSS saves the developer 
time by allowing the layout of multiple webpages 
to be controlled all at once. In a few examples 
we have specified the height and width of the 
image. See Figure 206. While this was convenient 
for the example, imagine trying to decide how 
every element should look across multiple pages 
on your website. When you add tags like <font> 
and <color> attributes to HTML, you will have a 
nightmarish experience trying to remember the 
color and other attributes of other similar elements 
on your page. Your webpage may end up looking 
inconsistent if you are not careful. Besides, the 
HTML file will be huge and messy. It gets worse. If 
you decide to change the colors or font styles on 
your site, you would have to update the look and 
feel of every such element on your page.

To avoid these problems, the best practice is for 
developers to define all their styles in a CSS file that 
they then link to their HTML documents. In this 
way, every “Submit” button on all webpages across 
your site will use the same size and color and every 
header will be of the same font size and style. 

To see how CSS works, let’s begin by trying to add 
some basic styling effects to our HTML document 
within the style tag as shown in Figure 215.

Figure 215 — Utilizing style in HTML allows users 
to personalize webpages. Here is the HTML (top) 
and its result (bottom).
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W3Schools is a great resource to learn about styles.171 You can tweak more aspects about the look and 
feel of your webpage than you can imagine. Once you develop some comfort with CSS, the next step 
to improve your productivity as a web developer is to create a separate CSS file (Figure 216) and then 
link it to your HTML file as shown in line 4 of Figure 217. 

  

FIGURE 216 — CSS files include styles and 
attributes that affect normal HTML elements. 

             

FIGURE 217 — Users can link stylesheets to HTML to 
reduce clutter in the HTML text.

Website Design and Storyboarding
Websites are collections of individual webpages that accomplish a specific purpose. For example, the 
website of your school district, say https://www.hillsboroughschools.org/ or your school, say https://
kingib.org/ has several pages that provide all the information and interaction students and parents 
expect from the school or school district.

When you visit a website (say, www.google.com), there are servers (owned and managed by a service 
provider) waiting for you to reach out to them. To support all their users and their requests, websites 
have a collection of webpages that are connected to one another through weblinks. This way, when 
you go from one Google webpage to another, you have a seamless experience. 

For example, when you search for a book on Google, you see a collection of results. If you click on 
a Google sponsored ad after reviewing the results, another result page opens. The entire flow is 
managed by multiple Google webpages and application programs that handle these user requests.

To accomplish this, websites should be coherent, easy to navigate, and accomplish what you set out 
to do. The same need for coherence and ease of use applies to much larger sites where you write 
your blog, sell your products, or promote your company. Building a website is a resource-intensive 
exercise. You must plan, build, and deploy your website. Just like you wouldn’t start constructing a 
house without having a plan, you don’t want to build a website on the fly. Therefore, once you learn 
the elements of webpages including HTML and CSS and are ready to build a website, it is a good idea 
to start with storyboards.

171	 The W3Schools CSS tutorial is at https://www.w3schools.com/css/default.asp (accessed June 
2023).

https://www.hillsboroughschools.org/
https://kingib.org/
https://kingib.org/
http://www.google.com
https://www.w3schools.com/css/default.asp
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Storyboards are visual representations of creative projects.172 When used with websites, storyboards 
help all members of the development team identify all the users of a website and their expected 
interactions.173 Once storyboards are developed, they are usually communicated using wireframes. 
Wireframes are illustrations of the webpage that focus on space allocation for the elements of the 
page and their intended behaviors.174 Wireframes are intended to be simple and disposable and 
typically do not include any styling, color, or graphics.

Storyboards and wireframes are both important tools in the design and development process of a 
website, but they serve different purposes and are used in different contexts. Storyboards are about 
the storytelling and visual components and wireframes focus on the user interface and interaction 
aspects of a website. For large scale projects, you should first do storyboarding before moving on to 
wireframing tools.

While storyboarding evolved from film and drama, the concept has found a home in website 
development. It is useful to understand the high-level overview and flow of the webpages and 
visualize the user experience. Once you and your team agree about the flow, you can then move to 
wireframing the design.

A wireframe outlines the structure and content of a website without including design elements such 
as colors, typography, or images. Wireframes are created during the planning phase to help designers 
and developers identify and address potential design and usability issues.

Wireframes typically include boxes and lines to represent the placement of different elements on the 
page, such as headers, navigation menus, content sections, and calls to action. Balsamiq175 is a popular 
wireframing software that lets you quickly wireframe your webpages and then share it with your team 
and customers to get their feedback before investing development effort to create the website (Figure 
218). Wireframing tools such as Balsamiq offer templates to pick, drag, and drop different webpage 
elements and put them on the screen to quickly develop wireframes. You can use wireframes to 
design browser-based webpages or for mobile apps like IOS or Android. Building wireframes to refine 
application concepts is an excellent, low-effort, no-cost way to test new application ideas.

172	 You can read about the origins of storyboards, and how Walt Disney and his team originated the 
concept in 1933 to convey the story of “Three Little Pigs” at https://www.instructionaldesign.
org/concepts/storyboarding/ (accessed June 2023).

173	 A good description of storyboards and their use is at https://www.capterra.com/resources/
what-is-a-storyboard-in-web-design/ (accessed June 2023).

174	 The US federal government’s usability website has a nice introduction to wireframing at https://
www.usability.gov/how-to-and-tools/methods/wireframing.html (accessed June 2023).

175	 https://balsamiq.com/ has an excellent tutorial on wireframing and user interface design at 
https://balsamiq.com/learn/courses/intro-to-ui-design/ (accessed June 2023).

https://www.instructionaldesign.org/concepts/storyboarding/
https://www.instructionaldesign.org/concepts/storyboarding/
https://www.capterra.com/resources/what-is-a-storyboard-in-web-design/
https://www.capterra.com/resources/what-is-a-storyboard-in-web-design/
https://www.usability.gov/how-to-and-tools/methods/wireframing.html
https://www.usability.gov/how-to-and-tools/methods/wireframing.html
https://balsamiq.com/
https://balsamiq.com/learn/courses/intro-to-ui-design/
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FIGURE 218 — Software, like Balsamiq, allows users to design outlines of webpages without committing to code. 

Another popular wireframing tool, Figma, was acquired by Adobe in September 2022 for $20 billion.176 
Figma not only lets you wireframe and collaborate with colleagues but also automatically converts 
your wireframe design into a working HTML website that you can later deploy to your webhost.

Structure of a Website
Once you learn HTML to build webpages and create storyboards and wireframes for your idea, you 
may be interested in creating your website so it can be viewed by anyone in the world. We now 
provide an overview of the elements of a working website.

If you want to create a website, your website admin (or you) will need to have a webserver (e.g., Apache 
webserver177) to host the website.178 You will need to save your HTML pages and other supporting files 
in an organized folder structure on the webserver. We will now discuss the basic structure of a website 
so you can understand how all the elements of a site are integrated together.

It is a good idea to include the folder structure of your website in your wireframe, so it is easy to see 
how it is organized on your webserver. Figure 219 shows an example of the folder hierarchy of a 
website and how it ties to the different sections of the site together. 

176	 You can read the announcement at https://news.adobe.com/news/news-details/2022/Adobe-
to-Acquire-Figma/default.aspx (accessed June 2023).

177	 The Apache webserver, which traces its origins to the first webserver built by Tim Berners Lee 
at CERN, is extremely robust and easy to install. If you have access to a personal computer, 
installing the Apache webserver and becoming familiar with its use is delightful learning. You 
can learn more and download Apache from https://httpd.apache.org/ (accessed June 2023).

178	 You can read more details online, including at GoDaddy’s page, https://www.godaddy.com/
garage/how-to-build-a-website-with-html-and-css/ (accessed June 2023).

https://news.adobe.com/news/news-details/2022/Adobe-to-Acquire-Figma/default.aspx
https://news.adobe.com/news/news-details/2022/Adobe-to-Acquire-Figma/default.aspx
https://httpd.apache.org/
https://www.godaddy.com/garage/how-to-build-a-website-with-html-and-css/
https://www.godaddy.com/garage/how-to-build-a-website-with-html-and-css/
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FIGURE 219 — Wireframes allow users to visualize projects, dependencies, and structure in the planning phase.

It is useful to maintain a consistent organization for the files within each folder. Figure 220 shows 
a popular organization structure for the files in a folder. The starting point of your application or 
website is typically called the “Root” folder of your site. A file called “index.html” is displayed by default 
if someone visits your website and does not specify a specific file name.179

FIGURE 220 — Webserver folder structures vary depending on the content and purpose of the website. 

Organizing folders for Images, Fonts, Common libraries, JavaScript, and Stylesheets (Figure 220) 
makes it easier to manage and maintain files. Search engines and users will also be able to navigate 
the website easily. Additionally, many websites also use a Content Management System (CMS) that 
provides a graphical interface to organize and manage the files and contents of websites.

179	 A question thread at StackOverflow on this file name convention is at https://stackoverflow.
com/questions/32408259/why-do-people-name-their-files-index-html (accessed June 2023).

https://stackoverflow.com/questions/32408259/why-do-people-name-their-files-index-html
https://stackoverflow.com/questions/32408259/why-do-people-name-their-files-index-html
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You can have all your HTML pages in a separate folder, or you can choose to divide your website into 
different functional areas and have a separate webpage for each topic within it. In Figure 221, you can 
see how the submenus of a website correspond to similarly named folders on the server. For example, 
if a user visits your home page, the server will show the root-level index.html file. However, if the user 
clicks Submenu 1, then the Index.html within the Submenu 1 folder will be displayed. 

FIGURE 221 — Concept and folder diagrams help users plan how to develop their websites and content. 

Website hosting providers allow users to quickly 
create and maintain their websites. 

Hosting a Website

Hosting a website means making it accessible to 
the public over the Internet by storing the website’s 
files and data on a webserver. A webserver is a 
computer that is connected to the Internet and is 
designed to store and deliver webpages to users 
who request them through their browsers.

When you host a website, you essentially rent 
space on a webserver from a hosting company 
or provider. This allows your website to be stored 
on the webserver and made available for access over the Internet. The web hosting company also 
provides a range of services, such as server maintenance, security, and technical support, to ensure 
that your website is always accessible and runs smoothly. You’ll need to upload your files to the 
webserver and configure your website settings so users can find your site on the web.180

180	 The primary configuration is to acquire a domain name (such as www.example.com) and 
point it to your website. Hosting service providers take care of this detail, so we do not discuss 
this in more detail in this book. For details, please see https://www.hivelocity.net/kb/dns-
configuration-everything-you-need-to-know/ (accessed June 2023). To see what the setup at a 
hosting service provider looks like, please see GoDaddy’s details at https://www.godaddy.com/
garage/configuring-and-working-with-domains-dns/ (accessed June 2023).

http://www.example.com
https://www.hivelocity.net/kb/dns-configuration-everything-you-need-to-know/
https://www.hivelocity.net/kb/dns-configuration-everything-you-need-to-know/
https://www.godaddy.com/garage/configuring-and-working-with-domains-dns/
https://www.godaddy.com/garage/configuring-and-working-with-domains-dns/
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Once your website is hosted, users can access it by typing your domain name (e.g., www.cyberflorida.
org) into their web browsers. This sends a request to the webserver hosting your website. The 
webserver then responds by sending the requested webpages back to the user’s web browser, which 
displays them on their screen.

Hosting from Your Home Computer

You can actually host your site from your own home computer. You’ll have to 
get a permanent IP address from your Internet service provider, purchase a 
domain name (website name) from a DNS registry, and connect the website 
name to your computer’s IP address. You’ll also need to ensure your computer 
can handle the load, is protected, is always turned on, and is being backed up 
regularly.

As you can see, this adds a lot of complexity and responsibility. Therefore, the 
alternative of taking advantage of web-hosting providers is very popular.

There are many popular web hosting sites available, each with its own features, pricing, and 
capabilities. Some of the most popular web hosting sites are GoDaddy,181 Bluehost, SiteGround, 
HostGator,182 DreamHost, A2 Hosting, InMotion Hosting, and Wix.183 It’s important to research and 
compare different options to find the one that best meets your needs and budget.184

Website Editors

There are multiple ways to build HTML pages. One way is to code it from scratch using the HTML 
elements like <table>, <text>, <img>, and others. Another way is to use a wireframe tool like Figma 
and then use the tool’s conversion feature to convert the wireframe into HTML code.

Another popular way is to use a WYSIWYG (Pronounced WIZ-EEE-WIG) editor. WYSIWYG is a popular 
industry acronym for “What You See Is What You Get.” In the context of HTML editors, a WYSIWYG 
editor is a software program that allows users to create and edit HTML documents without having to 
know the HTML code. With a WYSIWYG editor, users drag and drop website elements such as images 
and tables on a drawing canvas, and see the webpage they are creating as it will appear in a browser 
without having to manually code the HTML.185

WYSIWYG HTML editors make web technologies accessible to everyone. They are popular among 
non-technical users, such as bloggers, content creators, and small business owners, who may not 
have the technical expertise to create webpages using HTML code. Some popular free WYSIWYG 

181	 GoDaddy’s plans are at https://www.godaddy.com/hosting/web-hosting (accessed June 2023).
182	 You can check out plans at https://www.hostgator.com/web-hosting (accessed June 2023). 

HostGator started in a dorm room at Florida Atlantic University, so we are biased towards them.
183	 You can check out their services at https://www.wix.com/ (accessed June 2023).
184	 You can find several resources and comparisons online, e.g., https://geekflare.com/best-static-

site-hosting-platform/ (accessed June 2023).
185	 Wikipedia’s WYSIWYG page has a nice history of WYSIWYG editors at https://en.wikipedia.org/

wiki/WYSIWYG (accessed June 2023).

https://www.godaddy.com/hosting/web-hosting
https://www.hostgator.com/web-hosting
https://www.wix.com/
https://geekflare.com/best-static-site-hosting-platform/
https://geekflare.com/best-static-site-hosting-platform/
https://en.wikipedia.org/wiki/WYSIWYG
https://en.wikipedia.org/wiki/WYSIWYG
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HTML editors186 include Brackets from Adobe,187 Phoenix code editor from the Brackets developer 
community,188 and SeaMonkey from the Mozilla community.189 There are also commercial WYSIWYG 
editors, including Adobe’s Dreamweaver.190

Website hosting providers like Wix.com can also give you access to website builders and editors. The 
website builder is typically a WYSIWYG platform, where you can drag and drop elements on to the 
page. When you are ready, you can click the “Publish” button to deploy your website without writing 
or editing a line of code.

Google Sites (www.sites.google.com) is another website hosting provider that has its own WYSIWYG 
webpage builder (Figure 222). 

FIGURE 222 — Similar to Wix and other providers, Google Sites allows users to host and build websites. 

The capabilities of HTML editors are evolving rapidly. While the editors share most of the same basic 
capabilities, they can also offer additional capabilities depending upon the needs of their target 
audience, pricing structure, etc. For example, commercial editors may offer advanced features like a 
library to maintain your common themes, icons, a collaboration framework (so you can get your work 

186	 There are other choices and reviews available online, including for example in the article at 
https://www.thoughtco.com/best-windows-wysiwyg-editors-3471324 (accessed June 2023).

187	 You can download Brackets from https://brackets.io/ (accessed June 2023).
188	 The Phoenix editor is entirely online and can be accessed at https://phcode.dev/ (accessed June 

2023).
189	 You can download SeaMonkey from https://www.seamonkey-project.org/ (accessed June 

2023). SeaMonkey continues the all-in-one Internet application suite concept popularized by 
the Netscape browser, which all authors of this book used in the early days of the Internet.

190	 Available at https://www.adobe.com/products/dreamweaver.html (accessed June 2023).

http://www.sites.google.com
https://www.thoughtco.com/best-windows-wysiwyg-editors-3471324
https://brackets.io/
https://phcode.dev/
https://www.seamonkey-project.org/
https://www.adobe.com/products/dreamweaver.html
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approved before it gets published), and a built-in version control system (so you can go back to any 
previous version). Check out the capabilities and pricing models of the different editors to find one 
that best fits your needs.

Learning to build webpages and websites is a great way to enter the fascinating world of modern 
information technologies. You can continue your journey by following tutorials available online freely. 
The Mozilla Developer Network (MDN) is a great resource to learn the technologies introduced in this 
chapter.191 W3Schools is also a great resource.

HTML Extensions
We close this chapter by introducing some popular related technologies that power the web and 
commerce today. The popularity of the web has led to several innovations in web design, collectively 
called DHTML. The concept of tags has also been extended to XML, which generalizes publishing and 
even allows machines to directly exchange information with each other.

Dynamic HTML (DHTML)

As you begin developing your own webpages, you will notice that popular websites have capabilities 
beyond those introduced in this chapter. A static HTML page can look attractive with text in different 
fonts, shapes and sizes, and colorful images sprinkled all over. However, in the world of mobile phones, 
we expect our webpages to also be interactive. We want to click and see things change. When we 
go to a site such as Amazon, we like to see items added immediately to the shopping cart when 
we click the buy button. Developers use multiple web technologies to enable this interactivity. The 
collection of web technologies including HTML, CSS, and JavaScript to create interactive websites is 
called Dynamic HTML, or DHTML.192

One way to look at the DHTML technologies is to think of HTML code as answering the question 
“What to display,” CSS code as answering the question “How the display should look,” and JavaScript 
code answering the question “How the webpage should interact with the user.”

Using DHTML, you can create webpages that respond to user actions such as mouse clicks and hover 
events, without requiring the page to reload or requiring server-side processing.

Another recent development, popularized by social media websites such as Facebook and Twitter, is 
called the Single Page Architecture (SPA). Single Page Architecture (SPA) is a development approach 
in which the content and functionality of a web application is contained within a single HTML page. 
Instead of navigating to separate pages when clicking on links, the user remains on the same page 
while sections of the page get dynamically updated based on the user’s interaction with the website. 
The initial HTML page is loaded from the server, and then subsequent interactions with the application 
are handled through JavaScript. The JavaScript code updates sections of the page based on user 

191	 Tutorials for HTML, CSS and related technologies including JavaScript for developers at different 
levels of expertise can be accessed at https://developer.mozilla.org/en-US/docs/Web/Tutorials 
(accessed June 2023).

192	 We consider JavaScript to be beyond the scope of this introductory book. But interested students 
can follow the JavaScript tutorial at the Mozilla Developer Network (MDN) link in the previous 
footnote.

https://developer.mozilla.org/en-US/docs/Web/Tutorials
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interactions without requiring a full page reload, offering a seamless experience to visitors.193

SPAs offer several advantages to page visitors, including a smoother user experience, faster page load 
times, and easier development and maintenance due to the separation of client-side and server-side 
code.194 Popular examples of SPAs include Gmail, Facebook, and Twitter. Their convenience is also a 
source of criticism of single page applications—users keep scrolling SPAs, anticipating interesting 
news, a phenomenon popularly labeled doom-scrolling.195

Extensible Markup Language (XML)

HTML is designed specifically for publishing webpages. The popularity of HTML to publish 
information for the World Wide Web led to interest in generalizing this idea to standardize all forms of 
electronic publishing, including electronic documents, and electronic records. The core idea was that 
if information elements could be standardized, computers could easily modify the information for 
different purposes at the click of a button. For example, the same information could be formatted with 
stylesheets for web and print publication with the click of a button, saved as structured information 
into a relational database for archival storage at the click of another button, and relevant information 
extracted and reported to the government for tax purposes with another click. 

Extensible Markup Language (XML) is the generalization of tags for electronic publishing.196 Several 
electronic publishing technologies use XML behind the scenes for their operation. Almost all electronic 
documents are saved behind the scenes as XML. For example, Figure 223 shows the XML created by 
Microsoft Word for the title and opening sentence of this section.197, 198 You can see the styles and 
content for the title and paragraph in the figure.

As you can see in Figure 223, XML encodes documents in a format that is both human-readable as 
well as machine-readable. XML can specify how every element of an electronic document should be 
interpreted. With this detail, computers can precisely and easily transform information for different 
uses such as recordkeeping and publishing. 

193	 The technology to load sections of the page is called AJAX (Asynchronous JavaScript and XML). 
AJAX requests pieces of data from the server and updates small sections on the page with the 
data without disturbing the user’s flow. An example of the use of AJAX is how the Gmail just 
moves the entire view up one row when you delete an email, without reloading the entire page. 
You can learn more at the W3Schools AJAX tutorial at https://www.w3schools.com/xml/ajax_
intro.asp (accessed June 2023).

194	 However, SPA also present some challenges, such as search engine optimization (SEO) difficulties 
and the need for careful management of memory and performance.

195	 Doomscrolling can not only be a time sink, but also a health hazard, please read about it, a 
starting point is https://www.webmd.com/balance/what-is-doomscrolling (accessed June 
2023).

196	 The homepage of the technology working group is at https://www.w3.org/XML/ (accessed June 
2023).

197	 To view the XML for a Microsoft Word document, first change the extension of the file from 
“.docx” to “.zip”. Then unzip the file and view the “document.xml” file within the Word folder.

198	 The XML specification for Microsoft Office documents is called Office Open XML. You can read 
about it at https://en.wikipedia.org/wiki/Office_Open_XML (accessed June 2023).

https://www.w3schools.com/xml/ajax_intro.asp
https://www.w3schools.com/xml/ajax_intro.asp
https://www.webmd.com/balance/what-is-doomscrolling
https://www.w3.org/XML/
https://en.wikipedia.org/wiki/Office_Open_XML
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FIGURE 223 — XML tags format text into a language that humans and computers can interpret. 

XML is very useful if the organization you work for does data exchange, for example with buyers, 
sellers, credit card companies, banks, and other organizations. Data exchange between companies 
and customers is a critical aspect of online commerce, which makes XML a key language you should 
know about.

A unique feature of XML is that it allows users to create their own custom tags to represent specific 
data structures and identify elements within a document. This flexibility makes it suitable for a wide 
range of applications, including web services, data storage and retrieval, and configuration files for 
computer applications.

XML standards, which specify tags for specific uses, have been developed for most of the important 
information exchange contexts. For example, the XML Business Reporting Language (XBRL) helps 
organizations report financial performance in a universal format.199 Since 2018, the U.S. Securities and 
Exchange Commission, the principal regulator of publicly traded companies in the United States, has 
required that companies submit their annual reports using XBRL.200 An example is shown in Figure 
224.201 A critical feature you can see in the example is that the numbers are clearly associated with 
their corresponding meanings specified by the International Financial Reporting Standards (IFRS).202 
For example, the underlying XML conveys to every financial publishing technology anywhere in the 
world that the highlighted number of $3,404,031 represents salary expenses for the organization. 
This makes it easy and precise for investors to compare the performance of different organizations, 

199	 You can read about XBRL at https://www.xbrl.org/ (accessed June 2023).
200	 You can read about this at https://www.sec.gov/structureddata/osd-inline-xbrl.html (accessed 

June 2023).
201	 The example is from https://www.xbrl.org/ixbrl-samples/gleif-annual-report-2017/gleif-annual-

report-2017-viewer.html#f-f6 (accessed June 2023) (you can find this example by searching for 
“‘inline xbrl example”’)

202	 The home page for the standards is at https://www.ifrs.org/ (accessed June 2023).

https://www.xbrl.org/
https://www.sec.gov/structureddata/osd-inline-xbrl.html
https://www.xbrl.org/ixbrl-samples/gleif-annual-report-2017/gleif-annual-report-2017-viewer.html#f-f6
https://www.xbrl.org/ixbrl-samples/gleif-annual-report-2017/gleif-annual-report-2017-viewer.html#f-f6
https://www.ifrs.org/
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and for regulators to ensure that the numbers are correctly reported. Finally, XML viewers can format 
documents for easy human readability, as you see in Figure 224.

FIGURE 224 — XBRL aids business users in organizing financial data. 

One of the key features of XML for recordkeeping, electronic commerce, healthcare, and other 
industrial applications is that computers can validate data against a defined schema or document 
type definition (DTD). Computers can review every element of a document and ensure that the data 
is properly formatted and satisfies all necessary properties. For example, a DTD can specify that profits 
or losses must be numbers, or, as in the example of Figure 225, a person must have a name. This 
helps avoid errors and inconsistencies in electronic 
documents.

Figure 225 introduces the structure of XML 
documents. In this example, the XML document 
starts with a declaration that specifies the version of 
XML being used (“1.0”) and the character encoding 
used to encode the document (“UTF-8”).203

The main content of the document is contained 
within the <person> element, which has several 
child elements representing different aspects of 
the person’s information. The <name> element 
contains the person’s name, the <age> element 
contains the age, and the <address> element contains the street, city, state, and ZIP code. The DTD 
can specify the properties of each of these tags, including whether they are required or optional.

Note that each element has a corresponding closing tag (e.g., </name>) marking the end of the 
element’s content, just like HTML. Also note that elements can be nested inside other elements to 
create a hierarchical structure, as with the <address> element in this example.

FIGURE 225 — XML tags allow users to transfer 
and validate data efficiently.

203	 You can read about Unicode Transformation Format (UTF) and UTF-8 at https://blog.hubspot.
com/website/what-is-utf-8 (accessed June 2023).

https://blog.hubspot.com/website/what-is-utf-8
https://blog.hubspot.com/website/what-is-utf-8
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There are several reasons why the essential concept of XML is widely used:

·	 XML can be easily read by humans and parsed and processed by computers.

·	 XML is not tied to any specific platform or programming language, which makes it very flexible 
for data exchanges on the Internet.

·	 XML is designed to be extensible. Users can define their own tags to describe data in a way 
that is specific to their needs. This allows for the creation of custom data structures that can be 
tailored to particular use cases.

·	 XML documents can be validated against a defined schema or document type definition 
(DTD). You can easily ensure that data is properly formatted and structured to avoid errors and 
inconsistencies.

·	 XML is used for data exchanges between systems and applications. This is due in part to its 
flexibility, extensibility, and its ability to represent a wide range of data types and structures.

·	 XML is used for representing data, not formatting or styling. This allows for a clear separation 
between content and presentation, making it easier to reuse data in different contexts or 
formats.

If you receive data in an XML format, you may need an XML reader to read and parse the XML 
documents. An XML reader reads an XML document and extracts the information contained within it, 
making it available for use in applications. XML readers can also be used to validate XML documents 
against a schema or document type definition (DTD) and to transform XML documents into other 
formats.

XML and JSON

XML’s core idea of generalizable tags is extremely 
useful. However, the fast-moving technology 
industry has improved upon the idea to address 
one key limitation of XML technology–its verbosity. 
Of the 28 words in Figure 225, only 9 words (~33%) 
convey unique information. The remaining 19 
words (67%) are just protocol tags, not conveying 
unique information about John Smith. This is 
inefficient, particularly when an important use is to 
exchange information.

Therefore, developers have increasingly replaced 
XML with JavaScript Object Notation (JSON). 
JSON replaces tags with key-value pairs, thereby 
eliminating closing tags and greatly reducing the 
number of words needed to convey the same 
information. Figure 226 shows an example of a 
JSON file that specifies how a web application 
written using Python’s Flask framework should be 
run. You can see that JSON eliminates closing tags such as </configurations>, </name> etc.

FIGURE 226 — JSON files differ from XML by the 
use of key-value pairs.
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For the foreseeable future, in all likelihood, XML will continue to be popular in highly regulated 
environments such as financial reporting where the focus is on precisely specifying the document 
types and their properties. For most other contexts, where the focus is on simplified information 
exchange, XML is likely to be seen as a legacy technology, increasingly replaced by JSON.
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			   Chapter Terms and Definitions

Anchor Tag: The <a> tag allows you to add links 
to an HTML page, also known as hyperlinks

Bold Tag: The <b> tag is used to bold text

Cascading Style Sheets (CSS): A web markup 
standard that allows web designers to define the 
appearance and position of a webpage using 
special dynamic effects

DOCTYPE Declaration: The first line of an HTML 
page that tells the browser the kind of document 
to expect, specifically the version of HTML

Form Tag: Created using the <form> tag; every 
form also has multiple <input> tags to specify 
the kind of input you want from the user

Head Tag: The head tag contains information 
about the HTML document; it is mostly not visible 
to the user

Heading Tag: The <h1> tag represents the main 
heading on a page and is typically used for the 
page title, while the other headings <h2> to 
<h6> are used for subheadings

HTML Tag: A tag is a special keyword that is 
enclosed by <>; the HTML tag defines the start 
and end of an HTML document

Hypertext Markup Language (HTML): The 
standard markup language used for creating 
webpages and web applications

Image Tag: The <img> tag is used to add images 
to your HTML page; tt requires the source (src) 
attribute to give the location of the image so the 
browser can get the image and display it on the 
webpage

JavaScript: A programming language that lets 
you supercharge your HTML with animation, 
interactivity, and dynamic visual effects

Paragraph Tag: The <p> tag is used to define a 
block of text as a paragraph

POST: An HTML method that allows users to 
submit data to a server

Storyboard: A process used in the development 
of a website that involves the designer and 
colleagues simulating a particular set of visits to 
the site in order to gain ideas about how the site 
should be structured

Strike Tag: The <strike> tag is used to visually 
strikethrough text

Subscript Tag: The <sub> tag is used to display 
text as subscript

Superscript Tag: The <sup> tag is used to display 
text as superscript

Tables: Created using the <table> tag, and <tr> 
and <td> tags to define the rows and cells of the 
table

Underline Tag: The <u> tag is used to underline 
text

Wireframe: A rough visual outline of a proposed 
application and is a specific kind of prototype 
generated during the user-centered design 
process to collect input and feedback from target 
users before designs are finalized
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Webserver: Computer servers specifically 
designed and programmed to host websites 
and facilitate the communication between other 
computers across Internet networks

Website Host: Typically, a company or provider 
that allows users to maintain, secure, and support 
website domains on webservers
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		  	 Chapter Case

Wrenley Saves the Pets!
Wrenley was recently given an opportunity to develop a website for a local non-
profit company dedicated to helping animals housed in an animal shelter. The 
focus of the website was to help the pets find permanent homes through adoption. 
Wrenley really had a passion for pets and wanted to help find them new homes 
anyway she could. 

It is your job to help Wrenley plan out the new website. 

Question 1:	 Write out a detailed list of all the webpages Wrenley should include 
in her website (examples: “About Us”, “Contact Us”, “Donate”). As 
you list each webpage, include a small sample of content you think 
would be helpful on the webpage.

Question 2:	 What webpage development languages would you recommend on 
Wrenley’s website and explain why those languages are necessary?

Question 3:	 Research a good website host provider that could potentially host 
Wrenley’s website. List the URL and provide a description of the 
website host provider. 

Bonus:	 Develop an HTML prototype of your proposed website for Wrenley. 
You can learn more about how to develop a website using HTML at 
W3Schools (https://www.w3schools.com/html/default.asp). 

https://www.w3schools.com/html/default.asp
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“Computer language design is just like a stroll in the park. Jurassic Park, that is.”

—Larry Wall, creator of the Perl programming language

Overview
Computer languages are the rules for writing computer programs. Just as we need languages such 
as English to communicate ideas and information with each other, we need computer languages 
to tell computers what to do. Computer languages are popularly called programming languages. 
The important difference between human languages and computer languages originates from the 
human ability to handle ambiguity and fill context. For example, in most contexts people would 
understand the phrase “let’s meet tomorrow.” But computers would not be able to figure out who is 
meeting, the place of the meeting, the time of the meeting, any prior preparation for the meeting, 
etc. Therefore, computer languages use specific syntax and grammar to precisely communicate with 
machines to avoid miscommunication. Once you develop some familiarity with computer languages 
and comfort with giving precise instructions in computer languages to get the job done, you can 
create increasingly complex computer applications that make life easier. Computer applications are 
a set of instructions written in a programming language. Computers read these instructions and 
perform the corresponding set of actions.

Types of Computer Languages
Computer languages (programming languages) can be divided into a few broad categories for easier 
understanding: procedural programming languages, object-oriented programming languages, 
scripting languages, markup languages, domain-specific languages, and low-level languages. Here’s 
an overview of these categories:

·	 Procedural programming languages are computer languages that use precise steps to 
compose programs. In a way, all programming languages are procedural languages, but the 
term typically refers to languages with a limited set of data types such as numbers and strings. 
C, Fortran, and Pascal are examples of procedural languages and allow programmers to create 
procedures or subroutines to perform specific tasks. Today, procedural languages are primarily 
used for introductory programming classes. Historically, they were used to write the earliest 
scientific and engineering applications.

·	 Object-oriented programming languages are computer languages that allow developers 
to create their own data types by organizing data and related functions into objects. Object-
oriented (OO) languages greatly simplify representing the real world in computer programs 
and are widely used in software development. Examples of object-oriented languages include 
Java, C#, and C++.

·	 Scripting languages are computer languages used to automate tasks using the capabilities of 
existing applications. Scripting languages are typically aimed at end users and are considered 
easier to learn than procedural or object-oriented languages. AppleScript204 is an example 

204	 “AppleScript,” Wikipedia, https://en.wikipedia.org/wiki/AppleScript (accessed June 2023).

https://en.wikipedia.org/wiki/AppleScript
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of a scripting language for MacOS, and AutoHotKey205 is an example of a scripting language 
for Windows. JavaScript and Python are scripting languages that have evolved into powerful 
languages to create computer applications. Scripting languages are typically not used to 
create software for commercial distribution, since scripts are not compiled, and the programs 
can be read by all users.206

·	 Markup languages are computer languages used to specify how information should be 
displayed or interpreted. HTML, Markdown and XML are well-known markup languages. 
Markup languages define markup tags, which are used to create webpages and other content 
that can be displayed on a variety of devices.

·	 Domain-specific languages are computer languages optimized for specific application 
domains. SQL is an example of a domain-specific example. Other domain-specific languages 
include R for statistical applications and MATLAB for engineering applications. Domain-
specific languages greatly simplify application development for complex domains such as 
data retrieval (SQL) and statistical data analysis (R).

·	 Low-level languages are programming languages that are close to the processor’s native 
instruction set. They are sometimes called assembly language. Programs in all other languages 
(e.g., procedural, object-oriented, and domain-specific languages) are converted by compilers 
into low-level language programs for each type of processor.

Binary Code

Eventually, all computer programs are stored as instructions in binary code. Computers can only read 
binary code, which is a collection of 1s and 0s. Binary code is the native language of computers and 
is necessary for communication and storage of data. For example, files and data are stored in binary 
format on hard drives and other storage media.

Specialized software programs called compilers convert software code, written in any of the above 
languages, into binary code that can then be executed directly by the computers. Compilers allow 
developers to write computer programs in languages that resemble plain English (called high-level 
languages) and convert these programs into binary code customized for each processor.

Computer Programming
Each type of programming language has its own strengths and weaknesses. The choice of language 
often depends on the specific needs of the application being developed. It is common to use a 
combination of languages to build a software application.207 You may use HTML and JavaScript to 

205	 AutoHotkey homepage, https://www.autohotkey.com/ (accessed June 2023).
206	 A developer perspective, “How to Distribute Commercial Python Applications,” can be read at 

https://hackerboss.com/how-to-distribute-commercial-python-applications/ (accessed June 
2023).

207	 A good thread with examples of languages used in different popular applications is at https://
www.quora.com/In-what-programming-language-s-is-Gmail-implemented (accessed June 
2023).

https://www.autohotkey.com/
https://hackerboss.com/how-to-distribute-commercial-python-applications/
https://www.quora.com/In-what-programming-language-s-is-Gmail-implemented
https://www.quora.com/In-what-programming-language-s-is-Gmail-implemented
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manage the look and feel (frontend) of the application, and Java or C++ to create the middleware 
that handles the business logic and responds to requests from the frontend. You may use SQL to 
create your backend code that helps your middleware interact with the database to store and retrieve 
information.

Programming languages and frameworks are evolving rapidly to handle emerging business needs. 
These days, it is becoming increasingly common to use JavaScript to build the frontend as well as 
backend, so you just need to learn one language to build entire applications. This greatly improves 
developer productivity. Frameworks like React Native let you use JavaScript to build mobile 
applications. These frameworks also do the heavy lifting to convert your JavaScript code into the 
required low-level language components necessary to work with Apple IOS and Google Android 
phone systems.

We begin our introduction of programming languages with block-based programming. Block-based 
programming is a way to use graphical interfaces to write simple programs. If you have never tried 
computer programming before or if programming languages appear complicated, you could try 
block-based coding till you get comfortable enough to use regular programming languages. 

If you would like to learn programming, we have some recommended resources at the end of the 
chapter.

Block Based Coding

Block coding is a visual programming language that uses blocks or graphical elements to represent 
programming concepts instead of traditional text-based coding. These blocks can be dragged and 
dropped to create a sequence of commands or instructions.

FIGURE 227 — The drag and drop capability makes Blockly a great starting point when learning to code. 
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Blockly208 from Google is an example of a block-based computer language. Scratch from MIT labs is 
another block-based computer language that allows developers to create animations and stories. As 
shown in Figure 227, Blockly allows you to use simple graphical interfaces to specify instructions, and 
it converts these instructions into well-formed programs in different languages.

Block coding is a fun and interactive way to learn programming, ideal for beginners and even children. 
It allows you to focus on the logical structures of programming, without worrying about the syntax 
and details of text-based coding.

Block coding can give you a taste of the power of programming. It can also help you build foundational 
skills to assist in the move to text-based programming.

Programming Basics
While there are many popular programming languages (e.g., Java, C#, C, C++, JavaScript, Python), 
they all share most of the underlying concepts. Once you learn the basic programming concepts 
and use them in a few languages, learning new programming languages will be easy and fun. Here 
are a few concepts you will need to learn no matter which language you choose. If you would like to 
practice the examples in this chapter, and create your own programs, you can use the jdoodle online 
code editor. Most students find Python to be their favorite introductory language. The Python editor 
is at https://www.jdoodle.com/python3-programming-online/.

Variables

A variable is a named storage location in a computer’s memory that holds a value. Variables are the 
basic mechanism used to store and manipulate data in code. A variable is one of the first things you 
will learn when you begin to write software programs. 

Let’s say you are creating a program that calculates the area of rectangles. Since the area is computed 
from the length and width of the rectangle, you would need to store the width and height of the 
rectangle as variables. You would need to create one variable for each dimension, maybe one called 
width and the other called height. For simplicity in this example, let’s assume all numbers are integers. 
Every language has its own way of declaring a variable. Once you declare the variables to hold the 
dimensions of the rectangle, you would assign values to the variables when a user inputs the width 
and height values of the rectangle.

Variable declaration of the type int (integer):

int width;

int height;

Variable assignment:

width = 10;

height = 5;

208	 Blockly, https://developers.google.com/blockly (accessed June 2023).

https://www.jdoodle.com/python3-programming-online/
https://developers.google.com/blockly
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In programming, the equals operator (=) is typically used to assign values to variables. Once we have 
the values assigned to variables, we can perform calculations to get the area of the rectangle. If we 
wish to save this value for future use, we will need a third variable (Area) to store the value of the area: 

int area;

We can now compute the area as the product of the width and height as:

area = width * height;

In the above statement, we ask the computer to fetch the values stored in width and height and 
multiply the two. The final output or the area is stored in area. As you see in the example above, 
computer programs written in modern programming languages read much like the same commands 
written in plain English.

To be useful to end users, just doing the calculations is often not enough. Users likely also want to 
see the results. You can print the output to the display using the print function available in most 
programming languages: 

print (“The area of the rectangle is:”, area);

When users run your program and enter the height and the width values, they will see the following 
message:

The area of the rectangle is: 50. 

Functions/Methods

A function (aka method in some programming languages) is a block of code that performs a specific 
task. A function is defined with a name and can be called or invoked repeatedly from other parts of 
a program.

Functions provide a way to modularize code and make it easier to read, understand, and reuse. 
Instead of writing the same code multiple times in different parts of a program, a function can be 
defined once and called whenever it is needed. Functions also improve program correctness since 
program errors only need to be fixed in one place (the method), instead of all the places where the 
methods are used.

Functions typically have inputs and outputs. The inputs are called parameters or arguments. They 
represent the data that the function will receive and work on. The outputs are the result of the 
function’s computation and can be returned to the calling code.

Here is an example function in JavaScript that adds two numbers together and returns the result:

function AddNumbers (x, y) {

let sum = x+ y;

return sum;

} 
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In this example, the function AddNumbers takes two parameters x and y. The function adds x and y 
together and stores the result in a variable named sum. Finally, the function returns the value of sum 
to the calling code.

You can call this function from other programs by passing two numbers. Here’s how you could call the 
function AddNumbers.

let result = AddNumbers (5, 7);

There are several ways to view the result. Developers typically print the values to the console to test 
their code. JavaScript has the “console.log” function to print results to the console. We can use the 
console.log function to print the value of the result variable as shown below (// is used to add a 
comment. Comments are meant for developer reference and are ignored by the computer processor. 
// 12 in the line below is a comment, indicating that the output is expected to be 12.):

console.log (result); //Output: 12

Figure 228 shows the complete example. On the left is the html page with the JavaScript method 
defined in lines 6–9. Clicking the “Add” button on the page calls the AddNumbers method and passes 
the values 5 and 7 as arguments to the method. The result is saved as the value of the variable, “result.” 
Finally, the result is printed to the console. To view the console, we open the Inspector (right-click 
anywhere in the browser and select “Inspect,” and go to the console tab. We see the result in the 
console (bottom half on the right). You can type this example in a file, save it with an html extension, 
open the file in a browser, and use the Inspector to observe how the program is executed. A convenient 
way to do that is to set breakpoints in the JavaScript method. The browser will stop execution when 
it reaches the breakpoint and show you the value of every variable. You can then step through the 
function line by line, observing how the variables change values as the code is edited.

FIGURE 228 — An example of the AddNumbers method. 

Functions are an important part of programming languages and are used extensively in both frontend 
and backend development. They allow us to write reusable code that can be called from anywhere in 
our program, making our code more modular and easier to maintain.
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Algorithm

An algorithm is a set of instructions for solving a problem. While any computer program that does the 
job can be considered an algorithm, in computer science and computer programming, algorithms 
typically refer to the most efficient methods to perform a task. There are well-known algorithms to 
efficiently perform specific operations such as sorting and searching for data. Advances in algorithms 
are one of the most important ways that Digital Information Technologies have improved lives across 
the globe.

Your algorithm could be just an idea shown as a flowchart or it could be pseudocode—a detailed set 
of instructions to write a program in the language of choice. Algorithms are language independent 
and programmers can implement them in any language they choose.

For example, here’s an algorithm for a student to sign up for a class at the University of South Florida:

·	 begin by logging into the online registration system for the school;

·	 browse the course catalog to find the desired class;

·	 check for any prerequisites or restrictions on the class;

·	 select the desired class and verify the course details, including course number, schedule, 
location, and instructor;

·	 add the class to the student’s schedule;

·	 check for any conflicts with the student’s existing schedule or other classes;

·	 if there are no conflicts, confirm the enrollment in the class, else remove the class from the 
schedule;

·	 pay any associated fees or tuition for the class;

·	 confirm the enrollment and payment and review any important deadlines or course 
requirements;

·	 if there are conflicts or other issues preventing enrollment, contact the school’s registration 
office for assistance;

·	 end the enrollment process.

Here are a few popular algorithms you may want to learn about or implement if you are interested in 
computer science.

·	 Sorting algorithms are used to sort collections of data. Sorted data is much easier to search 
than unsorted data, therefore, sorting is an essential task for any data-intensive application. 
Depending on the type of data you have, you may choose from one of the many available 
sorting algorithms: bubble sort, quick sort, merge sort, heap sort, and others.209

·	 Search algorithms are used to find a specific piece of information within a collection of data. 
Once again, depending on the type of data and other constraints, you could try out the various 

209	 “Sorting Algorithms,” Wikipedia, https://en.wikipedia.org/wiki/Sorting_algorithm (accessed 
June 2023).

https://en.wikipedia.org/wiki/Sorting_algorithm
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search algorithms—linear search, binary search, jump search, exponential search, Fibonacci 
search, and others—to find the one that works best.210 

·	 Encryption algorithms are used to encrypt data to protect it from unauthorized access. AES, 
RSA, and DES are all examples of popular encryption algorithms.211 

·	 Machine learning algorithms have gained in importance and may change the way we 
analyze data or make predictions and decisions based on data. Neural networks are a machine 
learning algorithm modeled on our brains and designed to make decisions. Recommendation 
algorithms are popular and used by big businesses like YouTube and Netflix to predict what 
you like based on your previous choices.212 

Once you develop comfort with the syntax and structure of computer programming, algorithms will 
offer you a framework to solve complex problems and perform tasks efficiently.

Object Oriented Programming

Object-oriented programming (aka OOP) is a programming model that is based on the concept of 
classes and objects. A “class” in OOP represents the properties and behaviors of entities relevant to 
the program. Every time you create an instance of a class, you have an object with values attached 
to the predefined characteristics of the class. For example, if you are building a software to record 
student progress at a school, then Students and Teachers could be objects relevant to the program. 
Student objects would have properties such as names and addresses and behaviors such as course 
registration. Every time a new student or a teacher joins, you could create an instance of the class with 
the appropriate properties such as name and age.

OOP allows you to organize your code in a modular and reusable way by encapsulating data and 
behavior into objects. In OOP, objects have attributes (data) and methods (functions) to operate 
on that data. For example, a car object might have attributes such as color, make, and model, and 
methods such as accelerate, brake, and turn.

OOP provides several advantages over simpler programming paradigms such as procedural 
programming. 

·	 Simplicity: OOP allows you to define variables that closely resemble the properties and 
behaviors of the real world.

·	 Modularity: OOP allows you to break your code into small, reusable modules (objects).

·	 Encapsulation: OOP allows you to hide the internal details of an object and expose only the 
necessary methods and attributes.

·	 Inheritance: OOP allows you to create new classes that are based on existing classes (parent 

210	 “Search Algorithms,” Wikipedia, https://en.wikipedia.org/wiki/Search_algorithm (accessed June 
2023).

211	 “Category: Cryptographic Algorithms,” Wikipedia, https://en.wikipedia.org/wiki/
Category:Cryptographic_algorithms (accessed June 2023).

212	 “Outline of Machine Learning,” Wikipedia, https://en.wikipedia.org/wiki/Outline_of_machine_
learning (accessed June 2023).

https://en.wikipedia.org/wiki/Search_algorithm
https://en.wikipedia.org/wiki/Category:Cryptographic_algorithms
https://en.wikipedia.org/wiki/Category:Cryptographic_algorithms
https://en.wikipedia.org/wiki/Outline_of_machine_learning
https://en.wikipedia.org/wiki/Outline_of_machine_learning
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classes). The children inherit attributes and methods of the parent classes. For example, 
“Transfer Students” and “International Students” may inherit all the properties of regular 
“Students,” but may also have extra traits specific to Transfer and International students. This 
greatly simplifies application development.

Objects

As described above, an object is an instance of a class. An object consists of one or more properties 
that are key-value pairs defining the characteristics of the object, and methods, which are functions 
that define the behavior of the object.

Objects are a core feature of most programming languages used today, including JavaScript, Python, 
and Java. They allow us to encapsulate related data and functionality into a single unit, which can be 
more convenient and easier to work with than using separate variables and functions.

Here is an example of an object in JavaScript that represents a recipe:

let recipe = {

recipeName: “Lemon Orange Cake”,

recipeSource: “Taste of Home”,

recipeDetails: function () {

return recipeName + “from” + recipeSource;

}

};

In this example, we have defined an object named recipe that has three properties: recipeName, 
recipeSource, and recipeDetails. The recipeName and recipeSource have basic information about 
the recipe, while the recipeDetails property is a method that returns a string with the recipe name 
concatenated to the recipe source.

We can access the properties and methods of an object using dot notation or bracket notation. For 
example, to access the recipeName property of the recipe object, we can use the following code:

console.log (recipe.recipeName); //Ouput: Lemon Orange Cake

To call the recipeDetails of the recipe object, we can use the following code:

console.log(recipe.recipeDetails());//Output: Lemon Orange Cake from Taste of Home

Objects are a powerful tool in programming and make it easy to organize and manipulate complex 
data structures. They are used extensively in all types of programming.

Popular OOP Languages

Here are a few examples of programming languages that support object-oriented programming.

·	 Java is the first object-oriented language that gained commercial popularity. Java continues 
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to be a popular OOP language that is used for building mobile apps, web apps, and enterprise 
systems. It is known for its platform independence, robustness, enterprise support, and 
extensive libraries. Online learning resources, inbuilt functions, and libraries make Java easy 
to learn and use.

·	 Python is a versatile general-purpose OOP language that is used for a wide range of 
applications, including data analysis, machine learning, and web development. It is known for 
its simplicity, readability, and versatility.

·	 C++ is a powerful OOP language created by the notable computer scientist Bjorne Stroustrop. 
It is known for its efficiency and ability to interact with hardware and is used to build high-
performance applications, including operating systems, game engines, and embedded 
systems. Almost all widely used applications on desktops such as web browsers, email clients, 
and office suites are built using C++. C++ requires greater developer knowledge about the 
internal workings of computers and, therefore, is considered to have a steeper learning curve 
than other languages.

·	 C# is a modern OOP language that supports emerging design practices. It is used to build 
mobile apps, web applications, cloud-based services, and games. It is known for its simplicity, 
type safety, and extensive libraries.

·	 Ruby is a flexible, dynamic OOP language that is used for building web applications, scripting, 
and automation. It is known for its readability, expressiveness, and the Ruby on Rails web 
framework.213 Rails introduced the concept of Model-View-Controller to develop web 
applications, which is now the basis for almost all web applications written in any language.214

·	 Swift is a modern, fast OOP language that is used for building iOS, macOS, and watchOS 
applications. It is known for its safety, speed, and ease of use.

·	 JavaScript did not start out as an OOP language, but it has acquired a lot of OOP characteristics. 
It is a versatile language that can be used for both OOP and procedural programming styles. It 
supports OOP concepts such as encapsulation and abstraction and offers built-in objects and 
methods that can be used for OOP. 

Applications
Computer applications created by developers can typically be used in three different versions; (1) 
downloaded to desktops, (2) downloaded to mobile devices, or (3) accessed through browsers. This 
has evolved over time. Personal computers (desktops and laptops) running Microsoft Windows and 
Apple MacOS were the first computing platforms used to run applications. These became common 
in offices in the 1980s and homes in the 1990s. In the 2000s, the Internet and World Wide Web 
allowed desktops to connect to the web and exchange information. People began using web-based 
applications to file taxes and pay their bills. Then in 2007, Apple introduced the iPhone and the IOS 
mobile platform and launched the era of mobile applications.

213	 Ruby on Rails home page, https://rubyonrails.org/ (accessed June 2023).
214	 For a comparison of Ruby and Microsoft’s MVC.NET, see Yana Bonderchuk, “ASP.NET MVC 

vs Ruby on Rails: Choosing the Right Framework for Your Web Development Needs,” https://
marketsplash.com/tutorials/ruby-on-rails/asp-net-mvc-vs-ruby-on-rails/ (accessed June 2023).

https://rubyonrails.org/
https://marketsplash.com/tutorials/ruby-on-rails/asp-net-mvc-vs-ruby-on-rails/
https://marketsplash.com/tutorials/ruby-on-rails/asp-net-mvc-vs-ruby-on-rails/
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Each of these shifts in technology changed how we humans conduct our day-to-day lives and connect 
with others for fun and work. These shifts also changed how we access applications and the type and 
variety of available applications. 

Desktop Applications

Desktop applications are computer programs that are installed and run on a personal computer 
or a local network. Word processors, spreadsheets, graphics editors, and audio and video editors 
are desktop applications. Typically, desktop applications are faster, more powerful, and offer more 
features than web applications. Desktop applications can also be used offline, without an Internet 
connection. Here are just a few examples of desktop applications:

·	 Word, Excel, PowerPoint, and Outlook from Microsoft are desktop applications widely used for 
business and personal productivity. Chrome, Safari, Edge, Firefox, and Opera are popular web 
browsers.

·	 Photoshop, Illustrator, InDesign, and other applications are part of the Adobe Creative Suite 
and are used for graphic designing and photo and video editing.

·	 QuickBooks accounting software is used by businesses to manage financial transactions and 
generate reports.

·	 AutoCAD is a computer-aided design (CAD) software used by architects, engineers, and 
designers to create 2D and 3D drawings and models.

·	 Visual Studio is an integrated development environment (IDE) used by developers to create 
software applications for Windows, Mac, and other platforms.

Web Applications

Web applications run on remote servers and are accessed through a web browser. Facebook, Amazon, 
Gmail, Instacart, and Netflix are all web applications we use in our daily lives. Typically, web applications 
are relatively simpler in design and functions compared to desktop applications, as they are unable to 
use all the capabilities of desktops such as notifications. Popular web applications include:

·	 Gmail is used for emailing. Google Drive and Google Docs are used for storing information, 
editing, and collaboration.

·	 Amazon, Instacart, and other online shopping platforms allow users to buy and sell products 
and services, browse reviews and ratings, and compare prices.

·	 Yelp, TripAdvisor, and other rating platforms let users review products and services before 
making a major purchase or committing to a hiring decision. 

·	 Monday.com, Trello, and Asana are web-based tools that allow users to manage projects with 
the help of online boards, calendars, approval workflows, and reports.

Web applications are available 24*7 from any device that has a reliable Internet connection. Not 
surprisingly, they have become an essential part of our daily lives—we cannot imagine going back to 
the time when we didn’t have web applications.



Chapter 13—Computer Languages, Applications, and Emerging Technologies 289

Mobile Applications

Mobile applications run on mobile devices such as smartphones and tablets. In addition to the 
standard pre-installed apps that come with smartphones, you can buy and install mobile apps from 
mobile stores such as Microsoft Store, Google Play, and the App Store. 

Mobile apps are currently designed for the two major mobile platforms in the market: Android and 
iOS. These apps enable much of social networking, gaming, entertainment, communication, and 
even productivity, particularly since remote work became popular after Covid.

·	 WhatsApp is a popular mobile app that transformed the world of voice and video calling by 
offering the services for free. 

·	 Instagram, a photo and video sharing app, allows users to upload, edit, and share photos and 
videos.

·	 Spotify changed the world of music streaming by allowing users to listen to songs and to 
create playlists using their mobile phones.

·	 Google Maps not only provides directions but also real-time traffic updates and information 
on nearby businesses.

The ease of use of mobile apps has led to a rapid growth in the app development industry, with new 
apps being released every day. If programming is what you do for fun, you should consider building 
a mobile app and putting it for sale on online stores. 

The Interplay Between Desktop, Web, and Mobile

As you spend more time in the technology world, you will notice an interplay between desktop, web, 
and mobile apps. In the morning, you may open a word document on your laptop and edit it using 
Word. As a copy of the document is saved to Microsoft’s servers, you may later log into a library 
computer to access the same document through the browser. On the train ride back home, you may 
open the same doc on your mobile app and forward it to a friend. Although you are interacting with 
the same document, you are using different interfaces based on your needs. Most popular applications 
such as Gmail, Google Maps, and Discord have desktop, mobile, and browser-based versions.

Providers that sell both computers and mobile phones are increasingly developing end-to-end 
ecosystems, so your phone calls, meetings, alerts, and chat messages interact with you seamlessly 
through your desktop and phone.

Computer Program Design

When you first decide to write a software program, you should spend a bit of time designing the 
program first. Above all, the program should be safe and should not expose internal company 
information or customers’ personal information to the outside world. The program should also be 
designed so it does not consume more database or server resources than necessary. The UI of the 
program must be attractive and easy to use if you do not want your program to fall in the huge 
garbage bin of discarded, unused programs. 

Only after you are completely satisfied with the design, you should begin writing code in a language 
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best suited for the purpose. Most organizations have adopted an iterative programming model, so 
you will write small modules of the program, test it, and show it to potential users before going back 
to write more code. 

The language you choose for your program will depend on the needs of the program, the resources 
available to you, and the platform where you want to deploy your program.

Emerging Technologies
There is an adage in the technology industry that technology helps us build better technology. If 
you observe how computer chips are made, you will notice that the most powerful chips we have 
were made possible because of technology. It would have been impossible to build today’s computer 
chips in the 1980s or 1990s. The pace of development of several other technologies has increased 
in recent decades. The power of the mobile phone, your ability to connect to a GPS satellite and ask 
for navigation, the cost/speed of sending money to a friend, or the cost of messaging your friends 
are all examples of this trend. Being aware of emerging technologies can help us anticipate how our 
future is likely to shape over the next few decades. We provide a brief overview of some emerging 
technologies that we believe will have the greatest impact in our lifetimes.

Artificial Intelligence (AI) and Machine Learning (ML)

Artificial Intelligence is technology that enables computers to perform tasks normally associated with 
human intelligence. Intelligent systems tend to mimic the human ability to interact with each other 
to solve problems using capabilities such as image recognition, speech recognition, and language 
comprehension. If you have interacted with Apple’s Siri or Amazon’s Alexa, you must have noticed 
that they can understand your verbal commands and respond with an answer in an audio form. 
Similarly, you can direct questions or commands at ChatGPT, which may seem like a back-and-forth 
conversation with another human. This ability of software programs and devices to simulate human 
intelligence is Artificial Intelligence (AI). Self-driving cars, Facebook programs that tag photos with 
names, and automated fraud detection by credit card companies are all applications of AI software. 

Machine Learning is a subset of Artificial Intelligence that focuses on using large datasets to train 
models that can then predict outcome for new data sets. For example, you can use the data of all 
recently sold homes in a neighborhood to train a pricing model to figure out how homes are priced. 
Then, the model can be used to price new homes coming up on the market. Popular real estate 
pricing tools like Redfin and Zillow use Machine Learning to suggest possible rent and sale prices of 
apartments and homes. Machine Learning software can assist radiologists in reading X-rays, MRIs, 
CT scans, and Mammograms. ML is also widely used in voice recognition, email filtering, malware 
detection, fraud identification, and preference analysis. 
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FIGURE 229 — More than 60% of the jobs done in 2018 had not yet been “invented” in 1940.215

Machine Learning and Artificial Intelligence are highly likely to change our lives. While there is great 
fear that these technologies may make some jobs redundant, they will also create new job categories 
that we don’t even know about. For example, Figure 229 shows that a large percent of jobs done 
today are new, and this trend is likely to continue.

However, we must exercise caution when adopting AI and ML models because the long-term impact 
on humans is difficult to predict and the regulatory framework around these technologies, to guide 
software makers is still in its infancy. 

215	 Source: “The Work of the Future: Building Better Jobs in an Age of Intelligent Machines,” by 
David Autor, David Mindell and Elisabeth Reynolds, Figure 2, https://workofthefuture.mit.edu/
wp-content/uploads/2021/01/2020-Final-Report4.pdf (accessed June 2023).

https://workofthefuture.mit.edu/wp-content/uploads/2021/01/2020-Final-Report4.pdf
https://workofthefuture.mit.edu/wp-content/uploads/2021/01/2020-Final-Report4.pdf
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Blockchain and Cryptocurrencies

Bitcoin and other cryptocurrencies are based on an underlying technology called Blockchain. It is a 
decentralized digital ledger that records transactions in a secure and transparent manner. A collection 
of computers, owned by individuals all over the world, can run a blockchain software that enables 
them to interact with one another, review transactions, and add to the common ledger. Because no 
single computer controls the ledger, and all computers must agree before a ledger can be updated, 
the transactions are considered reliable and secure. 

While cryptocurrencies are the most prominent use of blockchains, the underlying technology can be 
used in other areas, too. Supply chain management, voting record management, and digital identity 
management are a few such fields. 

Ethereum, a variation of the Bitcoin block chain, enables you to not only track data in a distributed 
ledger but also execute code. This lets developers build distributed apps on the Ethereum blockchain 
where “smart contracts” can be written into the code. The contracts execute automatically when 
conditions are met. For example, if you implement a supply chain system on the Ethereum blockchain, 
your supply chain app could be written with smart contracts to automate payment to the vendor when 
the shipment has reached its destination. When the ledger is updated with the “shipment received” 
event, the money is automatically moved from the buyer’s wallet to the seller’s wallet, without any 
human intervention. This greatly reduces the transaction cost, improves transparency, and avoids 
risk.

Augmented Reality and Virtual Reality

Augmented Reality (AR) combines digital 
information and real-world information in one 
place. If you are a surgeon with AR glasses, you 
would have vital information about the patient as 
you look at the patient on your operating table. A 
warehouse worker can wear glasses that show him 
directions to the precise location of an item in the 
warehouse. If you are a student reading a textbook, 
you may want additional information about the 
topic visible to you as you read. If you are looking at 
a toy in Walmart, AR can display special offers and 
user reviews about that product.

AR uses cameras, computers, displays, computer 
vision, and context-aware software to project 
information that appears to overlay the real world. 
Microsoft’s HoloLens is an example of an AR device.216 

Virtual Reality (VR) focuses on simulating new reality. The real world is blotted out, and users are 
immersed in a computationally generated world.

Augmented reality devices help blend technology 
and our physical surroundings to increase 
emersion. 

216	 Microsoft HoloLens 2, https://www.microsoft.com/en-us/hololens (accessed June 2023).

https://www.microsoft.com/en-us/hololens
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In the military, VR is used to train soldiers by 
simulating flight and battlefield scenarios. In 
medicine, students use VR to study the human body 
and surgical procedures. Vision Pro VR headset from 
Apple provides an immersive gaming and movie 
watching experience.

VR generally uses a headset as it needs to immerse 
users in a simulated world. You don’t need headsets 
to experience AR. Cars with AR can display 
directions and local traffic information overlaid on 
the screen display or windshield. This means that as 
you navigate your car, you have information in front 
of your eyes to help you make judicious decisions 
without taking your eyes off the road.

Apple’s Vision Pro VR headset allows users to be 
fully emersed in content.

Internet of Things

Devices connected to the Internet form the Internet of Things (IOT). Your old doorbell did a good 
enough job of notifying you when someone rang the bell. However, if you attach a camera and a 
microprocessor to it and connect it to the Internet, it can notify you on your mobile device when 
someone is at your doorstep. It is not only a doorbell but also a security and communication device 
that lets you interact with the person at the door (even if you are not at home) to receive a package 
or let a family member in. Ring and Nest have become popular by selling smart doorbells. If you own 
a fleet of trucks, you can connect smart sensors to your trucks to notify you ahead of time about 
any required maintenance. Your smart fridge may determine that you are short on milk, eggs, and 
vegetables and place an order on your behalf for online delivery.

The Internet of Things and devices connected to the Internet can lead to savings of time and energy. 
The world as we know it will change as a result because many of the manual chores that we have been 
doing for ages will be done automatically by Internet connected devices.

Autonomous Vehicles (Self-Driving Cars, EVTOL, Drone Delivery)

If you live in San Francisco, Phoenix, LA, Beijing, or Las Vegas, you can hail a self-driving car. A recent 
McKinsey article estimates that a sizeable chunk of new cars will have autonomous driving features by 
2035.217 The report predicts that self-driving cars will lead to fewer accidents, increase in productivity, 
and improve mobility for senior drivers. 

The flying car has been promised by many science fiction writers, but it is not here yet. However, don’t 
be surprised if, within a decade, you look up at the sky and see streams of flying vehicles autonomously 

217	 “Autonomous Driving’s Future: Convenient and Connected,” January 6, 2023, https://www.
mckinsey.com/industries/automotive-and-assembly/our-insights/autonomous-drivings-
future-convenient-and-connected (accessed June 2023).

https://www.mckinsey.com/industries/automotive-and-assembly/our-insights/autonomous-drivings-future-convenient-and-connected
https://www.mckinsey.com/industries/automotive-and-assembly/our-insights/autonomous-drivings-future-convenient-and-connected
https://www.mckinsey.com/industries/automotive-and-assembly/our-insights/autonomous-drivings-future-convenient-and-connected
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delivering people and goods from point A to B. Companies like Joby aviation,218 Lilium,219 and Archer 
Aviation220 have prototype aircrafts that are already going through FAA certification to deliver that 
dream.

Developments in battery technologies, computer vision, electric motors, and robotics have made 
it possible to design drones that are whisper quiet, safe, and cheap. It is expected that by 2030, for 
about what you pay for an uber ride, you can catch an EVTOL (Electric Vertical Take Off and Landing) 
drone from New York JFK airport to downtown Manhattan or from Chicago O’Hare to downtown 
Chicago. 

Advanced Robotics

Imagine a world where a robot follows you around carrying your coffee and your laptop. A robotic 
dog walks around your property guarding your perimeter, looking for trespassers, broken fences, 
navigating difficult terrain, and using its camera like eyes. It can identify security risks and let you 
know if anything is amiss. Imagine a robotic exo-skeleton that lets a soldier carry 100s of pounds with 
ease over difficult terrain. A robotic surgeon that can do surgery with precision. A drone that can act 
as a refueling gas station in the sky for military aircraft. Robots that can run into a fiery building and 
rescue people. 

All these science-fiction sounding robots are available today. And they are continually getting better 
as their underlying computers, batteries, motors, and machine learning improve.

Biotechnology

Emerging biotechnology trends have the potential to impact our health and happiness in a big way. 
Here are a few:

·	 Gene editing techniques such as CRISPR have revolutionized the field of genetics and have 
the potential to cure genetic diseases. In the future, gene editing could become more precise, 
efficient, and accessible, opening new possibilities for genetic therapies.

·	 Personalized medicine is becoming a reality with advances in genomics and data analytics. 
Healthcare providers can use genetic data to develop targeted therapies for individual 
patients, reducing the need for trial and error in treatment and improving patient outcomes.

·	 Synthetic biology involves the design and engineering of biological systems for specific 
purposes. This field has the potential to create new biologically inspired materials, improve 
food production, and develop novel treatments for diseases.

·	 Cell therapies involve using living cells to treat diseases. Stem cell therapies are already being 
used to treat some diseases, but researchers are exploring the potential of other cell types, 
such as immune cells, to treat cancer and other conditions.

218	 “Electric Aerial Ridesharing,” https://www.jobyaviation.com/ (accessed June 2023).
219	 Lilium homepage, https://lilium.com/ (accessed June 2023).
220	 Archer homepage, https://www.archer.com/ (accessed June 2023).

https://www.jobyaviation.com/
https://lilium.com/
https://www.archer.com/
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·	 Microbiome research involves the human microbiome, which consists of trillions of 
microorganisms living in and on the body, and is increasingly recognized as playing a crucial 
role in human health. Researchers are studying the microbiome to better understand its 
impact on various diseases and to develop new therapies.

Overall, biotechnology is a rapidly evolving field, and new breakthroughs are likely to continue to 
emerge in the coming years. These advances have the potential to revolutionize not just medicine 
but also agriculture and other industries, improving our overall quality of life.

Learning to Program: Getting Started
Making programming easy for newcomers is a priority for the industry. We provide some 
recommendations here to get you started. As you develop comfort, continue to search online for 
additional or superior resources to grow your skills.

Most experts agree that Python is the best language to start learning programming. For this 
reason, most college courses, even at the most selective colleges, use Python for the introductory 
programming class.

The simplest way to get started is to use an online environment. Jdoodle lets you get started without 
creating an account. By clicking a button, you can run the basic addition program. You can access it 
at: https://www.jdoodle.com/python3-programming-online/.

If you are willing to create an online account, you can also use replit. REPL stands for Read-Eval-Print-
Loop, which is any interactive interface that can accept a user program as input, execute (evaluate) 
it, print the result for the user to check, and be ready for the next program (loop). Replit is a popular 
modern commercial implementation. You can access the Python interpreter at Replit—https://replit.
com/languages/python3.

Once you settle on an environment, you need a lesson plan. The official Python tutorial is at: https://
docs.python.org/3/tutorial/.

The official Python tutorial is text-heavy. For a more visual experience, YouTube has a few extremely 
popular introductory Python tutorials. “Learn Python—Full Course for Beginners” by Mike Dane is one 
of the most popular.221 You can get started by practicing these exercises on either JDoodle or Replit. 
Once you get comfortable and if you have access to a computer on which you can install software, 
you can install Python on your computer and write your programs locally.

In 2023, we also have an excellent resource to learn programming–ChatGPT. You can ask ChatGPT to 
write programs to meet your specifications as shown in Figure 230 (top). After you complete a few 
initial lessons in the tutorial of your choice, we encourage you to explore other similar examples from 
ChatGPT. To use ChatGPT, go to the website https://chat.openai.com and sign up for an account. After 
that, the site is as intuitive to use as a search engine.

221	 “Python—Full Course for Beginners,” on YouTube at https://www.youtube.com/
watch?v=rfscVS0vtbw (accessed June 2023).

https://www.jdoodle.com/python3-programming-online/
https://replit.com/languages/python3
https://replit.com/languages/python3
 https://docs.python.org/3/tutorial/
 https://docs.python.org/3/tutorial/
https://chat.openai.com
https://www.youtube.com/watch?v=rfscVS0vtbw
https://www.youtube.com/watch?v=rfscVS0vtbw
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FIGURE 230 — ChatGPT can be used to learn and write code (top). Then Chat GPT can be asked to evaluate and help 
debug code (bottom).

You can also use ChatGPT to identify errors in your programs as shown in Figure 230 (bottom). ChatGPT 
will not just fix errors but also explain them. ChatGPT can, therefore, serve as your personal tutor and 
debugger as you write programs.
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Once you get comfortable with basic programs and are curious to see how these programs work, 
Python Tutor is an excellent resource to show you exactly what happens inside the computer as it 
processes each line of the program. Many of the top computer science programs use Python Tutor in 
introductory programming classes. You can access Python Tutor at https://pythontutor.com/.

Writing programs is thrilling ,and the 2020s are a great time to learn computer programming. Between 
the online REPL environments, structured tutorials, and ChatGPT, all of which are available for free, 
you have everything to develop proficiency in computer programming at your own pace.

https://pythontutor.com/


298 Chapter 13—Computer Languages, Applications, and Emerging Technologies

			   Chapter Terms and Definitions

Algorithm: A set of instructions for solving a 
problem 

Augmented Reality (AR): Combines digital 
information and real-world information in one 
place

Compiler: A specialized software program that 
can convert software code written from specific 
languages into binary code, which can then be 
executed directly by the computers

Domain-Specific Languages: Computer 
languages optimized for specific application 
domains; examples include SQL, R, and MATLAB

Internet of Things (IOT): Devices that serve 
a specific purpose and are connected to the 
Internet

Low-Level Languages: Programming languages 
that are close to the processor’s native instruction 
set; these languages are sometimes called 
assembly language

Machine Learning: A subset of Artificial 
Intelligence that focuses on using large datasets 
to train models that can then predict outcome for 
new data sets

Markup Languages: Computer languages used 
to specify how information should be displayed or 
interpreted; examples include HTML, Markdown, 
and XML

Object-Oriented Programming Languages: 
Computer languages that allow developers to 
create their own data types by organizing data 
and related functions into objects; examples 
include Java, C#, and C++

Procedural Programming Languages: 
Computer languages that use precise steps to 
compose programs: examples include C, Fortran, 
and Pascal

Scripting Languages: Computer languages 
used to automate tasks using the capabilities 
of existing applications; examples include 
AppleScript, JavaScript, and Python

Variable: A named storage location in a 
computer’s memory that holds a value
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		  	 Chapter Case

Vivian’s Raspberry Pi
Vivian had a hard time with volleyball practice today. She couldn’t get her mind off 
of her science fair project idea. She wasn’t sure exactly what she wanted to do. All 
she knew is that she wanted to use a Raspberry Pi. Suddenly…BOOM! Here comes 
the volleyball straight at her head! And then…she got an idea!

 

A Raspberry Pi is a small low-cost computer that enables people of all ages to 
explore technology and learn how to program. There are lots of projects students 
can explore such as building a robot or creating wearable technology. Here is a 
list of projects: https://projects.raspberrypi.org/en. The projects are designed for 
people all over the world who speak different languages. For instance, here is the 
link for projects with the instructions in Spanish: https://projects.raspberrypi.org/
es-ES. The whole world can have fun with Raspberry Pi!

Question 1:	 Look through the projects on the Raspberry Pi website. Find a project 
that interests you. Describe at least 2 things about the project that 
interests you to include: What will you make and what will you learn?

Question 2:	 Each Raspberry Pi project includes a detailed set of Instructions. Look 
through all the steps included in the instructions of your project. What 
do you think would be the most difficult task for you to complete 
and why do you think it would be so difficult? Now, describe what 
you think you would need to learn in order to complete this most 
difficult task. 

https://projects.raspberrypi.org/en
https://projects.raspberrypi.org/es-ES
https://projects.raspberrypi.org/es-ES
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Once the business data have been centralized and integrated, the value of the 
database is greater than the sum of the preexisting parts 

—Larry Ellison, co-founder of Oracle

Overview
Databases are structured collections of data that can be efficiently searched and manipulated by 
computers.222 Databases are the underlying information store powering our modern technology-
driven world. These databases are like digital vaults where you can keep data safely, and authorized 
users can read or update the data as needed. While you may not yet know what databases are, they 
touch your life daily. Your student records, your score history in online video games, your checkout 
history at the library are all stored in databases somewhere. In all likelihood, your personal information, 
including your home address, your phone number, and your school grades are stored in multiple 
databases.

Database applications typically refer to software programs that help users interact with the data 
stored in databases. They fall into categories such as customer relationship management (CRM), 
enterprise resource planning (ERP), learning management system (LMS), etc. For example, enterprise 
resource planning applications help retailers update their stock information when you checkout 
items at the store. Learning management systems help schools tracks the performance of all students 
at the school. When you buy something online, inventory management applications update the stock 
information on the site and create the shipping label for the items to be delivered to your home. We 
have discussed these applications throughout this book.

In this chapter, we focus on databases and introduce the technologies and concepts used to 
build databases. While there are several types of databases including object-oriented databases, 
hierarchical databases, and relational databases, most modern applications use relational databases. 
We, therefore, introduce relational database technology in this chapter.

Evolution of Database Technologies223

Commercial databases trace their origins to the Apollo moon program. The Saturn V rocket used 
to land Neil Armstrong on the moon used more than 3 million parts.224 Rockwell International, the 
company building the rocket, asked IBM if it could build a computer system to track the status of all 
these parts. A team of about 25 engineers from IBM, Rockwell, and Caterpillar, led by IBM engineer 
Vern Watts, created IMS (Information Management System), the world’s first commercial database in 
1968. Since then, IMS has become the backbone of banking, hotel, and airline applications around 

222	 This definition is adapted from Oracle’s site at https://www.oracle.com/database/what-is-
database/ (accessed June 2023).

223	 This section draws heavily on Sinclair Target’s blog post at https://twobithistory.org/2017/12/29/
codd-relational-model.html. All posts on his blog are relevant to DIT, check them out at https://
twobithistory.org/ (accessed June 2023).

224	 An overview of the Saturn V is at https://airandspace.si.edu/exhibitions/space-race/online/
sec300/sec384.htm (accessed June 2023).

https://www.oracle.com/database/what-is-database/
https://www.oracle.com/database/what-is-database/
https://twobithistory.org/2017/12/29/codd-relational-model.html
https://twobithistory.org/2017/12/29/codd-relational-model.html
https://twobithistory.org/
https://twobithistory.org/
https://airandspace.si.edu/exhibitions/space-race/online/sec300/sec384.htm
https://airandspace.si.edu/exhibitions/space-race/online/sec300/sec384.htm
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the world. Any time you use your credit card or make an airline reservation, chances are that the 
transaction involves IMS at some point.225

IMS is considered a hierarchical database. Hierarchical databases are very efficient, but also very 
inflexible. Searches in hierarchical databases require traversing the data store.226 They are designed 
to respond to specific queries and can be very slow in responding to other queries.227 Relational 
databases improve upon this limitation.228

The relational model to store data was introduced by Edgar F. Codd of IBM in 1970.229 Codd used 
concepts from set theory to organize data. He used the term “relation” to refer to a table in the 
database based on set theory, and this reference to relations gives the technology its name. 

Following the publication of his landmark paper in 1970, which introduced the relational model, Codd230 
described how data storage could be optimized in the relational model (called normalization).231 He 
also demonstrated that a small set of operations could extract any information from the database.232, 

233 This language is now called Structured Query Language (SQL).234

225	 This is from IBM’s page on IMS at https://www.ibm.com/ibm/history/ibm100/us/en/icons/
ibmims/ (accessed June 2023).

226	 One of the leaders of hierarchical databases, Charles Bachman, provides an overview in 
his 1973 Turing award lecture, “Programmer as Navigator,” at http://people.csail.mit.edu/
tdanford/6830papers/bachman-programmer-as-navigator.pdf. Wikipedia has a page on 
Bachman at https://en.wikipedia.org/wiki/Charles_Bachman (accessed June 2023).

227	 An overview of hierarchical databases can be seen at https://dataintegrationinfo.com/
hierarchical-vs-relational-database/ and https://en.wikipedia.org/wiki/Hierarchical_database_
model (accessed June 2023).

228	 The Wikipedia page on relational databases provides a nice overview of the technology at 
https://en.wikipedia.org/wiki/Relational_database (accessed June 2023).

229	 The paper is considered a landmark paper in the commercialization of computing technologies. 
You can download it from https://www.seas.upenn.edu/~zives/03f/cis550/codd.pdf (accessed 
June 2023).

230	 E. F. Codd, Wikipedia https://en.wikipedia.org/wiki/Edgar_F._Codd (accessed June 2023). Codd 
has a Florida connection—he retired to Aventura, Florida, where he died in 2003.

231	 E. F. Codd, Normalized database structure: A brief tutorial, available at https://dl.acm.org/doi/
pdf/10.1145/1734714.1734716 (accessed June 2023). Proceedings of the 1971 ACM SIGFIDET 
(now SIGMOD) Workshop on Data Description, Access and Control, November 1971, Pages 1–17

232	 E. F. Codd, A database sublanguage founded on the relational calculus, https://dl.acm.org/doi/
pdf/10.1145/1734714.1734718 (accessed June 2023). Proceedings of the 1971 ACM SIGFIDET 
(now SIGMOD) Workshop on Data Description, Access and Control, November 1971, Pgs 35–68

233	 E. F. Codd, “Relational Completeness of Data Base Sublanguages,” Computer Science Research 
Report, 1972, available at http://www.geology.cz/personal/j/jan.sedlacek/codd2.pdf (accessed 
June 2023).

234	 For those interested in more detail on Codd’s relational model, his colleague C. J. Date has 
published a critique of the model, “Codd’s First Relational Papers: A Critical Analysis,” available at 
https://www.dcs.warwick.ac.uk/~hugh/TTM/CJD-on-EFC%27s-First-Two-Papers.pdf (accessed 
June 2023).

https://www.ibm.com/ibm/history/ibm100/us/en/icons/ibmims/
https://www.ibm.com/ibm/history/ibm100/us/en/icons/ibmims/
http://people.csail.mit.edu/tdanford/6830papers/bachman-programmer-as-navigator.pdf
http://people.csail.mit.edu/tdanford/6830papers/bachman-programmer-as-navigator.pdf
https://en.wikipedia.org/wiki/Charles_Bachman
https://dataintegrationinfo.com/hierarchical-vs-relational-database/
https://dataintegrationinfo.com/hierarchical-vs-relational-database/
https://en.wikipedia.org/wiki/Hierarchical_database_model
https://en.wikipedia.org/wiki/Hierarchical_database_model
https://en.wikipedia.org/wiki/Relational_database
https://www.seas.upenn.edu/~zives/03f/cis550/codd.pdf
https://en.wikipedia.org/wiki/Edgar_F._Codd
https://dl.acm.org/doi/pdf/10.1145/1734714.1734716
https://dl.acm.org/doi/pdf/10.1145/1734714.1734716
https://dl.acm.org/doi/pdf/10.1145/1734714.1734718
https://dl.acm.org/doi/pdf/10.1145/1734714.1734718
http://www.geology.cz/personal/j/jan.sedlacek/codd2.pdf
https://www.dcs.warwick.ac.uk/~hugh/TTM/CJD-on-EFC%27s-First-Two-Papers.pdf
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While the relational model was conceptually sound, the success of IMS prevented commercial 
investments from creating a working technology based on the relational model. IBM had a small 
team working on a project called System R to build a relational database, and Professor Michael 
Stonebraker235 at UC Berkeley obtained funding from NSF as well as Army, Navy, and Air Force to start 
a project called INGRES to create a database using the relational model.236, 237 The viability of INGRES 
and wide distribution of its open-source code facilitated the commercialization of the relational 
model. Today, the relational model is taught as the standard database model in all relevant academic 
programs.

A few popular relational databases include:

·	 Oracle Database, offered by Oracle corporation, is probably the most popular relational 
database system in the world. 

·	 MySQL is a widely used open-source relational database management system. MySQL is also 
owned by Oracle since its purchase of Sun Microsystems. 

·	 Microsoft SQL Server is provided by Microsoft and common in Microsoft-based ecosystems.

·	 PostgreSQL is another popular open-source relational database management system that is 
known for its advanced features and reliability. It is the successor to the INGRES project.

·	 IBM DB2 is provided by IBM and is widely used in enterprise applications.

·	 SQLite is a lightweight relational database management system that is often used in embedded 
systems and mobile applications. For example, your browser uses SQLite to manage bookmarks.

Why Study Databases

Compared to the technologies covered in other chapters in this book, database technologies have 
a unique feature—they are a core enterprise technology, there is an entire class of highly paid 
professionals—database administrators—who maintain databases. We introduce the relational 
database technology in this book because of its importance as well as because the basic concepts 
of relational databases should be very interesting to high school students. If you find the contents in 

235	 A summary of Stonebraker’s work can be seen in his award citation for the John von Neumann 
medal at https://par.nsf.gov/servlets/purl/10219488 (accessed June 2023).

236	 This paragraph draws from the excellent story in “The rise of relational databases,” Chapter 
6 in Funding a revolution: Government support for computing research,” available at http://
worrydream.com/refs/National%20Research%20Council%20-%20Funding%20a%20
Revolution.pdf, pgs 159–168 (accessed June 2023).

237	 For a report on INGRES, please see Michael Stonebraker, Eugene Wong, Peter Kreps and Gerald 
Held, “The Design and Implementation of INGRES Tandem Computers, Inc.,” available at https://
dl.acm.org/doi/pdf/10.1145/320473.320476. It goes into the details of INGRES’ working.

https://par.nsf.gov/servlets/purl/10219488
http://worrydream.com/refs/National%20Research%20Council%20-%20Funding%20a%20Revolution.pdf
http://worrydream.com/refs/National%20Research%20Council%20-%20Funding%20a%20Revolution.pdf
http://worrydream.com/refs/National%20Research%20Council%20-%20Funding%20a%20Revolution.pdf
https://dl.acm.org/doi/pdf/10.1145/320473.320476
https://dl.acm.org/doi/pdf/10.1145/320473.320476
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this chapter interesting, you can learn more online at your own pace at sites such as Khan Academy,238 
W3Schools,239 Coursera,240 EdX,241 etc.

Relational Databases
Relational databases are databases that organize data as tables linked to each other. Each row in a 
table represents one item in the database. A single database can have any number of tables, with 
each table representing all stored items of a type.

Each table (or relation) in a relational database represents an entity or a concept. Each table consists 
of rows, also known as records or tuples, and columns, also known as attributes or fields. Each row in a 
table represents a specific instance of the entity, and each column represents a specific characteristic 
or data related to that entity.

In a relational database, tables are related to each other using keys. Following set theory, every row 
in the database is unique. Keys uniquely identify data in each row and also allow data from different 
tables to be joined together. Let’s go over these ideas with an example of students enrolled in courses.

Figure 231 shows a relational database model storing information about courses taken by students. 
There is a table called Students, which stores information about students such as names (other 
information could also be added). A separate table called Courses has information about courses 
such as the title of the course. Finally, a table unique to the relational database model, called 
StudentCourses, identifies all the courses taken by each student.

FIGURE 231 — Relational databases allow users to query multiple tables of data.

The tables for students and courses are intuitive, but the way the tables are linked to each other to 
list all the courses taken by all the students gives the relational database model its power. First note 
that the Students and Courses tables have a column labeled Id, which assigns a unique label (called 
identifier, or Id for short) to each row. In the StudentCourses table, both students and courses are 

238	 “Intro to SQL: Querying and Managing Data,” https://www.khanacademy.org/computing/
computer-programming/sql (accessed June 2023).

239	 “SQL Tutorial,” https://www.w3schools.com/sql/ (accessed June 2023).
240	 “SQL for Data Science,” https://www.coursera.org/learn/sql-for-data-science (accessed June 

2023).
241	 “Databases: Relational Databases and SQL,” https://www.edx.org/course/databases-5-sql 

(accessed June 2023).

Students

StudentCourses

Courses

https://www.khanacademy.org/computing/computer-programming/sql
https://www.khanacademy.org/computing/computer-programming/sql
https://www.w3schools.com/sql/
https://www.coursera.org/learn/sql-for-data-science
https://www.edx.org/course/databases-5-sql
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represented by the respective unique identifiers (Ids). We can see from the StudentCourses table that 
only Maria (studentId 2) has taken History (courseId 5), but Sam, Maria, and Carter have all taken DIT 
(course Id 2).

In the relational model, a column (or combination of columns) that is guaranteed to be unique in a 
table can serve as the primary key for the table. For example, your license number is a primary key 
that uniquely identifies you in the Department of Motor Vehicles (DMV)’s database. Your student Id 
is a primary key that uniquely identifies you in your school’s database. Usually, the unique identifiers 
serve as the primary key column(s) of tables. For example, in the Students table, the “Id” column is the 
primary key of the Students table. Similarly, even in the Courses table, the “Id” column is the primary 
key. Typically, the database software generates a unique value for the primary key in a row.

When a primary key is defined on a table, the relational database management system ensures that 
no two rows in the table have the same primary key values. In addition, the primary key column(s) 
cannot have null (empty) values since a null value cannot uniquely identify a row.

Organizing data as shown in Figure 231 allows for efficient storage and retrieval of data using various 
relational operations and Structured Query Language (SQL) commands. For example, if you regularly 
buy goods from Amazon, they can maintain a record of all your purchases and returns made in the 
recent past by looking you up using your primary key and pulling all the purchase records associated 
with your primary key. Each purchase is a database record, and so is every return. Each record of 
purchase has many details, including the item name, the name of the seller, the time of transaction, the 
amount, and the location of the transaction. Once you have a way to input your data into a database, 
you can track, update, delete, and report on that data easily. In Amazon’s database, a collection of all 
the purchases and returns of all their customers comprises the transactions table. Can you imagine 
how huge the table must be, how many bytes of data it must have?

In the relational database model of Figure 231, you will only need to interact with the Students table if 
you want to get the basic information related to students. Similarly, if you just want to get information 
about all the courses offered, you will only need to query the Courses table. However, to get the 
course information of every student, you will need to use the StudentCourses table, which joins all 
the Students and Courses tables by Ids. Retrieving records by Ids is much faster than that by names, 
which makes well-designed relational databases extremely efficient.

In relational databases, the process of keeping data spread across multiple tables is called normalization. 
Normalization ensures that no single table becomes too unmanageable in size. Not surprisingly, the 
relational database model is widely used across industries for its flexibility, scalability, and robustness.

Introduction to SQL
Storing data in a database is just the first step. Once you have your data in a database, you need to 
interact with the database management system (the software that manages the database) to see or 
change the data. Structured Query Language (SQL) is a programming language used to interact with 
relational databases. 

SQL commands can be used to create new databases and tables. There are also SQL commands to 
insert, update, and delete data in existing tables. SQL can also be used to search for and retrieve 
specific data using queries, which are statements that specify the criteria for selecting data. Most 
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college programs in computing have a course on databases, which goes into all the details of SQL. In 
this chapter, we only provide an overview of SQL.242

SQL Commands Types
There are four main types of SQL commands you should know about: 

Data Manipulation Language (DML) commands are used to manipulate the data stored in databases. 
The most commonly used DML commands are SELECT, INSERT, UPDATE, and DELETE. SELECT is used 
to retrieve data from databases; INSERT is used to add new data; UPDATE is used to modify existing 
data; and DELETE is used to remove data from databases.

Data Definition Language (DDL) commands are used to define the structure (schema) of databases. 
When you are creating a new database, you will need to create tables, specify the relationship between 
tables, and add constraints on the data to make sure the integrity of the data is maintained. CREATE, 
ALTER, and DROP are the most common DDL commands you will need. CREATE is used to create new 
tables and other database objects; ALTER is used to modify the structure of existing tables; and DROP 
is used to delete tables and other database objects.

Transaction Control Language (TCL) commands serve as gatekeepers of changes. COMMIT, ROLLBACK, 
and SAVEPOINT are the most common TCL commands. If you COMMIT a transaction, you make the 
changes permanent; ROLLBACK undoes the changes you made earlier; and SAVEPOINT creates a 
bookmark in a transaction to which you can rollback later.

Data Control Language (DCL) commands are used to control who can access your database. GRANT 
and REVOKE are the most common commands. GRANT is used to grant permission to users to access 
and modify the database; and REVOKE is used to revoke permissions.

Querying a Database Using DML Commands
If you are a database developer, you will use DML commands very frequently to change previously 
added data, delete existing records, or insert new data. Luckily, SQL is easy to learn because it has 
English-like commands to select, insert, update, and delete. SELECT allows you to fetch data; INSERT 
is used to add data; UPDATE is used to change previously added data; and DELETE is used to remove 
records. 

Querying data—The first operation you will most likely want to do is view data stored in your database. 
Here’s an example of a basic SELECT statement: 

SELECT * 

FROM Students

WHERE Id= 56745;

242	 You can practice SQL at several sites online. A popular site for code practice is jdoodle, https://
www.jdoodle.com/execute-sql-online/ (accessed June 2023).

https://www.jdoodle.com/execute-sql-online/
https://www.jdoodle.com/execute-sql-online/
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This statement tells the RDBS to fetch all the details (*) from the Students table about the student 
whose Id is 56745. If you wanted to fetch just a few specific columns about the student, you could 
alter the query to specify the names of columns as:

SELECT StudentName, StudentAge, StudentAddress 

FROM Students

WHERE Id= 56745;

The WHERE command is powerful, offering many possibilities, and can be used to select exactly what 
you want to fetch.

Suppose you want to get all the students who are either from California or Florida, you could change 
the WHERE clause in the following way:

SELECT *

FROM Students

WHERE State = ‘California’ OR State = ‘Florida’;

This statement will only return those students who have the values California or Florida in the column 
“State.” Just like the equals (=) and the OR operations, you can also employ > (greater than), < (less 
than), BETWEEN, LIKE, and IN. 

SELECT *

FROM Students

WHERE State = ‘California’ AND GPA >= 3.5;

This command only returns the rows where the “state” column is equal to “California” and the “GPA” 
column is greater than or equal to “3.5.”

You can also use both “AND” and “OR” operators in the same query and even group conditions using 
parentheses. For example:

SELECT *

FROM Students

WHERE (State = ‘California’ AND GPA >= 3.5)

OR (State = ‘Florida’ AND GPA >=3.5);

Querying from Multiple Tables

In relational databases, data is stored in many tables to eliminate data duplication. However, you will 
frequently need to join tables to get the data you want. In SQL, JOIN is a special command that links 
tables based on shared columns.
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Let’s consider two tables “customers” and “orders” 
(Figure 232) to see how JOIN works:

Schema refers to the way a database is structured. 
To relate the orders to the customers who placed 
those orders, the Orders table has the Id of the 
customer as the customer_id column. This allows 
us to link the two tables (Customers and Orders). 
For example, to get the orders placed by customers, 
we can link the two tables, as shown below, and get 
all orders from all customers: 

SELECT customers.first_name, customers.
last_name, orders.order_date, orders.total

FROM customers, orders 

WHERE customers.id = orders.customer_id;

With this query, you are fetching the first name and 
last names of your customers from the Customers 
table and the order_date and total from your Orders 
table. We can join the two tables because the id 
column of the Customer table and the customer_id 
column of the Orders table contain the same data: 
the id of the customers. The relational model gives 
us this convenient method to retrieve the data we 
need from databases. SQL queries read like plain 
English sentences. (Figure 233.)

FIGURE 232 — Data is structured in tables with 
rows and columns, similar to spreadsheet files. 

FIGURE 233 — Separate tables can be joined by 
using matching columns or “keys.” 

Updating Data 

Databases need to be updated with the latest 
information all the time. For example, at the DMV, 
drivers will come in to register new cars, update their license plates, or change their current residential 
addresses. With the help of SQL, you can identify the record in the database that needs to be updated 
and set the new values. 

The UPDATE command allows you to change the values of one or more columns in one or more rows 
of a table. The basic syntax of the SQL UPDATE command is as follows:

​​UPDATE table_name

SET column1 = new_value1, column2 = new_value2, …

WHERE some_condition;

In this syntax:

·	 table_name is the name of the table you want to update.

·	 column1, column2, etc. are the names of the columns you want to update.
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·	 new_value1, new_value2, etc. are the new values you want to set for the corresponding 
columns.

·	 some_condition is a condition that specifies the rows to update. Only the rows that satisfy the 
condition will be updated.

Here’s an example that demonstrates how to use the UPDATE command to change the email address 
of a customer:

UPDATE customers

SET email = ‘newemail@example.com’

WHERE customer_id = 123;

This command will update the email address of the customer with ID 123 to “newemail@example.
com.”

You must be very careful when using the UPDATE command and not change data you don’t want to 
change. Always doublecheck your WHERE clause to make sure you are correctly specifying the rows 
to update. For example, the command below will update the email addresses of ALL the customers 
in the database to “newemail@example.com.” If your database has information about a million users, 
the email addresses of all million users will be updated instantly. Unless all your customers have the 
same email address, you don’t ever want to run a command like the one below:

Update customers 

SET email =’newemail@example.com’;

Deleting Data

If a student drops out of a class, you’ll need to remove the student from the Class table. If a customer 
requests you to remove them from your monthly mailers, you’ll need to delete the customer from 
your Subscriptions table. 

The DELETE statement deletes one or more rows from a table based on the selection criteria in the 
WHERE clause. The basic syntax of the DELETE statement is as follows:

DELETE FROM table_name

WHERE condition;

In this syntax:

·	 table_name is the name of the table from which you want to delete data;

·	 condition specifies which rows to delete and only the rows that satisfy the condition will be 
deleted.

Here’s an example that shows how to use the DELETE statement to remove a particular customer 
record:

DELETE FROM customers

WHERE customer_id = 123;

mailto:newemail@example.com
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This command will delete the customer record with Id 123 from the “customers” table.

It’s important to be careful when using the DELETE statement to avoid removing data you don’t 
want to delete. Always make sure that you have a backup of your data before performing deletions. 
Additionally, as mentioned earlier for the UPDATE command, double-check your WHERE clause to 
ensure that you are deleting only the data you want to remove.

If you forget to include a WHERE clause, as in the example below, you may end up deleting ALL the 
rows in the customers table:

Delete FROM customers;

Defensive Updates and Deletes

Before you run a DELETE command, you may want to test the WHERE clause in 
a SELECT statement to confirm you are deleting the right set.

For example, to DELETE all customers who live in a particular zip code, run this 
SELECT command first.

Select * from CUSTOMERS where zipcode=’95070’;

If the output has all the rows you want to delete, then use the same WHERE 
clause in your delete command to delete records.

Delete FROM customers WHERE zipcode=’95070’;

Advanced Querying Options

Databases can quickly get large and may require special reporting, sorting, and grouping to make 
sense of the stored data. If you have a database to keep track of exam results for your school, the 
“Students” table may have 1000s of rows. If you assume each student takes 50 courses over their high 
school career, the “StudentCourses” table will be 50 times as large as the “Students” table. Now if each 
course has 100 grading events, you can imagine how large the “Grading” table will be. 

When you report on this data, you need to know how to sort, group, and limit the amount of output 
to quickly get to the information you need. For example, your teacher may be interested in identifying 
the two students who have not submitted a deliverable, or the four or five students who have excelled 
on tests. It is not helpful in these cases to simply print out the 5 million rows for all grading events at 
the school. It is much more useful to use the capabilities of the database to list just the four or five 
rows with the needed information.

Sorting

The ORDER BY command sorts the result set in ascending or descending order based on one or more 
columns in the SELECT statement. The basic syntax of the ORDER BY clause is as follows:

SELECT column1, column2, …

FROM table_name

ORDER BY column1 [ASC|DESC], column2 [ASC|DESC];
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You can specify the column or columns you want 
to sort by, followed by either “ASC” for ascending 
order or “DESC” for descending order. If you want, 
you could sort by multiple columns, separated by 
commas.

Let’s consider a table of employees with the following 
data: id, name, age, and salary (Figure 234).

To sort this table by salary in descending order, you 
can use the following SQL query:

SELECT * FROM employees

ORDER BY salary DESC;

This will return the following output (Figure 235):

To sort the same table by age and then by salary, 
try the following SQL query:

SELECT * FROM employees

ORDER BY age ASC, salary DESC;

This will return the following output (Figure 236).

FIGURE 234 — The ORDER BY command allows 
users to efficiently sort data in a table. 

FIGURE 235 — Users can choose to sort a table by 
column name in ascending or descending order. 
This table is sorted by salary in ascending order.

FIGURE 236 — ORDER BY commands are not 
limited to one condition. A user can combine 
conditions to further refine their request. 

Grouping

The GROUP BY command helps you get a summary 
of data. If you have a database of students, you may 
want to group students by their courses to see how 
well the students are doing in different courses. Or, 
you may want to group students by their classes 
(freshman, sophomore, junior, senior) to see the 
average grade across different cohorts. 

The GROUP BY command in SQL is used to group 
rows that have the same values in one or more 
columns. It is typically used with aggregate 
functions like AVERAGE, MAX, MIN, and COUNT. The 
result set will contain only one row for every value 
of the column in the GROUP BY clause. For example, 
if you GROUP BY the department field in a table 
that has employee_name, salary, and department, 
then the result set will have one row for every department. 

As another example, if you want to count the number of employees and the average salary of 
employees in every department, you can use GROUP BY, COUNT, and AVG commands.
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SELECT department, COUNT(*) as num_employees, AVG(salary) as avg_salary

FROM employees

GROUP BY department;

In this example, the query counts the number of 
employees in each department (COUNT(*)) and 
gives you the average salary of those employees. 
In the original table, we did not have the count of 
employees or the average salary of employees. So, 
in the output, we have two new fields that did not 
exist before. You can use the “as” operator to give 
these fields meaningful names in the output as 
shown in Figure 237. 

The general syntax for using the GROUP BY command, is as follows:

SELECT column1, column2, …, aggregate_function(column)

FROM table_name

GROUP BY column1, column2, …;

In the above syntax, column1 and column2 are the columns you wish to GROUP BY. The aggregate_
function(column) is the function that you want to apply to the grouped data, such as COUNT, AVG, 
SUM, MAX, MIN, etc.

You can use multiple columns in the GROUP BY clause if you want to group data by more than one 
column.

As you can see, the GROUP BY command is a powerful tool in SQL that allows you to summarize data 
based on specific criteria, making it easy to extract useful information from large datasets.

FIGURE 237 — A variety of commands, including 
GROUP BY, allow users to count sets in data. 

* in SQL

The symbol “*” as used in the GROUP BY example above indicates “all.” In the 
example, it tells the database to count all rows in each group.243

Calculated Fields

There are times when you don’t want to simply present the data in the database but would like to 
apply some calculations before printing the output. For example, if you are looking at a database of 
students with their scores, you may also like to calculate and print their letter grades (A, B, C). Or, if 
you have a database of employees, you may want to calculate their bonuses as a percentage of their 
salaries. SQL lets you do these calculations easily without impacting the underlying data. 

A calculated field is a column in a query result set that is created by applying an expression or formula 
to one or more columns in a table. The expression can be a combination of arithmetic operators, 

243	 You can check out this Stackoverflow post for some additional information, https://stackoverflow.
com/questions/38662318/what-does-mean-in-sql (accessed June 2023).

https://stackoverflow.com/questions/38662318/what-does-mean-in-sql
https://stackoverflow.com/questions/38662318/what-does-mean-in-sql
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functions, and constants. This can be especially helpful when you need to perform complex 
calculations on columns in the table or create custom metrics that are not available in the original 
dataset. Consider this query:

SELECT first_name, last_name, salary, salary * 0.1 AS bonus

FROM employees;

In this example, the query calculates a 10% bonus 
for all employees. 

The result set of this query has four columns: first_
name, last_name, salary, and bonus (Figure 238). 
The bonus column is a calculated field that contains 
the bonus of employees based on their salaries. As 
the field does not exist in the original table, you can 
give it a meaningful name with the help of the “AS” 
operator.

Creating and Managing Tables Using DDL Commands
To create a table in SQL, you can use the CREATE statement. 

CREATE TABLE table_name (

column1 datatype,

column2 datatype,

column3 datatype,

…

);

In the above DDL command, the datatype specifies the type of data that can be stored in the column. 
Common datatypes are VARCHAR for text, INT for integers, DECIMAL for decimal numbers, and DATE 
for dates. An interesting feature of relational databases is that most data in databases is numbers or 
strings.

Here’s an example of a CREATE TABLE statement that creates a table Customers with columns for three 
items of information (name, email and rent) and an id:

CREATE TABLE boarders (

id INT PRIMARY KEY,

name VARCHAR(50),

email VARCHAR(100),

rent INT

);

FIGURE 238 — SQL queries can also preform 
calculations and output new fields, which is crucial 
in data analysis. 
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If you run this SQL command, you will create a table called boarders with four columns: id, name, 
email, and rent. The id column is an integer and is set as the primary key of the table.

There are occasions when you no longer need a table, either because you want to create a new table 
or because you have the same data in another table. You can use the DROP command to permanently 
delete tables.

DROP TABLE table_name;

For example, to delete the boarders table, run the following DDL command:

DROP TABLE boarders;

Sometimes you may need to change a table to add new columns, change the column name, or change 
the data type of a column. You can use the ALTER TABLE command to add, remove, and rename 
columns. You can even change the type or the size of data stored in columns. Here are examples for 
each of these commands:

ALTER TABLE table_name ADD COLUMN column_name data_type;

__________

ALTER TABLE table_name MODIFY COLUMN column_name new_data_type;

__________

ALTER TABLE table_name

RENAME COLUMN old_column_name TO new_column_name;

__________

ALTER TABLE table_name DROP COLUMN column_name;

The DROP COLUMN command removes an existing column from the table.

Storing Images, Documents, and Other Information in Relational Databases

Relational databases typically store simple data types such as numbers and 
strings. However, we often need to store information such as images and 
documents. How can you store such information in relational databases?

Most modern relational databases have a datatype called blob (binary large 
object) that can be used to store images, documents, videos, and any other 
information. However, a better alternative is to store these images, documents, 
videos, etc., as files in the file system and just save the name and location of the 
file in the database. This keeps the database compact, speeding up searches.

Inserting Data

To add data to tables in your database, you can use the INSERT INTO command.

The INSERT command expects you to know the column names and the type of data the columns can 
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hold; therefore, you will need to know the structure of the table before you can insert data into it. To 
check the structure of a table, use the DESCRIBE command. 

DESCRIBE Users;

When you run the above command, you will see the structure of Users, a result set that lists all the 
columns in Users, along with their data types and any constraints applied to them.

As you can see in Figure 239, the Users table has 
three columns: id, name, and email. The id column 
is an integer with a maximum length of 11 digits 
and is marked as the primary key. The type of 
both the name and email columns is varchar with 
a maximum length of 50 characters. They are also 
marked as nullable, which means that they can 
contain Null values. In a relational database, a Null 
value means that the data is unknown or missing. 
While this table looks okay in theory, a record that has just an id, but no name or email won’t make 
sense. So, ideally, you should change the table to make sure either the name or the email contains a 
value—cannot be Null.

Once you know what a table expects, you can use the INSERT INTO statement to begin adding data. 
Here’s an example.

INSERT INTO Users (id, name, email) VALUES (1, ‘Cecilia Flores’, ‘cecilia.flores@example.com’);

INSERT INTO Users (id, name, email) VALUES (2, ‘Ratna Devi’, ‘ratna.devi@writers.com’);

FIGURE 239 — Utilizing the DESCRIBE command is 
useful when determining data structure. 

INSERT INTO Variants

The examples shown are the typical ways the INSERT command is used. We 
listed three column names next to the table name (Users (id, name, email)) and 
gave the values to be inserted for each of these columns. There is another way 
to use the INSERT command by skipping the column names. However, you can 
only skip the column names if the data being passed has the same columns in 
the same order as the existing columns of the table. For this reason, the usage 
shown in the example is more typical.

Importing Data

There are times you already have data that you would like to insert into a table in a file. For example, 
you may want to move the data in an Excel file into a database. The general concept to import data 
is similar across all relational database systems and uses some common methods including the 
following:

·	 We’ve already used the INSERT INTO command to add data to a table in a database. You can 
also use the LOAD DATA INFILE command to insert data from a file into a database table. 
Ideally, the file should be a text file with well formatted input data, so you can map the data to 
the columns in your target table. 



Chapter 14—Database Applications 317

·	 Many database management systems provide command-line utilities to import data from 
different sources. For example, MySQL provides the mysqlimport utility that can be used to 
import data from CSV or TSV files. 

·	 Some database management systems provide GUI tools that allow you to import data. For 
example, Microsoft SQL Server Management Studio provides the Import Wizard that can be 
used to import data from different file formats such as Excel, CSV, and Access.

·	 You can write a script (software program) in a programming language such as Python or Java 
to read data from a file and insert it into a database table using the INSERT INTO command. 

In general, here are the steps developers follow to import data into an SQL database:

·	 Connect to the database using a database client or a programming language.

·	 Create a table or select an existing table to import data into.

·	 Prepare the data by cleaning it up and ensuring it is in the correct format.

·	 Use SQL commands, command-line utilities, or a programming language to import the data 
into the table.

·	 Verify that the imported data is accurate by querying the table.

Transactions Using TCL Commands
As stores of information, databases have stringent requirements for correctness. Therefore, if a 
database activity fails for any reason, you typically want to restore the data to its original state. Let’s 
demonstrate this by example.

Suppose you manage the database of Expedia.com and need to transfer a few passengers to a new 
flight because the original flight is inconvenient. Since the passengers want to be transferred only if 
the new flight has seats available, you want to make sure that both the transactions (booking seats on 
the new flight and cancelling seats on the original flight) are successful. If you remove the passengers 
from their original flight, you must be able to allocate seats for them in the new flight. If your operation 
completes the first step but fails the second, you will have some very angry passengers with no flight. 
Without the assurance that transactions complete as a set or do not occur at all, databases would not 
be very useful.

Banking transactions also need to fail or succeed as a set. If you remove money from one account 
but fail to add it to the target account (say if the network connection fails), then you end up in an 
inconsistent state as far as the database is concerned. The unfortunate account owners may wonder 
what happened to their money, and the bank may receive some frantic calls.

To avoid these problems, databases support the concept of a transaction. You can make sure that 
database operations in a transaction are executed as a single unit of work or a single transaction, or 
not at all. The Transaction Control Language (TCL) commands—BEGIN TRANSACTION, SAVEPOINT, 
ROLLBACK, and COMMIT are useful in ensuring a set of transactions fail or succeed as a set. 

The BEGIN TRANSACTION statement starts a transaction and the COMMIT statement commits or 
saves the transaction to the database permanently. If any part of the transaction fails, the ROLLBACK 
statement is used to undo the changes made by the transaction and to return the database to its 
original state. Consider the example:
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BEGIN TRANSACTION;

UPDATE accounts SET balance = balance - 250 WHERE account_id =786543;

UPDATE accounts SET balance = balance + 250 WHERE account_id = 90643;

COMMIT;

In this example, the transaction has two UPDATE statements. One subtracts $250 from account_id 
786543 and the other adds $250 to a different account. If either of the UPDATE statements fails, a 
ROLLBACK statement would undo the changes made by the transaction to return the database to its 
original state. Anytime you are unsure of the changes you are about to do; you may want to create a 
Savepoint to be able to Rollback the database changes to the Savepoint. Consider the following set 
of transactions:

SAVEPOINT Mark1;

UPDATE accounts SET balance = balance - 250 WHERE account_id =786543;

SAVEPOINT Mark2;

UPDATE accounts SET balance = balance + 250 WHERE account_id = 90643;

ROLLBACK TO Mark2;

At the end of the set of above transactions, the database will have just one change (the first update) 
since we have rolled back the second change. 

Transactions implement a few concepts unique to databases: atomicity, consistency, isolation, and 
durability (these are popular in the industry as the ACID properties of transactions).

·	 Atomicity: a transaction is atomic, meaning that it is executed as a single unit of work. Either 
all the operations in the transaction are completed successfully, or none of them are. If any 
part of the transaction fails, the entire transaction is rolled back, and the database is left in 
its original state. In our example, when you transfer money between accounts, both activities 
(removing from one account and depositing in another) complete as a single transaction. 

·	 Consistency: a transaction must keep the database in a valid state both before and after 
the transaction. Any constraints or rules that apply to the data must not be violated by the 
transaction. In our example, the total amount of money in accounts must be the same before 
and after the transfer of money between accounts. 

·	 Isolation: the data accessed by one transaction must be isolated and not affect other 
transactions running in parallel. A transfer of money from one account to another must not 
impact other banking activity between other users and their accounts.

·	 Durability: once a transaction is committed or saved to the database, the changes are 
permanent and must survive any subsequent failures or crashes. Even if the database crashes 
once a transaction has completed, the data must be recoverable. 
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Controlling Database Privileges Using DCL Commands
Database administrators manage databases using DCL commands. These commands help database 
administrators create roles and users, grant privileges to roles, assign roles to users, and alter and 
revoke privileges. Granting specific privileges prevents accidental errors. Removing users when they 
leave or change organizations prevent unauthorized access.

The CREATE USER command creates a new user account in the database.

Example: CREATE USER jose_robelo IDENTIFIED BY ‘password’;

The ALTER USER command modifies the properties or privileges of an existing user.

Example: ALTER USER jose_robelo PASSWORD ‘new_password’;

THE CREATE ROLE command is used to create a new role. Once you have a role, you can assign 
privileges to the role. You may have roles like developer, marketing, sales, and admin, each with a 
specific set of privileges. When Jose Robelo joins the organization, granting the right role to him will 
make sure he has all the necessary privileges.

CREATE ROLE marketing;

Once you have a role, you can grant privileges to the role; and then assign the roles to users.

GRANT select, update ON customers TO marketing;

GRANT marketing TO jose_robelo;

Later, if Jose Robelo leaves the marketing organization, you can revoke all his privileges with the 
following command:

REVOKE marketing FROM jose_robelo;

Conclusion
There is no modern organization or government that doesn’t own and rely on its huge databases of 
information about their people, industries, education, banking systems, and hospitals, among others. 
Modern databases are typically built using the relational model. A simple English-like language allows 
you to work with the data in databases.

Although relational databases are popular and widely used across industries and governments, newer 
technologies such as NoSQL databases and graph databases are also useful in certain scenarios. Every 
database has its own unique strengths and weaknesses. So, you should learn about them before you 
decide to pick one to store your data. Most computing programs in colleges discuss the development 
and maintenance of databases in more detail.
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			   Chapter Terms and Definitions

Data Control Language (DCL): SQL commands 
that serve as gatekeepers to changes in the data 
within the database; examples include COMMIT, 
ROLLBACK, and SAVEPOINT

Data Definition Language (DDL): SQL 
commands used to define the structure of 
databases; examples include CREATE, ALTER, and 
DROP

Data Manipulation Language (DML): SQL 
commands used to manipulate data stored in 
databases; examples include SELECT, INSERT, 
UPDATE, and DELETE

Database: A structured collection of data that 
can be efficiently search and manipulated by 
computers

Database Management System: The software 
that manages the database

Key: Uniquely identified data in each row that 
can be used to join different tables together

Query: SQL written to search for and retrieve 
specific data from a database based specific 
criteria

Relational Database: A database that organizes 
data as tables linked to each other

Structured Query Language (SQL): A 
programming language designed to execute 
a small set of operations that could extract any 
information from databases

Table: An entity within a relational database that 
consists of rows and columns

Transaction Control Language (TCL): SQL 
commands that serve as gatekeepers of changes 
to the database. Examples include: COMMIT, 
ROLLBACK, and SAVEPOINT.
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		  	 Chapter Case

Dionne’s Grade Tracking Database
Dionne is planning to attend the University of South Florida (USF) when he graduates 
from High School. USF has a Grade Point Average (GPA) requirement for admissions 
and Dionne wants to make sure he keeps a close eye on his grades. Now that he 
knows a lot more about the power of databases, he wants to design a database that 
will help him keep track of his grades. But he’s not sure which database to choose 
and what features the database offers. He’s also not sure if the database is free or if 
he will have to pay to use it. He doesn’t have a lot of money, so a cheap price or free 
is the best. Dionne also isn’t sure if he should pick a database that he will have to 
install on his laptop or if he can just login to a website online and use it. There are 
so many questions that Dionne needs to answer before he can design his database. 

Question 1:	 Use the Internet to research the World Wide Web for at least one 
database management system that Dionne could use to design his 
database. If you have trouble finding any database management 
systems, review the “Evolution of Database Technologies” section in 
this chapter where you will see a list of popular relational database 
management systems. List the database management systems you 
have found for Dionne and describe the following: What are some 
key features of the database management system? How much does 
it cost?

Question 2:	 Describe in detail what Dionne will have to do to use the database 
management system. In other words, will he have to install it on his 
laptop, login to a website, or use some other method?
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There were 5 exabytes of information created between the dawn of civilization 
through 2003, but that much information is now created every two days. 

—Eric Schmidt, Executive Chairman at Google

Overview
The interconnection of information systems is an extremely important function in today’s personal, 
consumer, and business world. Many people stay connected with information available on the 
Internet by using virtual assistant technologies such as Amazon’s Alexa to purchase items online with 
their Amazon Prime account. Similarly, businesses are motivated to use interconnected devices to 
conduct daily tasks such as virtual meetings and email communication. In all these cases, computer 
networks are required to move information from one application operating on a computer to another. 
Computer networks can be defined as the interconnection of information systems through the use of 
components designed to communicate using standardized technologies. 

Computers interact with networks by using specialized 
hardware components designed to communicate 
data in a very consistent way. In fact, today’s modern 
computer networks are the result of over 100 years 
of innovations engineered to communicate data. 
One of the earliest examples of using a network to 
communicate data from one device to another was 
the telegraph. Patented in 1840, the telegraph was 
a communications device used by Samuel Morse to 
send information to locations across great distances. 
To do this, the telegraph would connect and release 
a switch from a sender device that was designed to 
energize an electromagnet on a receiver device. Once 
the receiver’s electromagnet was energized, it would 
pull a marker to one side. The marker would then 
scratch a line on a paper at the receiver device. Morse 
then developed an encoding of the marks in the form of dots and dashes that today is known as 
Morse code. Morse code could be used to fully encode a message generated by energy that people 
can understand. For instance, the letter a is coded as a dot and a dash. 

Since the invention of the telegraph, communication technologies have evolved considerably and 
eventually motivated the standardization of network architecture. In particular, when computers 
from different manufacturers in different countries needed to be networked together, the 
components had difficulty interoperating between the different networking equipment from the 
various vendors. It, therefore, became necessary to standardize computer networking technology. 
This problem motivated the standards organizations to develop models that could be adopted by 
the entire computer networking industry. The computer network industry could now innovate while 
complying with the standard model. For example, by developing components that offered standard 
interoperable functionality while consuming less power. We will learn more about these models and 
standards later in this chapter. 

Samuel Morse’s electromagnet inker machine.
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The Internet

Typically, when we talk about computer networks, we cannot escape a historical conversation about 
the Internet. What is the Internet and how did we get it? How does it help us today? 

Put simply, the Internet can be defined as an interconnection of individual computers across the world 
through an interconnection of networks using a standardized set of communication protocols. The 
Internet allows people and systems to communicate in a consistent way as data moves across the 
multiple networks that are interconnected across the globe. 

Consider a spiderweb, which has been spun by a 
spider. Each time the spider constructs a new direction 
in the web it is continuously connected to another 
portion of the web. You can trace multiple directions 
from any point within the spiderweb. The spiderweb 
design is similar to the concept of the Internet where 
computers are connected by specialized hardware, 
and you can trace their communication in multiple 
directions creating a web-like design.

When we think of the Internet, it’s easy to relate it to 
what we know about the World Wide Web. The World 
Wide Web is what people use every day to do things 
like shop online, ask “Siri” (Apple’s digital assistant244) 
a question, or post videos to social media platforms 
such as Instagram.245 Historically, the World Wide 
Web grew in popularity through the use of web 
browser applications designed to enable people to 
navigate content in the form of webpages stored 
as documents on computers around the world. To 
navigate content and display it in a consistent way 
requires a standardized set of protocols. For instance, the Hypertext Transfer Protocol (HTTP) is an 
Internet protocol used by the World Wide Web that standardizes how documents such as webpages 
are transferred across systems.246 You can observe a secure version of HTTP called HTTPS if you type 
www.google.com in your Internet browser (Figure 240). 

The spiderweb design can represent the 
concept of the Internet, where computers are 
connected by specialized hardware and you 
can trace their communication in multiple 
directions.

244	 Siri, Apple’s digital assistant, https://www.apple.com/siri/ (accessed June 2023).
245	 Instagram home page, https://www.instagram.com/ (accessed June 2023).
246	 Hypertext Transfer Protocol—HTTP/1.1, https://www.ietf.org/rfc/rfc2616.txt (accessed June 

2023).

http://www.google.com
https://www.apple.com/siri/
https://www.instagram.com/
https://www.ietf.org/rfc/rfc2616.txt
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FIGURE 240 — Your browser will use the HTTPS protocol when you type www.
google.com.

As seen in Figure 240, the browser navigation bar has applied the secure HTTPS protocol to 
communicate the Google home page document content to the screen. Internet browser applications, 
such as Google Chrome or Firefox, help keep us compliant with the HTTP protocol requirements of 
the Internet. This allows us to access content and documents across the World Wide Web without 
worrying about the complexities of the standardized communication. 

TCP/IP Stack
As Internet technologies were standardized, they were eventually constructed as a stacked layer of 
technologies, specified as the Open Standards Interconnection (OSI) Model. Today, the OSI Model 
has been simplified using a core set of standardized technologies, which are described as the TCP/IP 
stack.

Layer 
Number

Layer Name Networking task 

5 Application Specify the needs of users
4 Transport Organize data for network transmission
3 Network Identify and locate the destination network
2 Data Link Remove errors during transmission and 

label devices
1 Physical Signals transmitted across a wire

The TCP/IP stack is a five-layered network architecture. The TCP/IP stack layers and their described 
functional networking tasks are described above, but includes some unfamiliar terms and technologies. 
Therefore, it makes sense to describe each layer in detail so that you can fully understand how the 
stack is used to support computer networks. 

http://www.google.com
http://www.google.com
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Physical Layer

The first thing needed for communication is the transmission of information over a distance. The 
physical layer of the TCP/IP stack does this and requires technology that can transmit signals across 
a physical medium. Different types of media include copper wire, optical fiber, or various forms of 
wireless communication (e.g., cellular and Wi-Fi). The signals are generated by capturing energy from 
an energy source and encoding the data using this energy for transmission over the physical medium. 

Depending on the physical medium, signals are commonly transmitted as digital or analog. A digital 
signal is typically generated when an energy source transmitting the signal turns on and off. If the 
energy is present, we can measure the data as a 1. If the energy is absent, we can measure the data as 
a 0. Analog signals are generated by an energy source that applies continuous energy to the medium. 
This continuous signal changes in amplitude and frequency forming a sine wave as energy varies in 
intensity and time. Since an analog signal can be measured by amplitude and frequency, data can 
be encoded by varying the amplitude or frequency of the signal or both. Figure 241 illustrates the 
difference in how an analog versus a digital signal can be visualized. 

FIGURE 241 — A digital signal consists of 1s and 0s representing the presence 
or absence of energy. 

The 1s and 0s data generated by signals traveling through a physical medium is commonly referred 
to as binary data. Binary data captured from signals can be encoded to represent characters that 
humans can understand. For instance, the American Standard Code for Information Interexchange 
(ASCII) includes numerical representations (decimals) that can be used to convert letters in the English 
language to binary data.247 

Hello

The word “hello” can be represented as a binary number using the ASCII code. 

Character ASCII Decimal Binary
h 104 01101000
e 101 01100101
l 108 01101100
l 108 01101100
o 111 01101111

247	 ASCII Table, https://www.asciitable.com/ (accessed June 2023).

https://www.asciitable.com/
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Early physical media used in networks were made 
of copper wiring. In fact, today, copper wire exists in 
many office buildings and schools. You may have seen 
network plug outlets in your school walls with a cable 
plugged into it and attached on the other end to a 
teacher’s PC, laptop, or printer. Copper is an excellent 
conductor of electricity and can be used to carry 
signals across great distances. The most common type 
of network copper cable used today is called Cat5e, 
and it has a connector on its end called RJ45 (Figure 
242).

As seen in Figure 242, Cat5e cable has four pairs of 
wires that are color coded. From left to right the pairs 
include White-Orange + Orange, White-Blue + Blue, 
White-Green + Green, and White-Brown + Brown. 
Each wire within the cable is carrying a different 
type of signal. Therefore, the color code sequence is 
important because it must match the signal sequence 
of receiving devices such as PCs, laptops, or printers. 

Additionally, each of these colored wires is tightly 
twisted. The tight twisting of the copper wire improves 
the rate at which a signal can be transmitted through 
the cable. This also improves the speed of the data 
transfer on the network that the cable is connected 
to. Data transfer rate is measured in bits per second. 
For example, a Cat5e cable is capable of supporting 
network speeds up to 1000 Mbps (megabits per 
second). A bit is a small unit of data. A megabit 
represents a million bits. Therefore, Cat5e cable has 
tightly twisted copper wires capable of moving up to 
1 million bits of data per second!

Another common physical medium used in networks is optical fiber. Optical fiber is typically bundled 
inside of fiber optic cable. Fiber optic cable is made up of a set of protected layers to prevent any 
damage to the inner glass fibers (Figure 243). 

The inner glass fibers are typically the width of a human hair and designed to allow laser light to travel 
through the medium. Once an energy source generates a laser light it travels through the glass tube 
to its destination. 

As the energized light signal is pulsed, or turned on and off, by a sending device (described in the 
“Data Link Layer” section below) it can be measured as data. Therefore, a light-sensitive receiver (also 
described in the “Data Link Layer” section) on the other end of the fiber optic cable can convert the 
pulses of light into a 1 or a 0. If light is present, the receiver can measure a 1 as data. If the light is 
absent, the receiver can measure a 0 as data. 

FIGURE 242 — Cat5e network cables are crucial 
to accessing the internet. 

FIGURE 243 — Fiber optic cables allow digital 
signals to travel. These cables play a key role in 
network configurations. 
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Data Link Layer

Signals can get damaged while traveling through a medium. It is also necessary for devices to know 
if a signal is directed at them. Therefore, it is necessary to include a layer of technology that supports 
getting the signal to the desired destination without errors. The Data Link layer functions to provide 
both addressing and error detection. 

Think about your home networks for a moment. You probably have devices such as PCs, smartphones, 
laptops, tablets, smart televisions, and network storage connected to the Internet on your home 
network. To make this network connection work, you will need a Router (described in the “Network 
Layer” section) between the devices, which is designed to connect to the Internet. We will talk more 
about what makes this possible later in this chapter. 

We can use Figure 244 to imagine a scenario where 
you are using your laptop at home to complete a 
homework assignment that must be submitted online. 
I’m sure you would want your homework to find its way 
through the Internet to its final destination and arrive 
there in the exact state as you completed it, with no 
errors. This is where the Data Link layer is necessary.

Whether it is wireless or wired, you will have a 
connection between your home device and your 
home router. This connection is considered an 
instance of the Data Link layer. For example, your 
home laptop contains hardware that has a wireless 
network interface card (WNIC) built inside. The word 
interface is referenced in the WNIC hardware name 
because it describes the technology used to make 
the connection between the laptop and the home router or other networking device. Interface is a 
commonly used term in networking to describe the connection between devices. 

Each WNIC, or any other type of network interface card (NIC), has what is called a Media Access Control 
(MAC) address, also called a physical address. The MAC address is a unique identifier assigned by the 
manufacturer of the hardware. If you were to open your laptop or other device, you may see the MAC 
address labeled on the hardware. But when you are connected to the Internet there are easier ways 
of discovering the MAC address you are currently using on a device. For instance, if you own a laptop 
with Microsoft Windows installed you can run a command within a command prompt that will output 
the MAC address actively being used by your WNIC. Here is an example of what some of the output 
would look like if you typed the command “ipconfig/ all” from a Microsoft Windows command prompt 
from a laptop that is actively connected to a wireless network:

C:\Users\clinton> ipconfig /all

Example of partial output from the above command (Note: your output will have different information 
than this one): 

FIGURE 244 — Home networks allow multiple 
devices to connect to the internet. 
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Wireless LAN adapter Wi-Fi: 

Description. . . . . . . . . . . . : Intel® Wi-Fi AX200 160Hz

Physical Address. . . . . . . . . : 6D-B1-00-5U-03-9R

DHCP Enabled. . . . . . . . . . . : Yes

IPv4 Address. . . . . . . . . . . : 192.168.1.26

In the above example of output from the “ipconfig /all” command, you can see that the Microsoft 
Windows operating system has identified that the active interface connection is using a WNIC 
described as “Intel Wi-Fi AX200 160Hz” with the physical address, or MAC address, of 6D-B1-00-5U-
03-9R. In this case, the Data Link layer is implemented within the WNIC where the physical address 
can be used to uniquely identify a device connected to a network. Circling back to the homework 
example we mentioned earlier, the physical address plays an important role in making sure that your 
homework finds its way toward its final destination. Other technologies that support the Data Link 
layer and your homework finding its way also work similarly, as we will describe in detail later. 

The Data Link layer not only functions to provide addressing, it also serves the function of error 
detection. There must be a technology within a layer of the TCP/IP stack that can detect if any errors 
were introduced during the transmission of a signal. Errors can occur when a signal is disrupted by 
events such as power outages or power spikes. When events like this occur, there must be a technology 
capable of detecting errors to improve the reliability of the network. 

Errors are typically detected on a network using specialized algorithms. This is where mathematicians 
really get to use their skills. The algorithm used by networks to detect errors is known as a cyclic 
redundancy check (CRC). CRC uses Modulo 2 arithmetic to reliably calculate bit-level errors on binary 
(1s and 0s) data that may occur during network communication. These algorithms are always getting 
better and will keep mathematicians in business for many years to come. 

Let’s look at a simple error-detection algorithm example that’s easy to understand, though not robust 
enough for industrial use. Recall that an algorithm is a set of steps used to accomplish a desired 
output. In this case we are constructing an algorithm designed to detect an error in the transmitted 
data. 

Let’s say we want to send HELLO in a text message. We could code the letters in integer format as 8 5 
12 12 15 based on their integer position in the English alphabet. In other words, the letter H is in the 
8th position of the English alphabet while E is in the 5th position and so on. A simple algorithm first 
step would be to add all integers together to get the single integer value of 52. 

8 + 5 + 12 + 12 + 15 = 52

Now add 5 and 2.

5 + 2 = 7

Now, the technology would send a text with the integer values of the letters HELLO as:

8 5 12 12 15 7

Where 7 is appended to the integer encoded version of HELLO. 

Now, let’s try to detect an error when our technology receives the text message. 
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The receiver technology will get 8 5 12 12 15 7

The receiver knows that the 7 is extra data, so it calculates: 

8 + 5 + 12 + 12 + 15 = 52

Then it calculates: 5 + 2 = 7

Now the receiver technology can interpret the HELLO text message, represented by integers in the 
data received, as having no errors because the calculated result 7 matches the extra data labeled as 7 
on the end of the text message.

This simple algorithm is easy to understand but it certainly has flaws. For instance, what if the receiver 
technology received 8 5 11 13 15 7 or 10 5 11 11 15 7. Both integer combinations will sum to 52. But 
they are messages with errors. The first one would translate to HEKMO while the second one would 
translate to JEKKO. These text messages are certainly not HELLO, but our simple algorithm would 
not detect the error. If you can imagine the power of this simple algorithm example, you can then 
understand how mathematicians can improve the accuracy of the algorithm so that it can detect all 
possible errors. This is just one example of why math plays a critical role in technology. 

Network Layer

While the Data Link layer is responsible for the 
connections between devices on a single network, 
the Network layer’s function is to transfer packets of 
data from a source computer, such as a laptop on your 
home network, to a destination computer through 
one or more networks. This task is also called routing 
and is performed by networking devices called 
routers. You may have a router in your home, that 
was supplied by your Internet service provider, which 
allows you to connect your home devices to resources 
across the global Internet (Figure 245). 

As previously mentioned, the Network layer functions to transfer packets across multiple networks. A 
packet of data is a small segment of a larger piece of data sent over a network. For example, consider 
a scenario where you are using the Internet to research a topic on the World Wide Web for your 
homework assignment. As you open a webpage (described later in the “Application Layer” section of 
this chapter) with your browser, packets of data are being sent across the Internet from a webserver 
somewhere in the world to your laptop. All the content included on the website is not being sent as 
one large file. Instead, the website data would be broken into small packets of data prior to being 
transmitted over the Internet. Once the packets reach their destination, they will be reassembled into 
their original form so that the complete webpage can be viewed in your browser. This reassembly 
process is handled by the “Transport Layer,” which we will cover later in this chapter. 

Communicating signals and data over networks involves the use of standard protocols. The most 
common protocol used at the Network layer is the Internet Protocol (IP). You may have noticed that 
this protocol is part of the name included in TCP/IP stack. This is because IP plays an essential role in the 
Network layer and is the standard responsible for routing packets across interconnected networks. IP 
is managed on networks by professionals who configure routers and facilitate routing by assigning IP 

FIGURE 245 — A home router. A Cat5e cable 
with an RJ45 connector allows access between 
your home devices and the Internet. 
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addresses to devices. An IP address is a unique identifier that has been assigned to devices accessing a 
network. Unlike a MAC address, which is uniquely assigned by a hardware manufacturer, an IP address 
is automatically or manually assigned by technology designed to manage devices connecting to a 
local network or the Internet. 

For example, in the “Data Link Layer” section of this chapter we reviewed the output of a Microsoft 
Windows command “ipconfig /all.” In the output of this command, you may have noticed:

IPv4 Address. . . . . . . . . . . : 192.168.1.26.

The 192.168.1.26 is the unique IP address assigned to the device connected to the Internet.

Additionally, you will notice in the output of the command “IPv4.” This indicates IP version 4. This 
version contains 4 sections of integer values ranging from 0 to 255 and separated by periods. So, IP 
addresses range from 0.0.0.0 to 255.255.255.255. This version of the IP address was created in an early 
period where most experts thought that at most, the world would have one computer-connected 
device per person on the planet. IPv4 could support 232 or about 4.29 billion devices. This was enough 
to assign one IP address per person at the time IPv4 was created. But today, many users have multiple 
devices, and we began running out of IPv4 addresses. So IPv6 was created that allows up to 2128 

or approximately 340,282,366,920,938,463,463,374,607,431,768,211,456 devices! The IPv6 address is 
significantly longer and consists of integers and letters. Here is a sample of what an IPv6 address looks 
like: 

2603:9000:f700:6347:1492:8241:c756:3812

Each of the four characters are separated by a colon. As you can see, it contains more information that 
can be used to support a lot more IP address combinations than IPv4. 

Transport Layer

The Transport layer functions to ensure that data is reliably delivered to its destination over a network. 
To do this the Transport layer includes technology designed to track data as it is broken down into 
small segments. Segmentation is the process of breaking data down into smaller units to allow for a 
more compact transmission over a network using IP. This is useful because IP has a limitation on the 
size of packets it can transfer over a network. Once a receiving technology receives all the segmented 
data, the Transport layer is then responsible for reassembling these segmented packets of data back 
into their original form so that they can be used by an application such as a web browser. 

The most common Transport layer protocol is the Transmission Control Protocol (TCP). Notice that 
TCP, just like IP, is part of the TCP/IP stack name. Applications like email can transfer data, such as an 
email message, to TCP so that the data can be broken into small segments before being transmitted to 
a destination on the Internet. These segments are assigned sequence numbers so that the receiving 
technology at the Internet destination knows how to logically reorder and reassemble to email 
message data back into its original format before handing it off to the receiving email application.

Application Layer

Since the Transport layer handles all details of transmitting data over a network, this opens tremendous 
potential for the development of applications. The Application layer functions to support the needs 
of technology users. If you want to send an email from your laptop or text a message to your friends 
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from your smartphone, you will need to use an application specialized for the task. TCP will make sure 
that the data is reliably sent across the Internet to your friends. This functional relationship between 
layers that support the Internet is why we call the technology stack TCP/IP. 

With the support of the Application layer, the technology industry has invented many functional uses 
for the Internet to fit our daily lives. This table summarizes five common application protocols that 
have been developed to support a variety of applications. 

Common Application Layer Protocols

           Application Protocol Functional Description

HTTP (Hyper Text Transfer Protocol) Used in the World Wide Web to 
communication data from webpages

SMTP (Simple Mail Transfer Protocol) Used to send and receive email

FTP (File Transfer Protocol) Used to communicate and transfer files 
between computers

SSH (Secure Shell) Used to send commands between 
computers 

IM (Instant Messaging) Used to exchange text-based messages 
using computers or mobile devices

As you can see, the Application layer is the most practical layer that Internet users can relate to. These 
application protocols support many of our daily personal, professional, and academic uses for the 
Internet. So, whether you are using an app on your smartphone or working on an assignment using 
your school device, you are being supported by the Application layer of the TCP/IP stack. 

Networking Support Services 
Services have been developed over time to support the use of Internet applications communicating 
on the TCP/IP stack. For instance, in order for an application to communicate on a network it needs to 
operate on a device that has been assigned an IP address. The Dynamic Host Configuration Protocol 
(DHCP) service was developed to manage the assignment of IP addresses on a network. This service is 
commonly used in places such as schools or businesses where people need to connect to the Internet. 

Consider a scenario where you are at school, and you turn on your device to join the network so you 
can use the Internet. As soon as your device is turned on, the operating system is seeking an available 
network to connect to. If the network allows you to connect to it, a DHCP service assigns your device 
an IP address on the network. This assigned IP address is then used by your device so that you can 
operate applications capable of communicating on the Internet. 

Another common service used on computer networks is the Domain Name Service (DNS). This service 
is used by the Domain Name System, which includes a set of databases responsible for translating IP 
addresses into domain names. To see DNS in action, you can execute a WHOIS query. A WHOIS query 
is used to check publicly available databases to identify who owns a domain. Additionally, you can 
check the DNS records to determine what IP addresses are owned and associated with the domain 
name. 
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To conduct a WHOIS query, open your browser and 
navigate to https://who.is/. Note, you can Google 
WHOIS and the search results will recommend many 
WHOIS query tools. Any of these will work just as well. 
Once you are on the who.is site, type usf.edu in the 
search bar and click the search button (Figure 246). 

Your WHOIS query will result in lots of contact and 
other information about usf.edu. For instance, usf.edu 
was activated on September 29, 1986, and is registered 
by the University of South Florida Information 
Technology at 4202 E. Fowler Avenue, SVC 4010 
Tampa, Florida 33620 USA. This information may be useful for anyone who is trying to investigate the 
owner and support for any specific domain. 

Next, click on the “DNS Records” button to view a report on the records documented over time with 
the usf.edu domain. Make a special note of the entry next to www.usf.edu under the “Hostname” 
column (Figure 247).

FIGURE 246 — A WHOIS query can be very 
useful in finding contact information regarding 
a domain. 

FIGURE 247 — A WHOIS query will return a lot of information regarding the searched domain. 

As seen in Figure 247, www.usf.edu is used to respond to any Internet requests on the World Wide 
Web and it is assigned the IP address 52.149.184.58. If you were to navigate to www.usf.edu with your 
Internet browser, you would actually be navigating to the IP address 52.149.184.58. However, DNS 
translates this IP address into a domain name that humans can easily remember and understand. 

Overall, many networking support services exist to promote the use of networks and their technologies. 
Information technology professionals make a career out of supporting, managing, and implementing 
these services in an enterprise business environment that supports people and business processes. 

https://who.is/
http://www.usf.edu
http://www.usf.edu
http://www.usf.edu
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College degree programs and industry certifications have developed entire curriculums to support 
the knowledge and expertise needed to support the technologies of today and tomorrow. Therefore, 
it is a worthy investment to learn more about these services, if you are interested in a future career in 
technology. 

Computer Network Security
Networks were originally motivated and designed around the concept of communication through 
technology. As you may have noticed throughout this chapter, these technologies were not designed 
to consider the risks of intentional harm to the systems or data as a result of a cyber-attack. You will 
learn more about cybersecurity in the “Cybersecurity” chapter of this textbook. For now, let’s consider 
a cyber-attack as an attempt by a malicious person or program to damage or destroy a computer 
network and the systems that support it. There are daily attacks on computer networks in our homes, 
schools, and business. Protecting networks using security technology is a necessity in today’s world. 

One specific and important security technology that is designed to protect networks is a firewall. A 
firewall is a computer that is positioned on the network between the devices used inside a network 
and the outside world. The firewall computer keeps a careful eye on all the incoming network traffic 
and applies filters that can block any unwanted or malicious packets. The filters are configured by 
IT professionals who can assign a set of rules that are designed to identify known harmful network 
traffic. 

Firewalls keep us all safe when we use our devices to communicate on the Internet. However, malicious 
people are always trying to get past these protective firewalls to cause harm to our systems. This is 
why for years to come cybersecurity professionals will continue to be in high demand. 

There are some simple things that we can do to protect the security of our networks. Two such 
easy security practices include patching our systems and making sure that we communicate on 
our networks using secure methods. Patching systems basically involves keeping our software and 
operating systems up to date with the latest security updates. It is common among software and 
hardware vendors to discover weaknesses in their products that may expose vulnerabilities to a 
cyber-attack. To prevent these attacks from occurring, the vendors recommend that we update our 
systems by downloading and installing these patches. 

Communicating on a network securely typically involves the use of encryption technologies. Put 
simply, encryption is the process where you use an algorithm to scramble data into a secret encoded 
message that can only be unlocked with a unique and guarded key. One such type of encryption 
uses a digital certificate. Digital certificates are issued by certificate authorities. You can use these 
digital certificates to encrypt data being transmitted over a network such as an email, text, or instant 
message. 

To understand how encryption technologies work, consider the following simple example. You have 
a text message consisting of the word “hello” that you are about to send to your friend using your 
smartphone app. 

Swap each letter with the one that holds its opposite position in the alphabet. For example, “a” would 
be swapped with “z” and “b” would be swapped with “y” and so on. 

So, the encrypted version of “hello” would be “svool.”
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The receiving technology would then need to have a key to unlock the algorithm. In other words, 
the receiver knows the algorithm used to scramble the letters and can execute the swap in reverse to 
translate “svool” back into “hello.”

This simple encryption example is useful to understand the concept. However, in practice the method 
to this algorithm could be leaked somewhere on the Internet and malicious people could write a 
simple program to decrypt all your network communication. This is why it is important to use strong 
algorithms that are so complex that it would be impractical for anyone to decrypt. You will learn more 
about the complexities of cybersecurity in the “Cybersecurity” chapter of the textbook. 
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			   Chapter Terms and Definitions

Encryption: The use of an algorithm to scramble 
data into a secret encoded message that can only 
be unlocked with a unique and guarded key

Hypertext Transfer Protocol (HTTP): An 
Internet protocol used by the World Wide Web 
that standardizes how documents such as 
webpages are transferred across systems

Interface: A networking term that describes the 
interconnection between a computing device, 
such as a laptop or smartphone, to a network

Internet: An interconnection of individual 
computers across the world through an 
interconnection of networks using a standardized 
set of communication protocols

Internet Protocol (IP): A network layer 
protocol responsible for routing packets across 
interconnected networks

Media Access Control (MAC) Address: 
Commonly known as a physical address; a unique 
identifier consisting of numbers and letters 
assigned to network interface hardware and 
used as the identity of a network address

Open Standards Interconnection (OSI) Model: 
A conceptual stack of technologies that could 
be used to describe the various functions of a 
networked system

Packet: A small segment of a larger piece of data 
sent over a network

Transmission Control Protocol (TCP): A reliable 
transport layer protocol that enables applications 
to exchange data over a network

World Wide Web: An information system 
designed to display content in the form of 
documents, such as webpages, which are stored 
on computers across the world
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		  	 Chapter Case

WHOIS Arianna’s Domain
Arianna has just learned about the World Wide Web and how it works. She was 
given an assignment by her teacher to come up with an online business idea. The 
online business should include a website that is available for her customers to use 
from any network across the world. Arianna knew this meant she had to purchase 
a domain and have it registered so that it is available to Domain Name Systems 
throughout the globe. To do this, Arianna needs to think of a unique domain name 
and complete a WHOIS query to see if its available. Basically, she must pick a domain 
name that nobody in the world has actively registered.

Question 1:	 Think of an online business idea. Now describe your online business 
in one or two sentences. Think of a unique domain name to use with 
your business and conduct a WHOIS query on the Internet to see if it’s 
available. If the domain name is already registered by someone else, 
think of another name. Continue to conduct WHOIS queries until 
you have identified a domain name that has not been registered by 
someone else. Write your domain name here.

Question 2:	 Now that you have explained your online business idea, use the 
Internet to conduct multiple WHOIS queries to identify at least one 
other company who has registered a domain name with a similar 
online business model idea. In other words, another company who 
may be a potential competitor. List all the information reported in 
that companies WHOIS query. 
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If security were all that mattered, computers would never be turned on, let alone 
hooked into a network with literally millions of potential intruders.

— Dan Farmer, computer security researcher and programmer

Overview—What is Cybersecurity?
The National Institute of Standards and Technology (NIST), founded in 1901, is part of the U.S. 
Department of Commerce and supports the U.S. mission to promote today’s innovations and industrial 
competitiveness. This mission is accomplished by advancing measurements and standards in science 
and technologies that enhance economic security and quality of life. NIST, defines cybersecurity as:

Prevention of damage to, protection of, and restoration of computers, electronic 
communications systems, electronic communications services, wire communication, 
and electronic communication, including information contained therein, to ensure 
its availability, integrity, authentication, confidentiality, and nonrepudiation. 248

At the core of cybersecurity is the motivation to protect information and the systems that manage 
it. In fact, the U.S. law, 44 USC 3552, defines information security as “protecting information and 
information systems from unauthorized access, use, disclosure, disruption, modification, or destruction in 
order to provide—integrity…, confidentiality…, and availability….249

In cybersecurity practice, this is commonly known as the CIA triad where C stands for confidentiality, 
I for integrity, and A for availability. What’s notable here is that cybersecurity is all about information 
and the systems that support its management. Our information and systems are increasingly under 
attack from powerful adversaries who would like to steal our information for profit. Therefore, having 
an understanding of cybersecurity is important to protecting the future of people, resources, and 
societies. Our journey to this understanding starts with exploring the past so we know how we have 
arrived to the present. Then, it demands we turn our attention toward studying where we are going 
in the future.

Before we begin to understand how we got to today’s climate of cybersecurity, let’s first establish some 
context with the CIA triad. This will help us understand what motivates the actors of cybersecurity in 
the past, present, and future. 

Confidentiality

According to 44 USC 3552(b)(3)(B):

Confidentiality…means preserving authorized restrictions on access and disclosure, 
including means for protecting personal privacy and proprietary information.

The law recognizes the right of individuals to privacy, and such right extends to information that, if made 
public, could cause harm to the person. It is the responsibility of the custodians of the information to 

248	 NIST, Computer Security Resource Center (CSRC), Information Technology Laboratory, https://
csrc.nist.gov/glossary/term/cybersecurity (accessed June 2023).

249	 44 USC 3552(b)(3), https://www.law.cornell.edu/uscode/text/44/3552 (accessed June 2023). 

https://csrc.nist.gov/glossary/term/cybersecurity
https://csrc.nist.gov/glossary/term/cybersecurity
https://www.law.cornell.edu/uscode/text/44/3552
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provide that privacy to the individuals whose information they have in their possession. For instance, 
people rely on banks to protect the privacy of their credit card information. The expectation is that 
banks (the custodian of the information) should not allow their customer account information to be 
exposed to those who do not require its access. 

Modern cybersecurity services have been put in place by banks to protect the privacy of their 
customers’ information. Such practices include services such as fraud alerts to customers when credit 
cards are used in unusual ways. These services provide an opportunity for customers to freeze their 
credit card so that it cannot be used by someone who has violated their confidential information. This 
response is typically followed up with changing the compromised credit card information so that the 
stolen information is no longer useful, and disputing all unwanted charges to the credit card. 

Integrity

The law under 44 USC 3552(b)(3)(A) defines integrity as:

Integrity…means guarding against improper information modification or 
destruction, and includes ensuring information non-repudiation and authenticity.

When you pull information from an information system, for example, your grades from school, or 
the monthly statement from your bank account, you trust that the information provided is reliable 
and actionable. For example, when the bank reports the balance in your checking account, you do 
not think it necessary to calculate the totals of credits, debits, and interest income yourself to verify 
the amount. Rather, you trust that the bank has made the right calculations. Imagine how complex 
life would be if the information you received from IT systems could not be trusted to be accurate. 
Integrity is the aspect of information security that prevents that from happening.

Consider the following example: you have worked really hard throughout the semester to keep up 
with the grades in all of your classes. Now it’s time for report cards and you expect to see straight A’s 
in all of your classes. You open your report card, and it shows that you have failed all of your classes. 
This could be devastating and perhaps ruin your chances of getting into the college of your choice. 
This is the impact of integrity. Your expectation is that the system that manages your grades in school 
should maintain its integrity so that you can be rewarded for your hard work. Now that you realize 
the information has somehow been modified, you will need to dispute the grades and the school 
will need to investigate how the integrity of its grade information has been violated. An information 
system without integrity is not useful for any serious work.

Availability

Availability as defined by 44 USC 3552(b)(3)(C):

Availability…means ensuring timely and reliable access to and use of information.

When you log into an online class, you expect it to be online. That in essence is availability. The 
relevance of availability to information security is self-explanatory. An information system that is 
unavailable is an information system that is not useful. Most viruses impact availability—they typically 
delete important files, causing a loss of availability. Even if the files can ultimately be recovered from 
backup systems or other sources, the time lost in recovering those files represents time not spent 
doing useful work, i.e., lack of availability.
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A famous example of lack of availability occurred on October 4, 2021. Facebook, Instagram, WhatsApp, 
and Oculus were unavailable globally for a period of time (Figure 248). This availability problem caused 
a global disruption of information services, which affected many different people and businesses 
who relied on the Facebook infrastructure for business. 

FIGURE 248 — Websites can be “down” for many reasons ranging from technical 
to malicious. 

Although the unavailability of Facebook 
and its services was not confirmed to be a 
cybersecurity attack, it demonstrated the 
impact of how the availability of Internet 
resources can quickly cause disruption in 
global information dependent societies. 
Figure 249 is a screenshot taken by 
this author on October 4, 2021, which 
demonstrates how quickly information 
availability cyber events such as this can 
become disruptive and cause fear and 
panic among people. 

FIGURE 249 — The global access to information allows for real-
time discussions of occurrences. 
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Update About the October 4, 2021, Outage by Meta250

What happened

The October 4 outage occurred due to a command issued by an engineer during 
routine maintenance that unintentionally took down all the connections in our 
backbone network, effectively disconnecting Facebook data centers from the 
Internet globally. Our Facebook Engineering blog provides a more detailed 
explanation about what caused this outage and why it took time to restore 
our services. Ads did not deliver during the time our systems were offline, and 
advertisers were not and will not be billed for ads during the outage. However, 
we’ve heard from customers that their campaigns experienced volatility as our 
services came back online.

Separately, on October 8, a configuration change caused some people and 
businesses to have trouble accessing some of our apps and products for a 
shorter period of time. Following discovery of the issue, our teams were able to 
quickly resolve it and restore access to our services.

Brief History of Cybersecurity Events
To better understand how the domain of cybersecurity functions in today’s businesses, it is useful 
to know about specific incidents that have happened in the past and how they have significantly 
influenced our business environment. The list of incidents that follow is not intended to be 
comprehensive. But they do serve as excellent examples of information security concerns at the 
time of their occurrences. These incidents also played a significant role in establishing some of the 
important laws and organizations related to cybersecurity. As you read through these various events 
in history, you will notice how new cybersecurity or technology terms and concepts are gradually 
introduced into our daily lexicon. 

1981—Development of the core Internet technologies (TCP and IP): The core technologies of the 
Internet were finalized in 1981. There was no mention of security in these technologies, indicating 
that at that time the technology world was not concerned about cybersecurity. Since TCP and IP 
were available for free, they became the preferred networking technology for UNIX systems, widely 
used at universities and various intensive organizations such as hospitals and banks. Without TCP/
IP, there would probably be no networking, and without networking, there would probably be little 
cybersecurity risk.

1982–1983—Gang of 414’s: Computer intrusions began soon after TCP and IP were integrated into 
industrial equipment. The most highly publicized incident of this time was the gang of 414’s, a group 
of six teenagers from Milwaukee, who got their name from the telephone area code for Milwaukee. 
These teenagers found it exciting to get into systems that were supposed to be out of their reach. 

250	 The information in this section is from “Update About the October 4 Outage” by Meta, https://
www.facebook.com/business/news/update-about-the-october-4th-outage (accessed June 
2023).

https://www.facebook.com/business/news/update-about-the-october-4th-outage
https://www.facebook.com/business/news/update-about-the-october-4th-outage
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Using home computers, phone lines, and default passwords, this group was able to break into 
approximately 60 high-profile computer systems, including those at the Los Alamos Laboratories 
and the Memorial Sloan-Kettering Cancer Center in New York. The incident received wide coverage, 
including a Newsweek cover story titled “Beware: Hackers at play.” This is believed to be the first use of 
the term “hacker” in the mainstream media in the context of computer security. While the teenagers 
themselves did no harm, it was easy for the industry to see that the simple techniques used by the 
kids could easily be replicated by others. As a result, the US Congress held hearings on computer 
security. After more such incidents, Congress passed the Computer Fraud and Abuse Act of 1986, 
which made it a crime to break into federal or commercial computer systems.

1988—Morris worm: Robert Morris, then a graduate student at Cornell, and now a Professor of 
Computer Science and Artificial Intelligence at MIT, released a 99-line self-replicating program on 
November 2, 1988, to measure the size of the then nascent Internet. As a result of a design feature of 
the program, it brought down many systems it infected, and achieved several landmarks in the process. 
It is considered the first Internet worm. In percentage terms, it is estimated to have brought down 
the largest fraction of the Internet ever (10%). It also resulted in the first conviction under the 1986 
Computer Fraud and Abuse Act. Robert Morris was sentenced to probation, community service, and 
a fine. The Morris worm prompted the US government to establish the CERT/CC (CERT coordination 
center)251 at Carnegie Mellon University as a single point to coordinate industry–government response 
to Internet emergencies. Prof. Morris was also a co-founder of Viaweb, an e-commerce firm bought by 
Yahoo and renamed “Yahoo! Store.”

Father and Son

As an interesting anecdote, Robert Morris’ father, Bob Morris, designed the 
password encryption system for the UNIX operating system that is still used 
today. Even more interestingly, at the time of this incident, the senior Bob 
Morris was the chief scientist for the National Computer Security Center (NCSC) 
of the National Security Agency (NSA),252, 253 the federal agency responsible for 
designing secure computers.

1995–1998—Windows 95/98: Microsoft released Windows 95 on August 24, 1995. The operating 
system had a graphical interface and was designed to run on relatively inexpensive computers. The 
release was supported with a heavy marketing push, and within a very short time, it became the most 
successful operating system ever produced. Windows 95 was designed primarily as a stand-alone 
single user desktop operating system and, therefore, had almost no security precautions. Most users 
ran Windows 95 without passwords and most applications ran on Windows 95 with administrative 
privileges for convenience. However, Windows 95 supported TCP/IP, thereby bringing TCP/IP into 
mainstream businesses. This combination of a security-agnostic networking technology (TCP/IP) 

251	 While CERT typically stands for Computer Emergency Response Team, CMU has registered the 
name as a service mark with the US Patents and Trademark Office.

252	 Robert Morris (cryptographer), https://en.wikipedia.org/wiki/Robert_Morris_(cryptographer) 
(accessed June 2023).

253	 For another very interesting account of Bob Morris, read the amazingly humorous book by Cliff 
Stoll, “The Cuckoo’s Egg,” ISBN 0671726889.

https://en.wikipedia.org/wiki/Robert_Morris_(cryptographer)
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combined with an equally security-agnostic business 
desktop created a fertile environment for information 
security compromises to flourish. In talks, security 
experts sometimes refer to this TCP/IP–Windows 95 
environment as the birthplace of the information 
security profession.254

1996—Health Insurance Portability and Accountability 
Act (HIPAA): This act, which primarily focused on 
protecting health insurance for US workers when they 
change or lose jobs, also had important information 
security implications. Many government leaders 
believed at the time that electronic health records 
(EHR) were an important instrument to lower rising 
health care costs in America. The act, therefore, also 
pushed for electronic health records. Since information 
security was getting recognized as an important 
concern, the law had provisions to make organizations 
responsible for maintaining the confidentiality of 
patient records in the health-care industry. The health-
care industry has now moved over completely to EHR, 
creating significant demand for information security 
within the healthcare industry.

2000—ILOVEYOU virus: On May 5, 2000, this virus was released by a student in the Philippines. The 
virus deleted images on infected computers and automatically sent itself as an email attachment 
to all of the Outlook contacts of the infected computers. The virus infected millions of computers 
worldwide, and caused billions of dollars in damage. The creators of the virus, Reomel Ramores 
and Onel de Guzman, were traced within hours of the release of the virus. However, investigators 
realized very quickly that Philippines had no law against writing computer viruses, and had to drop 
all charges against the students.255 This incident led to the realization that information security was a 
global phenomenon and led to a push from developed countries to encourage developing countries 
to revamp their information security laws. However, even today there are significant differences 
between countries regarding information security laws. For example, while writing a virus can lead 
to fines of up to $250,000 and 10 years of imprisonment in the United States, the punishment in the 
Philippines can range from 100,000 Pesos (about $2,500) and up to an amount commensurate to the 
damage and up to three years in prison. These international differences are an ongoing challenge to 
cybersecurity in technology-intensive societies.

2002—Sarbanes–Oxley Act: During 2000–2002, America witnessed many unpleasant incidents of 
corporate fraud involving such legendary companies as Enron, Tyco, and WorldCom. For example, Enron 
claimed revenues of over $100 billion in 2000 and declared bankruptcy the next year. MCI-WorldCom 
revealed in 2002 that it had overstated its earnings by over $72 billion in the past five quarters. These 

254	 For example, Dan Geer (chief information security officer for In-Q-Tel, the venture capital arm of 
CIA) referred to this in his talk at the ISSA meeting in Tampa, December 2011.

255	 Arnold, W. “TECHNOLOGY: Philippines to drop charges on e-mail virus,” New York Times, August 
22, 2000.
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frauds were enabled by fraudulent manipulation of accounting systems, believed to be at the behest 
of firm leadership. However, during trials the CEOs consistently tried to escape blame by pleading 
ignorance of accounting procedures and claiming blind trust in their highly paid and well-educated 
lieutenants. Since the retirements of most Americans are invested in large publicly traded firms, their 
downfall affects most American families. Compelled to act by these devastating corporate frauds 
and to ensure correctness in financial reporting, Congress enacted the Sarbanes–Oxley Act in 2002. 
The act focused on making the key executives personally accountable for the correctness of financial 
reports filed by publicly traded companies. The act had three major provisions. Section 302 of the act 
requires the CEO and CFO of firms to sign a declaration of personal knowledge of all the information 
in annual filings. Section 906 of the act imposes criminal penalties including imprisonment of up to 
20 years for incorrect certification. Section 404 of the act required that the certification in Section 302 
be based on formal internal controls. Section 404 has had a major impact on the information security 
profession because it required publicly traded companies to establish formal information security 
processes in place. This has led to significant investments in internal controls over financial reporting 
in publicly traded firms, and corresponding growth in the demand for cybersecurity professionals.

2005–2007—Retailer attacks: In December 2006, T.J.Maxx reported that its computer systems, which 
processed credit card payments, had been breached. On investigation, it was found that the breach 
had started in July 2005, a year and a half prior to its discovery, and over 45 million credit card and 
debit card numbers had been stolen. It turned out that the leader of the group involved in the breach 
was Albert Gonzalez,256 an informer for the US Secret Service and in fact Albert was cooperating with 
the Secret Service in connection with another case at the time of these attacks. Investigations also 
revealed that the group had also hacked into the systems at other retailers such as BJ’s Wholesale 
Club, DSW, Office Max, Boston Market, Barnes & Noble, and Sports Authority. The modus operandi 
of the group was to drive along US Route 1 in Miami and seek out an insecure store with wireless 
networks to enter the corporate networks. Later the group improved its methodology and used SQL 
injection attacks to enter the networks at Hannaford Brothers and Heartland Payment Systems, a 
credit card payment processing company. Over 125 million credit card numbers were estimated 
to have been stolen from Heartland, and the company estimated damages at over $12 million. In 
March 2010, Albert Gonzalez was sentenced to 20 years in prison. He also forfeited over $1.65 million 
that he had earned from selling fake credit cards based on the stolen information. These incidents 
highlighted that even large firms had glaring information security weaknesses that could lead to 
serious embarrassment and losses. The SQL injection attacks, in particular, created an awareness of 
the need to pay attention to information security during software development, and introduced the 
term “secure SDLC” to the IT lexicon.

2008—Denial of service attacks in Georgia: Coinciding with the military war between Georgia and Russia 
in 2008, Georgia was the victim of massive distributed denial of service attacks. The attacks defaced 
the websites of many media and government organizations, limiting their ability to communicate 
their viewpoints about the war to their citizens. Many experts believe that the cyber-attacks were 
caused by Russia as part of a war strategy. If so, these were the first known incidents of cyber-attacks 
being used as an instrument of warfare.

256	 The New York Times magazine published a detailed profile of Albert Gonzales, highlighting 
the intensely personal side of cybersecurity. James Verini, The great cyberheist, The New 
York Times magazine, Nov 10, 2010, accessible at https://www.nytimes.com/2010/11/14/
magazine/14Hacker-t.html (accessed June 2023).

https://www.nytimes.com/2010/11/14/magazine/14Hacker-t.html
https://www.nytimes.com/2010/11/14/magazine/14Hacker-t.html
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June 2009—Establishment of the US Cyber Command: 
In April 2009, the Wall Street Journal reported that 
intruders had broken into the computer networks 
of defense contractors developing the Joint Strike 
Fighter, also called the F-35 Lightning II. The $300 
billion project was the Defense Department’s costliest 
weapons program ever, and used 7.5 million lines of 
computer code. Intruders had stolen terabytes of data 
related to the aircraft ’s design and electronics. It was 
believed that the theft would help enemies plan their 
defenses against the fighter. The contractors involved 
in the project include Lockheed Martin, Northrop Grumman, and BAE Systems. Also, in April the Wall 
Street Journal reported that the US electricity grid had been penetrated by spies from China, Russia, 
and other countries. The spies also inserted computer software into the grid, which could be used to 
cause damage by remote control.257 Soon thereafter, on June 23, 2009, the US Cyber Command was 
created to defend US military computer networks against attacks from adversaries. The US Cyber 
Command is also responsible for responding in cyberspace as necessary.

2010—Operation Aurora and Google-China: On January 12, 2010, a blog post by Google ’s Chief Legal 
Officer reported that Google had detected an attempt, originating from China, to steal its intellectual 
property. The attacks were also aimed at accessing the emails of Chinese human-rights activists. The 
US government soon escalated the incident with Congress announcing its intention to investigate 
the allegations. The Secretary of State compared the Chinese censorship of the Internet to an 
information-age Berlin Wall. Further investigations traced the attacks to two educational institutions 
in China—Shanghai Jiaotong University and the Lanxiang Vocational School. Jiaotong is home to one 
of China’s elite computer science programs, and Lanxiang is involved in training computer scientists 
for the Chinese military.258 China has, however, denied formal government involvement and called 
the attacks simply an attempt by students to refine their computer skills. This was one of the earliest 
suspected state-sponsored cybersecurity incidents.

April 17, 2011—Sony PlayStation Network (PSN): Just before summer break 
of 2011, Sony announced that an external intrusion had compromised its 
PlayStation Network and Qriocity service, and that hackers had obtained 
personal information on the 70 million subscribers of the network. In 
response, the company took the network offline while it tried to ensure that 
all traces of the offending software had been removed from the network. 
During that time, millions of kids all over the world who had planned their 
summer breaks around catching up with online gaming on PSN had to find 
alternate ways to pass their time. While the intrusion affected a relatively 
innocuous network, the impact on families around the world was huge 
and almost every family with kids followed the daily developments around 
the attacks. Imagine losing out on an entire summer break because of a 
cybersecurity incident. This actually happened in the summer of 2011.

257	 Gorman, S. “Electricity grid in US penetrated by spies,” Wall Street Journal, April 8, 2009. 
258	 Markoff, J. and Barboza, D. “2 China schools said to be tied to online attacks,” New York Times, 

February 18, 2010, http://www.nytimes.com/2010/02/19/technology/19china.html (accessed 
June 2023).

http://www.nytimes.com/2010/02/19/technology/19china.html
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February 1, 2013—Mandiant APT 1 report:259 Cybersecurity firm Mandiant released a report alleging 
that a suspected Chinese military unit, 61398, was engaged in a novel form of state-sponsored 
cybersecurity attack—advanced persistent threat. An advanced persistent threat is a sophisticated 
and well-resourced adversary that uses multiple attack methods over an extended period to execute 
its objectives. Mandiant called this adversary APT1. The report attracted considerable attention 
among business and government leaders who realized that cyber-attacks were no longer limited 
to individuals for private gain. The stakes were raised when organizations realized that states could 
invest military-scale resources to compromise cybersecurity. 

2014—Cyber-attack on Yahoo: 500 million accounts were stolen260 by what was believed to be a 
state-sponsored actor. Email addresses, passwords, telephone numbers, dates of birth, and names 
were stolen by cybercriminals hired by Russian agents who targeted Yahoo employees via a phishing 
campaign. Phishing is a form of social engineering. In this case, a Yahoo employee with network access 
clicked on a malicious link in an email. This allowed hackers to gain continuous access to the network 
to obtain confidential data such as security questions and answers that were stored unencrypted 
by Yahoo. Social engineering attacks have been getting progressively sophisticated since the early 
2000s. This cyber-attack on Yahoo is one of the most significant attacks recorded to date. Today, the 
US Cybersecurity & Infrastructure Security Agency (CISA) publishes security tips on how to avoid 
social engineering and phishing attacks.261

2021—RockYou2021: In 2021, a hacker whose identity has not been disclosed harvested billions of user 
passwords. To date, this is the largest collection of passwords ever leaked online.262 The anonymous 
hacker uploaded a 100GB TXT (text) file to a popular hacker forum that contained approximately 8.4 
billion entries of passwords. Some would argue that this number of passwords exposed could cover 
the entire global online population several times over. Today, the rockyou.txt file is commonly used 
by cybersecurity researchers and professionals as a wordlist to study or recreate brute force attacks 
on user passwords. A brute force attack is a programming scripts designed to repeatedly execute its 
code while attempting to log into a system with a user account. These types of wordlists are managed 
within software packages found in today’s open-source distributions of Linux, such as Kali Linux, 
which are designed for cybersecurity professionals to assess the security of their systems.263

This brief chronology highlights how information security attacks have evolved from technical proofs-
of-concept to commercially driven attacks to steal credit card information. Of late even governments 
are being suspected of pursuing their agendas through cybercrime. In Europe, a remote Romanian 

259	 Mandiant, “APT1, Exposing One of China’s Cyber Espionage Units,” https://www.mandiant.com/
sites/default/files/2021-09/mandiant-apt1-report.pdf (accessed June 2023).

260	 Yahoo says hackers stole data from 500 million accounts in 2014. Reuters by Dustin Volz. 
Article access via the website on 2/21/2023: https://www.reuters.com/article/us-yahoo-cyber-
idUSKCN11S16P (accessed June 2023).

261	 “Avoiding Social Engineering and Phishing Attacks,” Security Tip (ST04-014), Cybersecurity & 
Infrastructure Security Agency, https://www.cisa.gov/uscert/ncas/tips/ST04-014 (accessed June 
2023).

262	 “RockYou2021: largest password compilation of all time leaked online with 8.4 billion entries,” 
cybernews.com, 27 July 2022, website accessed on 2/21/2023: https://cybernews.com/security/
rockyou2021-alltime-largest-password-compilation-leaked/ (accessed June 2023).

263	 Kali Linux, website accessed on 2/21/2023: https://www.kali.org/ (accessed June 2023).

https://www.mandiant.com/sites/default/files/2021-09/mandiant-apt1-report.pdf
https://www.mandiant.com/sites/default/files/2021-09/mandiant-apt1-report.pdf
https://www.reuters.com/article/us-yahoo-cyber-idUSKCN11S16P
https://www.reuters.com/article/us-yahoo-cyber-idUSKCN11S16P
https://www.cisa.gov/uscert/ncas/tips/ST04-014
https://cybernews.com/security/rockyou2021-alltime-largest-password-compilation-leaked/
https://cybernews.com/security/rockyou2021-alltime-largest-password-compilation-leaked/
https://www.kali.org/
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town, Râmnicu Vâlcea, has emerged as the focal point in global cyber money laundering. In the 
middle of nowhere, this town has car dealerships selling Mercedes-Benz and other expensive cars.264 
Social response has evolved as well, from judges merely warning intruders and laws making specific 
exceptions for juveniles, in spite of their known involvement in cyber-attacks (414’s), to governments 
establishing entire military commands to deal with cybersecurity.

The Basic Information Security Model
Information security is a very broad subject area because most information security incidents 
exploit some new weakness in an organization. Maintaining information security, therefore, requires 
attention to almost every aspect of the organization. To provide structure to these efforts, it is useful 
to organize all the activities associated with maintaining information security into a unified model. 
A model is used to represent a concept that exists in the real world. This will make it easy for you to 
understand what motivates cybersecurity events. Let’s start with examining the model diagrammed 
in Figure 250. 

FIGURE 250 — IT systems and data are vulnerable from multiple areas, making 
active monitoring crucial to maintain security. 

Figure 250 represents a framework for understanding information security. The core components 
of this model illustrate the relationship between assets, vulnerabilities, threats, and controls. These 
four components are extremely important to understand any cybersecurity event or case where 
information is the target. 

264	 Yudhijit Bhattacharjee, “How a Remote Town in Romania Has Become Cybercrime Central,” Wired, 
Jan 31, 2011, https://www.wired.com/2011/01/ff-hackerville-romania/ (accessed June 2023).

https://www.wired.com/2011/01/ff-hackerville-romania/
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Assets

At the center of Figure 250 are assets. In the context of information security, an asset is defined as a 
resource or information that is to be protected. All security scenarios, whether related to information 
security or simply related to securing one’s own property, start with an asset that is considered 
valuable enough for you to put forth special efforts on protecting it from harm. Information security is 
no different. If some information or related resource is valuable to the organization, the organization 
needs to put forth a special effort to secure it.

There are, however, two important differences 
between conventional assets and information 
assets—invisibility and duplicability. In most security 
scenarios that you are likely to be familiar with, the 
items to be protected can be seen and felt. For 
example, you lock your cars to prevent theft. You 
install home alarm systems to prevent home break-
ins. In both cases, the assets are visible to the naked 
eye. The damage is also visible. If someone breaks into 
your car or home, the damage is immediately visible. 
If there are closed-circuit cameras in the vicinity, they 
will capture the act of vandalism.

But information security is different. The assets in information security are not tangible artifacts that 
can be seen and felt. Instead, they are data and information stored as 0s and 1s on computers, tapes, 
phones, and other devices. While the hard drives and other devices are themselves visible, the valuable 
data stored on these devices is invisible. If the data is stolen over the network, the transfer of data 
is not visible to cameras or other conventional security devices. The thieves may even operate from 
another country, thousands of miles away, safe from the scrutiny of conventional security agencies.

The second important difference between conventional assets and information assets is duplicability. 
Continuing with the car example, if your car is stolen, you will notice the missing car in the morning. 
This is because the car can only exist in one place at any given time. However, information can be 
duplicated. If your data is stolen, you will not notice the theft until it is brought to your attention. For 
example, if someone finds your laptop unattended, emails a copy of your assignment to himself and 
submits the copied assignment as his own work, you will have no idea of the act of plagiarism unless 
the instructor brings it to your attention.

These two differences between conventional assets and information assets—invisibility and 
duplicability—make information security a considerably different challenge than conventional 
security. Conventional security methods such as locks and guards are not very effective at maintaining 
information security. For example, conventional locks will do little to prevent the theft of data over 
the network. A stolen conventional asset such as gold can be recovered and restored to its owner. But 
stolen data may be copied to a hundred locations and even if a few of these copies are destroyed, it 
is almost impossible to deny the thief the benefit of having access to the data. Information security 
controls, therefore, must try to prevent theft in the first place and detect and block thefts as they 
occur through constant monitoring.
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IT Assets

In the most common scenario you will encounter, the information assets are 
stored in an IT system. Paper-based systems simply cannot provide the density 
of information storage required by modern organizations. An IT system is 
defined as an assembly of computer hardware, software, and firmware, configured 
for the purpose of processing, storing, or forwarding information. In a small family-
owned business, this IT system may be as simple as an Excel spreadsheet.

Threats

A threat is defined as the capabilities, intentions, and 
attack methods of adversaries to exploit or cause harm 
to assets. In the Excel example, a worker may want to 
exploit the lack of password protection on the file and 
modify their hourly rate. These threats are shown in 
the framework of Figure 250 as arrows.

Today, it is common practice among cybersecurity 
professionals to use a framework created by Mitre 
called “MITRE ATT&CK.”265 Mitre is a non-profit federally 
funded research and development organization. 
This framework from Mitre includes real-world 
observations through a globally accessible knowledge inventory of tactics and techniques used by 
cybercriminals to exploit vulnerabilities in IT systems. The MITRE ATT&CK knowledge inventory is a 
tremendous source for what is called threat intelligence. NIST (National Institute of Standards and 
Technology) defines threat intelligence as:

Threat information that has been aggregated, transformed, analyzed, interpreted, 
or enriched to provide the necessary context for decision-making processes.266 

Basically, there are public and private threat intelligence resources available to cybersecurity 
professionals that provide a collection of information necessary to understand the global threats 
actively seeking to exploit the vulnerability of IT system assets. For instance, Figure 251 illustrates 
a threat intelligence report published by the MITRE ATT&CK knowledge base that warns of three 
threats (Axiom, GOLD SOUTHFIELD, and Hikit), which have been used to execute phishing campaigns 
to gain access to victim IT systems.267

265	 MITRE ATT&CK home page, https://attack.mitre.org/ (accessed June 2023).
266	 NIST, Computer Security Resource Center, https://csrc.nist.gov/glossary/term/threat_

intelligence (accessed June 2023).
267	 “Phishing, Sub-techniques,” T1566, MITRE ATT&CK, https://attack.mitre.org/techniques/T1566/ 

(accessed June 2023).

https://attack.mitre.org/
https://csrc.nist.gov/glossary/term/threat_intelligence
https://csrc.nist.gov/glossary/term/threat_intelligence
https://attack.mitre.org/techniques/T1566/
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FIGURE 251 — Threat intelligence resources make referencing and identifying malicious attacks easier for professionals. 

As illustrated in Figure 251, Axiom is a suspected Chinese cyber espionage group while GOLD 
SOUTHFIELD is a group motivated for financial gain. Both groups are considered global threats to 
cybersecurity. The third name mentioned in Figure 251, Hikit, is classified as malware that can be used 
to remotely connect to an IT system for the purpose of creating a persistent threat. Persistent threats 
are used to cause damage to an IT system at any time a malicious actor chooses. 

The most popular types of threats observed in cybersecurity include viruses, worms, phishing, and 
malware. Viruses and worms are computer programs that adversely affect computers and propagate 
through the network without the user’s consent. The difference between a virus and a worm is that a 
virus uses other programs (e.g., the user’s email client) to spread, whereas the worm can propagate 
all by itself. Since the authors of worms and viruses know that most users use antivirus software, 
modern-day worms and viruses are designed to cause all possible damage within minutes of release.

Phishing is an attempt to compromise a user by masquerading as a trustworthy entity in electronic 
communication. Early phishing attacks attempted to acquire information such as usernames, 
passwords, and credit card details. Most people receive at least one or two of these emails every 
week. The emails appear to originate from banks and lead users to visit a website that looks like the 
bank’s website. At the website, users are asked to provide their username and password in order to 
make some correction at the bank. While the emails and target website appear to be legitimate, they 
really aren’t. A careful look at the URL will show that the website has been hosted at a compromised 
server.

Users can easily fall victim to a phishing attack.
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Malware (malicious software) is a general term used to describe software or code specifically designed to 
exploit a computer, or the data it contains, without the user’s consent. A very common way for malware 
to reach computers is via free downloads where the malware author creates a computer software that 
appears to be very useful and distributes it for free. When unsuspecting users download and install 
this apparently useful software, the malware is installed along with it. This is called the Trojan horse 
technique.

Vulnerabilities

Information security becomes important because all systems have vulnerabilities. A vulnerability is 
a weakness in an information system that gives a threat the opportunity to compromise an asset. The 
vulnerability of an asset enables threats. In the case of the Excel-based IT system discussed above, 
such vulnerabilities include unauthorized access that may cause loss of confidentiality or integrity 
and hard drive failures that may cause loss of availability. If we reached some state of utopia where no 
vulnerabilities existed in IT systems, we would not have to study information security and would not 
need a cadre of professionals dedicated to information security. However, modern software products 
are large. For example, Microsoft Windows took millions of lines of code to create. It is difficult to 
anticipate and eliminate all possible vulnerabilities in such large products. 

To deal with vulnerabilities, the software industry in collaboration with the federal government has 
invested considerable resources to create an inventory of known software vulnerabilities. This is the 
Common Vulnerabilities and Exposures (CVE) list.268 The CVE list aims to provide common names and 
identifiers for all publicly known software vulnerabilities. The list is also maintained by Mitre. 

Vulnerabilities can be classified into specialized categories such as software vulnerabilities. A software 
vulnerability is an error in the specification, development, or configuration of software such that its 
execution can violate the security policy.269 For example, a software developer may create a website 
that requires user input within a textbox prior to submitting a form. However, if the developer does 
not write code to validate the input of the user on the web form it is possible for a malicious hacker 
to inject Structure Query Language (SQL) into the textbox when the form is submitted. This is also 
called a SQL Injection attack. 

Figure 252 illustrates a SQL Injection attempt on ChatGPT.270 ChatGPT is a free Artificial Intelligence 
(AI) website by OpenAI that allows a user to enter text in a textbox. ChatGPT then analyzes the text 
and attempts to respond to the text using AI, similar to the way a human may answer a verbal query. 
Here, as seen in Figure 252, the user attempts to inject malicious SQL and ChatGPT does not allow 
the code to execute. This illustrates how the ChatGPT developers have written code that validates the 
user input to prevent any software vulnerabilities of the IT system.

268	 The list can be accessed at https://cve.mitre.org/ (accessed June 2023).
269	 Krsul, I. “Software vulnerability analysis,” unpublished PhD dissertation, Purdue University, 1988. 
270	 ChatGPT by OpenAI, https://openai.com/blog/chatgpt/ (accessed June 2023).

https://cve.mitre.org/
https://openai.com/blog/chatgpt/
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FIGURE 252 — Some webpages are vulnerable to SQL injection attacks when characters are typed into the search bar. 

Controls

All IT systems will be vulnerable for the foreseeable future. Also, in this timeframe there will be 
dedicated attackers threatening to exploit these vulnerabilities for personal gain or other motives. 
What does a system administrator do to defend the computers they are in charge of?

The role of information security is to minimize the impact of threats. This is done by deploying security 
controls around the vulnerable IT system. Security controls are safeguards used to minimize the impact 
of threats. Within the framework illustrated in Figure 250, these controls are shown as the ring around 
the IT system. The width of the arrows in Figure 250 indicates the relative frequencies of the different 
categories of threats seen by a typical organization. Most threats are blocked by the controls commonly 
adopted by organizations. For example, most operating systems now come with a firewall configured 
with some default settings and encourage users to use a strong password to secure the administrative 
user account on their computers. Commercially, even the smallest businesses backup their important 
files on external storage appliances or other Internet services and keep their computers locked to 
prevent unauthorized access.

Even rudimentary controls such as firewalls and passwords can successfully block a large majority 
of the threats facing organizations. However, as shown in Figure 250, even the best security controls 
have holes. For example, users often prefer memorable passwords over secure passwords. They 
are also often irregular in backing up their data even if they have spent hundreds or thousands of 
dollars to purchase backup systems. Threats exploit these weaknesses in security controls to reach 
the vulnerable IT systems. These threats are shown by the arrow on the right, which has breached the 
controls and reached the IT system. Fortunately, many of these threats may yet do no harm, as shown 
by the inability of the arrow on the right of Figure 250 to reach the IT system.

Cybersecurity controls can be classified as physical, procedural, and technical. Physical controls use 
traditional non-technical methods of preventing harm. Typically, they prevent unauthorized users 
from being able to enter technical facilities. Examples of such controls include locks, fire extinguishers, 
background checks, and doors. Procedural controls are prescribed plans of action that govern the 
use of computer resources. Examples of procedural controls include the procedures for obtaining 
computer accounts, procedures for escalating privileges, procedures for modifying programs, 
procedures for hiring, and requirements that users change their passwords periodically. Technical 
controls are the security measures built into the information system itself. Common examples include 
passwords, firewalls, intrusion detection systems, system updates, and antivirus software.
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Cyber Hygiene
The US Cybersecurity & Infrastructure Security Agency (CISA) defines cyber hygiene as those practices 
that reduce the risk of a successful cyber-attack.271 Today, it is important for people to understand 
how to use good cyber hygiene practices in order to safely use online IT systems and resources. Some 
intuitive practices of good cyber hygiene include simple measures of updating the security of your 
technical devices. For instance, if your mobile device has a software update, it will typically notify you 
by displaying an alert on your screen. A mobile device user can choose to ignore these updates or 
take the time to download and install them. Keeping your mobile device up to date is an excellent 
way to maintain good cyber hygiene and prevent cybercriminals from causing harm to your personal 
information. 

Other types of good cyber hygiene practice include the use of end-point protection (formerly called 
antivirus) software and changing your passwords regularly. Antivirus software, such as McAfee,272 
are designed to protect your identity, privacy, and devices. This protection is accomplished through 
software products that are designed to monitor your devices for known viruses and other malicious 
technologies that have the intent of harming the user. 

Password management is one of the most effective ways to practice good cyber hygiene. Keeping 
passwords safe and secure include practices such as: 

·	 avoid using the same password for multiple accounts;

·	 change passwords on a regular basis;

·	 passwords should be at least 12 or more characters long;

·	 passwords should include a mixture of upper and lower-case letters plus symbols and letters;

·	 avoid obvious passwords such as sequential numbers like 1234 or personal information 
someone could acquire on your social media accounts such as your pet’s name or your first 
car;

·	 avoid sharing passwords with others;

·	 use a password manager to help generate, store, and manage all your passwords in one 
security online account, for example: 1Password, https://1password.com/;

·	 use apps that require multi-factor authentication, for example, many social media accounts 
require a login username/password and a code sent as a text to your cell phone to complete 
the login process; 

·	 back up your important files in a secure and protected location, for example, on an external 
hard drive or cloud storage;

·	 don’t post private information such as your home address or phone number on social media 
accounts;

271	 Cybersecurity & Infrastructure Security Agency (CISA), “Cyber Hygiene Services,” https://www.
cisa.gov/cyber-hygiene-services (accessed June 2023).

272	 McAfee, https://www.mcafee.com/ (accessed June 2023).

https://1password.com/
https://www.cisa.gov/cyber-hygiene-services
https://www.cisa.gov/cyber-hygiene-services
https://www.mcafee.com/
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·	 check all your social media privacy settings because each social media account is slightly 
different and designed to protect its users when settings are appropriately applied;

·	 keep your devices locked with a password or PIN when not in use;

·	 do not use websites or apps that disclose private information on a public Wi-Fi; 

·	 only make online transactions on websites that are secure (this requires a URL with https:// 
rather than just http://);

·	 change the default name of your home Wi-Fi router—in other words, don’t leave your home 
router with the same name it has been given by the manufacturer when you took it out of the 
box;

·	 setup a guest network on your home Wi-Fi so that guests in your home use this network 
instead of the one setup for your personal use; 

·	 use firewalls to prevent malicious software from accessing your home network; 

·	 encrypt devices that contain sensitive data, for example, removable USB drives; and 

·	 before selling or disposing of a device, it is a good practice to wipe the hard drive clean. 

Overall, people are typically the weakest link to a cybersecurity attack. Many cyber-attacks are 
designed to exploit the vulnerabilities of people and their poor cyber hygiene. For instance, cyber-
attack techniques such as social engineering are used by malicious actors with the intent of getting 
people to expose specific information they would otherwise be unwilling to share. This specific 
information, exposed by poor cyber hygiene, can be used against a person to do horrible things such 
as stealing their identity or emptying their bank accounts. Therefore, as technologies evolve over 
time it will continue to be a basic necessity for the general population to stay informed on what it 
takes to practice good cyber hygiene.

Teams in Cybersecurity
Professionals who work in cybersecurity often work in teams to respond to or investigate a 
cybersecurity event. These teams must be familiar with the tactics, techniques, and procedures (TTP) 
used by bad actors in a cybersecurity event. Tactics can be described as the basic methods used by 
the hacker to gain access to a system or information. A technique may include the tools or methods 
used by the hacker to gain access to the system or information. Finally, the procedure describes how 
a hacker carries out the techniques step-by-step. 

Cybersecurity teams need to be familiar with the TTPs known by the cybersecurity intelligence 
community in order to understand the behavior of a hacker. This behavioral understanding is what 
teams need to better protect companies and systems from being attacked. One of the world’s 
largest open-source repository of TTP knowledge used by cybersecurity teams is the MITRE ATT&CK 
framework. Cybersecurity teams can use this real-world threat intelligence to help make the world a 
safer place to live. 

Although people may commonly call a bad actor a malicious hacker, not all hackers are bad. 
Cybersecurity teams have evolved over time to specialize in different areas of behavior commonly 
engaged by hackers. In fact, the members of these specialized teams could also be called hackers. 
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Essentially, hackers are classified by the intent of their behavior. Whether the actor has bad or good 
intensions, cybersecurity teams must understand all classifications of hacker behavior. 

The following summarizes the two common types of cybersecurity teams that specialize in the TTPs 
used by actors involved in a cybersecurity event: 

Red Teams: These cybersecurity teams consist of operators that use tools and techniques 
typically used by malicious actors to attack a system or the information it manages. If this 
were a sport, you could think of Red Teams as the “offense.” Cybersecurity attacks executed by 
Red Teams are often called campaigns. The intent of a Red Team operator (hacker) is to help 
companies understand how their security weaknesses (vulnerabilities) can be exploited by a 
malicious actor. This understanding can help the company put better business and technology 
practices in place to protect their systems from future attacks. 

Blue Teams: These cybersecurity teams focus on the constant defense of systems and 
information managed by organizations. It is common for companies to work with Security 
Operation Centers (SOC), which consist of multiple Blue Teams dedicated to keeping a close 
watch on all the systems critical to conducting their daily business. Blue Teams are trained to use 
tools designed to protect, capture, analyze, and respond to a cybersecurity event. For instance, 
in the event a company’s system is attacked by a malicious actor or malware a Blue Team will 
work together to investigate what happened. Once they understand what happened, they will 
work to understand how it happened and recommend a mitigating response to prevent the 
event from happening again. 

Overall, you can consider cybersecurity as a “team sport.” It requires teams of individuals working 
together to endlessly understand the offensive and defensive TTPs used by hackers across the globe. 
Ultimately, these “good” hackers are motivated with a passion to prevent the “bad” hackers from 
harming the security of information and the management of critical systems. 
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			   Chapter Terms and Definitions

Asset: A resource or information that is to be 
protected

Brute Force Attack: A programming script 
designed to repeatedly execute its code while 
attempting to log into a system with a user 
account

CIA Triad: The provision of confidentiality, 
integrity, and availability; by protecting 
information and information systems from 
unauthorized access, use, disclosure, disruption, 
modification, or destruction

Control: Safeguards used to minimize the impact 
of threats

Cyber Hygiene: The practices that reduce the 
risk of a successful cyber-attack

Cybersecurity: Prevention of damage to, 
protection of, and restoration of computers, 
electronic communications systems, electronic 
communications services, wire communication, 
and electronic communication, including 
information contained therein, to make 
sure its availability, integrity, authentication, 
confidentiality, and nonrepudiation

Denial of Service Attack: The act of more than 
one networked computer overwhelming a 
network with fraudulent traffic

Hacker: A person who wishes to gain access to an 
identified target to learn more about the target 
and exploiting the target for an attack

Information Security: Protecting information 
and information systems from unauthorized 
access, use, disclosure, disruption, modification, 
or destruction in order to provide integrity, 
confidentiality, and availability

Malicious Actor: Someone or something that 
causes harm in the digital domain

Phishing: Attempting to compromise a user 
by masquerading as a trustworthy entity in 
electronic communication

Social Engineering: When deception is used 
to make a person give up private information 
or provide unauthorized access to a computer 
system or network

Threat: The capabilities, intentions, and attack 
methods of adversaries to exploit or cause harm 
to assets

Virus: A computer program that uses other 
programs to spread and adversely affect 
computers and propagate through the network 
without the user’s consent

Vulnerability: A weakness in an information 
system that contributes to a threat with the 
opportunity to compromise an asset

Worm: A computer program that can propagate 
all by itself and adversely affect computers and 
propagate through the network without the 
user’s consent
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		  	 Chapter Case

The Red Team Operators
NIST defines a “Red Team” as a group of people authorized and organized to emulate 
a potential adversary’s attack or exploitation capabilities against an enterprise’s 
security posture. The Red Team’s objective is to improve enterprise cybersecurity 
by demonstrating the impacts of successful attacks and by demonstrating what 
works for the defenders (i.e., the Blue Team) in an operational environment. Also 
known as Cyber Red Team.273 In the figure below, two Red Team operators are 
attempting to exploit any vulnerabilities by the Widget Inc. Human Resources (HR) 
department. 

Damian Hatter, Red Team Operator 1, walked past the Widget Inc. HR department 
and looked through several of the windows to observe the general layout of the 
room prior to entering. He noticed that a single HR clerk was sitting behind a 
front desk and there were several workstations positioned across the room that 
were shielded by cubicle walls. Hatter then walked in the HR department and 
approached the HR clerk behind the front desk. He asked the clerk if he could fill 
out an application for a job opening. The clerk then directed him to sit down at a 
workstation and click the shortcut icon located on the PC desktop to begin the 
application process. Hatter then proceeded as instructed by sitting down at one of 
the workstations while the clerk remained sitting behind the front desk.

Shortly after Hatter sat down at a workstation, he began to evaluate the PC for 
vulnerabilities. His primary goal was to implant a backdoor274 and maintain 
network persistence275 through a remote command and control server (C2).276 To 
accomplish this, he first started with verifying that he could use one of the open 
USB ports located on the PC. He reached into his pocket, pulled out his USB flash 
drive, and inserted it into an open USB port. The Windows Operating System 
immediately responded with a notification confirming that the USB port access 
was enabled. Upon confirmation, Hatter proceeded with opening his USB flash 
drive and executed a malicious program he had installed earlier prior to leaving his 
office desk. The malicious program running on his USB flash drive then successfully 
communicated with his C2 instance running on a remote system located offsite

273	 National Institute of Standards and Technology (NIST), Computer Security Resource Center, “Red 
Team,” https://csrc.nist.gov/glossary/term/red_team (accessed June 2023).

274	 “Backdoor (computing),” TechTarget, August 2017, https://www.techtarget.com/searchsecurity/
definition/back-door?Offer=abMeterCharCount_var3 (accessed June 2023). 

275	 Maloney, Sarah, “What is an advanced persistent threat (APT)?” Cybereason, 1/9/2018, https://
www.cybereason.com/blog/advanced-persistent-threat-apt (accessed June 2023).

276	 “Command and Control Server,” TechTarget, January 2017, https://whatis.techtarget.com/
definition/command-and-control-server-CC-server (accessed June 2023).

https://csrc.nist.gov/glossary/term/red_team
https://www.techtarget.com/searchsecurity/definition/back-door?Offer=abMeterCharCount_var3
https://www.techtarget.com/searchsecurity/definition/back-door?Offer=abMeterCharCount_var3
https://www.cybereason.com/blog/advanced-persistent-threat-apt
https://www.cybereason.com/blog/advanced-persistent-threat-apt
https://whatis.techtarget.com/definition/command-and-control-server-CC-server
https://whatis.techtarget.com/definition/command-and-control-server-CC-server
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		  	 Chapter Case (continued)

from Widget Inc. Once he confirmed that his C2 instance could communicate with 
the malicious program executed from a networked PC located inside of the Widget 
Inc. network, his goal was complete. Hatter then ejected his USB flash drive, placed 
it in his pocket, and left the HR room.

As soon as Hatter left the HR room, Wanna Bee, Red Team Operator 2, walked in 
and went directly to a workstation without confronting the HR desk clerk. As soon 
as he sat down at the workstation, he immediately used a web browser to navigate 
to a website that he had previously setup on a remote webserver for the purpose 
of downloading malicious software. The user account setup on the PC had enough 
privileges to download and execute applications directly from the Internet. Upon 
successfully downloading and executing the malicious software, Bee was able to 
communicate with the remote C2 system. 

Hatter and Bee had successfully gained unauthorized persistent access to the 
Widget Inc. network. This was accomplished through exploiting unsecure physical 
and technical entry points. 

Illustrates a Red Team operation on a company’s Human Resources (HR) department. 
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		  	 Chapter Case (continued)

Question 1:	 What vulnerabilities do you think exist in the HR department?

Question 2:	 Identify as many cybersecurity controls as you can that you think 
should be added to the HR department based on this case scenario. 
Be sure to consider physical, procedural, or technical controls.
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Ethics is knowing the difference between what you have a right to do and what is 
right to do. 

—Potter Steward, former Associate Justice of the US Supreme Court

Overview
Ethics are a community’s shared beliefs about what is good for the individual and for society and the 
duties that people owe themselves and one another.277 The word “ethics” traces to the Greek word 
ήθος (ethos), which describes the guiding ideals of a community. Though some ethical principles 
may be codified as law, ethics are more commonly enforced by disapproval among members of the 
community. For example, not breaking a promise to a friend is a common ethical principle. It is not 
prohibited by the law; however, strong disapprovals ensure that friends do not break promises among 
each other.

Today, we talk of ethics in most workplaces as the expectations of the membership in the organization 
or profession. These ethical principles help the organization, profession, and community to flourish 
and prosper. Much like the consequences of breaking promises among friends, failure to abide by 
these ethical principles can lead to dismissal from the organization or profession, even if the specific 
conduct does not violate the law. Ethics are a strong force that help communities prosper.

Ethics have evolved with time. One of the oldest and most influential texts in western thought is 
Aristotle’s, Nicomachean Ethics.278 In the book, Aristotle (384–322 BC) aims to search for the highest 
good in life. He begins by asserting that the highest good in life has three characteristics: (1) it is 
desirable for itself, (2) it is not desirable for the sake of some other good, and (3) all other goods are 
desirable for its sake.279 He then identifies εύδαιμονία (eudaimonia), translated as happiness/living 
well, as this highest good. These ideas have guided society since our earliest days, and ethics may be 
seen as our quest to use our own reasoning to act in ways that maximize happiness over a lifetime.

With regard to modern times, our use of networked computers has introduced several unique 
ethical concerns. Several common practices from earlier times raise ethical concerns when powerful 
computers and high-speed networks become available to everybody. Most of these contemporary 
ethical concerns are associated with the use of information, and we will highlight some of the most 
salient concerns in this chapter. As an example of how computers make a long-standing practice 
an ethical concern, consider music sharing. Artists spend long hours creating a song and invest 
considerable money packaging it into an album. In olden days when people listened to music on 
cassette tapes, it helped everybody if music-lovers made copies of songs they had purchased. For 
example, to create a collection of songs to listen to on the road. It was even considered acceptable 
for users to make copies of these personal collections for friends, because eventually many of those 
friends would buy their own copies of the original albums for their superior audio quality. These 

277	 Definition of Ethics, Cornell Law School, https://www.law.cornell.edu/wex/ethics (accessed June 
2023).

278	 Nicomachean Ethics, Aristotle http://classics.mit.edu/Aristotle/nicomachaen.html (accessed 
June 2023).

279	 “Aristotle’s Ethics,” Stanford Encyclopedia of Philosophy, https://plato.stanford.edu/entries/
aristotle-ethics (accessed June 2023).

https://www.law.cornell.edu/wex/ethics
http://classics.mit.edu/Aristotle/nicomachaen.html
https://plato.stanford.edu/entries/aristotle-ethics
https://plato.stanford.edu/entries/aristotle-ethics
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copies, therefore, served a marketing purpose for the artists, and everyone benefited. This was even 
codified as the Fair Use Act, which we will discuss later in this chapter. 

However, with computers, it is now easy to make flawless copies of original music and distribute it 
widely to the entire world at no cost. This reduces revenues for artists, which reduces their incentives 
to create new music, which hurts everybody. There is, therefore, a need to develop appropriate ethical 
principles for music distribution in the digital era, which provide financial incentives for the artists as 
well as listening freedoms to consumers for the music they have purchased. Most ethical concerns 
with computers and networks can be traced to this general idea.

Ownership Rules
Most users believe everything available online is free to use as they please, because they can hop 
from one website to another and gather a ton of information without buying any tickets or paying 
any fees. In reality, everything you see on the World Wide Web is “owned” by someone, usually the 
creator or publisher of the information. Users are expected to recognize this ownership of images, 
text, media, or ideas they find on the Internet. The online world has ownership rules just like the real 
world, and you need to be aware of them to be a good netizen and avoid getting into legal trouble. 
In this chapter, we highlight a few terms that existed long before the Internet arrived but have gained 
special importance with the advent of computers and online resources.

Copyright 

Copyright is a type of intellectual property that protects original works of authorship as soon as an 
author fixes the work in a tangible form of expression.280 The combination of originality and fixation 
gives the creator copyright over the work. Copyrights for “works made for hire” are owned by the 
employer and copyrights for work commissioned by a publisher are owned by the publisher. Copyright 
does not protect ideas or facts per se, but an original expression of an idea in a tangible form is 
protected by copyright. Thus, several people can own the copyright to the same idea or fact, each 
based on the originality the creator brings to the idea or fact. For example, multiple photographers 
can take pictures of the same sunrise from the same location, and each photographer will own the 
copyright to their own photographs, since they are the photographer’s original expression of the 
idea, expressed in tangible form as a photograph.

Since January 1, 1978, creators own the copyright until seventy years after the author’s death. 
Copyright protection for works made for hire is 95 years from publication or 120 years from creation, 
whichever is shorter. An interesting copyright case with particular reference to Florida is Disney’s 
copyright over several beloved characters, including Mickey Mouse.281 The 95-year copyright deadline 
for Mickey Mouse is in October 2024.

If a content is copyrighted, the creator of the content has complete ownership of the work. Even if 
copyrighted material is publicly displayed online, you cannot use it personally without the explicit 

280	 “What is Copyright?,” https://www.copyright.gov/what-is-copyright/ (accessed June 2023).
281	 “Disney could soon lose exclusive rights to Mickey Mouse,” The Guardian, https://www.

theguardian.com/film/2022/jul/03/mickey-mouse-disney-copyright-expiry (accessed June 
2023).
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permission of the creator. This test becomes even more stringent if you use copyrighted content in 
commercial work, where you anticipate some income. Search engines can help you find images with 
license terms that allow you to incorporate them in your own work.282

Beginning with the 1978 report of the National Commission on New Technological Uses of Copyrighted 
Works (CONTU), an author’s original creation expressed as computer software can be copyrighted. 
Computer software is, therefore, also subject to copyright laws. In the early days of the computer 
industry, computer manufacturers bundled software at no additional cost to help buyers make the 
best use of their expensive computers. However, in January 1969 the US government filed a lawsuit 
against IBM, the dominant computer company of the time, calling this practice of bundling software 
with hardware as anti-competitive.283 Software became an independent marketable product, and as 
the cost of creating computer software rose, an independent computer software industry emerged. 
The copyright protections created further incentives to create and monetize computer software.

The ethical principle of copyright protection is well codified in law. Software companies take former 
employees to court for copying company code and offering it to competitors. However, the issues 
involved often become complicated for lawyers, judges, and juries to understand.284

However, several developers and even leading software vendors have continued to offer their 
computer code to the public for free for various reasons. Some individuals are motivated by the 
general good of humanity. A leader in this school of thought is Richard Stallman who created the 
Free Software Foundation285 in October 1985 to create software that users can run, edit, contribute to, 
and share freely.286 Other motivations include establishing standards in an area critical to a company’s 
success. For example, Google has made the source code for its Chrome browser available for free287 
and Microsoft has made the source code for its web application development technology (MVC Core) 
available for free.288

Open-Source Software (OSS) is software whose source code is designed to be publicly accessible. 
Open source is a popular term in the industry. Much critical Internet infrastructure runs on open-
source software such as the Linux Operating System. Contributing to open-source projects can be a 
great learning and rewarding experience. However, using open-source code within the commercial 

282	 A good example can be found on Google’s help page, “Find images you can share and use,” 
https://support.google.com/websearch/answer/29508 (accessed June 2023).

283	 “Software Becomes a Product,” Computer History Museum, https://www.computerhistory.org/
revolution/mainframe-computers/7/172 (accessed June 2023).

284	 For example, in the case of Sergey Aleynikov found in the article, “Judge overturns conviction of 
Goldman Sachs programmer for stealing code,” https://nakedsecurity.sophos.com/2015/07/08/
judge-overturns-conviction-of-goldman-sachs-programmer-for-stealing-code/ (accessed June 
2023).

285	 The Free Software Foundation homepage, https://www.fsf.org/ (accessed June 2023).
286	 The foundation defines freedom in “What is Free Software?” https://www.gnu.org/philosophy/

free-sw.en.html (accessed June 2023).
287	 The open-source browser project, Chromium, is described at https://www.chromium.org/

Home/ (accessed June 2023).
288	 ASP.net Core, is described at https://github.com/dotnet/aspnetcore (accessed June 2023).
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code of a company can create several risks to the commercial product.289 Therefore, if you work for 
a for-profit software company, you should talk to your legal department before taking advantage of 
any open-source software within the product. Software companies typically scrutinize their code to 
ensure that no open-source code has crept into their software.

Public Domain

The body of creative work to which no intellectual property rights apply is considered to be in the 
public domain. Creative work generally comes within the public domain either because the work is 
not eligible for copyright protection in the first place, or because copyright protection on the work has 
expired, for example, 70+ years after the death of the author.290 For example, the book Nicomachean 
Ethics is now in the public domain because it’s been millennia since the death of its author(s). You can 
use material in the public domain extensively in your own creative works even though you cannot 
own it.

Project Gutenberg is an easily accessible library of most classic books that are in the public domain.291 
Books available at Project Gutenberg include Alice in Wonderland292 and The Adventures of Sherlock 
Holmes.293

Fair Use

Fair use is any copying of copyrighted material done for a limited and “transformative” purpose, such as 
to comment upon, criticize, teach, research, or parody a copyrighted work.294 Fair use principles allow 
the use of copyrighted materials without permission from the copyright owner. Fair use balances the 
interests of the copyright owner and freedom of expression by allowing unlicensed use of copyright-
protected works in certain circumstances.295 

Fair use is a legal doctrine that promotes freedom of expression by permitting the 
unlicensed use of copyright-protected works in certain circumstances. 

—Section 107 of the US Copyright Act

289	 “Risk Management of Free and Open Source Software” (FOSS) is explained by the Federal Financial 
Institutions Examination Council, https://www.federalreserve.gov/boarddocs/srletters/2004/
sr0417a1.pdf (accessed June 2023).

290	 “The Public Domain,” University of California, https://copyright.universityofcalifornia.edu/use/
public-domain.html (accessed June 2023).

291	 The Project Gutenberg homepage, https://www.gutenberg.org/ (accessed June 2023).
292	 Lewis Carroll, Alice’s Adventures in Wonderland, Project Gutenberg, https://www.gutenberg.org/

ebooks/11 (accessed June 2023).
293	 Arthur Conan Doyle, The Adventures of Sherlock Holmes, Project Gutenberg, https://www.

gutenberg.org/ebooks/1661 (accessed June 2023).
294	 “What is Fair Use?,” Stanford Libraries, https://fairuse.stanford.edu/overview/fair-use/what-is-

fair-use/ (accessed June 2023).
295	 The US Copyright Office Fair Use Index, https://www.copyright.gov/fair-use/ (accessed June 

2023).
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Section 107 of the Copyright Act specifies the framework for fair use.296 Generally, fair use guidelines 
in the US allow the use of brief excerpts of copyrighted material for teaching, research, criticism, 
commentary, or news reporting. If you have any doubts or concerns about fair use, you may want to 
contact the copyright owner. Most companies have information about fair use of their copyrighted 
material.297

Plagiarism

Plagiarism is the use of someone else’s words or ideas in your own work without permission, attribution, 
or acknowledgment.298 The ethical principles around plagiarism protect intellectual creativity in a 
society and encourage creative expression of ideas in all possible forms. Since ideas build on each 
other, you can use the specific creative expression of another person or published material. However, 
when doing so, you are required to clearly demarcate the creative expression of the other person and 
cite the source of the borrowed expression. For short expressions, it is appropriate to use quotation 
marks around the borrowed words and cite the source. For more extensive content, it is appropriate to 
paraphrase or summarize the information, while citing the source. Citing the source gives the reader 
the opportunity to engage directly with the original creator’s full expression. If these procedures 
appear unnecessarily tedious, consider how you’d feel if the content you created was used by others 
without attribution to you.

It is possible to plagiarize unintentionally without meaning to do so. For instance, when looking up 
information online, you must take special care not to plagiarize, as everything on the web seems to 
be publicly available for general consumption. In the academic world, technology such as TurnItIn299 
checks submitted work against a database of all prior published and submitted work to detect 
potential plagiarism and instill the discipline of attribution among students.

Computer technologies can help businesses detect plagiarism to protect their patented/copyrighted 
material and also make sure they do not plagiarize content intentionally or unintentionally. In 
the publishing world, a plagiarism check is a critical step in the publishing process for books and 
magazines. 

Plagiarism is an example of an ethical principle that is not illegal.300 However, plagiarism is considered 
a serious violation of ethical codes and can lead to significant disciplinary action, including dismissal 
from an organization. Copyright owners can also initiate legal action for plagiarism.

296	 17 USC 107, https://www.copyright.gov/title17/92chap1.html#107 (accessed June 2023).
297	 For example, see https://about.google/brand-resource-center/guidance/ for Google 

“Guidance,” or https://www.mcdonalds.com/us/en-us/contact-us/trademark-permission.html 
for McDonald’s “Trademark Permission” (accessed June 2023).

298	 “What is Plagiarism?,” Academic Integrity at MIT: A Handbook for Students, https://integrity.mit.
edu/handbook/what-plagiarism (accessed June 2023).

299	 Turnitin homepage, https://www.turnitin.com/ (accessed June 2023).
300	 Definition of Plagiarism, Cornell Law School, https://www.law.cornell.edu/wex/plagiarism 

(accessed June 2023).
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Piracy

Piracy is the unauthorized copying, distribution, and selling of copyrighted content.301 While 
plagiarism involves passing off another’s creation as your own, piracy involves distributing another’s 
creation without permission, without claiming it as your own. Piracy is typically relevant for creative 
expression with immediate monetary value, for example music, movies, TV shows, and software.

One of the best-known examples of piracy was the use of Napster to distribute music around 2000.302 
Napster claimed that its service was an example of fair use—helping customers sample music before 
buying. But the courts concluded that the Napster service was really commercial, given the volume 
of copying and distribution involved.

The media industry uses several measures to prevent piracy including encryption and user-friendly 
apps with reasonable pricing.

Ethics and Online Content
Ethical use of the web does not only involve the use of information consumers find on websites. 
Individuals, companies, and users responsible for maintaining, monitoring, tracking, and posting on 
sites also have an ethical responsibility to the site’s consumers.

Online Privacy

Privacy is understood as the right to be left alone.303 In various judgments, the Supreme Court has 
found that the first, third, fourth, and fifth amendments give individuals a right to privacy. This right 
extends to privacy over one’s information. In 1974, the Privacy Act established a code of fair information 
practice for the collection, use, and dissemination of personally identifiable information by federal 
agencies. These principles have guided personal privacy protections in various laws established for 
specific contexts such as healthcare (HIPAA) and education (FERPA).

The individual right to privacy creates responsibilities for anyone storing personal information about 
anyone else. This is where online privacy is important. Information you collect about others should 
be used only for the express purpose for which it is collected. You must be particularly careful about 
the privacy of your users if your work involves finding and storing personal information online. Fraud 
and online identity theft being big concerns, you need to have a safe way to handle the personal 
and copyrighted information of your customers and vendors. For example, if you create a website for 
a fast-food chain and take the credit card information of your patrons to process transactions, you 
are responsible for securing the information and ensuring it is not misused. Similarly, teachers are 
responsible for safeguarding in their computers the personal and academic information of students. 

301	 “About Piracy,” RIAA, https://www.riaa.com/resources-learning/about-piracy/ (accessed June 
2023).

302	 A&M Records, Inc. v. Napster, Inc., 239 F.3d 1007 (9th Cir. 2001), https://www.copyright.gov/fair-
use/summaries/a&mrecords-napster-9thcir2001.pdf (accessed June 2023).

303	 “History of Privacy Timeline,” Safe Computing, University of Michigan, https://safecomputing.
umich.edu/privacy/history-of-privacy-timeline (accessed June 2023).
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Healthcare workers in the US have the additional responsibility of complying with HIPAA, which 
dictates how to store, handle, and dispose of sensitive health data of patients. If you intern at a bank 
or in the financial industry, you may have to follow protocols specific to the industry for dealing with 
privacy issues.

Social Media Addiction

Evidence increasingly suggests that online content, particularly the content offered by social media, 
has created a new form of addiction for many adults and children, who are glued to their computers 
and phones, wasting away their days in the virtual world, playing games, and watching videos. One 
reason suggested for this addiction is the instant gratification offered by social media.304 Following 
friends on social media makes us feel good and release a chemical in the brain called Dopamine. A 
Dopamine release happens during experiences that increase our chances of survival, for example, 
upon finding food or shelter. This is nature’s mechanism to direct us toward behaviors that help 
us flourish as a species. Unfortunately for the human species, particularly in developed nations, as 
scarcity has been replaced with plenty, this Dopamine-mediated survival mechanism has become an 
addiction mechanism. People crave pleasure and seek out pleasurable experiences, which are now 
within easy reach. For some, drugs offer these chemical mediators directly. For others, social media 
delivers these pleasurable and thereby addicting experiences. The term “Dopamine Nation” captures 
this phenomenon.305

There are also adverse effects from these addictions. Estimates suggest that when visual social media 
(e.g. Instagram) became dominant among teenagers and access to high-speed wireless Internet 
significantly increased, teen girls’ mental health diagnoses increased by as much as 90% relative to 
teen boys.306 Possible mechanisms include reduced self-esteem and reduced body image, which 
affects both boys and girls, but has a greater impact on girls.307 Thus, widespread use of computers 
and networks can have significant adverse effects, with some demographic groups affected more 
than others. This is an important concern for national competitiveness and is likely to draw increasing 
attention from parents and lawmakers in the coming years.

Online Tracking

Search companies, ecommerce companies, and social media companies have a commercial interest 
in knowing about your personal interests. They use the vast computing power and algorithmic 
expertise at their disposal to analyze your browsing behaviors and store detailed information about 
your preferences in their databases. For example, you may have noticed that if you search for shoes 

304	 Bruce Goldman, “Addictive Potential of Social Media, Explained,” Scope, Stanford Medicine, 
https://scopeblog.stanford.edu/2021/10/29/addictive-potential-of-social-media-explained/ 
(accessed June 2023).

305	 Anna Lembke, MD, Dopamine Nation, https://www.annalembke.com/ (accessed June 2023).
306	 Elaine Guo, “Social Media and Teenage Mental Health: Quasi-Experimental Evidence,” 2022, 

Working Paper.
307	 Yvonne Kelly, “Social Media Use and Adolescent Mental Health: Findings From the UK Millennium 

Cohort Study,” https://www.thelancet.com/journals/eclinm/article/PIIS2589-5370(18)30060-9/
fulltext (accessed June 2023).
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on your browser, advertisements for shoes begin to show up in your TikTok feed, your Facebook and 
Instagram pages, and other websites you may visit. You may even see mailers for shoes show up at 
your home address.

Something as benign as lingering too long on a TikTok video, liking a post on Facebook, or searching 
for a device on Google is equivalent to standing in a public square and raising a flag to trumpet your 
personal interest. 

While tracking customers to sell shoes may seem harmless, online trackers are capable of other 
practices that may not be as harmless. 

Your digital fingerprints are everywhere.

Political Impacts

The Internet has also given a great new tool to governments eager to manipulate and/or monitor 
their citizens’ opinions. Rogue regimes can now fight bloodless wars by influencing voter opinion in 
democracies, and disabling critical infrastructure such as the power grid.308 Digital authoritarianism 
is the term used to describe the actions of countries to influence and coerce private citizens and 
businesses in other countries to advance their own interests.309 These actions are considered unethical 
in most countries.

Additionally, in some authoritarian countries, the Internet is a highly monitored zone where behaviors 
and words are tightly controlled. The authorities can get notified if you search for certain phrases. 

308	 “Securing the US Electricity Grid form Cyberattacks,” USGAO, https://www.gao.gov/blog/
securing-u.s.-electricity-grid-cyberattacks (accessed June 2023).

309	 “Cyber Operations Enabling Expansive Digital Authoritarianism,” National Intelligence Council 
Assessment, https://www.dni.gov/files/ODNI/documents/assessments/NICM-Declassified-
Cyber-Operations-Enabling-Expansive-Digital-Authoritarianism-20200407--2022.pdf (accessed 
June 2023).
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If you criticize the government in a social media post, not just you but even your friends may be 
answerable and may need to justify your action. Even buying thermometers or fever reducers could 
trigger a visit by health officials and a lock down of your building in a post-Covid world.

The use of the Internet and computers has changed how we live and think. It has had broad 
implications on our society and has affected how groups with opposing ideas engage with each 
other. Technology has given social media firms the ability to understand your passions, interests, and 
political inclinations, and group you with others similarly inclined.

By diverting and holding your attention with their algorithms, companies can influence your opinions 
in unprecedented ways. While their motivation is simply to get you to spend more time on their 
platform and make more money, they end up emphasizing our differences. Their actions can have a 
pernicious effect that can threaten the very fabric of our social structure. 

Biases in Artificial Intelligence (AI) Models

Artificial intelligence is the ability of computers to do tasks that require intelligence and training. 
With the help of AI, we can train software programs to analyze vast amounts of existing information 
to predict the outcome of an event. As examples, AI models can analyze X-rays to detect tuberculosis 
and examine mammograms to identify cancerous tissues. AI models also enable self-driving cars to 
interpret images captured by a car’s cameras to determine safe driving paths.

Although these AI models save time and lives, we 
introduce new ethical risks when we increase our 
reliance on them in matters central to human lives, such 
as criminal justice, healthcare, and finance. We may 
inadvertently introduce biases related to race, gender, 
age, and other human attributes into AI models, by 
the way we collect data to train the models. This may 
result in individuals of certain backgrounds being 
denied loans, rental opportunities, and admittance 
into colleges. For example, in 2015, Amazon discovered 
that an AI model they had built to identify potential 
high-performing software developers was biased 
against women.310 This happened because most 
developers at the company were men and Amazon’s 
model learned to associate words more common on 
men’s resumes with success. Similarly in 2016, a news 
organization claimed that an AI algorithm used by courts to predict whether a criminal was more 
likely to revert to crime (recidivism) was biased against black people.311 Similar biases can enter into 

AI models without bias.

310	 Roberto Iriondo, “Amazon Scraps Secret AI Recruiting Engine that Showed Biases Against 
Women,” https://www.ml.cmu.edu/news/news-archive/2016-2020/2018/october/amazon-
scraps-secret-artificial-intelligence-recruiting-engine-that-showed-biases-against-women.
html (accessed June 2023).

311	 Julia Angwin, Jeff Larson, Surya Mattu, and Lauren Kirchner, ProPublica, “Machine Bias,” https://
www.propublica.org/article/machine-bias-risk-assessments-in-criminal-sentencing (accessed 
June 2023).
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AI models in other contexts, and as we delegate increasing responsibilities to AI, we should be aware 
of the ethical concerns raised by AI model bias.

AI models may detect too many false positives when analyzing the data of some ethnicities. A false 
positive happens when a model incorrectly identifies an individual as a fraudster, a criminal, or 
someone suffering from a disease or being at risk for certain medical conditions. False positives result 
in billions of dollars of unnecessary treatments, innocent individuals being tagged as offenders, and 
consumers being denied benefits. Since most of the data used to train and build the AI models is from 
the western world, these models also fail if we use them in other parts of the world without taking 
location into consideration.
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			   Chapter Terms and Definitions

Artificial Intelligence: The science and 
engineering of creating intelligent computer 
programs 

Copyright: A type of intellectual property that 
protects original works of authorship when 
an author fixes the work in a tangible form of 
expression

Fair Use: Ability to use material that is copyrighted 
for limited purposes and limited conditions (for 
example, we use the Apple logo in this textbook 
to depict what a technology company is)

Netizen: A user of the Internet

Online Privacy: Information on the Internet that 
shouldn’t be accessible without permission

Online Tracking: Collecting, storing, and sharing 
information about visitors’ activities on the web

Piracy: Unauthorized duplication and distribution 
of copyrighted material

Plagiarism: Claiming another entity’s work as 
your own

Public Domain: Work exempt from copyright 
protection; also referred to as commons
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		  	 Chapter Case

Allison’s Report—To Plagiarize or Not To Plagiarize
Allison had just finished reading Romeo and Juliet, a tragedy written by William 
Shakespeare, as part of an assignment for her 4th period reading class. She was 
required to write a two-page report that summarized what she had learned from 
reading the novel and provide examples of how the story had been reproduced or 
adapted in modern films. 

Allison opened up the Google search engine on her laptop and searched for, 
“Romeo and Juliet in modern films.” To her surprise, over five million results were 
estimated in the search results. As she read through many of the webpages, she 
realized that the topic was overwhelming. So many films had been adapted from 
themes written by Shakespeare in the classical novel version of Romeo and Juliet. 

Allison thought to herself, “How do I write about all of these modern films without 
just copying some of what I’ve read on these webpages?” She was supposed to turn 
in an electronic version of her report because her teacher was going to check the 
paper using a software called turnitin (https://www.turnitin.com/). Software like 
turnitin was designed to verify the originality of student work by calculating the 
likelihood of plagiarism. 

Allison understood what plagiarism was and wanted to do her best on this report. 

Question 1:	 What kinds of things can Allison do to avoid plagiarizing her report 
on Romeo and Juliet? 

Question 2:	 Romeo and Juliet was written by Shakespeare hundreds of years ago. 
Therefore, the original work is now considered in the Public Domain. 
Today, there are many modern films that represent a recreation 
or adaptation of its original story. If you were to create your own 
modern version of Romeo and Juliet, how can copyright laws protect 
your work? Note: Review the U.S. Copyright Office website on this 
topic, https://www.copyright.gov/what-is-copyright/.

https://www.turnitin.com/
https://www.copyright.gov/what-is-copyright/
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The social-media landscape changes incredibly fast, so you have to be open-
minded and nimble to keep up with it.

—Alexis Ohanian, co-founder of Reddit 

Overview
At the turn of the century, we were still at the beginning of our journey into this always-on, always-
connected world. We still wrote physical letters and sent birthday cards by mail. Phone calls were 
expensive and video calling was like science fiction. Google and Facebook didn’t exist.312 You couldn’t 
download video games on your mobile phone because you didn’t have access to an app store that 
sold software.

In contrast, just today you might have viewed TikTok videos, checked Instagram, sent a WhatsApp 
message, liked an author’s tweet, and chatted with your friends on Discord. All before starting your 
school day. You may not realize it, but the smart-phone-always-on-hand lifestyle has turned us into 
social media creatures constantly dropping digital breadcrumbs about our lives on the Internet. 
Without being aware, you may have shared information about your friends, your boss at work, the 
books you like, your vacation plans, the products you use at home, and even revealed your eagerness 
to find a partner. These breadcrumbs help companies show you ads for the things you are most 
interested in. But they also have a dark side. Social media apps—the comsumer-facing applications 
of the digital world—could potentially hurt your career and relationships. All these possibilities arise 
from social media apps—the consumer-facing applications of the digital world.

While the benefits of social media are well known, in recent 
years there is increasing awareness of its potential harms. 
Several states have passed laws to regulate social media 
use, and the US Surgeon General has issued an advisory 
summarizing results from research on social media’s impact 
on mental health. The Surgeon General’s advisory informs 
us on large sections of this chapter and is a great resource to 
augment the information in this chapter.313 Particularly useful 
are the links in the advisory to the empirical studies that have 
looked at the issues we have brought up in this chapter.

Adapting from Carr and Hayes314 and the advisory from the 
Surgeon General, we define social media as Internet-based 
channels that allow users to interact and derive value from user-
generated content. The goal of this chapter is to make you 

312	 Television was the primary information source on 9/11.
313	 “Social Media and Youth Mental Health,” The U.S. Surgeon General’s advisory, https://www.

hhs.gov/sites/default/files/sg-youth-mental-health-social-media-advisory.pdf (accessed June 
2023).

314	 Carr, C. T., & Hayes, R. A., “Social Media: Defining, Developing, and Divining,” Atlantic Journal 
of Communication, 23:1, 46-65, https://doi.org/10.1080/15456870.2015.972282 (accessed June 
2023).

https://www.hhs.gov/sites/default/files/sg-youth-mental-health-social-media-advisory.pdf
https://www.hhs.gov/sites/default/files/sg-youth-mental-health-social-media-advisory.pdf
https://doi.org/10.1080/15456870.2015.972282
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more aware of the impact of social media, so you can make the best use of social media in your life 
and career, while avoiding the pitfalls. For both benefits and risks, we look at both professional and 
personal aspects.

Benefits of Social Media

Professional Benefits

When you want to watch a movie, you may check out movie ratings and user comments on IMDb 
before choosing a movie to buy. Before you purchase a product on Amazon, you often read reviews 
posted by previous buyers to confirm the product will work as expected. In college, students often 
review websites where students post comments about professors before picking classes.

You face similar situations when you enter the workforce. When you are looking for jobs, in many 
ways it is useful to think of yourself as a product on the market for potential employers to buy. Before 
people hire you for your next job, they are very likely to explore what others have to say about you in 
the digital world. They may go to LinkedIn to check if your previous employers and colleagues have 
great things to say about you. They may even check your social media activities and learn about your 
family and political inclinations. The stakes are high. Hence, it is important to carefully manage your 
presence in the digital world, so your digital presence helps you and does not adversely affect your 
chances of finding a new job or striking new alliances.

One great software tool you can take advantage of is LinkedIn. 
It was officially launched in 2003315 to connect working 
professionals and now boasts over 930 million members in over 
200 countries. Even as a high-school student, you may want 
to create your LinkedIn profile to list your accomplishments 
and work experiences and to connect with your classmates, students at other schools you meet at 
events, teachers, and employers. If you have done a great job as an intern, you may request your 
boss and your colleagues to leave a review about you on LinkedIn. This will not only help exhibit 
your experience and interest but also confirm your identity to your potential employers. Before you 
graduate high school, don’t forget to connect with your friends on LinkedIn to start building your 
professional network and stay connected.

Good reviews and connections on LinkedIn may prove to be more valuable than what you list about 
yourself on your resume. An important challenge for both fresh graduates and employers is the high 
uncertainty about the work ethic and professionalism of fresh graduates. Do you show up on time? 
Are you a team player or do you create disruptions on the team? Do you show initiative, or do you 
have to be pushed to complete every task? A school or college transcript does not reveal these details. 
LinkedIn reviews from internship employers or team coaches can help close this gap and be a critical 
asset as you get started in your career.

315	 For a quick history of LinkedIn, please see, “Looking Back at the History of LinkedIn,” https://
penningtoncreative.com/history-of-Linkedin. “The Complete History of LinkedIn: Everything 
You Need to Know,” is a slightly more detailed version, https://history-computer.com/the-
complete-history-of-Linkedin/ (accessed June 2023).

https://penningtoncreative.com/history-of-linkedin
https://penningtoncreative.com/history-of-linkedin
https://history-computer.com/the-complete-history-of-linkedin/
https://history-computer.com/the-complete-history-of-linkedin/
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A basic LinkedIn account is free and allows you to send emails to your connections on LinkedIn. 
To send messages to members you don’t know, you need to pay for a premium account. If you are 
interested in working at a company, you can check on LinkedIn to see if any of your friends are working 
there and message them politely to make them aware of 
your interest. If a suitable position opens, your friends may 
reach out to you and may even connect you with the hiring 
manager. In fact, if your LinkedIn profile looks strong, a new 
job is likely to find you rather than the other way around. 
Recruiters, particularly in fields such as Digital Information 
Technology, with demand for good talents constantly scour 
LinkedIn in search of candidates.

Other than LinkedIn, you may also want to establish your 
presence on sites frequented by other professionals in your 
field. If you are a programmer, you may want a GitHub profile316 
to showcase all the hobby programming work you have done. 
If you are technically proficient, you could answer questions 
on StackOverflow and build your online reputation. If you do 
gig work, sites like Upwork317 and Fiverr318 can help you create 
a repertoire of work and reviews.

Personal Benefits

People of all ages use social media for its benefits. The authors of this book stay connected with 
their friends from high school through social media, decades after graduation. The Surgeon General’s 
advisory identifies several benefits, including a sense of community for people with shared values 
identities, abilities, and interests. Users get important information quickly and also use social media 
to express their opinions. Social media helps you sustain friendships online and organize social events 
easily. By giving you access to a wider community, social media can increase the diversity of your peer 
groups. If you need social support, social media increases the likelihood that you will find one close 
to your preferences. Most adolescents report that social media helps them feel more accepted, more 
supported, more creative, and more connected to what’s going on in their friends’ lives.

Risks of Social Media

Professional Risks

Unfortunately, the benefits of social media come with several risks that are not present in face-to-
face interactions. Comments made during personal interactions stay limited to the memories of 
those present at the time of the interaction. But comments made on social media are persistent and 
available for review potentially forever. Many employers don’t just look at professional websites like 
LinkedIn but also do a Google search of your name. Employers, particularly large employers, are 

316	 You can create a GitHub profile at https://github.com/ (accessed June 2023).
317	 Upwork home page, https://www.upwork.com/ (accessed June 2023).
318	 Fiverr home page, https://www.fiverr.com/ (accessed June 2023).

https://github.com/
https://www.upwork.com/
https://www.fiverr.com/
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very concerned about how their customers feel about them. Anything associated with you on social 
media that can be interpreted as being disagreeable, such as racist, homophobic, xenophobic, or 
misogynistic, even statements made as jokes, may come in the way of a great career opportunity. In 
contrast, a carefully curated online persona can have a positive and meaningful impact on both your 
career and life. Therefore, be careful before you share information online.

Another risk of social media relates to how you spend your time and attention. How you spend your 
time during your school years to learn skills relevant to a career can have a disproportionate impact 
on your professional outcomes. The earlier you enter a career, the longer you can benefit from the 
income earned from the career. Unfortunately, teenagers are also eager for social validation. They 
may end up spending their time and attention on trying to look like social-media influencers with 
excellent physiques. They do this without considering that having a certain body structure may be 
a job requirement for influencers, but few people can make a living by just relying on their great 
physique.

For most people, it would take far greater effort to maintain physique and acquire skills necessary to 
earn a living as models (social media influencers) than it would take to learn technology for a profitable 
career. Focusing your attention on learning skills (such as enterprise technologies introduced in this 
book) that can help you find a good job may be very valuable ultimately compared to maintaining 
influence on social media. Besides, it becomes increasingly difficult to create novelty and maintain 
influencer status. But careers in widely relevant skills such as Digital Information Technologies can 
easily last a lifetime.

Personal Risks

Tracking

Ever wondered how Spotify picks up songs aligned with your 
taste? How Netflix, YouTube, and TikTok can keep you glued 
for a long time with their recommendations? How the surprise 
loot box pops up just when you are about to wrap up video 
games for the day? How Amazon seems to know what you 
want to buy, as if it’s reading your mind?

When you watch a TikTok video, not only do they know what 
you watched but also where you placed your finger when 
watching, how long you watched it, how many times you 
watched it, and how many similarly themed videos you watched. They know what time of the day 
you usually watch videos and how much time you spend on every session. They know whether you 
are stationary or driving when you watch videos. They know what you liked, disliked, followed, or 
commented on. They know who your friends are and what their viewing preferences are. This enables 
TikTok to build a profile about you, and it’s safe to assume that TikTok knows more about you and your 
innermost thoughts, likes, and dislikes than your teachers, doctors, parents, friends, and colleagues. 
TikTok may even know more about you than you might be willing to acknowledge about yourself. 
This information gives TikTok, and other social media companies who are similarly tracking your 
information, enormous leverage over you.
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You should not be surprised to see digital ads follow you around wherever you go on the Internet. 
Even if your partner searches for a new car on a laptop that is connected to your home router, you 
may soon begin to see car advertisements. It doesn’t take long for a search engine to figure out that 
two people are closely associated if they use the same home router. If your friend is interested in a car, 
car companies are willing to spend their dollars to influence you, too.

Even if you use your browser in the incognito mode, all you can hope to achieve is not leave a trace 
on your computer of your activity. However, the websites you access still know that the request came 
from your computer. There is always a server log somewhere of your activity; and breadcrumbs have 
been dropped.

Addiction

Research in this area is nascent but according to the Surgeon General’s advisory, it is possible that 
social media exposure affects the reward center in the brain in ways comparable to addiction. There 
is evidence that frequent and inappropriate social media use may cause brain structures to change in 
ways similar to people with substance use or gambling addictions.

Not surprisingly, social medial companies are able to offer targeted advertisements to keep people 
glued to their platforms for hours. Teenagers and young adults are particularly susceptible to social 
media addiction. If you answer “Yes” to any behaviors such as those listed here, you may be suffering 
from this addiction.319 

·	 Do you become restless if you haven’t checked your social media accounts in the past few 
minutes? 

·	 Do you wake up in the middle of the night to see how many people have liked your post? 

·	 Do you stalk people online? 

·	 Do you spend your free time playing video games with strangers? 

·	 Are your closest friends in the online world? 

·	 Are you compelled to send snaps on Snapchat just to have a high Snapstreak count? 

Social Media addiction can be as dangerous as Cocaine addiction, since it has the potential to come 
in the way of your life and career. The algorithms of social media apps are designed to make you 
feel good by giving you dopamine-induced highs. Snapchat encourages you to check the app 
constantly, so you don’t lose your winning streak. Similarly, Facebook and YouTube can keep you on 
their platform by dangling content you like. Even LinkedIn sends notifications to entice you to hop on 
to their platform by notifying you of a colleague’s promotion, someone’s new job, and the names of 
people you can connect with to expand your network. However, once you go on LinkedIn, you may 
end up wasting hours doom-scrolling and checking on ex-colleagues and even people you are not 
likely to ever meet in your life. 

319	 There are several scales developed to measure social media addiction, including the 
Bergen Scale, https://pubmed.ncbi.nlm.nih.gov/29130330/ (accessed June 2023), and the 
social media addiction scale for adolescents https://openaccess.marmara.edu.tr/entities/
publication/258b3245-75d7-4a95-8f9c-d28a707e6da1 (accessed June 2023). The items 
presented here are our adaptations of the items in these scales.

https://pubmed.ncbi.nlm.nih.gov/29130330/
https://openaccess.marmara.edu.tr/entities/publication/258b3245-75d7-4a95-8f9c-d28a707e6da1
https://openaccess.marmara.edu.tr/entities/publication/258b3245-75d7-4a95-8f9c-d28a707e6da1
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Heavy social media users end up being more isolated from others and are less physically active 
because they are static in one place with their phones and laptops. Studies have also shown that 
the indiscriminate use of social media can lead to anxiety, stress, poor work performance, and low 
self-esteem. Most people project a narrow view of themselves on social media—photos in which 
they are looking great, receiving an award, or smiling with their happy families. Even folks suffering 
from deadly, incurable diseases may post glamorous pictures of themselves on social media without 
offering a hint of the truth. And their friends who are unable to post great pictures may feel miserable 
in comparison. The pressure to be liked on social media can turn it into a village square where 
everyone is judged all the time based on the whims and fancies of the most vocal participants. Your 
online friends usually have no clue of your financial situation; they may have no clue that you are 
suffering from mental or physical disabilities or going through a breakup, while posting unflattering 
comments related to you. 

The good news is that social media addiction can be cured. While research results are limited at this 
time, several experts have shared their personal experiences on how they cured their own social 
media addictions.320 Setting rules and boundaries is a common theme. Here are a few suggestions 
based on these experiences:

·	 Create a social media “happy hour.” Designate a happy hour dedicated to social media and use 
it for social media engagement but eliminate social media activity outside this window. This 
limits doom scrolling where you spend hours scrolling through your accounts. For example, 
you may decide to spend 30 minutes in the evenings or after accomplishing a major task.

·	 Avoid social media during lonely or low times. The apps are likely to make you feel worse as you 
will end up comparing yourself to others. Instead, find ways to create in-person interactions 
by visiting a library to borrow books or engage in other activities—e.g., yoga studio, cycling, 
dancing, or other team sports. 

·	 Disable notifications. Most social media apps hook you by notifying you of some event that 
promises excitement. This interferes with any serious activity. If you get notified of your friends’ 
dating adventures every five minutes, you are not likely to focus on your upcoming exams. 
Focus on what is in your best interests, not on what is in the social media companies’ best 
interests.

·	 Practice technology hygiene. Keep laptops and phones way from your bedroom at night to 
avoid disrupting your sleep.

·	 Visit friends and family when you want company. 

Cyberbullying

The mobile Internet connected us to people, but it also connected 
us to their darker sides. Cyberbullying is a pattern of threatening, 
mocking, or demeaning posts about someone on social media 

320	 For example, a Harvard Business Review blog article, “I Ran 4 Experiments to Break My Social 
Media Addition. Here’s What Worked.” describes the experiences of Sarah Peck, an entrepreneur 
in NYC, https://hbr.org/2018/10/i-ran-4-experiments-to-break-my-social-media-addiction-
heres-what-worked (accessed June 2023).

https://hbr.org/2018/10/i-ran-4-experiments-to-break-my-social-media-addiction-heres-what-worked
https://hbr.org/2018/10/i-ran-4-experiments-to-break-my-social-media-addiction-heres-what-worked
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apps or messaging platforms. Once limited to physical interactions, bullying can now easily become a 
pervasive and permanent feature of our life, following us wherever we go. It is no longer confined to school 
playgrounds and toxic family gatherings.

Adolescents often minimize sharing their social media experiences with their loved ones, so it is possible 
for them to bully or get bullied without others finding out about it. Sometimes, it may not be clear if 
the jokes about you are unintentional, harmless, or a form of cyberbullying. However, if something 
happens repeatedly and ends up hurting you emotionally, then it is cyberbullying. Here are a few 
forms of cyberbullying, according to UNICEF:321

·	 spreading lies about or posting embarrassing photos or videos of someone on social media;

·	 sending hurtful, abusive, or threatening messages, images, or videos via messaging platforms;

·	 impersonating someone and sending mean messages to others on their behalf or through 
fake accounts.

If you are experiencing cyberbullying, please act immediately to avoid impacting your physical and 
mental health. Here are a few options to consider:

·	 hide or delete offensive posts;

·	 bring the cyberbullying to the attention of a trusted adult;

·	 unfriend or block bullies; 

·	 alert your school counselors since they deal with cyberbullies regularly;

·	 delete the social media app where you are being bullied until the issue is addressed (This may 
be a temporary measure since you are likely to depend upon social media apps and messaging 
platforms as a source of information and a networking tool.); 

·	 contact the help center of the social media app or the messaging platform where you are 
being bullied. (Social media companies are far more aware of cyberbullying now than they 
were a decade ago and are constantly developing new technology and offering help to thwart 
cyberbullying. The UNICEF website to stop cyberbullying lists the help centers of social media 
apps at the bottom of the page.322) 

Online Predators

Parents strongly discourage their children from getting close to strangers, but often give children 
access to the Internet, where strangers can contact them, talk to them, and share inappropriate 
content with them. Someone pretending to be a sixteen-year-old girl may be a fifty-year-old man 
convicted of pedophilia. Unfortunately, the Internet offers anonymity, which can be a blessing as well 
as a curse. Online predators hang around in social media sites that are popular with children, pose as 

321	 “Cyberbullying: What is it and how to stop it,” https://www.unicef.org/end-violence/how-to-
stop-cyberbullying (accessed June 2023).

322	 “Cyberbullying: What is it and how to stop it,” https://www.unicef.org/end-violence/how-to-
stop-cyberbullying (accessed June 2023).

https://www.unicef.org/end-violence/how-to-stop-cyberbullying
https://www.unicef.org/end-violence/how-to-stop-cyberbullying
https://www.unicef.org/end-violence/how-to-stop-cyberbullying
https://www.unicef.org/end-violence/how-to-stop-cyberbullying
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children to befriend them, and gain their trust over time before trying to take advantage of them in 
inappropriate ways. Here are a few things to keep in mind:

·	 never give your contact information (e.g., address or phone number) to people you meet 
online;

·	 never arrange to physically meet a person you have only met online;

·	 never share a picture or a video of yourself that has the potential to embarrass you publicly or 
to blackmail you;

·	 beware if someone uses excessive flattery;

·	 immediately alert trusted adults/school counselors/police if someone shares inappropriate 
content.

Online Scammers

In the physical world, we can avoid pickpockets and scammers by avoiding busy places and refusing 
to talk to strangers. However, in the online world, we could be in the comfort of our homes and be 
scammed by a sweettalking conman sitting thousands of miles away in another country.

By posting your real birthday on Facebook, you give away an important 
bit of personal information about yourself. If you click on an email 
from an organization that you don’t completely trust, you may end 
up installing malware on your computer. If you follow the directions 
to update your credit card information sent in an email, scammers 
may end up withdrawing money from your account. If you tell people 
on Facebook that you are vacationing in Hawaii, then you may end 
up revealing to potential thieves that you are not at home. There are 
many types of scams going on in the online world, including job offer 
scams, lottery scams, hitman scams, romance scams, disaster relief scams, grandparent scams, and 
others. Scammers can pose as FBI agents, bank officials, IRS agents, or sheriffs. Sometimes, groups 
of individuals come together to scam and may play different roles to make it appear legitimate. With 
time, scammers are becoming so good at their jobs that it may be practically impossible to tell fake 
from real. So, what can you do to protect yourself? Here are a few tips:

·	 Be wary of revealing personal information. A favorite trick of scammers is to ask you for 
credentials to help fix a problem in your account. This is so common that being solicited for 
credentials is now a known security risk. Almost no legitimate service provider will ever solicit 
you for credentials or contact information. If there is a problem with your account, you will 
know it from your account page at the service provider’s website. If you are threatened with 
disruption of service, call the help desk number of the service provider directly. It is almost 
never appropriate to share your SSN, driver’s license, or other information in response to a cold 
outreach. 

·	 Look for “https://” at the beginning of the URL, which indicates a secure connection. Additionally, 
check for a padlock symbol in the browser’s address bar. People eager to secure U.S. visas are 
regularly scammed by look-alike websites. 
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·	 Automate updates on your machines so you always have the most current security updates. 

·	 Use strong passwords and update them regularly. 

·	 Don’t click or hover on links in unsolicited emails or texts to avoid installing malware on your 
computer. 

·	 Report scams to your local law enforcement agencies or to the appropriate platforms. This 
may mobilize action to end the scam and reduce the chances that others fall victim to it. You 
may also file a complaint with the Internet Crime Complaint Center (IC3) of the FBI.323 

In general, be skeptical of unsolicited communication asking for your financial or personal information. 
If some offer looks too good to be true, then it probably is. You can get more information about the 
current recommendations to defend against scammers by visiting the Federal Trade Commission’s 
website on scam defense.324

Echo Chambers or Confirming Your Biases

As human beings, we tend to seek information that reinforces our preexisting beliefs. Echo chambers 
refer to groups that promote information that fits their conclusions and ignore information that does 
not. If you spend time on social media apps, you are likely to gravitate towards information that 
you agree with. Social media algorithms will then flood you with similar information to keep you 
engaged. If you are not careful, social media apps can then become echo chambers and confirm and 
solidify your biases. Unfortunately, this can prevent you from learning counterpoints to your opinions. 
Potentially, you may accept untrue information that reinforces your opinions. The Internet is full of 
fringe groups spouting fake news and rumors. Over time, this leads people to move further away 
from the truth and reluctant to listen to opposing viewpoints. Social scientists believe that social 
media apps have contributed to the polarization we see in our world.

To avoid getting into this trap, try to consciously reach out to people and groups with opposing 
opinions and try to understand what might be behind their opinions. It is generally not useful to label 
those who disagree with you in adversarial terms.

Mental Health

The Surgeon General’s advisory identifies several mental health 
concerns associated with social media use. Spending significant 
time on social media (three hours per day or more) greatly 
increased the risk of anxiety and depression among adolescents. 
Social media use increased depression even among college 
students. Evidence suggests that these concerns are greater for 
girls. Specific health concerns linked to social media use include 
cyberbullying-related depression, body image and disordered 
eating behaviors, and poor sleep quality.

323	 Internet Crime Complaint Center (IC3), FBI, https://www.ic3.gov/ (accessed June 2023).
324	 “Avoiding and Reporting Scams,” FTC, https://consumer.ftc.gov/scams (accessed June 2023).

https://www.ic3.gov/
https://consumer.ftc.gov/scams
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Conclusion
Although social media apps connect us to each other and give us unlimited access to information, 
they also have the potential to isolate and divide us. It is important to carefully monitor what we say 
or do on social media apps to not just avoid scammers, bullies, and predators but also to build a good 
online reputation. Assume that anything you say or do on social media will be used against you at the 
most critical time in your life. Just the way a potential employer may ask you to do a drug test before 
hiring you, employers may also ask for your social media handles to review your online reputation. 

As the Surgeon General’s advisory states, social media platforms are designed for adults, but used 
extensively by adolescents, placing adolescents at high risk of harm. By the time we understand how 
social media affect our youth, the current generation of youth may experience long-lasting harm. 
Many of the concerns associated with social media may eventually be addressed by regulation, but 
until then, it has become the responsibility of children, adolescents, parents, and teachers to minimize 
harm from inappropriate social media use.
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			   Chapter Terms and Definitions

Social Media: Internet-based channels that 
allow users to interact and derive value from 
user-generated content

LinkedIn: A global social network designed to 
connect working professionals

GitHub: A complete developer platform with 
communities across the world collaborating on 
software development

Cyberbullying: A pattern of threatening, 
mocking, or demeaning posts about someone 
on social media apps or messaging platforms

Echo Chambers: Groups that promote 
information that fits their conclusions and ignore 
information that does not

Social Media Tracking: The process of collecting 
social media data and saving it into a data store 
for analysis and use in algorithms

Social Media Addiction: Social media exposure 
that affects the reward center in the brain in ways 
comparable to addiction
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		  	 Chapter Case

Ken’s Social Media Safety Research
Ken just finished taking a class on Internet safety. He knew that social media was 
a place where lots of good and bad things can happen. Ken wanted to know more 
about social media and what their companies can do to protect the safety of their 
users. He remembered that when he joined several social media platforms, he would 
just ignore the terms of use. At that time, he just wanted to start using the social 
media platform and socialize with his friends. But now, he was concerned about 
safety and researched the terms of use for three popular social media platforms. 
Here is a sample of what Ken found from Instagram, Snapchat, and Twitter: 

Instagram: Maintain our supportive environment by not glorifying self-injury. 

The Instagram community cares for each other, and is often a place where 
people facing difficult issues such as eating disorders, cutting, or other kinds 
of self-injury come together to create awareness or find support. We try to 
do our part by providing education in the app and adding information in the 
Help Center so people can get the help they need.

Encouraging or urging people to embrace self-injury is counter to this 
environment of support, and we’ll remove it or disable accounts if it’s reported 
to us. We may also remove content identifying victims or survivors of self-
injury if the content targets them for attack or humor. 

Snapchat: Rights You Grant Us

Many of our Services let you create, upload, post, send, receive, and store 
content. When you do that, you retain whatever ownership rights in that 
content you had to begin with. But you grant us a license to use that content. 
How broad that license is depends on which Services you use and the Settings 
you have selected.

For all content you submit to the Services, you grant Snap and our affiliates 
a worldwide, royalty-free, sublicensable, and transferable license to host, 
store, cache, use, display, reproduce, modify, adapt, edit, publish, analyze, 
transmit, and distribute that content. This license is for the purpose of 
operating, developing, providing, promoting, and improving the Services 
and researching and developing new ones. This license includes a right for 
us to make your content available to, and pass these rights along to, service 
providers with whom we have contractual relationships related to the 
provision of the Services, solely for the purpose of providing such Services.
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		  	 Chapter Case (continued)

Twitter: Targeted harassment

We consider targeted behavior as malicious, unreciprocated, and intended to 
humiliate or degrade an individual(s). We prohibit the following behavior on 
the platform:

·	 Posting multiple Tweets, over a short period of time, or continuously 
posting replies with malicious content, to target an individual. This 
includes accounts dedicated to harassing an individual or multiple 
individuals.

·	 Mentioning or tagging users with malicious content.

Question 1:	 Review the terms of use samples from the three social media 
platforms listed above. Choose one and describe in your own words 
why you think the platform has listed this term of use and how it can 
keep its users safe.

Question 2:	 Think of a feature you could add to any social media platform of 
your choice that would help keep people safe. Describe the feature 
in detail and how you think it will keep the platform’s users safe.
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Grouping :: 312

Importing data :: 316
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Query :: 307, 311, 320
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Updating data :: 309
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Spreadsheets :: 179

Word processors :: 144, 166
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System :: 10, 21, 26, 35
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Generated folders :: 92

Table of contents :: 133, 144, 161, 166

Keyboard shortcut :: 163

Tables

Creating and managing, database :: 314

HTML :: 255, 274

Inserting data, database :: 315

Pivot :: 118, 174, 190, 191

Presentation applications :: 203

Relational database :: 303, 314, 320

Word processors :: 145

Tablet computers :: 25, 35, 54

Tags in HTML

Anchor :: 253, 274

Body :: 252

Bold :: 253

Form :: 257, 274

Head :: 251, 274

Heading :: 252, 274

HTML :: 251, 274

Image :: 254, 274

Input :: 257

List tags :: 255

Paragraph :: 252, 274
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Strike :: 253, 274

Subscript :: 253, 274

Superscript :: 253, 274

Table :: 255

Underline :: 253, 274

Task Manager :: 62, 105, 109

TCP/IP Stack :: 326

Application layer :: 332

Data link layer :: 329

Network layer :: 331

Physical layer :: 327

Transport layer :: 332

Teams, cybersecurity :: 356

Template, word processors :: 133, 166

Themes

Presentation applications :: 196, 213

Spreadsheets :: 179

Thesaurus :: 157

Threats, information security :: 349, 351, 358

Malicious actor :: 352, 358

Track changes :: 152
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Training, online :: 43

Transaction Control Language (TCL) :: 317, 
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Transistor :: 58, 75
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213
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337
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Transmission Control Protocol (TCP) :: 332, 
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Trash :: 99, 109
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Uniform Resource Locator (URL) :: 46, 49

Universal Serial Bus (USB) :: 53, 75
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Updating data, SQL :: 309

Upwork :: 382
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User interface :: 25, 35, 83, 109
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Variable, programming :: 281, 298
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Virtual reality :: 292
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Risks, pitfalls, strategies :: 45, 382
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Strategies :: 45

Use :: 37

Webserver :: 263, 265, 275

Website development

Content Management System (CMS) :: 264

Design :: 261

Editors :: 266

Hosting :: 265, 267, 275
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Webserver :: 263, 265, 275
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WYSIWYG :: 266

Wide Area Networks (WANs) :: 17

Wi-Fi :: 31, 54, 75
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Windows File Explorer :: 109
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Women in technology :: 18
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Alignment :: 142
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Bookmarks :: 160
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Comments :: 153

Creating content :: 137

File operations :: 135

Find and replace :: 154, 166
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Footnotes :: 161, 166
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Insert menu :: 148
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Page Layout :: 149, 166
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Table of contents :: 133, 144, 161, 166
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